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About This Guide

This Novell® Group Wise® 7 Installation Guide helps you install a new GroupWise system or update
an existing GroupWise 5.x/6.x system. The guide is divided into the following sections:
» “Installation” on page 15
» “Update” on page 217
* “Migration” on page 267
* “Appendixes” on page 301
* Appendix A, “GroupWise Version Compatibility,” on page 303
* Appendix B, “Third-Party Materials,” on page 313
* Appendix C, “Documentation Updates,” on page 323

Audience

This guide is intended for network administrators who install and administer GroupWise.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.

Documentation Updates

For the most recent version of the GroupWise 7 Installation Guide, visit the Novell GroupWise 7
Documentation Web site (http://www.novell.com/documentation/gw?7).

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 7
Documentation Web site (http://www.novell.com/documentation/gw7):

* Administration Guide

* Multi-System Administration Guide

* Interoperability Guide

* Troubleshooting Guides

* GroupWise Client User Guides

» GroupWise Client Frequently Asked Questions (FAQ)

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path.

13
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A trademark symbol (®, ™ etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for
other platforms, the pathname is presented with a backslash. Users of platforms that require a
forward slash, such as Linux*, should use forward slashes as required by your software.

When a startup switch can be written with a forward slash for some platforms or a double hyphen for
other platforms, the startup switch is presented with a forward slash. Users of platforms that require
a double hyphen, such as Linux, should use double hyphens as required by your software.
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Installation

* Chapter 1, “What Is GroupWise?,” on page 17

* Chapter 2, “GroupWise System Requirements,” on page 21
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What Is GroupWise?

Novell® GroupWise® is an enterprise collaboration system that provides secure e-mail, calendaring,
scheduling, and instant messaging. GroupWise also includes task management, contact
management, document management, and other productivity tools. GroupWise can be used on your
desktop on Linux, Windows*, or Macintosh*; in a Web browser anywhere you have an Internet
connection; and even on mobile devices. Your GroupWise system can be set up on NetWare®,
Linux, Windows, or any combination of these operating systems.

The following sections include more details about what GroupWise provides and what you need to
do to set up GroupWise to best meet your needs.

» Section 1.1, “What GroupWise Provides,” on page 17

+ Section 1.2, “What You Need to Do,” on page 19

1.1 What GroupWise Provides

GroupWise provides communication and collaboration services that are secure, highly available,
and easily accessible, as explained in the following sections:

» Section 1.1.1, “Essential Communication and Collaboration Services,” on page 17

» Section 1.1.2, “Available Anytime,” on page 18

» Section 1.1.3, “Accessible Anywhere,” on page 18

» Section 1.1.4, “Always Secure,” on page 18

1.1.1 Essential Communication and Collaboration Services

GroupWise provides a variety of tools to enable users to work together and work smarter.

* Messaging: Send and receive mail messages, phone messages, and reminder notes. A mail
message is for general correspondence. A phone message is designed for those who take phone
messages for others. A reminder note includes a start date and, when accepted by the recipient,
is posted to the recipient’s Calendar.

* Instant Messaging: Communicate in real time with other GroupWise users through
GroupWise Messenger. GroupWise Messenger lets you know when other users are online,
busy, or away from their desks. It also allows you to save conversations.

¢ Scheduling: Schedule both appointments and tasks. When you schedule an appointment, you
can search other users’ Calendars to find free times for the appointment. When you schedule a
task, you can assign a priority and due date to the task. If the recipient accepts an appointment
or task, it is automatically added to his or her Calendar.

* Calendaring: View and manage your appointments, tasks, and reminder notes in a Calendar
view. You can create multiple calendars

* Task Management: Accept or decline the tasks you are sent, and track accepted tasks through
to completion. You can also turn any message into a task by adding it to your Checklist folder.

* Contact Management: Manage information for your contacts, groups, resources, and
organizations, including being able to view, update, delete, and add information to the contacts
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in your address book. In addition, you can view a history of messages sent to and received from
individual contacts.

* Document Management: Store documents in GroupWise libraries. In a library, documents are
compressed to save disk space and encrypted to maintain security. With document
management, you can check in, check out, share, and version documents.

1.1.2 Available Anytime

GroupWise ensures that your essential communication tools are always available:

¢ Caching: The GroupWise Windows and Cross-Platform clients include a Caching mode that
allows you to cache GroupWise information to your local drive and continue to work even
when you aren’t logged into your network mailbox.

¢ LDAP Pooling: If you are using LDAP authentication for GroupWise mailbox authentication,
LDAP pooling ensures that there is always an LDAP server through which authentication can
be performed.

¢ Clustering: To ensure that GroupWise data is always available and GroupWise components
are always running, you can install GroupWise in a cluster on NetWare, Linux, or Windows.

1.1.3 Accessible Anywhere

GroupWise lets you communicate and collaborate with other people using the device that is most
convenient:

¢ Personal Computers: To access your mailbox, you can run the GroupWise Windows client on
any workstation that uses Windows 2000 or higher. On Linux and Macintosh workstations, you
can run the GroupWise Cross-Platform client.

* Web Browsers and Mobile Devices: With GroupWise WebAccess installed, you can also
access your mailbox through a Web browser, a cellular phone, or a PDA (personal digital
assistant) such as Pocket PC*. The GroupWise WebAccess client formats information to best
accommodate the type of device on which it is being displayed.

¢ Other E-Mail Clients: GroupWise enables you to access your mailbox with any POP3,
IMAP4, and SOAP e-mail clients.

1.1.4 Always Secure

GroupWise provides extensive security measures to protect your information.

* Encryption: To protect your information as it is stored in the various GroupWise databases and
moved across the network, GroupWise encrypts the information. Each piece of information is
encrypted differently through the use of randomly-generated encryption keys.

* Open Security Standards: To further ensure that your information is secure while moving
across your internal network or across the Internet, GroupWise supports open security
standards such as Secure Socket Layer (SSL), Secure Multipurpose Internet Mail Extension (S/
MIME), Public Key Infrastructure (PKI), and Transport Layer Security (TSL).

* Spam Protection: To protect you from seeing unwanted messages, the GroupWise Windows
client includes a Junk Mail Handling feature that lets you control unwanted Internet e-mail
messages. In addition, you can configure the Internet Agent (the GroupWise component
responsible for sending and receiving Internet e-mail messages) to reject messages from known
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open relay hosts and spam hosts. GroupWise also works with partner products that provide

additional anti-spam solutions.

* Virus Protection: GroupWise works with partner products to provide solutions that detect and

eliminate viruses.

For information about additional security solutions available for GroupWise through GroupWise
partners, see the Novell Partner Product Guide (http://www.novell.com/partnerguide).

1.2 What You Need to Do

GroupWise includes multiple components that you need to install to realize the full benefits of
GroupWise. However, some components might not be necessary, depending on your needs. The
following table outlines the components, what they provide, and where to find instructions for

installing them.

Table 1-1 Components of Your GroupWise System

Component What it does

Go to

Administration, Agents,
and Client (Windows or
Cross-Platform)

Necessary for a basic GroupWise
system. These components are
required and must be installed
before any other components.

Provides Internet e-mail
communication, POP3/IMAP4 client
access, and paging services.

Internet Agent

Provides access to mailboxes
through a Web browser or mobile
device.

WebAccess

Monitor Provides administrative monitoring

of the GroupWise agents.

Messenger Provides instant messaging.

Chapter 3, “Installing a Basic GroupWise
System,” on page 25

Chapter 4, “Installing the GroupWise
Internet Agent,” on page 79

Chapter 5, “Installing GroupWise
WebAccess,” on page 103

Chapter 6, “Installing GroupWise
Monitor,” on page 139

GroupWise Messenger Installation
Guide (http://www.novell.com/
documentation/nm2)

In addition to the sections referenced in the above table, this Installation Guide includes the

following sections:

» Chapter 7, “Installing GroupWise Agents,” on page 161

* Chapter 8, “Installing the GroupWise Windows and Cross-Platform Clients,” on page 203

* Chapter 9, “Installing the GroupWise Connector for Microsoft Outlook,” on page 211

* Chapter 10, “Installing the GroupWise Mobile Server,” on page 213

* Chapter 11, “Installing GroupWise Messenger,” on page 215

The information in these sections is provided as a reference for installing additional components

after you’ve created your basic GroupWise system.
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GroupWise System Requirements

You, as a GroupWise® administrator, must ensure that your system meets GroupWise system
requirements, so that your GroupWise system can be set up successfully. After your GroupWise
system is set up, you must ensure that users’ workstations meet GroupWise client requirements, so
that users can run the GroupWise clients successfully.

» Section 2.1, “GroupWise Administration Requirements,” on page 21

* Section 2.2, “GroupWise Client Requirements,” on page 22

* Section 2.3, “Supported Environments,” on page 23

2.1 GroupWise Administration Requirements

O 32-bit/x86 processor or 64-bit/x86 processor running in 32-bit mode

U Any of the following server operating systems for the GroupWise agents (Post Office Agent,
Message Transfer Agent, Internet Agent, WebAccess Agent, Monitor Agent):

* Novell® Open Enterprise Server (N etWare® or Linux version), plus the latest Support
Pack

* NetWare 5.1, NetWare 6, or NetWare 6.5, plus the latest Support Pack for your version of
NetWare

Domains and post offices can be located on NetWare 3.12 and NetWare 4.2 servers,
although the agents cannot run there. The Monitor Agent is not available for NetWare.

« SUSE® Linux Enterprise Server 9, plus the latest Support Pack

The X Window System* is required by the GUI GroupWise Installation program,
Installation Advisor, and Setup Advisor that step you through the process of creating a
new GroupWise system. A text-based Installation program is also available.

The X Window System and Open Motif* are required by the GUI GroupWise agent server
consoles. By default, the agents run as daemons without user interfaces.

* Windows Server 2000 or Windows Server 2003, plus the latest Service Pack for your
version of Windows

(W

Adequate server memory as required by the operating system
O eDirectory™ 8.7 or later, plus the latest Support Pack
O ConsoleOne® 1.3.6 or later

On Linux, ConsoleOne requires Java* Virtual Machine (JVM*) 1.4.2, plus the X Window
System, version X11R6 or later. If necessary, you can download ConsoleOne for Linux from
the Novell Product Downloads site (http://download.novell.com).

O Windows 2000/XP/2003 and the Novell Client™ on any administrator Windows machine
where you run ConsoleOne or the GroupWise Installation program

If necessary, you can download the Novell Client from the Novell Product Downloads site
(http://download.novell.com).

O Adequate server disk space:

 Software distribution directory: 500 MB for all GroupWise components in one language
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* Domain directory: 100-200 MB for the domain database; plus 1 GB or more for message
queues when links are down

* Post office directory: 5 MB per user (minimum); 100 MB or more per user
(recommended); plus 100-300 MB for the post office database; plus 500 MB or more for
message queues when links are down

* MTA/POA installation: approximately 25 MB (varies by platform)
+ Internet Agent installation: approximately 37 MB (varies by platform)

* WebAccess installation: approximately 215 MB (111 MB shared with Monitor; varies by
platform)

* Monitor installation: approximately 140 MB (111 MB shared with WebAccess; varies by
platform)

O Internet connectivity for the Internet Agent

* Internet domain name for your company

* Internet Service Provider (ISP) or in-house DNS address resolution
O Any of the following Web servers for WebAccess and Monitor:

* NetWare 6: Netscape Enterprise Server* for NetWare, Apache 1.3 plus Tomcat 3.3 plus
the Jakarta Connector

* NetWare 6.5: Apache 2 plus Tomcat 4 plus the Jakarta Connector
 Linux: Apache 2 plus Tomcat 4 plus the Jakarta Connector

» Windows Server 2000/2003: Microsoft Internet Information Server (IIS) 5 or later plus
Tomcat 5.5 plus the Jakarta Connector

* UNIX*: Apache 2 plus a compatible servlet engine and connector
O Any of the following Web browsers for the agent Web consoles:
* Linux: Mozilla* Firefox*
» Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox
* Macintosh: The latest version of Safari* for your Mac OS; Mozilla Firefox
+ UNIX: Mozilla Firefox

2.2 GroupWise Client Requirements

* Section 2.2.1, “Windows Client,” on page 22

* Section 2.2.2, “Cross-Platform Client on Linux,” on page 23
 Section 2.2.3, “Cross-Platform Client on Macintosh,” on page 23
» Section 2.2.4, “WebAccess Client,” on page 23

2.2.1 Windows Client

* Any of the following desktop operating systems for the GroupWise Windows client:
* Windows 2000 on a Pentium™ II 200 or higher with at least 128 MB of RAM
* Windows XP Professional on a Pentium III 300 or higher with at least 128 MB of RAM
* Windows 2003 on a Pentium III 350 or higher with at least 256 MB of RAM

» 200 MB of free disk space on each user’s workstation to install the Windows client
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2.2.2 Cross-Platform Client on Linux

* Any of the following desktop operating systems:

* Novell Linux Desktop, plus the KDE desktop or the GNOME* desktop

» Red Hat* Desktop 4 or Red Hat Enterprise Linux WS 4, plus the GNOME desktop
+ Java Virtual Machine (JVM) 1.5 or later

* 200 MB of free disk space on each user’s workstation to install the Cross-Platform client

2.2.3 Cross-Platform Client on Macintosh

* Any of the following desktop operating systems:
* Mac OS 10.3 (Panther) or Mac OS 10.4 (Tiger)
* Mac OS X for Intel

+ Java Virtual Machine (JVM) 1.4.2 or later

* 75 MB of free disk space on each user’s workstation to install the Cross-Platform client

2.2.4 WebAccess Client

* Any of the following Web browsers:
* Linux: Mozilla Firefox
* Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox
* Macintosh: The latest version of Safari for your Mac OS; Mozilla Firefox
+ UNIX: Mozilla Firefox
* Any of the following mobile devices:

* Any mobile device that supports the Wireless Access Protocol (WAP) and has a
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or later, or
Wireless Markup Language (WML) 1.1 or later

» Pocket PC with Windows 2000/2002/2003

2.3 Supported Environments

» Section 2.3.1, “IPV6 Support,” on page 23
» Section 2.3.2, “Clustering Support,” on page 24
» Section 2.3.3, “Virtual Machine Support,” on page 24

2.3.1 IPV6 Support

The POA, the MTA, the Internet Agent, and the Monitor Agent support the IPV6 protocol when it is
available on the server. If it is available, the agent detects it and supports IPV6 by default, along with
IPV4. The WebAccess Agent and its accompanying Viewer Agent do not support [PV6.

As you configure your GroupWise system and specify the network address of an IPV6 server, you
must specify its DNS hostname. IP Address fields in ConsoleOne do not accommodate IPV6
address format.
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IPV6 support is available on Linux and Windows. IPV6 support is not currently available on
NetWare.

2.3.2 Clustering Support

You can set up your GroupWise system in any of the following clustering environments, as
described in the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7):
* “Novell Cluster Services on NetWare”
» “Novell Cluster Services on Linux”
» “PolyServe Matrix Server on Linux”
* “Microsoft Clustering Services on Windows”

If you are using one of these clustering environments, follow the installation instructions in the
GroupWise 7 Interoperability Guide, rather than the installation instructions in this guide.

2.3.3 Virtual Machine Support

You can install components of your GroupWise system in virtual environments where a software
program enables one physical server to function as if it were two or more physical servers. The
following virtualization software is supported:

* VMware* GSX Server®, an enterprise-class virtual infrastructure for x86-based servers

* VMware ESX Server*, a data center-class virtual infrastructure for mission-critical
environments

For more information, see the VM Ware Web site (http://www.vmware.com).
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Installing a Basic GroupWise
System

Every Novell® GroupWise® system, whether it services five users or 50,000 users, starts as a basic
GroupWise system. The following sections present the background information and installation
instructions you need to successfully implement your basic GroupWise system.

* Section 3.1, “Basic System Overview,” on page 25

» Section 3.2, “Planning Your Basic GroupWise System,” on page 26

» Section 3.3, “Setting Up a Basic GroupWise System,” on page 45

» Section 3.4, “What’s Next,” on page 72

+ Section 3.5, “Basic GroupWise System Worksheet,” on page 73

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before starting to
set up your GroupWise system.

3.1 Basic System Overview

A basic GroupWise system consists of a single domain with one post office, a document library, and
one or more users, as shown below.

Figure 3-1 Basic GroupWise System

Domain

Q
I

Message
Transfer
Agent

Post Office Post Office
Agent ﬁ % with Library

1

GroupWise
Client

Each GroupWise user has a mailbox in the post office; users run the GroupWise client (Windows,
Cross-Platform, or WebAccess) to access their mailboxes and to send and receive mail.

The GroupWise Post Office Agent (POA) delivers messages between users’ mailboxes in a post
office, and the GroupWise Message Transfer Agent (MTA) routes messages between post offices (if
there is more than one post office in the domain) and between domains (if there is more than one
domain in the system).

After you finish setting up your basic GroupWise system, you can review Section 3.4, “What’s
Next,” on page 72 to learn how you can expand your system.
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3.2 Planning Your Basic GroupWise System

The GroupWise Installation program includes an Installation Advisor to help you install the
GroupWise files to the appropriate locations and a Setup Advisor to help you create and configure
your GroupWise system. Both Advisors provide information to guide you through the process.

If you are comfortable with your knowledge of GroupWise, you can skip this planning section and
continue with Section 3.3, “Setting Up a Basic GroupWise System,” on page 45. Otherwise, you
should review the following sections while filling out Section 3.5, “Basic GroupWise System
Worksheet,” on page 73. The worksheet lists all the information you are prompted for as you run the
Adpvisors.

» Section 3.2.1, “Determining Installation Locations,” on page 26

* Section 3.2.2, “Planning Your Domain,” on page 30

 Section 3.2.3, “Planning Your Post Office,” on page 35

» Section 3.2.4, “Planning Your GroupWise Agents,” on page 38

» Section 3.2.5, “Sample GroupWise Configurations,” on page 43

IMPORTANT: If you plan to install GroupWise in a clustered server environment, refer to the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) as you plan your
GroupWise system.

3.2.1 Determining Installation Locations

The Installation Advisor prompts you for information about the Novell eDirectory™ tree where you
plan to create GroupWise objects and the network server locations where you plan to create
GroupWise directories and install files. The following sections prepare you to supply the required
information.

* “Novell eDirectory” on page 26

* “ConsoleOne” on page 27

* “GroupWise Software Distribution Directory” on page 28
* “GroupWise Languages” on page 29

Novell eDirectory

GroupWise is administered through eDirectory, the directory service provided by Novell. All
components, such as domains, post offices, libraries, and agents, as well as all users” GroupWise
accounts, are configured through objects in eDirectory. You need to make sure that you have
eDirectory installed in your environment. eDirectory can be installed on NetWare, Linux, or
Windows.

GroupWise 7 includes the Novell eDirectory CD to assist those who do not already have eDirectory
installed and want to install it on Linux. Follow the instructions in the Novell eDirectory Installation
Guide (http://www.novell.com/documentation/edir87) to install eDirectory, along with its latest
Support Pack, and ConsoleOne® before proceeding to install your basic GroupWise system.
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Extending the eDirectory Tree’s Schema

The Setup Advisor must extend the schema of the eDirectory tree where you plan to create your
GroupWise system. Because all objects for a single GroupWise domain must reside in the same
eDirectory tree, installing a basic system (one domain) requires you to extend one tree only.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 5: Tree Name, specify the eDirectory tree where you plan to create the GroupWise objects.

Making Sure Users Exist in eDirectory

You must make sure all users who will use GroupWise exist in eDirectory. GroupWise accounts can
only be assigned to eDirectory User objects and GroupWise External Entity objects.

GroupWise external entities represent non-eDirectory users and are added to eDirectory for the sole
purpose of assigning GroupWise accounts to these users. GroupWise external entities require
GroupWise licenses but not eDirectory licenses. You can add GroupWise external entities only after
you have installed GroupWise. Instructions for adding GroupWise external entities are provided in
Section 8.3.1, “Assigning GroupWise Accounts to Users,” on page 204.

ConsoleOne

GroupWise administration is performed through ConsoleOne, using the version listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21. When you install GroupWise, the
GroupWise Administrator snap-in files are copied into an existing ConsoleOne installation. The
GroupWise Administrator snap-in files extend the functionality of ConsoleOne to let you administer
GroupWise. ConsoleOne considerations differ by platform:

NetWare and  For a GroupWise system on NetWare or Windows, you need to decide which

Windows: ConsoleOne location you want use to administer GroupWise. This can be a
ConsoleOne location on a network server, or it can be on a local workstation. If you plan
to use ConsoleOne on a local workstation, you need to perform the GroupWise
installation from that workstation. For your convenience, ConsoleOne is included on the
GroupWise 7 Administrator for NetWare/Windows CD. The Installation program lets you
install ConsoleOne if necessary. You can also use the Installation program at a later
time to install ConsoleOne and the GroupWise Administrator snap-in files to additional
locations.

IMPORTANT: For a GroupWise system on NetWare, you cannot run ConsoleOne to
administer GroupWise at the NetWare server console. The GroupWise Administrator
snap-ins to ConsoleOne do not run in that environment.

Linux: For a GroupWise system on Linux, ConsoleOne must already be installed before you
set up your GroupWise system. GroupWise 7 includes eDirectory for Solaris*, Linux,
and AIX*, from which you can install ConsoleOne. ConsoleOne is installed to /uszr/
ConsoleOne. Make sure that ConsoleOne is installed on the Linux server where you
plan to create your basic GroupWise system.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 2: ConsoleOne Path, specify the path for the ConsoleOne location you want to use to
administer GroupWise.
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GroupWise Software Distribution Directory

During installation, you are prompted to create a GroupWise software distribution directory on a
network server and then copy selected GroupWise software components to the directory.

You should consider the following when deciding where to create the software distribution
directory:

» “User Access to the Directory” on page 28
» “Disk Space Required for the Software” on page 28

User Access to the Directory

User access considerations depend on which GroupWise client users are running:

Windows Users can install the GroupWise Windows client through a TCP/IP or mapped connection

Client: to the software distribution directory. If you want users to install via a mapped connection,
you should create the software distribution directory on a server where you can provide
appropriate user access.

When users install the GroupWise Windows client, they can choose to copy it to a local
drive or they can run it from the software distribution directory. If you want users to be able
to run the GroupWise client from the software distribution directory, they must have a
permanent drive mapping to the directory.

Cross- Users can install the GroupWise Cross-Platform client from the GroupWise 7 Client for
Platform Linux and Macintosh CD or from the software distribution directory, which requires user
Client: access to the file system where the software distribution directory is located. However,

Cross-Platform client users cannot run the client from the software distribution directory.
They must install it locally.

WebAccess The GroupWise WebAccess client does not require that users install any GroupWise
Client: software on their workstations.

Disk Space Required for the Software

The disk space required for the directory depends on which software components you copy to the
directory. The maximum disk space required to store all the GroupWise software components for
one language is approximately 500 MB. For a breakdown by component, see Chapter 2,
“GroupWise System Requirements,” on page 21.

We recommend that you copy at least the GroupWise client files to the directory. This enables users
to install the GroupWise client from the distribution directory. Otherwise, you need to mount the
GroupWise 7 Client for Windows CD or GroupWise 7 Client for Linux and Macintosh CD as a
network volume or file system, or distribute the CD to individual users, unless you use one of the
software distribution methods described in “Distributing the GroupWise Client” in “Client” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

All GroupWise software other than the client is used for administrative purposes only; if disk space
is an issue and you don’t mind accessing the Group Wise 7 Administrator CD for your platform when
you need to install one of the software components, you might want to leave the administrative
software on the CD.

NOTE: On Linux, you might want to install the GroupWise Administration component to your
software distribution directory. It includes the RPMs for GroupWise Check (GWCheck) and the
GroupWise Database Copy utility (DBCopy). These RPMs are not installed by the GroupWise
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Installation program. For more information about these utilities, see “Standalone Database
Maintenance Programs” in “Databases” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw7).

BASIC GROUPWISE SYSTEM WORKSHEET

Under ltem 3: Software Distribution Directory, specify the path for the software distribution directory.

Under Item 4: Select Software, select the software components you want copied to the software
distribution directory.

The Installation Advisor lets you create one software distribution directory. After you’ve set up your
basic GroupWise system, you can create additional software distribution directories if needed.

For example, if not all users can access a single software distribution directory to run the GroupWise
Windows client Setup program, you can create an additional software distribution directory on a
server they can access. For information about creating additional software distribution directories,
see “Software Directory Management” in “System” in the GroupWise 7 Administration Guide (http:/
/www.novell.com/documentation/gw7).

GroupWise Languages

The GroupWise 7 CDs contain multiple languages.

NetWare Decide which languages you want to install. Your choice affects the programs listed below.
and

Windows:

Linux: All languages are always automatically installed. You can run any GroupWise program in

any available language at any time.

The language selection affects the following GroupWise components:

* GroupWise Administrator snap-ins for ConsoleOne

* GroupWise agents

» GroupWise client (Windows, Cross-Platform, and WebAccess)
For example, if you install English-US and German, you can run GroupWise Administrator and the
agents in either language. By default, GroupWise Administrator runs in the language in which you

are running ConsoleOne. Your users then have the choice of using either the English-US client or
the German client.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 1: Select Languages, specify the languages you want to install for a GroupWise system. The
GroupWise Administrator languages are copied to the ConsoleOne location. The GroupWise agent and
client languages are copied to the software distribution directory.

For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).
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3.2.2 Planning Your Domain

The domain functions as the main administration unit for the GroupWise system. When you
configure GroupWise information in eDirectory, it is also stored in the GroupWise domain database.
From the domain database, the GroupWise agents distribute the information to each post office
database. Users then get the information, such as user addresses, from the post office database.

In a multiple-post-office system, the domain also organizes post offices into a logical grouping for
addressing and routing purposes, and enables you to scale your GroupWise system to meet your
current and future needs.

As you create your basic GroupWise system, the Setup Advisor prompts you for information about
the domain. The following sections prepare you to supply the required information.

* “System and Domain Names” on page 30

* “Domain Directory” on page 31

* “Domain Context” on page 32

* “Domain Language” on page 35

* “Domain Time Zone” on page 35

System and Domain Names

The domain requires a unique name. The name is used as the Domain object’s name in eDirectory. It
is also used for addressing and routing purposes within GroupWise, and can appear in the
GroupWise Address Book. The domain name can reflect a location, company name or branch name,
or some other element that makes sense for your organization. For example, you might want the
domain name to be the location (such as Provo) while the post office name is one of the company’s
departments (such as Research).

A domain names should consist of a single string. Use underscores (_) rather than spaces as
separators between words to facilitate addressing across the Internet. Do not use any of the
characters listed below in system and domain names:

ASCII characters 0-13 Comma,

Asterisk * Double quote "

At sign @ Extended ASCII characters that are graphical or typographical symbols;
accented characters in the extended range can be used

Braces { } Parentheses ()

Colon : Period .

Name your domain carefully. After it is created, the name cannot be changed.

You must also provide a name for your GroupWise system. The system name is used when
connecting to other GroupWise systems; for this reason, it must be different than any other
GroupWise system with which you might want to connect. The system name can be your company
name (for example, Novell), GroupWise, or anything else that fits the naming scheme you want to
use. The system name is displayed only in ConsoleOne so any characters can be used. You cannot
change the name after your system is created.
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Under Item 6: System Name, specify the system name.

Under Iltem 7: Domain Name, specify the domain name.

Domain Directory

The domain requires a directory structure in which to store database files and temporary files that
are created during message routing. As you choose a location for the domain directory, consider the
following:

¢ Security: GroupWise users never need access to the domain directory, so you should create it
in a location that you can easily secure.

¢ Server Platform and Version: The domain directory can be located on any of the supported
platforms listed in Section 2.1, “GroupWise Administration Requirements,” on page 21. It can
also be located on any platform that an MTA running on a supported platform could access
successfully.

For example, NetWare 4.2 is not a supported platform for GroupWise 7, but you could put a
domain directory on a NetWare 4.2 server because an MTA running on a supported NetWare
version would be able to access it there.

¢ MTA Access: The MTA requires direct access to the domain directory so that it can write to
the domain database. Therefore, you might want to consider the server type (NetWare, Linux,
or Windows) and location (local or remote) of the MTA before deciding on a domain directory.
For information about the MTA, see Section 3.2.4, “Planning Your GroupWise Agents,” on
page 38. For examples of possible domain directory locations and MTA configurations, see
“Sample GroupWise Configurations” on page 43.

IMPORTANT: On Linux, the MTA must be installed on the same server where its directory
structure is located. A file system mount between Linux servers does not provide the necessary
file locking mechanisms for the GroupWise Linux MTA to write to the domain database on a
remote Linux server.

* Disk Space Requirements: The domain directory requires a minimum of 100-200 MB of disk
space for the domain database. In addition, you should plan for an additional 1 GB or more of
free disk space for the temporary storage of messages when links are down.

* Directory Name: You should specify an empty directory for the domain. If you want, the
directory can reflect the domain name you chose. Use the following platform-specific
conventions:

NetWare: Use a maximum of 8 characters
Linux: Use only lowercase characters

Windows: No limitations.

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the
directory you specify does not exist, it is created during installation.
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Under Item 8: Domain Directory, specify the full path for the domain directory.

Domain Context

You can create the Domain object in any Organization or Organizational Unit container in any
context in your eDirectory tree. The only requirement is that it be in the same tree as the other
objects associated with the domain (Post Office object, User objects, and so forth).

The following sections provide examples of where you might place your Domain object. Because it
is helpful to discuss the Domain object’s context in relationship to the Post Office object’s context,
the examples also include context information for the Post Office object.

* “Objects in the Same Container as Users’ Organizational Units” on page 32
* “Objects Mirror eDirectory Organization” on page 32

* “Objects Mirror Network Server Organization” on page 33

* “Objects in a Dedicated Container” on page 33

* “The GroupWise View in ConsoleOne” on page 34

Objects in the Same Container as Users’ Organizational Units

In the following example, the Domain object (Provo) and Post Office object (Research) reside in the
same container (Provo) as the organizational units (Accounting, Manufacturing, R&D, and Sales)
that contain the users. This allows you to associate the domain with a single organization and
associate one post office with all users within the organization.

Figure 3-2 eDirectory Tree with the GroupWise Objects and Users’ Organizational Units in the Same Organization
Container

=& Provo
‘:'lﬁ Accounting
‘:'l§ Manufacturing
- Provo
#-78 RED
QEJ Research
-8 Sales

Objects Mirror eDirectory Organization

The following example is similar to the previous example, except that a separate post office is
created for each organizational unit that contains users. The Domain object (Provo) resides in the
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organization (Provo) and the Post Office objects reside in the same organizational units
(Accounting, Manufacturing, R&D, and Sales) as the users.

Figure 3-3 eDirectory Tree with the GroupWise Objects Mirroring the eDirectory Structure

- Provo

=78 Accounting
- Payroll
=8 Manufacturing
- Shipping
=82 Provo
=-*8 RED
-G Research
-8 Sales

-G Marketing

As in the previous example, this organizational structure allows you to quickly associate users with
their post offices. In addition, if you have thousands of users split between the different
organizational units, this method allows you to create multiple post offices with a smaller number of
users on each post office.

Objects Mirror Network Server Organization

Because the domain and post office have directory structures on network servers, you could also
choose to place the Domain and Post Office objects in the same context as the servers where the
directories will reside, as shown in the following example.

Figure 3-4 eDirectory Tree with the GroupWise Objects Located in the Same Containers as the Network Servers
Where Their Directories Reside

=& Provo
-7 Accounting
L8 Manufacturing
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- Provo
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-G Research

Objects in a Dedicated Container

If, rather than mirroring your eDirectory or server organization, you prefer to keep all your
GroupWise objects together, you could create a container, such as GroupWise, and place all
GroupWise objects in that container, as shown below.
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Administratively, this type of organizational structure makes it easier to restrict a GroupWise
administrator’s object and property rights to GroupWise objects only.

Figure 3-5 eDirectory Tree with the GroupWise Objects in a Dedicated Organizational Unit Container
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o @ Provo
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----- 83 Manufacturing
, ..... =3 R&D
.78 Sales

For information about GroupWise administrator rights, see “GroupWise Administrator Rights” in
“Security Administration” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw?7).
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Under Item 9: Domain Context, specify the context where you want to create the Domain object. If the
context does not already exist in your eDirectory tree, create the context now.

The GroupWise View in ConsoleOne
ConsoleOne includes a GroupWise View, displayed under the GroupWise System container.

The GroupWise View filters out all non-GroupWise objects and shows how GroupWise objects
relate to each other. For example, in the left pane, notice the Post Office object (Research) is
subordinate to the Domain object (Provo). You can select an object in the left pane and display its
associated objects (User, Resource, and so forth) in the right pane.

Figure 3-6 GroupWise View in ConsoleOne
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The GroupWise View is particularly useful if your GroupWise objects are placed in different
contexts in the eDirectory tree. Rather than searching for GroupWise objects throughout the tree,
you can administer the objects from the GroupWise View.
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Some GroupWise administrative functions can only be done while in the GroupWise View. This
includes such tasks as defining users from other GroupWise systems so that they appear in your
system’s Address Book.

Domain Language

The domain language determines the sort order for items in the GroupWise Address Book.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 10: Domain Language, specify the language for the domain. The domain language becomes
the default language for the domain’s post offices.

For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

Domain Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific
Time) for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los
Angeles user’s calendar at 1:00 p.m. Pacific Time.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 11: Domain Time Zone, specify the time zone for the domain. The domain time zone
becomes the default time zone for the domain’s post offices.

3.2.3 Planning Your Post Office

The post office contains users’ mailboxes. Like a domain, a post office requires a name, has a
directory structure and an eDirectory object, and can be configured to support different languages
and time zones. The following sections prepare you to supply the Setup Advisor with the required
information.

* “Post Office Name” on page 35

* “Post Office Directory” on page 36

* “Post Office Context” on page 37

» “Post Office Language” on page 37

» “Post Office Time Zone” on page 38

» “Post Office Users” on page 38

Post Office Name

The post office, like the domain, requires a unique name. The name is used as the Post Office
object’s name in eDirectory. It is also used for addressing and routing purposes within GroupWise,
and can appear in the GroupWise Address Book. The post office name can reflect any element that
makes sense for your organization. For example, you might want the domain name to be the location
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(such as Provo) while the post office name is one of the company’s departments (such as Research).
Name your post office carefully. After it is created, the name cannot be changed.

Post office names must be a single string. The same characters that are invalid in domain names are
also invalid in post office names (see “System and Domain Names” on page 30).
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Under ltem 12: Post Office Name, specify the name you've selected.

Post Office Directory

The post office requires a directory structure in which to store database files and temporary files that
are created during message routing. As you choose a location for the post office directory, consider
the following:

¢ Security: The GroupWise Windows and Cross-Platform clients access the post office through
a client/server (TCP/IP) connection to the Post Office Agent (POA). The WebAccess client
uses an HTTP connection. Therefore, GroupWise users never need access to the post office
directory, so you should create the directory in a location that you can easily secure.

¢ Server Platform and Version: The post office directory can be located on any of the
supported platforms listed in Section 2.1, “GroupWise Administration Requirements,” on
page 21. It can also be located on any platform that a POA running on a supported platform
could access successfully.

For example, NetWare 4.2 is not a supported platform for GroupWise 7, but you could put a
post office directory on a NetWare 4.2 server because a POA running on a supported NetWare
version would be able to access it there.

* POA Access: The POA requires direct access to the post office directory so that it can write to
the post office database. Therefore, you might want to consider the server type (NetWare,
Linux, or Windows) and location (local or remote) of the POA before deciding on a post office
directory. For information about the POA, see Section 3.2.4, “Planning Your GroupWise
Agents,” on page 38. For examples of possible post office directory locations and POA
configurations, see Section 3.2.5, “Sample GroupWise Configurations,” on page 43.

IMPORTANT: On Linux, the POA must be installed on the same server where its directory
structure is located. A file system mount between Linux servers does not provide the necessary
file locking mechanisms for the GroupWise Linux POA to write to the post office database on a
remote Linux server.

¢ Disk Space Requirements: The post office directory holds users’ messages and attachments,
so you should plan a minimum of 5 MB per user. 100 MB or more per user is recommended.
Although actual messages are relatively small, message attachments (documents, spreadsheets,
images, and so forth) can greatly increase the amount of disk space used.

Using ConsoleOne, you can restrict the amount of disk space users are allowed for their
mailboxes. When you know the number of users and the amount of disk space allocated to each
user, you can more accurately determine the amount of disk space required for the post office.

You can reduce the amount of disk space required for the post office by forcing users to run the
GroupWise Windows and Cross-Platform clients in Caching mode rather than Online mode. In
Online mode, messages are stored only in the post office. In Caching mode, messages are also
stored on users’ local drives, so you can reduce the size of users’ Online mailboxes independent
of what users want to store in personal locations.
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In addition to user messages and attachments, the post office directory also contains a
document library. If you want to use GroupWise document management, you should take into
account the disk space you want to provide for storing documents.

Plan for 100-300 MB for the post office database, which holds the GroupWise Address Book
and updates to it for download by Remote client users. Also plan 500 MB or more for the
temporary storage of messages when links are down.

* Directory Names: You should specify an empty directory for the post office. If you want, the
directory can reflect the post office name you chose. Use the following platform-specific
conventions:

NetWare: Use a maximum of 8 characters
Linux: Use only lowercase characters

Windows: No limitations.

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the
directory you specify does not exist, it is created during installation.

BASIC GROUPWISE SYSTEM WORKSHEET

Under ltem 13: Post Office Directory, specify the full path for the post office directory.

Post Office Context

Like the Domain object, you can create the Post Office object in any Organization or Organizational
Unit container in any context in your eDirectory tree. The only requirement is that it be in the same
tree as the Domain object and other objects associated with the domain (User objects and so on). For
configuration examples, see “Domain Context” on page 32.

BASIC GROUPWISE SYSTEM WORKSHEET

Under ltem 14: Post Office Context, specify the context where you want to create the Post Office object.
If the context does not already exist in your eDirectory tree, create the context now.

Post Office Language
The post office language determines the sort order for items in the GroupWise Address Book.

The post office assumes the same language as its domain unless you specify otherwise. For example,
if you set the domain and post office language to English-US, the Address Book items are sorted
according to English-US sort order rules. This is true even if some users in the post office are
running non-English-US GroupWise clients such as German or Japanese. Their client interface and
Help files are in German or Japanese, but the sort order is according to English-US standards. Time,
date, and number formats for the non-English clients default to the workstation language.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 15: Post Office Language, specify the language for the post office.
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For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

Post Office Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific
Time) for a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los
Angeles user’s calendar at 1:00 p.m. Pacific Time.

The post office assumes the same time zone as its domain unless you specify otherwise.

BASIC GROUPWISE SYSTEM WORKSHEET

Under ltem 16: Post Office Time Zone, specify the time zone where the post office is located.

Post Office Users

You need to assign a GroupWise account to each eDirectory user who should have a mailbox in the
post office. You can do this while creating your system, or you can do it afterwards. However, we
recommend that you at least add yourself as a GroupWise user so you can test the system.

BASIC GROUPWISE SYSTEM WORKSHEET

If desired, specify the context for each user under Item 20: Post Office Users.

The Setup Advisor lets you select users from the eDirectory tree to add to the post office. You do not
need to list all of the users at this time.

If you are adding non-eDirectory users as GroupWise external entities, you must wait to add them to
the post office until after you have finished the installation. Instructions for adding GroupWise
external entities are provided in Section 8.3.1, “Assigning GroupWise Accounts to Users,” on

page 204.

3.2.4 Planning Your GroupWise Agents

The Message Transfer Agent (MTA) and Post Office Agent (POA) route messages through the
GroupWise system. The MTA handles all message traffic between the domain and post office, while
the POA handles all message traffic within the post office.

MTA: GroupWise requires one MTA per domain, which means that you need to install and run one
MTA for your basic GroupWise system.

In addition to routing user messages between post offices and between domains, the MTA routes
administration messages from the domain to the post office. For example, when a user is given a
GroupWise account in eDirectory, the user is added to the GroupWise domain database. At the same
time, the MTA routes an administration message from the domain to the post office so that the POA
can add the user to the post office database. After the user is added to the post office database, the
post office’s users can see the newly added user’s information in the GroupWise Address Book

POA: GroupWise requires one POA per post office, which means that you need to install and run
one POA for your basic GroupWise system.
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The POA routes messages within the post office, updates the post office database when it receives
administration messages from the MTA, and performs other maintenance tasks in the post office.

The following sections prepare you to supply the information required when installing the MTA and
POA:

» “Agent Platform” on page 39

» “Agent Location” on page 39

* “MTA Link to the Post Office” on page 41

* “Web Console” on page 41

» “Agent Language” on page 42

* “Windows Installation Option: Application vs. Service” on page 42

Agent Platform

The MTA and POA are available as NetWare NLM™ programs, Linux executables, and Windows
executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating
system where the post office and domain are located. For example, if a domain and post office are
located on a NetWare server, then you would install the NetWare agents for them. However, this is
not required. For configuration examples, see Section 3.2.5, “Sample GroupWise Configurations,”
on page 43.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 21: Agent Platform, specify the type of agents (NetWare, Linux, or Windows) you want to use.

Agent Location

The MTA requires direct access to the domain directory so that it can write to the domain database.
The POA requires direct access to the post office directory so that it can write to the post office
database.

In general, we recommend that you install an agent on the same server as its directory. For example,
you would install the MTA on the same server as the domain directory and the POA on the same
server as the post office directory. This ensures that the agent always has access to its directory.

Figure 3-7 Direct Access between Agents and Directories
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However, if necessary, you can install the agent on a different server from its directory. This requires
the agent to have a direct link (mapped drive, UNC path, or file system mount) to its directory in
order to function. The following diagram illustrates the direct links:

Figure 3-8 MTA with UNC or Mapped Path to Domain and Post Office Directories; POA with UNC or Mapped
Path to the Post Olffice Directory
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For the purpose of simplifying the setup of your basic system, you are required to install both the
MTA and the POA to the same server. If, at a later time, you decide that you want to run one of the
agents on a different server, see Chapter 7, “Installing GroupWise Agents,” on page 161.

Consider these platform-specific guidelines:

NetWare:  When installing the NetWare agents, we recommend you use the sys: \system directory
on the NetWare server. This simplifies the use of startup files and ensures that the agent
NLM programs are in the server’s search path. If you use a different directory, you must add
that directory to the server’s search path.

Linux: The Linux agents are automatically installed to /opt/novell/groupwise/agents. On
Linux, do not move the agent software to a different location.

Windows: The default installation directory is c: \grpwise. However, you can install the agents to any
directory you want.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Item 22: Installation Path, specify the installation path for the agents.
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MTA Link to the Post Office

To route user and administration messages to the post office, the MTA requires a TCP/IP connection
with the post office’s POA, or alternatively, direct access or a direct link (mapped drive, UNC path,
or file system mount) to the post office directory. The following diagram illustrates the alternatives:

Figure 3-9 MTA Link Alternatives
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In general, a TCP/IP connection between the MTA and the POA is preferable.
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Under ltem 17: Post Office Link, select whether the MTA will connect to the post office through a TCP/IP
link to the POA or a direct link to the post office directory.

Under Item 18: POA Network Address, specify the IP address or DNS hostname of the POA’s server.
The GroupWise Windows and Cross-Platform clients, which access the POA through TCP/IP, need to
know the address. If the MTA will have a TCP/IP connection to the POA, it will also use this address.

If you plan to have the MTA use a TCP/IP connection to the POA, under ltem 19: MTA Network Address,
specify the IP address or DNS hostname of the MTA's server.

Web Console

The MTA and POA provide server consoles to let you monitor and configure the agents while at the
agents’ servers.

NetWare: The MTA and POA consoles are always displayed.

Linux: The MTA and POA consoles are displayed only if you start the agents with the --show
switch on the command line.

Windows: The MTA and POA consoles are displayed if you run the agents as applications but are not
displayed if you run the agents as services.

When the MTA and POA consoles are not available, you can monitor and configure the agents
through a Web browser. This feature, referred to as the agent Web console, lets you access the

agents’ statistics and diagnostic information from any location where you are connected to the
Internet and have access to a Web browser, either at a workstation or on a mobile device.
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By default, the MTA Web console is enabled on port 7180 and the POA Web console is enabled on
port 7181. In your browser, you access the agent Web consoles using the following URLSs:

http://mta network address:port
http://poa network address:port

where mta_network_address and poa_network_address are the agents’ IP addresses or host names
and port is the agent’s HTTP port number.
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Under Item 18: POA Network Address, specify the POA's HTTP port. The default port, 7181, should be
used unless there is a port conflict.

Under Iltem 19: MTA Network Address, specify the MTA's HTTP port. The default port, 7180, should be
used unless there is a port conflict.

Agent Language

If you have users with various language preferences, you can install the GroupWise agents in
multiple languages. The language determines the agents’ interface language only. It does not affect
messages processed by the agents.

By default, the agents start in the language selected for the domain. If that language has not been
installed, the agents start in the language used by the operating system. If that language has not been
installed, the agents start in English-US.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.
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Under ltem 24: Language, list the languages you want to install for the agents.

For more information, see “Multilingual GroupWise Systems” in “System” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

Windows Installation Option: Application vs. Service

You can run the Windows MTA and POA as normal applications or as services. When you run the
agents as Windows services, they must run under a specific user account. The user account you use
depends on where the domain and post office directories are located:

* When the domain and post office directories are located on the same server where you are
installing the agents, the agents can run under the local system account. You can also display
the agent server console when the agent software, directories, and databases are local.

* When the domain and post office directories are located on a remote server, you must specify a
user with rights to access the domain and post office directories.

Windows If the Windows agents need to log in to another Windows server, provide a Windows
username and password.
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NetWare: If the Windows agents need to log in to a NetWare server, provide an existing
eDirectory username and password, or create a new account for the agents, as
described in “Creating a NetWare Account for Agent Access (Optional)” on page 172.

Linux: Configuring the Windows agents to log in to a Linux server is not recommended.

As with all Windows services, you can start the agents manually or have them start automatically
each time the Windows server restarts.
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Under ltem 23: Windows Installation Options, select Install as Windows Services if you want to run the
agents as Windows services.

If you want to run the agents as Windows services, under Item 25: Windows Services Information, record
the account the agents will run under, and if necessary, the password for the account. Also select
whether you want the service to start automatically or manually.

3.2.5 Sample GroupWise Configurations

Many different configurations are possible for your GroupWise system. The following diagrams
illustrate some of the ways a basic GroupWise system (one domain and one post office) can be set

up.
* “NetWare 6.x Server” on page 43
* “Linux Server” on page 44
* “Windows 2003 Server” on page 44
* “Open Enterprise Server and Windows 2003 Server” on page 44

NetWare 6.x Server
The following diagram shows a basic GroupWise system set up on a single NetWare 6.x server.

Figure 3-10 GroupWise System Installed on a Single NetWare 6 Server
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from a local drive.

TCP/IP
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Linux Server

The following diagram shows all GroupWise components on a Linux server.

Figure 3-11 GroupWise System Installed on a Single Linux Server
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The following diagram shows all GroupWise components on a Windows 2003 server.

Figure 3-12 GroupWise System Installed on a Single Windows 2003 Server
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Open Enterprise Server and Windows 2003 Server

The following diagram shows the domain, post office, and software distribution directory on a
server running the NetWare version of Novell Open Enterprise Server (OES). The MTA and POA,
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located on a Windows 2003 server, use a UNC path to access the domain directory and post office
directory on the OES NetWare server.

Figure 3-13 GroupWise System Installed on an OES NetWare Server and Windows 2000 Server
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The following diagram shows the domain and MTA on a NetWare 6 server. The post office, software
distribution directory, and POA are on a Windows 2000 server. The MTA communicates with the
POA through TCP/IP.

Figure 3-14 GroupWise System Installed on a NetWare 6 Server and Windows 2000 Server
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NOTE: The above configuration has the MTA on one server and the POA on another. Because the
basic GroupWise system setup requires you to install the MTA and POA on the same server, you
would need to do additional setup to create a similar configuration.

TCP/IP
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3.3 Setting Up a Basic GroupWise System

Follow the setup instructions for the platform where you are creating your basic GroupWise system:

* Section 3.3.1, “NetWare and Windows: Setting Up a Basic GroupWise System,” on page 46
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* Section 3.3.2, “Linux: Setting Up a Basic GroupWise System,” on page 61

3.3.1 NetWare and Windows: Setting Up a Basic GroupWise
System

You should have already reviewed Section 3.2, “Planning Your Basic GroupWise System,” on
page 26 and filled out the worksheet.

The following sections step you through the GroupWise Installation program, Installation Advisor
and, Setup Advisor. The Installation Advisor installs the GroupWise software. It then launches the
Setup Advisor to create your domain and post office, set up the GroupWise agents, and set up the
GroupWise Windows client (if desired) on your local machine.

» “Starting the GroupWise Installation Program on Windows” on page 46

* “Installing the GroupWise Software” on page 48

* “Providing System Information” on page 49

» “Creating Your Basic GroupWise System” on page 52

 “Installing and Starting the GroupWise Agents” on page 53

» “Setting Up and Running the GroupWise Windows Client on Your Local Machine” on page 59

+ “Installing the GroupWise Administrator Snap-Ins to Additional Windows Machines” on
page 60

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before starting to
set up your GroupWise system.

Starting the GroupWise Installation Program on Windows
To start the GroupWise Installation program:

1 Ata Windows machine that meets the administrator machine requirements listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21, log in as an Admin equivalent to the
eDirectory tree in which you are installing GroupWise.
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2 Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the

GroupWise Installation program.

¥ GroupWise

Novell: GroupWise.

View the Readme Displays a text file with important information you should read before installing.

View the Quick Start

Displays a high-level checklist of system requirements and installation steps to guide you
through setting up your GroupWise system.

Displays overview and task information (in .PDF format) that will help you plan, install, and

View the Installation Guide update a GroupWise system, as well as install additional ¢ such as GroupWi
WebAccess and GroupWise Internet Agent.
Creat dat L the Group ion and Setup Advisors. These advisors step you
Lfeale or update a through the creation of a new GroupWise system or the isting Grouj
GroupWise system system.
Displays the GroupWise components you can individually install once you've created a
Install Products GroupWise system.
Visit the Novell GroupWise Launches your Web browser to display GroupWise information located on the Novell Web
Web Site site. (hWtpziwww.novell.com/productsigroupwise).

e J

E. ]

If the Installation program does not start automatically, run setup . exe from the root of the

CD.

3 Click Create or Update a GroupWise System, then click Yes to accept the license agreement and

display the Welcome to GroupWise Install page.

GroupWise Installation — |EI ll

Welcome to GroupWise Install

Install does the following:
Novell .

Helps you plan your system

& Ensures that eDirectory is extended o work with
GroupWise

3 & Lpdates ConsoleOne
=
\[K ® |ngtalls Group'wise ddministrator files for
~ Consoleline

Sets up the Groupiwize software distribution
directory

®& Runs ConsoleOne with the Setup Advizor ta
help you configure your Groupifise spstem if
neceszay

< Back I Next > I Exit
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4 Click Next until you reach the Administration Options page.

GroupWise Installation =101=]
Administration Options

N ove " “T'ou may create or update a GroupWWise system, or
‘ perform other administrative tagks.

[V Create a new system or update an esisting system

¥ [stall admiristration files

‘.IQ ¥ Copy files to a software distibution diectan,
.

Installation Guide: < Back. I Mext > I Exit |

5 Make sure that Create a New System or Update an Existing System is selected, then click Next.
6 Continue with Installing the GroupWise Software.

Installing the GroupWise Software

1 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.

Item 1: Select Languages

Item 2: ConsoleOne Path

Item 3: Software Distribution Directory
Item 4: Select Software

When you have provided this information, the Installation Advisor is ready to install the
GroupWise administrative software.

GroupWise Installation o ]

Ready to Install

N ove "‘ Click Inztall ta copy Graupwise files to pour spstem.
}:‘;
4
&
&

Installation Guide: < Back Inistall Exit

2 Click Install.

The Installation Advisor installs GroupWise software to the ConsoleOne location and software
distribution directory.
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3 Follow the prompts until you reach the Determine Next Step page.

GroupWise Installation =1=]=|
Determine Next Step

N ove "‘ Groupwise software has been successfully installed

Install will nows guide you through the remaining
steps to complete the Groupttise system
caonfiguration.
=
I[LM‘-‘
.
Are you
F * Updating an existing Groupiise system?
L "~ Creating a hew Grouphwise system?

Installation Guide: < Back. I Mext > I Exit |

()
o

4 Select Creating a New GroupWise System, then click Next to display the Run ConsoleOne
page.

GroupWise Installation - |EI ll

Run ConsoleOne

N " ‘T'ou can now configure and administer Groupiaise
ovell. fram Conzolelne:

& Click Run to start ConsoleOne with the
GroupWise Setup Advisor to help you configure
your system,

Click Exit and ConsoleOne will not mn at this
time. However, the nest time you run
Cansolelne, you will have the option to use the
Groupise Setup Advisor,

Installation Guide: < Back Rur Exit |

5 Continue with Providing System Information.

Providing System Information
The Installation Advisor launches ConsoleOne with the GroupWise Setup Advisor active.

1 On the Run ConsoleOne page, click Run to start ConsoleOne and the GroupWise Setup
Advisor.
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The Setup Advisor provides an overview of the information it needs to collect in order to create
your basic GroupWise system.

GroupWise System Setup 3 ll

GroupWise Setup Progress

Novell

The first step in creating a Groupyise system is to collect
information about the system you want to create

SIS

5 Collect system information
* Create system
* Install agent software

& * Setup client sofware
S

= Hack |ﬂe>d> Cancel | Finish | Help |

2 Follow the prompts to provide the GroupWise system and domain information from your Basic
GroupWise System Worksheet.

I[tem 3: Software Distribution Directory
Item 5: Tree Name

Item 6: System Name

Item 7: Domain Name

Item 8: Domain Directory

Item 9 Domain Context

Item 10: Domain Language

Item 11: Domain Time Zone

3 Follow the prompts to provide the GroupWise post office information from your Basic
GroupWise System Worksheet.

Item 12: Post Office Name
Item 13: Post Office Directory
Item 14: Post Office Context
Item 15: Post Office Language
Item 16: Post Office Time Zone

4 Follow the prompts to provide information about how to link the domain and the post office
from your Basic GroupWise System Worksheet.

Item 17: Post Office Link
Item 18: POA Network Address
Item 19: MTA Network Address (for a TCP/IP link)

When you have provided the system, domain, post office, and link information for your
GroupWise system, you are ready to create users. However, adding users at this point is
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optional. After the Setup Advisor has finished, you can add users to the post office at any time
by using ConsoleOne.

GruupWise System Setup

Post Office Users

Wou can give existing eDirectory users Grouphise accounts on this
post office now, or you can create GroupWWise accounts later

Novell

Select users for the post office:
e | .

Remove

= Biack | Mext = I Cancel | Firfsh | Help |

5 Add any users that you listed on your Basic GroupWise System Worksheet, then click Next.

The Setup Advisor summarizes your overall progress.

GroupWise System Setup

GroupWise Setup Progress

You are now ready to create your GroupWWise system. You will he
given a chance to review the information before your system is
created.

Novell

¥ Collect system infarmation
25 Create systemn

* Install agent sofware

* Setup client software

Cancel | Eimist | Help |

< Back
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6 Click Next to display a summary of the system, domain, post office, and link information you

entered.
GroupWise System Setup ll
Novell, = Summary
System narne: Novell
Dornain harme: Provo
== ";"; Dornain contesxt ProvoNovell
— = Dornain directory: WGl Zrovo
a | Domain time zane: (GMT-02:00) Mid-Atlantic
= ,“|, 5 Domain language English- US
= Post office name Research
Post office context: Provoovell
& Post office directary WEWwolZiresearch
. Post office time zone (GMT-02:00) Mid-Atlantic
S Fostoffice language: English- US

Ifthe above information is correct, click Next ta create your
GroupWise systern. To correct any infarmation, click Back until
you reach the appropriate page.

= Back | Cancel | Finish | Help |

7 Continue with the Creating Your Basic GroupWise System.

Creating Your Basic GroupWise System

After you have verified that the information you entered is correct, you are ready for the Setup
Advisor to create your GroupWise system.

1 On the Summary page, click Next.

The Setup Advisor creates the GroupWise system using the information you provided.

2 When your system has been created, click Next to display the GroupWise Setup Progress:
Install Agent Software page.

GroupWise System Setup 5[

Novell. GroupWise Setup Progress

You have successfully created your GroupWise systern. You
must now install and run the GrouphVise agent software.

¥ Collect system infarmation

¥ Create system
25 Install agent sofware
* Setup client software

o =

Cancel | Eimist | Help |

3 Continue with Installing and Starting the GroupWise Agents.
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Installing and Starting the GroupWise Agents

At this point, the Setup Advisor has created GroupWise objects in eDirectory and directory
structures on servers for your GroupWise system. You now need to install and start the MTA and
POA on your NetWare or Windows server.

1 On the GroupWise Setup Progress page, click Next to have the Setup Advisor launch the Agent
Installation program and display the Select Platform page.

GroupWise Agent Installation =1ol=

Select Platform

Select the agent software platform:
Novell.

' Nebware

’  Windows

Installation Guide < Back I Mext > I Exit |

2 Ifyou are installing the NetWare agents (worksheet item 21), continue with NetWare: Installing
and Starting the GroupWise Agents.

or

If you are installing the Windows agents (worksheet item 21), skip to “Windows: Installing and
Starting the GroupWise Agents” on page 55.

NetWare: Installing and Starting the GroupWise Agents

1 Follow the prompts to provide NetWare Agent information from your Basic GroupWise
System Worksheet.

Item 22: Installation Path
Item 24: Language

2 Review the information displayed on the Summary page, then click Install to install the
NetWare agents.
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The Installation Complete page appears when the software has been installed.

GroupWise Agent Installation [_1C]

Installation Complete

The Grouptise agent software has been successfully

N ove "_ installed and configured.

r— Options

W Launch GroupWise agents now
™ Launchin Protected Mode

Installation Guide: < Btk I Einish I Exit

3 Select from the following options:

Update AUTOEXEC File: Select this option to reference the grpwise .ncf file from the
server’s autoexec.ncf file so that the GroupWise agents are automatically loaded
whenever the server is started.

Launch GroupWise Agents Now: Select this option to have the Installation program start the
GroupWise agents for you immediately. You should only do this if the MTA and POA are on
the same server as the domain and post office directories. If you want the agents to run in
protected mode, select Launch in Protected Mode.

4 Click Finish to return to the Setup Advisor. The GroupWise Setup Progress page is again
displayed.

GroupWise System Setup 5'

GroupWise Setup Progress

The final step is to $et up the Groupwise client software.

¥ Collect system infarmation
¥ Create system

¥ Install agent software

25 Setup client sofware

= Back | Hext = I Cancel | Finish | Help |

5 Ifyou selected Launch GroupWise Agents Now, skip to Step 8.
or

To configure the agents to access the remote server where their domain and post office
directories have been created, continue with Step 6.

6 Use a text editor to modify the agents’ startup files.
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The load command in the grpwise.ncft file includes a startup switch that points the agents
to their startup files. The startup files include configuration information the agents need to
function properly. When the MTA is not on the same server as the domain directory, you need
to edit the MTA startup file to include the MTA’s eDirectory distinguished name. When the
POA is not on the same server as the post office directory, you need to edit the POA startup file
to include the POA’s eDirectory distinguished name.

The startup files are located in the agent installation directory you specified in Step 1. The
MTA startup file is named doma in.mta, where domain is the first 8 letters of the domain
name (for example, provo.mta). The POA startup file is named post office.poa,
where post_office is the first 8 letters of the post office name (for example, research.poa).

The /dn-distinguished object name startup switch is located in Section 1 of the startup file.
Delete the semicolon (;) at the beginning of the line and replace the distinguished object name
variable with the distinguished name of the MTA or POA. For example, if the MTA is for a
domain named Provo that is located in a container named Novell, you would enter:

/dn-mta.provo.novell
7 At the NetWare server console, enter grpwise.ncf to start the agents.

If the agents do not start successfully, see “Starting the NetWare GroupWise Agents” on
page 175.

8 Now that you have the NetWare agents installed and running, skip to “Setting Up and Running
the GroupWise Windows Client on Your Local Machine” on page 59.

Windows: Installing and Starting the GroupWise Agents

To install the Windows agents, you must run the Agent Installation program at the Windows server
where you are installing the agents.

1 Ifyou are already running the Agent Installation program at the Windows server where you are
installing the agents, skip to Step 6.

or

Click Exit to close the Agent Installation program that was launched automatically by the Setup
Advisor, go to the Windows server where you want to install the agents, then continue with
Step 2 below.

2 Make sure you are logged in as an Admin equivalent and have network access to the software
distribution directory (or the GroupWise 7 Administrator for NetWare/Windows CD), domain
directory, and post office directory.
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3 Start the Agent Installation program (install.exe in the agents subdirectory), then click
Yes to accept the license agreement and display the Overview page.

GroupWise Agent Installation — |EI ll
Overview
Welcome to the GroupWise Agent [nstallation Program.
N ove "> The follawing agent software will be installed and
configured;

Message Transfer Agent [MTA]  Routes messages between
domainz, post offices, and
Qatewas

Post Dffice Agent [POA] Delivers messages to users’
mailboxes

< Back I Next > I Exit

4 Click Next to continue.

5 Select Install, then click Next to display the Select Platform page.

GroupWise Agent Installation - |EI 5[

Select Platform

Select the agent software platform:
Novell.

' Netw'ars

’  windows

Installation Guide: < Back. I Mext > I Exit

6 Seclect Windows, then click Next.

7 Follow the prompts to provide Windows Agent information from your Basic GroupWise
System Worksheet in the order listed.

Item 22: Installation Path

Item 23: Windows Installation Options

Item 24: Language

[tem 7: Domain Name and Item 8: Domain Directory (if prompted)

Item 12: Post Office Name and Item 13: Post Office Directory (if prompted)
Item 25: Windows Service Information (if applicable)
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8

10

1"
12

If you are not running the Agent Installation program on the same server as the GroupWise
Setup Advisor, the Domains/Post Offices page is displayed.

GroupWise Agent Installation — |EI ll

Domains | Post Offices

To configure the agent software, Install must know the
N ove "> locations of the domains and post offices these agents
will service.

Click Add ta specify a domain or post office location. Click
Mext when all domains and post offices have been
added.

MHame |F‘alh ‘Type |HTTP Part

Add Remove

Installation Guide: < Back I Next > I Exit |

The MTA and POA must know the location of the domain and post office directories. Continue
with Step 9.

or

If you are running the Agent Installation program on the same server as the GroupWise Setup
Advisor, the Setup Advisor passes the domain and post office information to the Agent
Installation program so you are not prompted for it again. Skip to Step 13.

To specify the location of your domain, click Add, select Domain, specify the domain name,
provide the path to the domain directory, then click OK.

The location you specify for the domain directory is stored in the MTA startup file. When you
start the MTA, it reads the startup file to find the location of the domain directory. The MTA
then reads the domain database (wpdomain . db) in the domain directory for all
configuration information it needs to run.

The MTA startup file is located in the agent installation directory you specified in Step 7. The
startup file is named doma in.mta, where domain is the first 8 letters of the domain name (for
example, provo.mta).

To specify the location of your post office, click Add, select Post Office, specify the post office
name, provide the path to the post office directory, then click OK.

The location you specify for the post office directory is stored in the POA startup file. When
you start the POA, it reads the startup file to find the location of the post office directory. The
POA then reads the post office database (wphost . db) in the post office directory for all
configuration information it needs to run.

The POA startup file is located in the agent installation directory you specified in Step 7. The
startup file is named post office.poa, where post_office is the first 8 letters of the post
office name (for example, research.poa).

Click Next to continue.

If you are installing the agents as Window services, the Windows Service Information page is
displayed. Fill in the service information (worksheet item 25), then click Next to display the
Summary page.

or
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If you are not installing the agents as services, the Summary page is displayed.

GroupWise Agent Installation ;IEIEI

Summary

Platform:  Windows

N Ove "> Path: c:hgipwise

It the above infarmation is incarect. click Back until pou
reach the appiopriate page and then enter the comect
values.

Installation Guide: < Back. I Install I Exit

13 Click Install to install the agents.

The Installation Complete page appears when the files have been installed.

GroupWwise Agent Installation [_ ]

Installation Complete

The Group'#ise agent software has been successfully

N ove "_ installed and configured.

r— Options

I= Launichjin Frotect=d hade

Installation Guide: < Btk I Einish I Exit

14 Select from the following options:

Update the AUTOEXEC File: This option does not apply to the Windows agents, so it is
dimmed.

Launch GroupWise Agents Now: This option applies only if you installed the agents as
Windows applications, rather than services. Select this option to start the GroupWise agents as
applications.

If the agents do not start successfully as applications, or if you need to start them as services,
see “Starting the Windows GroupWise Agents” on page 196.
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15 Click Finish, then if necessary, return to the workstation where the Setup Advisor is running.
The Set Up Client Software page is displayed.

GroupWise System Setup ll

GroupWise Setup Progress

Novell

The final step is to set up the Groupwise client software.

= ";"; ¥ Collect system infarmation

¥ Create system

il

¥ Install agent software
25 Set up client software

=
Sl
X

= Back |ﬂe>d> Cancel | Finish | Help |

16 Now that you have the Windows agents installed and running, continue with Setting Up and
Running the GroupWise Windows Client on Your Local Machine.

Setting Up and Running the GroupWise Windows Client on Your Local Machine

1 In the Setup Advisor, click Next to launch the GroupWise Windows client Setup program, then

follow the prompts.
i‘é‘- GroupWise - Welcome 5'
Welcome to the Installshield wizard for
Novell GroupWise

The InstallShield(R) Wizard will install Grouptivise on vour
computer. To continue, click Next.

2

WARMING: This program is protected by copyright law and
international treaties.

< Back

Cancel |

2 When setup is finished, double-click the GroupWise shortcut on your desktop to start the
GroupWise Windows client.

Because the GroupWise client can get the location of your post office from eDirectory, and
because you do not yet have a password on your mailbox, the GroupWise client starts without
prompting you for post office and password information.

If the GroupWise client cannot get the location of your post office from eDirectory or cannot
access the post office, the GroupWise Startup page appears. You should make sure that you are
logged in through your own eDirectory user account and not through an Admin account, and
that your current eDirectory tree is the tree in which the post office is located. By default, the
GroupWise client logs in to GroupWise as the user who is logged in at the workstation. If you
are not logged in as yourself, you might receive a “user not found” error; specify your
GroupWise user ID in the User ID field, then click OK to log in.
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3 Get started with the GroupWise client by completing the following tasks:

¢ Setting A Mailbox Password: After you are logged in and using GroupWise, one of the
first things you should do is set a password on your mailbox so that other users cannot
access it. For information about setting a password, see Help in the GroupWise client.

¢ Sending Messages and Scheduling Appointments: You can send messages to or
schedule appointments with any users you have added to the post office. To test your
system, you might want to send a message to yourself. As soon as users set up the
GroupWise clients on their workstations, as described in Section 8.4.1, “Setting Up the
GroupWise Windows Client,” on page 206, they will also be able to send messages and
schedule appointments.

¢ Using Document Management Services (Optional): GroupWise Document
Management Services (DMS) lets you store documents in GroupWise libraries. Library
documents can be shared with other users, versioned, and searched for within the library.
The Setup Advisor created a library under the post office directory. For information about
using Document Management Services, see Help in the GroupWise client.

4 Continue with Installing the GroupWise Administrator Snap-Ins to Additional Windows
Machines.

or

If you have installed all the administrative software you need, skip to Section 3.4, “What’s
Next,” on page 72.

Installing the GroupWise Administrator Snap-Ins to Additional Windows Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to
ConsoleOne were installed in one location (worksheet item 2). If ConsoleOne is installed in multiple
locations and if you want to be able to administer GroupWise from those locations, you need to
install the GroupWise snap-ins to each ConsoleOne installation.

1 Go to the Windows machine where you want to install the GroupWise snap-ins to ConsoleOne.

2 Make sure you are logged in as an Admin equivalent and have network access to a software
distribution directory (or GroupWise 7 Administrator for NetWare/Windows CD) and the
domain directory.

3 Start the GroupWise Administration Installation program (install.exe in the \admin
subdirectory)

4 Accept the License Agreement, then follow the prompts to provide the necessary information.
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5 In the Administration Options dialog box, deselect Create a New System or Update an Existing
System. Also deselect Copy Files to a Software Distribution Directory. Then continue to install
just the GroupWise Administrator snap-ins to ConsoleOne.

GroupWise Installation i |EI ll

Administration Options

N ove " “r'ou may create or update a GroupWWise system, or

perform ather administrative tasks.

I™ Create a new system or update an existing spstem.

I Install administration files.
I Copy files to a software dishibution directory,

Installation Guide: < Back. I Next > I Exit |

B o
s

6 Repeat Step 1 through Step 5 for each location where you want to install the GroupWise snap-
ins.

7 Skip to Section 3.4, “What’s Next,” on page 72.

3.3.2 Linux: Setting Up a Basic GroupWise System

You should have already reviewed Section 3.2, “Planning Your Basic GroupWise System,” on
page 26 and filled out the worksheet.

The following sections step you through the GroupWise Installation program, Installation Advisor,
and Setup Advisor on Linux. The Installation Advisor installs the GroupWise software on your
Linux server. It then launches the Setup Advisor in ConsoleOne to create your domain and post
office and set up the GroupWise agents.

» “Starting the GroupWise Installation Program on Linux” on page 62

* “Installing the GroupWise Software” on page 63

» “Selecting a Linux Mount Directory” on page 64

» “Using ConsoleOne to Create Your Basic GroupWise System” on page 65

* “Installing and Starting the Linux GroupWise Agents” on page 68

» “Setting Up and Running the GroupWise Cross-Platform Client on Your Local Machine” on
page 71

» “Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines” on page 72

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before starting to
set up your GroupWise system.

If you are new to Linux, you might want to review “Useful Linux Commands for Administering a
GroupWise System” in GroupWise 7 Troubleshooting 2. Solutions to Common Problems (http://
www.novell.com/documentation/gw7) before beginning to set up your GroupWise system on Linux.
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Starting the GroupWise Installation Program on Linux
1 Make sure that ConsoleOne is installed on your Linux server.
ConsoleOne is installed in /usr/ConsoleOne/bin. If ConsoleOne and eDirectory have
not yet been installed on your system, see “Novell eDirectory” on page 26.
2 In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise Installation program, Installation Advisor, and the Setup Advisor. If you are not
using the X Window System, you can install GroupWise components individually, as described
in “Installing the GroupWise Agents Using the Text-Based Installation Program™ on page 179.

3 Change to the root of the GroupWise 7 Administrator for Linux CD.
4 Start the GroupWise Installation program:
./install

5 Select the language in which you want to run the GroupWise Installation program, then click
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.

L Group Vi 1.
. Novell. GroupWise. N
View the Readme Displays a web page with important infermation you should read before installing.
View the Quickstart Displays a high-level checklist of system requirements and installation steps to guide you through setting
up your GroupWise system.
Wiew the Installation Guide Displays overview and task infommation that will help veu| plan, install, and updm AGrOUpWise systen,
as well as install additonal suchas Intemet Agert
Create or update a GroupWise system Launches the Groupwise Installation and Setup Advisers, These advisors mp vou through the creation
of anew GroupwWise system orthe updating of an existing Groupwrise syste)
Install Products Displavs the VO CAR install once you 've created A CroupWise
system,
W¥isit the Novell Gmupwige Web Site Lawunches vour Web browserto display GroupWise information located on the Hovell Web site,
(httms s novell.com,
products yroupwise).

6 Continue with Installing the GroupWise Software.
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Installing the GroupWise Software

1 Click Create or Update a GroupWise System to start the Installation Advisor.

GroupWise Administration Configuration

Introduction
[ introduction “Welcame to the GroupiWise Administration Configuration Program. This
program will do the following
D ® Install Administration and Agent software
D ® Setup the software distribution directory
D ® Update an existing Group'Wise system or launch Conscole One to allow
creation of a new Groupiiise system
Cancel g Hext

The list on the left details the steps the Installation Advisor performs for you.
2 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.

Item 3: Software Distribution Directory
Item 4: Select Software

The Installation Advisor automatically installs the GroupWise Administrator snap-ins to
ConsoleOne under /usr/ConsoleOne. Then, the Installation Advisor copies the selected
software components into your software distribution directory.

3 When the copying is complete, click Next.

GroupWise Administration Configuration

Mext Step

[] Introduction Are you
E License Agreement « Updating an existing Group'ise system?

[#] Software Distribution @ Creating 3 new Groupise system?
Directory

[#] Select Software
[] Copy Files
[] Hext Step

o

Cancel g Hext

4 Select Creating a New GroupWise System, then click Next.
You use the New System utility in ConsoleOne to create your basic GroupWise system.
5 Click Run to start ConsoleOne.

6 Continue with Selecting a Linux Mount Directory
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Selecting a Linux Mount Directory

The first time you start ConsoleOne with the GroupWise Administrator snap-ins installed, you are
prompted to specify a Linux mount directory under which you create mount points. Typically, Linux
servers and workstations use /mnt for this purpose. In the future as your system grows, this
information helps ConsoleOne resolve the UNC paths of GroupWise database locations into Linux
paths. Although the mount directory information is not used when you are creating your basic
GroupWise system, it is gathered at this time for later reference.

GroupWise databases can be located on Linux servers, NetWare servers, or Windows servers. In the
Linux mount directory, you will eventually create mount points that have the same names as the
servers that are mounted to those mount points. You will need to do this for each server where a
domain or post office is located that you want to access from ConsoleOne. The following table
illustrates the correspondence between UNC paths and mount points for GroupWise database
locations on Linux, NetWare, and Windows, assuming the typical mount directory of /mnt:

Table 3-1 Correspondence between UNC Paths and Mount Points

Platform GroupWise Domain UNC Path Corresponding Linux Mount Point

Linux \Vlinux_servengw_patrtition\domain_directory Imnt/linux_serverigw_partition
NetWare \\netware_servengw_volume\domain_directory = /mnt/netware_server/gw_volume

Windows \\windows_servengw_share\domain_directory /mnt/windows_server/gw_share

IMPORTANT: Although NetWare and Windows are not case-sensitive operating systems, the case
of characters in pathnames becomes significant when the directory structure is mounted to a Linux
machine.

1 In the Linux Mount Directory dialog box, browse to and select the Linux mount directory, then
click OK.

GroupWise Administrator __

Linux Mount Directory:

[ srmmt [ |

Enter a walid path to the mount directory and click OK, ar
click Cancel to continue

oK || cancer |

The typical Linux mount directory is /mnt.

In the future, you and other GroupWise administrators might have different mount points
depending on the workstation or server where ConsoleOne runs. To change the mount directory
later in ConsoleOne, click Tools > GroupWise System Operations > System Preferences >
Linux Settings. The mount directory information is stored in a user-specific preferences file
(.consoleone/SnapinPrefs.ser in each GroupWise administrator’s home directory).

2 Continue with Using ConsoleOne to Create Your Basic GroupWise System.
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Using ConsoleOne to Create Your Basic GroupWise System

ConsoleOne automatically attempts to authenticate to an eDirectory tree when it starts.

1 Fill in the following fields, then click Login to start ConsoleOne:

If the Login dialog box does not appear automatically, select the NDS® object, then click File

> Authenticate.

Login =

Novell

Login name: |

Password: |

Tree; |

=I5

Context: [

[=]

Login Cancel

Login Name: Provide a Novell eDirectory username that has rights to create eDirectory

objects.

Password: Provide the password for the username.

Tree: Type or select the eDirectory tree where you want to create GroupWise objects.

If the eDirectory tree is located on a Windows server, you might need to specify the IP address
of the server instead of the tree name.

Context: Provide the full context of the User object associated with the username you

provided.

2 Under the NDS object, select the tree where you want to create the GroupWise system, then
click Tools > GroupWise Utilities > New System.

GroupWise System Setup

Novell.

GroupWise Setup Progress

The first step in creating a GroupWise system is to collect
information about the system wou want to create.

I35 Collect system information
« Create systern
« [nstall agent software

3 Follow the prompts to provide the GroupWise system and domain information from your Basic
GroupWise System Worksheet.

Item 3: Software

Distribution Directory
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Item 5: Tree Name

[tem 6: System Name

Item 7: Domain Name

Item 8: Domain Directory
Item 9 Domain Context
Item 10: Domain Language
Item 11: Domain Time Zone

4 Follow the prompts to provide the GroupWise post office information from your Basic
GroupWise System Worksheet.

Item 12: Post Office Name
Item 13: Post Office Directory
Item 14: Post Office Context
Item 15: Post Office Language
Item 16: Post Office Time Zone

5 Follow the prompts to provide information about how to link the domain and the post office
from your Basic GroupWise System Worksheet.

Item 17: Post Office Link

Item 18: POA Network Address

Item 19: MTA Network Address

When you have provided the system, domain, post office, and link information for your
GroupWise system, you are ready to create users. However, adding users at this point is

optional. After the Setup Advisor has finished, you can add users to the post office at any time
by using ConsoleOne.

GroupWise System Setup &y

Past Office Users

Nove"' Tou can give existing eDirectory users Groupilise accounts on
this post office now, or vou can create GroupWise accounts
||_||_ later.
= _—l Select users for the post office
— -—l- : Users ] T
X
o
<Back | met> | cancer | rmisn | Hem |

6 Add any users that you listed on your Basic GroupWise System Worksheet, then click Next.
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The Setup Advisor summarizes your overall progress.

GroupWise System Setup &y ol

GroupWise Setup Progress

“ou are now reachsto create your GroupWise systerm. You will
be given a chance to review the information before your
system is created

Novell.

v Collect system infarmation
@Crea{e system
» Install agent software

] || Cancel H Finish H Help ‘

7 Click Next to display a summary of the system, domain, post office, and link information you

entered.

GroupWise System Setup 83 Eﬁ

Summary
Novell
SySIEr Name: Nowell
Tree: CORP_TREEE
Cornain name Waltharn
Domain context; Croupiise
Domain directory: Jowsystem fwalthamns
Daomain time zone (GMT-08:00) Pacific Time (US & Can
Domain language: English - US
Fost office narne: Support
Post office context CrouplWise
Post office directony:  Jgwsystemfsupport
Post office time zone: (GMT-08:00) Pacific Time {US & Can:
Post office language:  English - US

If the above information is correct, click Mext to create your
CroupWise systemn. To correct any information, click Back
unitil you reach the appropriate page

< Back ||

|| Cancel H Finish ” Help |

After you have verified that the information you entered is correct, you are ready for the Setup

Advisor to create your GroupWise system.

8 Click Next to create your GroupWise system.
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The Setup Advisor summarizes your overall progress.

GroupWise System Setup & " T |

Novell.

GroupWise Setup Progress

You have successfully created your CroupWise systerm. You
frust now install and run the GroupiWise agent software.

v Collect system information
v Create system
5 Install agent software

< Back H [Next >/ H Cancel || Finish || Help |

9 Click Next to install the MTA and POA software.

10 Continue with

Installing and Starting the Linux GroupWise Agents.

Installing and Starting the Linux GroupWise Agents

At this point, the Setup Advisor has created eDirectory objects and network server directories
associated with your GroupWise system. You now need to install and start the MTA and POA on

your Linux server.

* “Installing the

Linux Agents” on page 68

+ “Starting the Linux Agents with a User Interface” on page 69

Installing the Linux Agents

The Setup Advisor

Figure 3-15 Introduct

starts the Agent Configuration program for you.

ion Page

GroupWise Agents Configuration

Introduction

[ Introduction

Cancel

‘Welcome to the GroupWise Agent Configuration Program. The fallowing
agent software will be configured:

Message Transfer Agent{MTA): Routes messages betueen
domaing, post offices, and
gateways

Post Office Agent{PDA). Delivers messages to users’
mailboxes.

Next

1 Review the Introduction, then click Next.

2 Accept the License Agreement, then click Next.
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On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected
by default.

IMPORTANT: If you want to configure the agents for high availability, as described in
“Enabling the High Availability Service for the Linux GroupWise Agents” on page 187, they
must be configured to start automatically on system startup.

3 Ifyou do not want the agents to start automatically when the server restarts, deselect Launch
GroupWise Agents on System Startup.

4 Click Exit to complete the configuration.

5 Continue with Starting the Linux Agents with a User Interface.

Starting the Linux Agents with a User Interface
1 In a terminal window, become root by entering sux and the root password.
The sux command enables the X Window System, which is required for running GUI
GroupWise agent server consoles.
2 Change to the GroupWise agent bin directory.
cd /opt/novell/groupwise/agents/bin
3 Use one of the following commands to start the MTA:

Syntax:
./gwmta --show --home domain directory &
./gwmta --show @domain.mta

Example:
./gwmta --show --home /gwsystem/domlnx &
./gwmta --show @provo.mta

The --show startup switch starts the MTA with a server console interface similar to that
provided for the NetWare and Windows MTAs. This user interface requires that the X Window
System and Open Motif be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.

The @domain.mta startup switch specifies the MTA startup files, which contains the --home
startup switch.
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The ampersand (&) causes the MTA to run in the background, so that the terminal window you
started it in is again available for use.

&% Provo3 - GroupWise MTA - =5 e

File Configuration Log Help
Prous3 Up Tine: 3 Days 8 Hrs 12 Hins
Croupliise Message Transfer fgent
—Status atistics
Processing * Tatal 10 Hinutes

Total Closed [ Routed 0 o
Domains 8 0 [ Undsliverable 0 o
Past Dffices 1 o [ Errors 0 o
Gateuays H o
<02¢26/2004 05109306 AM> DIS: MTA configuration loaded A
v
<] |

The status messages displayed on the MTA server console are also written to the MTA log file
(mmddmta.nnn)inthe /var/log/novell/groupwise/domain.mta directory. The
log file name includes the month and day when it was created, along with an incrementing
extension to accommodate multiple log files on the same day.

In ConsoleOne, you can see that the domain database has been updated by the MTA because
the Version field on the Identification page of the Domain object shows 7 when the database
update is complete.

Wait until the domain has been updated before you start the POA.
5 Use the following command to start the POA:
Syntax:

./gwpoa --show --home post office directory &
./gwpoa --show @post office.poa

Example:

./gwpoa --show --home /gwsystem/polnx &
./gwpoa --show --home /gwsystem/polnx &

Provo O e POA = e |

File Configuration Log Statistics Actions Help
Ressarch, Prova3 Up Tine; 3 Days 8 Hrs 13 Hins
Croupllise Post Dffice fgent
—Status atistics

Processing % Busu; 0 ; 0 C/5 Requests: 3731 Total Messages: o

(i e 2 | Requests Perdings 0 Undeliverables o

Bt ovzrss 0 | User Timed Out: 2 Problen fessagss: o

00;00;01 803 Check disk space every; 5 (nins)

00:00:01 803 Perform disk check actions no more than everyt 2 (hrs)

0030001 803 Event #1 ; Default POA Disk Check Event

00:00:01 803 Free disk space threshold: 201E

00300501 803 Action Set #1 ; Default POR Disk Check Actions

00:00:01 803 Hail message to adwinistrators upon failure

0030001 803 Tupe of database filss to check: User Msg Doc

00:00:01 803 Database check action: Reduce

0030001 803 Delste tewporary/backup Files older than (days): 1

00200201 803

00300301 803 Database Maintenance Events:

00:00:01 803 Event #1 : Default POA Mailbox/Library Maintenance Event

0030001 803 Days to perform action(s): F

00:00:01 803 Time to perform action(s): fidnight (12am)

0030001 803 Action Set #1 ; Default POR MailboxeLibrary Maintenance Actions

00:00:01 803 Tupe of database files to check: User Msg Doc

0030001 803 Database check action; AnalyzedFixup

00:00:01 803 Level of database analusis and verification: Structural

0030001 803 Delste tewporaru/backup Files older than (days): 7

00200201 803

00;00;14 C1A Guardian database; OK
BT |
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The status messages displayed on the POA server console are also written to the POA log file
(mmddpoa.nnn)inthe /var/log/novell/groupwise/post office.poa
directory. The log file name includes the month and day when it was created, along with an
incrementing extension to accommodate multiple log files on the same day.

In ConsoleOne, you can see that the post office database has been updated by the POA because
the Version field on the Identification page of the Post Office object shows 7 when the database
update is complete.

After the post office database has been updated, you can install the GroupWise Cross-Platform
client and connect to the post office.

If you want to finish setting up your basic GroupWise system, continue with Setting Up and
Running the GroupWise Cross-Platform Client on Your Local Machine.

or

If you want to learn more about managing the GroupWise agents on Linux, skip to the
following sections in Chapter 7, “Installing GroupWise Agents,” on page 161:

» “Starting the Linux GroupWise Agents as Daemons” on page 182

* “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 183

» “Starting the Linux GroupWise Agents on System Startup” on page 183

* “Running the Linux GroupWise Agents as a Non-root User” on page 184

» “Enabling the High Availability Service for the Linux GroupWise Agents” on page 187
» “Stopping the Linux GroupWise Agents” on page 190

Setting Up and Running the GroupWise Cross-Platform Client on Your Local
Machine

The Create or Update a GroupWise System option in the GroupWise Installation program does not
include installation of the GroupWise Cross-Platform client. Therefore, you have to install it
separately.

1

On the GroupWise Installation program main page, click /nstall Products > Install GroupWise
Client.

When the Cross-Platform client files have been copied, click OK.

To start the Cross-Platform client, click its icon on your desktop.

GroupWise Client Login <2> g - O %

User |D {Recuirec) [ |

Passward: | |

(@ anline Address: | ‘ Part |1677 |

(3 Carhing mailbox path : B

Specify your GroupWise user ID, password, and the required information about the server
where the POA is running (worksheet item 18), then click OK.

Get started with the GroupWise Cross-Platform client by completing the following tasks:

¢ Setting A Mailbox Password: After you are logged in and using GroupWise, one of the
first things you should do is set a password on your mailbox so that other users cannot
access it. For information about setting a password, see Help in the GroupWise client.
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¢ Sending Messages and Scheduling Appointments: You can send messages to or
schedule appointments with any users that you have added to the post office. To test your
system, you might want to send a message to yourself. As soon as users set up the
GroupWise clients on their workstations, as described in Section 8.4, “Setting Up the
GroupWise Client,” on page 206, they will also be able to send messages and schedule
appointments.

5 Continue with Installing the GroupWise Administrator Snap-Ins to Additional Linux

Machines.
or

If you have installed all the administrative software you need, skip to Section 3.4, “What’s
Next,” on page 72.

Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to
ConsoleOne were installed under /usr/ConsoleOne of the server where you ran the GroupWise
Installation program. If ConsoleOne is installed in multiple locations and if you want to be able to
administer GroupWise from those locations, you need to install the GroupWise snap-ins to each
ConsoleOne installation.

1
2

7

Go to the Linux machine where you want to install the GroupWise snap-ins to ConsoleOne.

Make sure you are logged in as root and have network access to the software distribution
directory (or GroupWise 7 Administrator for Linux CD) and the domain directory.

Start the GroupWise Installation program (install at the root of the software distribution
directory or the CD), then click Install Products > GroupWise Administration > Install
Administration.

When the installation is complete, click OK, then click Configure GroupWise Administration.
Accept the License Agreement, then follow the prompts to provide the necessary information.

Repeat Step 1 through Step 5 for each location where you want to install the GroupWise snap-
ins.

Continue with What’s Next.

3.4 What’s Next

After you have set up your basic GroupWise system, you can expand the system by:

Setting up access to the Internet through the GroupWise Internet Agent. See Chapter 4,
“Installing the GroupWise Internet Agent,” on page 79.

Setting up GroupWise WebAccess so that users can access their mailboxes through a Web
browser on a computer or mobile device such as a telephone. See Chapter 5, “Installing
GroupWise WebAccess,” on page 103.

Setting up GroupWise Monitor to monitor your GroupWise agents. See Chapter 6, “Installing
GroupWise Monitor,” on page 139.

Installing the MTA or POA on a different server than the one you installed to during the basic
system setup. See Chapter 7, “Installing GroupWise Agents,” on page 161.

Setting up users to run the GroupWise client on their workstations. See Chapter 8, “Installing
the GroupWise Windows and Cross-Platform Clients,” on page 203.
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+ Setting up Microsoft Outlook users to access GroupWise mailboxes. See Chapter 9, “Installing
the GroupWise Connector for Microsoft Outlook,” on page 211.

 Setting up synchronization between users’ GroupWise mailboxes and their mobile devices. See
Chapter 10, “Installing the GroupWise Mobile Server,” on page 213.

+ Setting up users with instant messaging capabilities. See Chapter 11, “Installing GroupWise
Messenger,” on page 215.

After your GroupWise system is fully installed, you can refer to sections of the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw7) as you maintain your
GroupWise system by:

» Adding more users to the post office. See “Users”.

* Defining resources that users can schedule. See “Resources”.

* Defining groups of users that GroupWise users can select when addressing messages. See
“Distribution Lists, Groups, and Organizational Roles”.

* Changing the GroupWise client from Online mode to Caching mode so that users’ messages
are stored on a local drive as well as in the post office. See “Client”.

* Setting up GroupWise Remote so that Windows client users can access their mailboxes from a
computer that is not directly connected to your network. See “Client”.

* Controlling the functionality of users’ GroupWise client software. See “Client”.

» Configuring your current post office’s library or setting up additional libraries. See “Libraries
and Documents”.

* Adding additional post offices to the domain. See “Post Offices”.
* Adding additional domains to the system. See “Domains”.

» Configuring the Post Office Agent (POA) and Message Transfer Agent (MTA) to support
secure connections (SSL). See “Post Office Agent” and “Message Transfer Agent”.

» Connecting to other GroupWise 5.x, 6.x, or 7.x systems. See the GroupWise 7 Multi-System
Administration Guide (http://www.novell.com/documentation/gw?7).

3.5 Basic GroupWise System Worksheet

The GroupWise Installation Advisor helps you install the GroupWise software. It then launches the
GroupWise Setup Advisor, which helps you set up your first domain and post office. The Advisors
prompt you for the information in this worksheet. You should print the worksheet and carefully fill
in the information for your system.

Item Explanation

1) Select Languages: Specify the languages to install for the GroupWise
Administrator snap-ins to ConsoleOne, the GroupWise
agents, and the GroupWise clients.

See “GroupWise Languages” on page 29.
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Item

Explanation

2) ConsoleOne Path:

Windows default:

c:\novell\consoleone\1l.2

Linux default:
/usr/ConsoleOne

3) Software Distribution Directory:

NetWare default:

\\server\vol\grpwise\software

Linux default:

/opt/novell/groupwise/software

Windows default:
c:\grpwise\software

4) Select Software:

GroupWise Administration
GroupWise agents
Internet Agent
WebAccess

GroupWise client

Monitor

5) Tree Name:

6) System Name:

7) Domain Name:

Specify the path to a ConsoleOne location, either on the local
workstation or on a network server. The GroupWise
Installation Advisor installs the GroupWise Administrator
snap-in files in the specified location.

Your existing ConsoleOne installation must meet the version
requirements listed in Section 2.1, “GroupWise Administration
Requirements,” on page 21

See “ConsoleOne” on page 27.

Specify the directory path for the software distribution
directory. If the directory does not exist, it is created.

The path should be from the perspective of the machine you
plan to use to install GroupWise.

See “GroupWise Software Distribution Directory” on page 28.

Select the software you want copied to the software
distribution directory.

See “GroupWise Software Distribution Directory” on page 28.

Specify the name of the eDirectory tree where your domain
and post office will be created. Because GroupWise
introduces new objects into the tree, the eDirectory schema
must be extended.

See “Novell eDirectory” on page 26.

Specify a one-word name. Names can reflect companies,
locations, and so forth.

See “System and Domain Names” on page 30.

Specify a one-word name. Names can reflect locations,
organizations, and so forth.

See “System and Domain Names” on page 30.
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Item

Explanation

8) Domain Directory:

9) Domain Context:

10) Domain Language:

11) Domain Time Zone:

12) Post Office Name:

13) Post Office Directory:

14) Post Office Context:

15) Post Office Language:

Specify the path for the domain directory. If the directory does
not exist, it is created. On NetWare, do not use a directory
name that exceeds 8 characters. On Linux, use lowercase
letters.

The path should be from the perspective of the machine you
plan to use to install GroupWise.

See “Domain Directory” on page 31.

Specify the eDirectory context where you want to create the
Domain object. Make sure the context exists before you start
installing GroupWise.

See “Domain Context” on page 32.

Specify a language for the domain. The language determines
the sort order for items in the GroupWise Address Book.

See “Domain Language” on page 35.

Specify the time zone where the domain is located. The time
zone information is used to ensure that times for messages
sent between time zones are adjusted properly.

See “Domain Time Zone” on page 35.

Specify a one-word name. Names can reflect locations,
organizations, and so forth.

See “Post Office Name” on page 35.

Specify the path for the post office directory. If the directory
does not exist, it is created.

The path should be from the perspective of the machine you
plan to use to install GroupWise.

See “Post Office Directory” on page 36.

Specify the eDirectory context where you want to create the
Post Office object. Make sure the context exists before you
start installing GroupWise.

See “Post Office Context” on page 37.

The post office language defaults to the domain language.
Specify a different language if you do not want the post office
to use the default domain language.

See “Post Office Language” on page 37.
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Item

Explanation

16) Post Office Time Zone:

17) Post Office Link:

e TCP/IP link
« Direct link

18) POA Network Address:

* |P address or DNS hostname:

» Client/Server port:
(default = 1677)

» Message transfer port:
(default = 7101)

* HTTP port:
(default =7181)

19) MTA Network Address:
« |P address or
DNS hostname:

» Message transfer port:
(default = 7100)

e HTTP port:
(default = 7180)

The post office time zone defaults to the domain time zone.
Specify a different time zone if the post office is not in the
same time zone as the domain.

See “Post Office Time Zone” on page 38.

Select whether you want the MTA to link to the post office
through a TCP/IP connection to the POA or a direct
connection to the post office directory.

See “MTA Link to the Post Office” on page 41.

If you mark Direct Link, skip to worksheet item 20.

This item applies only if you selected TCP/IP as the post office
link type (worksheet item 17).

Specify the IP address or DNS hostname of the POA’s server.

By default, the POA listens for the GroupWise client on Client/
Server port 1677. If this port is already being used, specify a
different C/S port number (for example, 1678).

If the MTA and POA are communicating using TCP/IP, the
POA listens for the MTA on Message Transfer port 7101 by
default. If this port is already being used, specify a different
MT port number (for example, 7111).

By default, the POA uses HTTP port 7181 for its Web console.
The Web console enables you to view POA information
through a Web browser. If this port is already being used,
specify a different HTTP port number (for example, 7183).

See “MTA Link to the Post Office” on page 41.

This item applies only if you selected TCP/IP as the post office
link type (worksheet item 17).

Specify the IP address or DNS hostname of the server
running the Message Transfer Agent.

By default, the MTA listens for the POA on Message Transfer
port 7100. If this port is already being used, specify a different
MT port number (for example, 7103).

By default, the MTA uses HTTP port 7180 for its Web console.
The Web console enables you to view MTA information
through a Web browser. If this port is already being used,
specify a different HTTP port number (for example, 7182).

See “MTA Link to the Post Office” on page 41.
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Item

Explanation

20) Post Office Users:

21) Agent Platform:

* NetWare
e Linux
* Windows

22) Installation Path:

NetWare default:
\\serverl\sys\system

Linux default:
/opt/novell/groupwise/agents

Windows default:
c:\grpwise

23) Windows Installation Options:

* Install GroupWise agent software:

Yes | No

* Install and configure SNMP for
GroupWise Agents:
Yes | No

* Install as Windows services:
Yes | No

24) Language:

Specify the users who will have mailboxes in the post office.
The Setup Advisor lets you browse the eDirectory tree to
select the users you want.

Adding users at this point is optional. After the Setup Advisor
has finished, you can add users to the post office at any time
by using ConsoleOne.

See “Post Office Users” on page 38.

Specify the platform (NetWare, Linux, or Windows) where you
want to run the GroupWise agents.

See “Agent Platform” on page 39.

Specify the path to the directory where you want to install the
agents.

We recommend that you install the NetWare agents to the
sys:\system directory to simplify the use of startup files and
ensure that dependent NLM programs load properly.

The Linux agents are automatically installed into /opt/novell/
groupwise/agents.

You can install the Windows agents to any directory on the
Windows server. Because the installation is done from the
Windows server, the default is c:\grpwise.

See “Agent Location” on page 39.

This item applies only if you are installing the Windows
agents.

Specify the installation options you want to use.

The Install GroupWise Agent Software option needs to be
selected to install the files.

The Install and Configure SNMP for GroupWise Agents option
requires the SNMP service to already be enabled on the
Windows server. If SNMP is not enabled, this option is dim in
the Installation Advisor.

The Install as Windows Services option configures the agents
as Windows services.

See “Windows Installation Option: Application vs. Service” on
page 42.

Specify the language in which you want to be able to run the
agents.

See “Agent Language” on page 42.
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Item

Explanation

25) Windows Service Information:

* Use local system account
* Use a user account

« Startup:
Automatic | Manual

This item applies only if you are installing the Windows agents
as Windows services.

Select whether you want the services to use the local system
account or another user account. If the domain and post office
directories are on the same Windows server as the agents,
you can use the local system account. If the domain and post
office directories are on a different server, specify a different
user account that exists in eDirectory and has rights to the
domain and post office directories.

Select whether you want to manually start the services or
have them start automatically when the server starts.

See “Windows Installation Option: Application vs. Service” on
page 42.
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Installing the GroupWise Internet
Agent

The Novell® GroupWise® Internet Agent enables you to send and receive messages over the
Internet. The following sections provide information to help you successfully install the Internet
Agent in your existing GroupWise system.

» Section 4.1, “GroupWise Internet Agent Overview,” on page 79

» Section 4.2, “Internet Agent System Requirements,” on page 83

» Section 4.3, “Planning the GroupWise Internet Agent,” on page 84

» Section 4.4, “Setting Up the Internet Agent,” on page 91

» Section 4.5, “What’s Next,” on page 100

* Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 100
After you’ve installed the Internet Agent, there are additional tasks you can perform to optimize and

maintain your GroupWise system. These tasks are discussed under Section 4.5, “What’s Next,” on
page 100.

IMPORTANT: If you plan to install the Internet Agent in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
the Internet Agent.

4.1 GroupWise Internet Agent Overview

The Internet Agent allows communication between GroupWise users and users of other messaging
systems who send e-mail across the Internet. The Internet Agent picks up inbound e-mail messages
from the Internet, converts them from RFC-822 or MIME format to the GroupWise message format,
and then passes the converted messages to the GroupWise Message Transfer Agent (MTA).
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For outgoing messages to the Internet, the GroupWise MTA passes the messages to the Internet
Agent, which then converts the messages to Internet messaging format, and then sends them to the
designated Internet addresses.

Figure 4-1 GroupWise Internet Agent Connecting a GroupWise System to the Internet
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Choose from the following list of topics to learn more about the capabilities of the GroupWise
Internet Agent.

* “SMTP/MIME Service” on page 80

* “POP3 Service” on page 81

* “IMAP4 Service” on page 82

* “LDAP Services” on page 82

» “iCal and iMip Services” on page 82

» “Secure Connections via SSL” on page 82

» “Access Control” on page 82

» “Multiple Threading” on page 82

* “SNMP-Compliant” on page 82

* “SMP Support (NetWare Only)” on page 82

SMTP/MIME Service

The SMTP/MIME service in the Internet Agent allows you to send and receive e-mail with standard
encoding on attachments, international character sets, and multipart messages. Multimedia e-mail
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with images, sound, and video can also be exchanged. The service also includes these additional
features:

¢ SMTP Dial-Up Service: The Internet Agent includes SMTP dial-up functionality. This can be
useful when your system does not meet the requirements of a dedicated Internet connection, or
when you prefer not to have a permanent Internet connection. With the SMTP dial-up feature,
you can establish a schedule to periodically check the message store without maintaining a
permanent link.

* Flexible Addressing: The Internet Agent offers full GroupWise addressing support, including
system groups, nicknames, and individual users.

The Internet Agent also takes advantage of GroupWise Internet addressing, which allows
inbound messages addressed in a variety of formats to be delivered to GW users. These formats
include:

UserID@Internet domain name
UserID.PostOffice@Internet domain name

Last Name.First Name@Internet domain name
First Name.Last Name@Internet domain name
First Initial Last Name@Internet domain name

¢ Internet Users in the Address Book: Internet users can be added to the GroupWise Address
Book so users won’t have to remember long Internet addresses.

¢ Real-Time Blacklists: Many organizations, such as Mail Abuse Prevention System (MAPS*),
Open Relay DataBase (ORDB), and SpamCop#*, provide lists of IP addresses that are known to
be open relay hosts or spam hosts. You can use the real-time blacklists provided by these sites
to protect your users from offensive spam.

¢ Spam Protection: Anti-spam services use different indicators to mark potential spam. One
might use a string of asterisks; the more asterisks, the greater the likelihood that the message is
spam. Another might use a numerical value; the higher the number, the greater the likelihood
that the message is spam. You can configure the Internet Agent to recognize as spam whatever
indicators your anti-spam service uses and flag such messages for processing by the client Junk
Mail Handling feature.

¢ Accounting: The accounting feature provides inbound and outbound tracking of messages
passing through Internet Agent. This lets administrators track how the Internet Agent is being
used. GroupWise Monitor includes a Gateway Accounting report that organizes information
gathered in Internet Agent accounting files into a format that is visually easy to read.

* DNS Name Resolution: The Internet Agent can access a DNS server directly to resolve host
names to [P addresses, or it can rely on a relay host to perform the name resolution.

¢ Connect to Other GroupWise Systems Through the Internet: Using passthrough
addressing, you can connect to other GroupWise systems anywhere on the Internet and have
access to all of the GroupWise features. The Internet simply becomes a mail transport medium
for GroupWise.

POP3 Service

The POP3 service in the Internet Agent allows you to download messages from your GroupWise
post office to a POP3 client application such as a Web browser’s e-mail program or a Telnet
application. The Internet Agent acts as the POP3 server, providing a TCP connection between the
user’s GroupWise post office and a POP3 client. Accessing the GroupWise post office via the
Internet Agent’s POP3 server capability, users can retrieve their e-mail messages and manage them
through user ID login options.
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IMAP4 Service

The GroupWise Internet Agent supports the Internet Messaging Access Protocol 4 (IMAP4). As an
IMAP4 server, the Internet Agent allows IMAP4-compliant e-mail clients to read and manipulate
GroupWise messages.

LDAP Services

The Internet Agent supports the Lightweight Directory Access Protocol (LDAP) directory standard
with LDAP server capability that allows access for directory searches of GroupWise post offices.
Using LDAP Public Access, Internet mail clients can do lookups on GroupWise users and address
information.

iCal and iMip Services

The Internet Agent supports iCalendar (iCal), the Internet Calendaring and Scheduling core object
specification (RFC 2445), and iMIP, the iCalendar Message-based Interoperability Protocol (RFC
2447). When a GroupWise user sends an appointment to an external Internet user, the Internet agent
converts the appointment into an iMIP message that can be read and accepted or declined in
compatible e-mail systems such as Microsoft Exchange and Lotus Notes. GroupWise users can also
receive and accept or decline appointments from users of these e-mail systems. Accept/decline
notifications are also exchanged between systems.

Secure Connections via SSL

The Internet Agent supports the use of SSL for its connections to SMTP hosts, POP3 clients, IMAP4
clients, and Internet Agent Web console.

Access Control

The Internet Agent program includes security capabilities called Access Control that allow
administrators to control user access to all services (SMTP/MIME, LDAP, POP3, and IMAP4).
Access Control can help you reduce costs and provide added security.

With the SMTP/MIME service, Access Control can be used to block messages being sent to or
received from specific host or IP addresses.

Multiple Threading

Multiple threading allows more than one send or receive process to be running concurrently. You
can configure the number of threads to enhance the speed and performance of the Internet Agent.
The number of thread switches are set separately for the SMTP/MIME service, POP3 service,
IMAP4 service, and LDAP service.

SNMP-Compliant

The Internet Agent can be managed by any SNMP-compliant network manager, such as the alarm
management features of Novell ZENworks® Server Management.

SMP Support (NetWare Only)

The NetWare Internet Agent supports Symmetric Multi-Processing (SMP), letting it take advantage
of a server with multiple processors.
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4.2 Internet Agent System Requirements

The following sections define the Internet Agent’s requirements:

» Section 4.2.1, “Network Server Requirements,” on page 83
» Section 4.2.2, “GroupWise System Requirements,” on page 83

» Section 4.2.3, “Internet Connectivity Requirements,” on page 84

4.2.1 Network Server Requirements

The network server where you install the Internet Agent must meet the following requirements:

O 32-bit/x86 processor or 64-bit/x86 processor running in 32-bit mode

O Any of the following server operating systems for the GroupWise agents (Post Office Agent,
Message Transfer Agent, Internet Agent, WebAccess Agent, Monitor Agent):

* Novell Open Enterprise Server (NetWare or Linux version), plus the latest Support Pack

* NetWare 5.1, NetWare 6.0, or NetWare 6.5, plus the latest Support Pack for your version
of NetWare

Domains and post offices can be located on NetWare 3.12 and NetWare 4.2 servers,
although the agents cannot run there. The Monitor Agent is not available for NetWare.

« SUSE® Linux Enterprise Server 9, plus the latest Support Pack

The X Window System is required by the GUI Installation Advisor and Setup Advisor that
step you through the process of creating a new GroupWise system. A text-based
Installation program is also available.

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles. By default, the agents run as daemons without user interfaces.

* Windows Server 2000 or Windows Server 2003, plus the latest Service Pack for your
version of Windows

O Adequate server memory as required by the operating system
O Adequate server disk space:
* 17 MB for the Internet Agent program files.

* 200 MB minimum for message file processing. The actual amount will be determined by
the number and size of message files being processed at one time by the Internet Agent.

O Adequate RAM

* 12 MB. This is the amount of memory the Internet Agent needs to operate. It does not
include memory for the operating system or for TCP/IP connectivity. This amount can
increase depending on message size and complexity.

4.2.2 GroupWise System Requirements

The GroupWise system in which you install the Internet Agent must meet the following
requirements:

U The domain’s version must be equal to or later than the Internet Agent’s version. The domain’s
version is determined by the Message Transfer Agent (MTA) version running for it.
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a

The versions of any post offices that the Internet Agent will access on behalf of POP3 or
IMAP4 clients must be equal to or later than the Internet Agent’s version. A post office’s
version is determined by the Post Office Agent (POA) version running against it.

4.2.3 Internet Connectivity Requirements

Before you install the Internet Agent, you need to ensure that your network is configured for Internet
connectivity.

a

a

Internet Connection: You can connect to the Internet using a direct connection over a leased
line or a standard switched telephone line.

Internet Domain Name: You must have an Internet domain name. The domain name must be
defined by an MX RR (mail exchanger resource record) in DNS.

DNS Server Access or Relay Host Access: If you want the Internet Agent to send messages
directly to other SMTP hosts, it requires access to a DNS server for address resolution.
Otherwise, it requires access to a relay host that can perform the address resolution and
message routing. Make sure the server where you plan to install the Internet Agent is
configured to access a DNS server or can access your relay host. For specific details, refer to
your server documentation.

IP Address: The Internet Agent’s server requires a static IP address and a fully qualified
hostname.

4.3 Planning the GroupWise Internet Agent

Use Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 100 to record your
decisions about how to install the Internet Agent as you review the following considerations:

Section 4.3.1, “Selecting the Internet Agent Platform,” on page 85

Section 4.3.2, “Gathering Server Information,” on page 85

Section 4.3.3, “Selecting the Internet Agent Installation Directory,” on page 86
Section 4.3.4, “Gathering Domain and Gateway Information,” on page 86
Section 4.3.5, “Selecting the Gateway Object Name,” on page 86

Section 4.3.6, “Specifying the Internet Mail Domain Name for Your GroupWise System,” on
page 87

Section 4.3.7, “Handling Outbound Mail,” on page 87

Section 4.3.8, “Enabling the Internet Agent Web Console,” on page 87

Section 4.3.9, “NetWare Installation Options: Automatic Startup and Clustering,” on page 88
Section 4.3.10, “Linux Installation Options: LDAP Information and Clustering,” on page 89

Section 4.3.11, “Windows Installation Options: Service vs. Application and SNMP Traps,” on
page 90

IMPORTANT: If you plan to install the Internet Agent in a clustered server environment, refer to
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) as you plan
your Internet Agent installation.
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4.3.1 Selecting the Internet Agent Platform

The Internet Agent is available as a NetWare NLM™ program, a Linux executable, and a Windows
executable.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 1: Software Platform, mark whether you plan to install the Internet Agent on NetWare, Linux,
or Windows. Review Section 4.2, “Internet Agent System Requirements,” on page 83 to ensure that the
specific server you have selected meets the listed requirements.

4.3.2 Gathering Server Information

Prior to GroupWise 7, the Internet Agent and the MTA communicated by transferring message files
through message queue directories, as shown in diagrams in GroupWise 7 Troubleshooting 3:
Message Flow and Directory Structure (http://www.novell.com/documentation/gw7):

* “Mapped/UNC Link: Outbound Transfer to the Internet Successful”
* “Mapped/UNC Link: Inbound Transfer from the Internet Successful”

Starting in GroupWise 7, you can configure the Internet Agent so that it uses TCP/IP to
communicate with the MTA, instead of message files, as shown in these additional diagrams:

e “TCP/IP Link: Outbound Transfer to the Internet Successful”
e “TCP/IP Link: Inbound Transfer from the Internet Successful”

The Internet Agent Installation program needs to know the network address of the server where the
Internet Agent will run. For best performance, install the Internet Agent on the same server with the
domain it belongs to. In this configuration, in a GroupWise system with a single Internet Agent,
UNC links between the Internet Agent and the MTA are sufficient. Therefore, the Internet Agent
Installation program displays a default port number of 0 (zero), indicating that TCP/IP will not be
used.

In a larger GroupWise system with multiple Internet Agents, you can configure the Internet Agent to
communicate with the MTA by way of TCP/IP. This configuration enables you to designate an
alternate Internet Agent for the domain. With this configuration, if the domain’s primary Internet
Agent goes down, the MTA can fail over to another Internet Agent in your GroupWise system until
the primary Internet Agent is up and running again. This feature is especially useful in larger
GroupWise systems where multiple Internet Agents handle a large number of Internet messages.

If you want to enable TCP/IP communication between the Internet Agent and the MTA, use a port
number of 7102 or any other available port number. If you do not want to enable TCP/IP
communication, use 0 (zero) as the port number.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under ltem 3: Server Information, list the IP address and DNS hostname of the server where you plan to
install the Internet Agent. Also, specify the port number for TCP/IP communication if you want to enable
it.
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4.3.3 Selecting the Internet Agent Installation Directory

You should install the Internet Agent on the same server where the domain directory is located. The
Internet Agent installation directory depends on the platform where you are installing it.

Consider these platform-specific guidelines:

NetWare: When installing the NetWare Internet Agent, we recommend you use the sys:\system
directory on the NetWare server. This simplifies access to the Internet Agent configuration
file and ensures that the NLM program is in the server’s search path. If you use a different
directory, you must add that directory to the server’s search path.

Linux: The Linux Internet Agent is automatically installed to /opt/novell/groupwise/
agents.

Windows: The default installation directory is c: \grpwise\gwia. However, you can install the
Internet Agent to any directory you want.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, record the directory where you want to install the Internet Agent
software.

4.3.4 Gathering Domain and Gateway Information

The Internet Agent requires a GroupWise gateway directory in which to store configuration
information and work files. The gateway directory must be located under a GroupWise domain
directory. The default directory name is gwia. If you change the name, use the following platform-
specific conventions:

NetWare: Use a maximum of 8 characters
Linux: Use only lowercase characters

Windows: No limitations.

After you specify the domain directory location and a gateway directory name, the Internet Agent
Installation program creates the gateway directory under the doma i n\wpgate directory (for
example, provo\wpgate\gwia).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 6: GroupWise Domain, specify the domain name and the full path to the domain directory
where you want to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux Internet Agent, record the eDirectory™ context of the Domain object (for
example, cn=provo3, ou=groupwise, o=corporate).

4.3.5 Selecting the Gateway Object Name

The Internet Agent also requires a GroupWise Gateway object in Novell eDirectory. By default, it is
named the same as the gateway directory and is referred to as the Internet Agent object. This object
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stores the Internet Agent’s information and enables configuration of the agent through
ConsoleOne®.

The Internet Agent’s object is created below the Domain object. If you have multiple domains, the
Installation Advisor uses the Domain object associated with the domain directory where you are
creating the Internet Agent’s gateway directory.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 6: GroupWise Internet Agent Name, specify the name you want to give the Internet Agent’s
object. The default name is the same as the gateway directory name you chose under Iltem 5.

4.3.6 Specifying the Internet Mail Domain Name for Your
GroupWise System

When e-mail users across the Internet address messages to GroupWise users, the address includes
the Internet mail domain for your GroupWise system (for example, novell.com). Typically, the
Internet mail domain name for your GroupWise system is the name of your company, with its
accompanying domain type (.com, .edu, and so on).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 8: Internet Mail Domain Name, specify the name you want your GroupWise system to be
known by across the Internet.

4.3.7 Handling Outbound Mail

If the Internet Agent is connected to the Internet and is able to perform DNS name resolution, it can
send messages from GroupWise users directly across the Internet to Internet users. However, you
might prefer to keep the Internet Agent behind your firewall. To accomplish this, you can configure
the Internet Agent to route all outbound messages to a relay host.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 5: Relay Host, mark how you want to handle outbound mail. If you plan to use a relay host,
specify the IP address of the relay host.

4.3.8 Enabling the Internet Agent Web Console

The Internet Agent server console enables you to monitor the Internet Agent from the server where
it is running. If you want, you can enable the Internet Agent Web console. The Web console lets you
view the Internet Agent’s statistical and diagnostic information through a Web browser, which is
useful if want to see the Internet Agent’s activity without physically visiting the agent’s server.

You access the Web console by entering the Internet Agent’s network address and HTTP port
number in a Web browser (for example, http://172.16.5.18:7211). If necessary, you can change the
Internet Agent’s default HTTP port number (9850).

If you want to restrict access to the Web console, you can assign a username and password. This can
be any username and password you want. By default, the username and password are passed through
an unsecure connection between the Web browser and the Internet Agent. Therefore, we recommend
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that you do not use an existing eDirectory username and password unless you secure this connection
using SSL. For information about securing the Internet Agent’s connections, see “Internet Agent” in
the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 4: Web Console Information, select Yes if you want to enable the Internet Agent Web
console. If you want to restrict access to the Web console, enter a username and password.

4.3.9 NetWare Installation Options: Automatic Startup and
Clustering

When you install the NetWare Internet Agent, the following options specific to NetWare are
available in the Internet Agent Installation program:

» “Automatic Startup” on page 88

* “Novell Cluster Services” on page 88

Automatic Startup

You can have the Internet Agent Installation program add a reference to the gwia.ncf file in the
NetWare server’s autoexec.ncf file so that the Internet Agent is automatically loaded whenever
the server is started.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark whether or not you want to configure the NetWare server to start
the Internet Agent automatically.

Novell Cluster Services

Novell Cluster Services™ is a server clustering system that ensures high availability and
manageability of critical network resources including volumes (where GroupWise domains reside)
and applications (such as the Internet Agent). Novell Cluster Services supports failover, failback,
and migration of individually managed cluster resources.

The NetWare Internet Agent can be configured to take advantage of the fault-tolerant environment
provided by Novell Cluster Services if the following requirements are met:

* The domain where the Internet Agent is installed has already been created on a shared NSS
volume in the cluster.

» The NetWare Internet Agent is being installed to a server that is part of the same cluster.

When the Internet Agent is configured for clustering, its startup file is configured with shared
volume names rather than specific server names.
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GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark whether or not you want to configure the NetWare Internet Agent
for clustering. If you do, follow the installation instructions in “Implementing the Internet Agent in a
NetWare Cluster” or “Implementing the Internet Agent in a Linux Cluster” in the GroupWise 7
Interoperability Guide (http://www.novell.com/documentation/gw7), rather than the installation
instructions in this guide.

4.3.10 Linux Installation Options: LDAP Information and
Clustering

When you install the Linux Internet Agent, the following Linux-specific options are available in the
Internet Agent Installation program:

* “LDAP Information” on page 89

* “Clustering Alternatives on Linux” on page 89

LDAP Information

The Linux Internet Agent Installation program needs to access eDirectory through LDAP.
eDirectory access is required in order to create the Internet Agent object. To obtain access, the
Installation program needs the IP address and port number of an LDAP server, along with an
eDirectory username and password to log in with. The user must have sufficient rights to create
GroupWise objects in eDirectory. Because the Linux Installation program uses LDAP to access
eDirectory, you must provide the username in LDAP format. For example:

cn=admin, ou=users, o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For
background information about SSL, see “Encryption and Certificates” in “Security Administration”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by
deselecting Require TLS for Simple Binds with Password. The LDAP snap-in to ConsoleOne is
required in order to change the setting.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 9: LDAP Authentication, specify the IP address and port number of an LDAP server, a
username in LDAP format, the password for the username, and if necessary, the full path to your SSL
certificate file.

Clustering Alternatives on Linux

On Linux, you can install the Internet Agent in three different clustering environments, as described
in the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7):

e “Novell Cluster Services on Linux”

* “PolyServe Matrix Server on Linux”
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If you are using Novell Cluster Services, the Linux GroupWise Installation program provides a
Configure GroupWise for Clustering option that simplifies the process of installing the Linux
Internet Agent on multiple nodes in the cluster.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark whether or not you want to configure the Linux Internet Agent for
clustering using Novell Cluster Services. If you do, follow the installation instructions provided in
“Implementing the Internet Agent in a Linux Cluster” in Novell Cluster Services on Linux in the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7), rather than the
installation instructions provided in this guide.

If you are installing the Linux Internet Agent on PolyServe Matrix Server, the Linux GroupWise
Installation program does not assist you with the setup. See the GroupWise 7 Interoperability Guide
(http://www.novell.com/documentation/gw7) for installation instructions.

4.3.11 Windows Installation Options: Service vs. Application
and SNMP Traps

When you install the Windows Internet Agent, you have choices about how the Internet Agent
interacts with the Windows operating system.

» “Service vs. Application” on page 90
* “SNMP Traps” on page 91
Service vs. Application

When you run the Windows Internet Agent as a service, it can start automatically and run without a
user interface, just like any Windows service.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under ltem 2: Installation Options, mark Install as Windows Service if you want to run the Internet Agent
as a service.

When you run the Windows Internet Agent as a service, it must run under a specific Windows user
account.

When the Internet Agent domain is located on the same server where you are installing the Internet
Agent, the Internet Agent can run under the local system account. Installing the Internet Agent on
the same server with its domain is recommended.

If the Internet Agent domain is located on a remote server, you must specify a user with rights to
access the domain directory.

Windows If the Windows Internet Agent needs to log in to another Windows server, provide a
Windows username and password.

NetWare: If the Windows Internet Agent needs to log in to a NetWare server, provide an existing
eDirectory username and password, or create a new account for the agents, as described
in “Creating a NetWare Account for Agent Access (Optional)” on page 172.

Linux: Configuring the Windows Internet Agent to log in to a Linux server is not recommended.
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GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under ltem 10: Windows Service Information, record the account the Internet Agent will run under, and if
necessary, the password for the account.

As with all Windows services, the Windows Internet Agent can be started automatically or manually
as a service each time the Windows server restarts.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 10: Windows Service Information, mark how you want the Windows Internet Agent to start
each time the server is restarted.

SNMP Traps

If you want to use an SNMP manager program, such as the Management and Monitoring Services
component of Novell ZENworks Server Management, to monitor the Windows Internet Agent, you
must install some SNMP components along with the Internet Agent software.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Item 2: Installation Options, mark Install and Configure SNMP for GroupWise Agents if you want to
use an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows
server where you are installing the agents. If you want to monitor the agents from an SNMP management
program, the SNMP service must be enabled so you can select this option.

NOTE: The NetWare and Linux Internet Agents rely on operating system components for SNMP
functionality and do not require this installation option.

4.4 Setting Up the Internet Agent

Complete the following tasks to set up the Internet Agent:

» Section 4.4.1, “Installing the Internet Agent,” on page 91
» Section 4.4.2, “Assigning a Postmaster,” on page 96

» Section 4.4.3, “Starting the Internet Agent,” on page 97
+ Section 4.4.4, “Testing the Internet Agent,” on page 99

4.4.1 Installing the Internet Agent

As you install the Internet Agent, you are prompted to supply configuration information. Use
Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 100 to understand the
prompts and to record your installation and configuration information.

* “NetWare and Windows: Installing the Internet Agent Software” on page 92
* “Linux: Installing the Internet Agent Software” on page 94
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IMPORTANT: If you plan install the Internet Agent in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
the Internet Agent.

NetWare and Windows: Installing the Internet Agent Software

The Internet Agent Installation program does the following:

Installs the Internet Agent software files to the server where the Internet Agent will run and to
the domain directory.

Tests the server you are installing to for correct Internet configuration.
Creates the Internet Agent object in eDirectory.

Configures the Internet Agent startup file (gwia.cfg).

To install the Internet Agent:

1

Select an appropriate location to run the Internet Agent Installation program.

NetWare: If you are installing the NetWare Internet Agent, you can run the Installation
program from any Windows machine that meets the administrator machine
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on
page 21.

Windows: If you are installing the Windows Internet Agent, you must run the Installation
program at the Windows server were you want to install the Internet Agent. It must
also meet the administrator machine requirements listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21.

Make sure that no other GroupWise agents are running on the server where you want to install
the Internet Agent.

Make sure that you have access to the directory where you want to install the Internet Agent
and to the domain directory.

Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the
Installation program to create the Internet Agent object.

Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install GroupWise Internet
Agent. If the Installation program does not start automatically, run setup . exe from the root
of the CD.

or
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If you have already copied the Internet Agent software to a software distribution directory, run
internet\gwialinstall.exe to start the Agent Installation program.

GroupWise Internet Agent Installation — |EI ll
Welcome
Grougize Intemet Agent Install does the following:
Novell.

Installs Groupise Intemet Agent

Creates the GroupWwize Intemet Agent object in

1 i eDirectoy
3 Conligures startup files for Groupiwize Intemnet

Agent

Tests the server you are installing to for corect
Internet configuration

< Back I Next > I Exit |

6 Follow the prompts, using the following information from the GroupWise Internet Agent
Installation Worksheet.

Item 1: Software Platform

Item 2: Installation Options

Item 3: Server Information

Item 4: Web Console Information

Item 5: Relay Host

Item 6: GroupWise Domain

Item 7: GroupWise Internet Agent Name

Item 8: Internet Mail Domain Name

Item 10: Windows Service Information (Windows only)

GroupWise Internet Agent Installation - |E| 5'

Post Installation Task List

The following topics describe resolution of problems

N ove " encountered during installation ar tasks that remain in
’ order to configure GroupWWise Internet Agent.
. Topic
‘IQ RFC Compliance: Specify a Posthaster
.

v Launch Intemet Agent now

I™ Launch in Protected Mode

I~ Wiew Internet configuration test results

[ Save task list to a file

Installation Guide: < Back. I Firish I Exit |

7 When the installation is complete, select from the following options:

Options not applicable to the platform where you are installing or to the configuration you
selected are dimmed.

Launch Internet Agent Now: This option starts the Internet Agent immediately.
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Launch in Protected Mode: This option starts the NetWare Internet Agent in its own
protected address space.

View Internet Agent Configuration Test Results: During the installation process, the
Internet Agent Installation program examined the server where it was installing the Internet
Agent to see if the server was properly configured to connect to the Internet. This option
displays the results of the test and can help you resolve any problems the Installation program
discovered with the Internet connectivity of the server.

Save Task List to a File: This option saves the task lists in the Topic box to a file so you can
complete them later. Typically, the task of assigning a postmaster is listed. You may see other
tasks listed as well.

8 Click Finish, then continue with Section 4.4.2, “Assigning a Postmaster,” on page 96.

Linux: Installing the Internet Agent Software

As you install the Internet Agent, you are prompted to supply configuration information. Use
Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 100 to understand the
prompts and to record your installation and configuration information.

» “Installing the Internet Agent” on page 94

» “Configuring the Internet Agent” on page 95

IMPORTANT: If you plan install the Internet Agent in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
the Internet Agent.

Installing the Internet Agent

1 Make sure that LDAP is running on your eDirectory server and that it is configured to accept
login from the Internet Agent Installation program (worksheet item 8).

The Internet Agent Installation program requires eDirectory access in order to create the
Internet Agent object in eDirectory. The Installation program uses LDAP to gain the required
access.

2 In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise Installation program. If you are not using the X Window System, you can install
GroupWise components individually, as described in “Installing the GroupWise Agents Using
the Text-Based Installation Program” on page 179.

3 Change to the root of GroupWise 7 Administrator for Linux CD.
4 Start the GroupWise Installation program.
./install

5 Select the language in which you want to run the GroupWise Installation program, then click
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.
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Novell. GroupWise.

View the Readme

Wiew the Quickstart |
WP VOMFGROMpWiSe System,

Wiew the Installation Guide
as well as install additonal

Displays aweb payge with inporant infomiation veu showld vead before installing,

Displavs a hiyh-level checklist of system vequirements and installation steps to guide vou throwuh setting

Displays overview and task infomation that will help you plan, install, and update a GroupWise syster,

Create or update a GroupWise systen

Install Products Displays the
systen.,

Wisit the Novell GroupWise Web Site
(bt rwww novell.coms
products voupwise).

Intemet Agert

Launches the GroupWise Installation and Setup Advisors. These advisers step you through the creation
of anew GroupWise system orthe updating of an existing GroupWise systen.

install once you've created a GroupWise

Launches yourweb browserto display Groupwrise information located on the Movell web site.

6 Click Install Products > GroupWise Internet Agent > Install Internet Agent
7 When the installation is complete, click OK.

The Internet Agent software is installed to /opt/novell /groupwise/agents.

8 Continue with Configuring the Internet Agent.

Configuring the Internet Agent

1 After the Internet Agent files have been installed, click Configure Internet Agent.

The Internet Agent installation and configuration steps are separate so that you can install

updated agent software without repeating the agent configuration steps.

GroupWise Internet Agent Configuration

Introduction

[] mtroduction
program will do the following:

o

L] Retay Host

Information

[ intermet Mail Domain Name

* Configure startup files for GroupWise Internet Agent

‘Welcome to the GroupWise Internet Agent Configuration Program. This

# Create the Group'ise Internet Agent obigct in eDirectary

2 Follow the prompts, using the following information from the GroupWise Internet Agent

Installation Worksheet in the order listed.

Item 3: Server Information

Item 5: Relay Host

Item 8: Internet Mail Domain Name
Item 6: GroupWise Domain
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Item 9 LDAP Authentication
Item 7: GroupWise Internet Agent Name

On the Configuration Complete page, Launch Internet Agent on System Startup is selected by
default.

IMPORTANT: If you want to configure the Internet Agent for high availability, as described
in “Enabling the High Availability Service for the Linux GroupWise Agents” on page 187, it
must be configured to start automatically on system startup.

3 If you do not want the Internet Agent to start automatically when the server restarts, deselect
Launch Internet Agent on System Startup.

4 Click Exit to complete the configuration.

5 Continue with Assigning a Postmaster.

4.4.2 Assigning a Postmaster

The Internet requires each site to assign at least one user to be a Postmaster. The Postmaster is
assigned to be the recipient of messages addressed to postmaster@host.

1 In ConsoleOne, right-click the Internet Agent object, the click Properties.
2 Click GroupWise > Gateway Administrators.

Properties of GWIA il

Server Directoties I Access Control vI Resttach | Post Office Links ‘ GroupWise + | DS Rights vI Other} EE
Gateweay Administrators

Add Delete |
[ Administrator Role
I Operatar
™ Accaurtant
™ Postmaster
™| Foreion Gperator
Page Options Ok | Cancel | Apply I Help |

3 On the Gateway Administrators page, click 4dd, select a GroupWise user to be the Postmaster,
then click OK.

4 Select the user from the list, then click Postmaster.
5 Click OK to save the information.
6 Continue with Starting the Internet Agent.

The Internet Agent can also be configured to send problem messages to the Postmaster. For
instructions, see “Determining What to Do with Undeliverable Messages” in “Internet Agent” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).
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4.4.3 Starting the Internet Agent

After you’ve installed the Internet Agent and configured a Postmaster, you can start the Internet
Agent.

+ “NetWare: Starting the Internet Agent” on page 97

* “Linux: Starting the Internet Agent” on page 97

* “Windows: Starting the Internet Agent” on page 99

NetWare: Starting the Internet Agent

During installation, the Internet Agent Installation program copied the gwia . ncf startup file to the
sys:\systemn directory (unless you specified a different directory). You use this file when you
load the Internet Agent.

If you chose to have the Internet Agent Installation program add the gwia.ncf command to your
autoexec.ncf, the Internet Agent loads whenever you start the server.

To manually start the Internet Agent:

1 At the NetWare server console, enter gwia to run the gwia.ncf file.

If the Internet Agent does not start successfully, see “Starting the NetWare GroupWise Agents
on page 175.

After you have started the Internet Agent, verify that the program is running. You can monitor
the program from the operation screen. Press F10-Options, then press F9-Stats. If you see an
error message in the Statistics window, the program has not loaded properly.

2 If you enabled the Internet Agent Web console, you can use the following URL to view the
Web console:

http://internet agent network address:http port
For example:
http://172.16.5.18:9850

For more information, see “Using the Internet Agent Web Console” in “Internet Agent” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

3 Skip to with Section 4.4.4, “Testing the Internet Agent,” on page 99.

Linux: Starting the Internet Agent
To start the Linux Internet Agent with a user interface:

1 If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server, disable it
before starting the Internet Agent.

For example, use the following commands to stop and disable Postfix:

/etc/init.d/postfix stop
chkconfig postfix off

As an alternative, you could configure the Internet Agent to bind exclusively to the server IP
address, as described in “Binding the Internet Agent to a Specific IP Address”, so that the

Installing the GroupWise Internet Agent

97


http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7

Internet Agent does not conflict with the the default Postfix IP address of 127.0.0.1 (the
loopback address).

2 If you want to use the Internet Agent for POP3 and IMAP4 mail, make sure no POP3 or
IMAP4 daemons are running on your Linux server.

3 Make sure that the MTA for the domain is running.
In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
Internet Agent server console.

5 Change to the /opt/novell/groupwise/agents/bin directory.
6 Enter the following command to start the Internet Agent:
./gwia --show @gwia.cfg &

The --show switch starts the Internet Agent with a server console interface similar to that
provided for the NetWare and Window Internet Agent. This user interface requires that the X
Window System and Open Motif be running on the Linux server.

The @ startup switch points to the Internet Agent startup file and is required to start the Internet
Agent.

The ampersand (&) causes the Internet Agent to run in the background, so that the terminal
window you started it in is again available for use.

54 GroupWise Internet Agent

File Configuration Log Statistics Help
|Pmu03.GL-IIn Up Time: 3 Days & Hrs 14 Hins
—Status ————————Message Statistics
Processing % Out 10 Hinutes In 10 Minutes
i i 0 0 ] 1]
Grouphlizs Open gl
Status 0 0 0 0
Other Link Open || pasethraugh [l [ [ 0
Program Idle 4 | Convert Errors [ 0 (4] o
e easedl Depiil Communication Errors 0 0 0 0
Total Bytes 0.0 0.0
A

Time Zone= HST

GHT Offset= =7 hours, O minutes

Hemisphere= MORTH

Daylight Sawing Change= 1 hours, O minutes

Daylight Saving Begin= 474 (month/day)

Daylight Saving End= 10431 (month/day}

SNHP On

Startup Switches= —show fhome=/gqusysten/prova3 /upgate/g
wia Adhome=/gusysten/provod /upgatesguia Jantp Apopd /
imapd /ldap /mime /http /mudas=2 /mailview=internet /
sd=B /rd=16 /p=10 /te=2 /tg=h /tc=b /tr=5 Jtd=3 /tt=1
0 /pt=10 fit=10 Aldapthrd 10 /st=4 Jrt=4 fari=never /
attachmsg /dsn Adsnage=4 /hn=jbd-lnx.provo.nove
11, comnow

End Configuration Information

The status messages displayed on the Internet Agent server console are also written to the
Internet Agent log file (mmddlog.nnn)inthe /var/log/novell/groupwise/
domain.gwia directory. The log file name includes the month and day when it was created,
along with an incrementing extension to accommodate multiple log files on the same day.

After the Internet Agent starts successfully, refer to the following sections in Chapter 7,
“Installing GroupWise Agents,” on page 161 for additional information about managing the
Internet Agent on Linux:

o “Starting the Linux GroupWise Agents as Daemons” on page 182
* “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 183
» “Starting the Linux GroupWise Agents on System Startup” on page 183
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* “Running the Linux GroupWise Agents as a Non-root User” on page 184
» “Enabling the High Availability Service for the Linux GroupWise Agents” on page 187
* “Stopping the Linux GroupWise Agents” on page 190
* “Uninstalling the Linux GroupWise Agents” on page 192
7 Skip to Section 4.4.4, “Testing the Internet Agent,” on page 99

Windows: Starting the Internet Agent
1 If the domain directory is not on the Internet Agent server, map a drive to the domain directory
as a user that has rights to access the domain directory.

2 If the Internet Agent is installed as a Windows application, click Start > Programs >
GroupWise Internet Agent > GroupWise Internet Agent.

hﬂ GroupWise Internet Agent g L | = 1'
File Configuration Log Statistics Help
Provo2 Gl Up Tirme: 0 Days OHrs 1 Mins
—Status—————— — Message Statistic:
Processing Out 10 Minutes In 10 Minutes
e MNormal 0 1} i} 1}
Group'wize Open i 0 i 0 0
Other Link  Open Passthrough 0 a a a
Program  Idie g || Corvert Erors il 1} 0 1}
Commuricatiorn 0 ] ] ]
Log Lewel  Mormal Total Bytes 0.0 0.0
0755 42B38  vo2WWwWPGATENGWIA /DHome-c:\gipwisehowia ASMTP /POP3 /1 d

07.65:42B38  MAP4 /LDAP MIME MUDAS-2 /SD-B /RD-16 /P10 /TE-2/T
07:55:42838  G-5/TCS/TR-S/TD-3/TT-10 /PT-10 AT-10 ALdapThrd-
07:55:42B38 10/5T-4 /RT-4 /ARI-MEVER /éttachMeg /DSM /Dsnbge-4 /
0755:42B38  HN-"bd-wak.prova novel.com™ AVORE-c:harpwizet,
075542838 gwia000.FPRCWGEW WORK /LOG-c:hgipwisehgwia /ntzervicena

07:5542038  me-"|
07:55:42 B3B End Configuration Information j
07:55:42 888 LDAP server running =

or

If the Internet Agent is installed as a Windows service, click the Start menu > Settings >
Control Panel > Administrative Tools > Services. Right-click the GWIA service, then click

Start.
If the Internet Agent does not start successfully, see “Starting the Windows GroupWise Agents”
on page 196.

3 Ifyou enabled the Internet Agent Web console, use the following URL to log into the Web
console:
http://internet agent network address:http port

For example:
http://172.16.5.18:9850

For more information, see “Using the Internet Agent Web Console” in “Internet Agent” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

4 Continue with Testing the Internet Agent.

4.4.4 Testing the Internet Agent

After you’ve started the Internet Agent, you should send a message to ensure that the system is
working properly.

To send a message:
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1 Open a new mail message in your GroupWise client.

2 In the To field, enter your Internet address using the following syntax:
internet agent:"user@host"
where internet_agent is the Internet Agent’s name. For example:
gwia:"rcollins@novell.com"

3 Send the message, then check your mailbox to verify that you receive it.

4 Continue with What’s Next.

4.5 What’s Next

The “Internet Agent” section of the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7) provides information to help you further configure and maintain the Internet
Agent, including how to:

 Configure addressing options. By default, your GroupWise system is set up to use the standard
GroupWise address format (user_id.post_office.domain). This requires your users to enter
Internet addresses in the following format: internet _agent:"user@host". You can configure
your GroupWise system to use Internet-style address format (user@host) rather than the
standard GroupWise address format. See “Configuring Internet Addressing”.

* Optimize configuration settings for the SMTP/MIME, IMAP, POP, and LDAP services. See
“Configuring Internet Services”.

» Use SSL to secure connections between the Internet Agent and other SMTP hosts, POP/IMAP
clients, and the Internet Agent Web console. See “Securing Internet Agent Connections with
SSL”

 Control users’ access to SMTP/MIME (inbound and outbound), IMAP, and POP services. See
“Controlling User Access to the Internet”

* Protect users from spam. See “Blocking Unwanted E-Mail from the Internet”

* Control logging for the Internet Agent. See “Using Internet Agent Log Files”

4.6 GroupWise Internet Agent Installation
Worksheet

The following table lists the information you are prompted to provide as you complete the Internet
Agent installation

Item Explanation
1) Software Platform Select the type of server where you will install the Internet Agent.
* NetWare For more information, see Section 4.3.1, “Selecting the Internet Agent
Li Platform,” on page 85.
* Linux
* Windows
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Item

Explanation

2) Installation Options

Path:

NetWare Options:
» Update AUTOEXEC File

» Configure Internet Agent
for Clustering

Linux Options:

» Configure GroupWise for
Clustering

Windows Options:

« Install and Configure
SNMP for GroupWise
Agents

¢ Install as Windows
Service

3) Server Information
* |P Address:
* DNS Host Name

* Message Transfer Port:

4) Web Console Information
Enable: Yes | No

* Username:
« Password:
* HTTP Port: 9850 (default)

5) Relay Host

» Send Outbound Mail
Directly to Internet Hosts
or

» Send Outbound Mail
through a Relay Host

IP address:

Specify the server path where you want the Internet Agent files
installed.

For more information, see Section 4.3.3, “Selecting the Internet Agent
Installation Directory,” on page 86.

If you selected NetWare as the Internet Agent'’s platform under item 1,
see Section 4.3.9, “NetWare Installation Options: Automatic Startup
and Clustering,” on page 88 for more information.

If you selected Linux as the Internet Agent’s platform under item 1, see
Section 4.3.10, “Linux Installation Options: LDAP Information and
Clustering,” on page 89 for more information.

If you selected Windows as the Internet Agent’s platform under item 1,
see Section 4.3.11, “Windows Installation Options: Service vs.
Application and SNMP Traps,” on page 90 for more information.

Specify the network address of the server where the Internet Agent will
run.

If you want the Internet Agent and the MTA to communicate by way of
TCP/IP, specify 7102 or another available port number. If you do not
want to use TCP/IP, specify 0 (zero) to disable TCP/IP communication.

For more information, see Section 4.3.2, “Gathering Server
Information,” on page 85.

Specify whether or not you want to enable the Internet Agent Web
console. The Web console allows you to monitor the operation of the
agent through a Web browser.

For more information, see Section 4.3.8, “Enabling the Internet Agent
Web Console,” on page 87.

Mark how you want the Internet Agent to handle outbound messages
from GroupWise users to Internet users.

For more information, see Section 4.3.7, “Handling Outbound Mail,” on
page 87.
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Item

Explanation

6) GroupWise Domain

Domain Name:
Domain Directory:
Gateway Subdirectory:

eDirectory Context:

7) GroupWise Internet Agent
Name

8) Internet Mail Domain Name

9) LDAP Authentication

LDAP Server IP Address:

LDAP Server Port:

Username in LDAP
Format:

Password:
SSL Certificate

10) Windows Service
Information

Use Local System
Account

Allow Service to Interact
with Desktop: Yes | No

Use this Windows User
Account

Name:
Password:

Startup Type: Automatic |
Manual | Disabled

Specify the domain name and the domain directory where you want to
create a subdirectory for the Internet Agent.

On Linux, specify the eDirectory context of the Domain object.

For more information, see Section 4.3.4, “Gathering Domain and
Gateway Information,” on page 86.

Specify a name for the GroupWise Gateway object that will be created
in eDirectory to represent the Internet Agent.

For more information, see Section 4.3.5, “Selecting the Gateway Object
Name,” on page 86.

Specify the Internet domain name assigned to your GroupWise system.

For more information, see Section 4.3.6, “Specifying the Internet Mail
Domain Name for Your GroupWise System,” on page 87.

This item applies to the Linux Internet Agent only.

List the IP address and port of an LDAP server in your system and the
username and password that the Internet Agent Installation program
can use to log in to eDirectory to create the Internet Agent object. If you
want to use an SSL connection, specify an SSL certificate file.

For more information, see Section 4.3.10, “Linux Installation Options:
LDAP Information and Clustering,” on page 89.

This information applies only if you are installing the Internet Agent as a
Windows service.

Indicate how you want the Internet Agent to access the domain
directory specified under item 5.

For more information, see “Service vs. Application” on page 90.
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Installing GroupWise WebAccess

Novell® GroupWise® WebAccess enables user access to GroupWise mailboxes through Web
browsers, WAP-enabled cellular phones, and Pocket PCs. The following sections provide
information to help you successfully install the GroupWise WebAccess (including GroupWise
WebPublisher if desired) in your existing GroupWise system.

» Section 5.1, “GroupWise WebAccess Overview,” on page 103

» Section 5.2, “WebAccess System Requirements,” on page 107

+ Section 5.3, “Planning GroupWise WebAccess,” on page 108

» Section 5.4, “Setting Up GroupWise WebAccess,” on page 116

» Section 5.5, “What’s Next,” on page 131

* Section 5.6, “GroupWise WebAccess Installation Worksheet,” on page 132

IMPORTANT: If you plan to install WebAccess in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
WebAccess.

5.1 GroupWise WebAccess Overview

» Section 5.1.1, “GroupWise WebAccess Introduction,” on page 103
+ Section 5.1.2, “GroupWise WebAccess Components,” on page 104
» Section 5.1.3, “One WebAccess Server vs. Two,” on page 105

» Section 5.1.4, “WebAccess Security Requirements,” on page 105

» Section 5.1.5, “GroupWise Document Viewer Agent,” on page 107

5.1.1 GroupWise WebAccess Introduction

GroupWise WebAccess, when used in a Web browser, provides most of the functionality available
in the other GroupWise clients. For information about tasks that can be completed using the
WebAccess client, see the WebAccess Help after installation. WebAccess client functionality on
mobile devices or PDAs might be limited in comparison to the other GroupWise clients.

GroupWise WebAccess also includes GroupWise WebPublisher, an optional extension to
GroupWise WebAccess. GroupWise WebPublisher lets GroupWise users publish documents from a
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GroupWise library to the Web. Web users can then view the published documents in their Web
browsers.

Figure 5-1 GroupWise WebAccess Requires the User to Log in to a GroupWise Mailbox, but GroupWise

WebPublisher Does Not
D\ Login GroupWise .
WebAccess < Mailbox
Browser rouise s
\I/ No Login WebPublisher Documents
Internet
Intranet

As shown above, GroupWise WebAccess requires users to have a mailbox in a GroupWise post
office. GroupWise WebPublisher, on the other hand, is designed to provide public access to
GroupWise library documents; WebPublisher users do not require a mailbox.

After you’ve finished setting up GroupWise WebAccess, you should look at Section 5.5, “What’s
Next,” on page 131 for additional information you might want to be aware of as you configure,
maintain, and expand GroupWise WebAccess.

5.1.2 GroupWise WebAccess Components

GroupWise WebAccess consists of four components: the WebAccess Application, the WebPublisher
Application, the WebAccess Agent, and the Document Viewer Agent.

Figure 5-2 GroupWise WebAccess Components
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WebAccess Application: The WebAccess Application, which resides on the Web server, provides
the WebAccess user interface. As users perform actions in the WebAccess client, the WebAccess
Application passes information between the Web browser and the WebAccess Agent.
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WebPublisher Application: The WebPublisher Application, which resides on the Web server,
provides the WebPublisher user interface. As users perform actions in the WebPublisher client, the
WebPublisher Application passes information between the Web browser and the WebAccess Agent.

WebAccess Agent: The WebAccess Agent receives user requests from the WebAccess Application
and WebPublisher Application, accesses post offices and libraries to process the requests, and then
passes information back to the applications.

The WebAccess Agent is required for both WebAccess and WebPublisher. The WebAccess
Application must be installed in order to use WebAccess. Likewise, the WebPublisher Application
must be installed in order to use WebPublisher.

Document Viewer Agent: The Document Viewer Agent isolates the document conversion task
from the WebAccess Agent. The Viewer Agent can simultaneously convert multiple documents into
HTML format. If it encounters a problem converting a document, the problem does not affect
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conversion of other documents, nor does it affect the functioning of the WebAccess Agent.
Therefore, WebAccess users do not experience interruptions because of documents that fail to
convert into HTML.

5.1.3 One WebAccess Server vs. Two

The WebAccess Application and WebPublisher Application can be installed to a NetWare, Linux,
Windows, or UNIX Web server. If desired, you can install the WebAccess Agent and the Viewer
Agent on the same server with the Web server.

Figure 5-3 The GroupWise WebAccess Application, WebPublisher Application, WebAccess Agent, and Viewer Agent
Are All Installed on the Web Server
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The server where they run together must be a Web server because the WebAccess Application is
installed into the Web server installation.

The WebAccess Agent and Viewer Agent can also run on a different server from where the
WebAccess Application runs. In addition to running on a NetWare, Linux, or Windows server, the
WebAccess Application can also run on a UNIX Solaris server in conjunction with a Web server
running on one of those platforms, as illustrated below:

Figure 5-4 The GroupWise WebAccess and WebPublisher Applications Are Installed on the Web Server, and the
WebAccess Agent and Viewer Agent Are Installed on a NetWare or Windows Server
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Security, discussed in Section 5.1.4, “WebAccess Security Requirements,” on page 105, might also
determine whether you run the WebAccess Agent and Viewer Agent on the same server as the Web
server.

5.1.4 WebAccess Security Requirements

GroupWise WebAccess can be configured to support the level of security you have established for
your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use WebAccess on a
secured intranet), you can install the WebAccess components to any servers that provide access for
your users and meet the requirements listed in Section 5.2, “WebAccess System Requirements,” on
page 107.
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If you plan to use WebAccess to provide users with access to their mailboxes from anywhere on the
Internet (rather than simply within a secured intranet), and you already have a firewall in place to
provide security, you have the following options for configuring WebAccess:

* Install all WebAccess components inside your firewall and use a proxy service. See
“Configuration Using a Proxy Service” on page 106. This is the recommended configuration.

* Install the WebAccess and WebPublisher Applications on a Web server outside your firewall
and the WebAccess Agent and Viewer Agent on a server inside your firewall. See
“Configuration Without a Proxy Service” on page 106.

Configuration Using a Proxy Service

If your firewall includes a proxy service, you can install the WebAccess Application and
WebPublisher Application to a Web server inside your firewall, and the WebAccess Agent and
Viewer Agent to another server inside the firewall, as shown in the following illustration.

Figure 5-5 WebAccess Installed in an Environment That Uses a Proxy Service
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If desired, the WebAccess Agent and Viewer Agent can also be installed to the Web server rather
than a separate server, as discussed in Section 5.1.3, “One WebAccess Server vs. Two,” on
page 105.

Configuration Without a Proxy Service

If your firewall does not provide a proxy service, you need to install the WebAccess Application and
WebPublisher Application to a Web server that is outside the firewall. Because the WebAccess
Agent requires direct access (mapped path or UNC path) to a GroupWise domain directory, it needs
to be installed to a server that is located within the firewall.

Figure 5-6 WebAccess Installed in an Environment That Doesn't Use a Proxy Service
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The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port
number of the WebAccess Agent (for example, 172.16.5.18:7205).

In addition, the firewall must allow outbound IP packets to be sent from the WebAccess Agent to the
Web server. This requires all high ports (above 1023) to be open to outbound IP packets.
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5.1.5 GroupWise Document Viewer Agent

The documents that users attach to e-mail messages are as varied as the combinations of document
formats, tools, and users throughout the world. In order to display documents in your Web browser,
WebAccess must convert them to HTML. Because some documents contain unexpected data,
WebAccess cannot convert them. In earlier versions of GroupWise, the WebAccess Agent
sometimes shut down when it could not convert a document. This occurrence then interrupted the
activities of all WebAccess users.

The GroupWise 7 Document Viewer Agent resolves the problem by taking over the document
conversion task from the WebAccess Agent. The Viewer Agent can process multiple documents
simultaneously, and if it encounters a problem with a document, the problem does not affect its
processing of other documents, nor does it affect the functioning of the WebAccess Agent.
Therefore, WebAccess users no longer experience interruptions because of documents that fail to
convert into HTML.

The Viewer Agent is automatically installed along with the WebAccess Agent, and the WebAccess
Agent manages the Viewer Agent, starting and stopping it as needed. The default configuration of
the Viewer Agent is sufficient to provide basic document conversion functionality. The default
configuration includes a minimum of 5 worker threads that run independently of the Viewer Agent
process. Additional Viewer Agent functionality can be enabled using startup switches in the Viewer
Agent startup file (gwdva . dva). Configuring the Viewer Agent in ConsoleOne is not currently
possible. For more information, see “Configuring the Document Viewer Agent” in “WebAccess” in
the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

5.2 WebAccess System Requirements

O GroupWise 7 system: The GroupWise 7 WebAccess Agent can only access GroupWise 7 post
offices and libraries

O 32-bit/x86 processor or 64-bit/x86 processor running in 32-bit mode
O Any of the following server operating systems for the WebAccess Agent and the Viewer Agent:
* Novell Open Enterprise Server (NetWare or Linux version), plus the latest Support Pack

* NetWare 5.1, NetWare 6.0, or NetWare 6.5, plus the latest Support Pack for your version
of NetWare

Domains and post offices can be located on NetWare 3.12 and NetWare 4.2 servers,
although the agents cannot run there.

+ SUSE® Linux Enterprise Server 9, plus the latest Support Pack

The X Window System is required by the GUI Installation Advisor and Setup Advisor that
step you through the process of creating a new GroupWise system. A text-based
Installation program is also available.

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles. By default, the agents run as daemons without user interfaces.

* Windows Server 2000 or Windows Server 2003, plus the latest Service Pack for your
version of Windows

O Adequate server memory as required by the operating system

NOTE: On NetWare only, the Document Viewer Agent requires 1 GB of memory for its own
use in its default configuration of 5 worker threads.
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O Any of the following Web servers for the WebAccess Application and the WebPublisher
Application:

* NetWare 6: Netscape Enterprise Server for NetWare; Apache 1.3 plus Tomcat 3.3 plus the
Jakarta Connector

* NetWare 6.5: Apache 2 plus Tomcat 4 plus the Jakarta Connector
 Linux: Apache 2 plus Tomcat 4 plus the Jakarta Connector

* Windows Server 2000/2003: Microsoft Internet Information Server (IIS) 5 or later plus
Tomcat 5.5 plus the Jakarta Connector

» UNIX: Apache 2 plus a compatible servlet engine and connector

O Any of the following Web browsers for the WebAccess client and the WebAccess Agent Web
console:

* Linux: Mozilla Firefox
* Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox
* Macintosh: The latest version of Safari for your Mac OS; Mozilla Firefox
+ UNIX: Mozilla Firefox
O Any of the following mobile devices for the WebAccess client:

* Any mobile device that supports the Wireless Access Protocol (WAP) and has a
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or later, or
Wireless Markup Language (WML) 1.1 or later

* Pocket PC with Windows 2000/2002/2003
U Adequate server disk space

» Approximately 215 MB for the WebAccess program files (111 MB shared with Monitor;
varies by platform)

* Approximately 50 MB for the Document Viewer Agent program files (varies by platform)

» Adequate disk space for the document cache and document quarantine used by the
associated Document Viewer Agent, as described in “Configuring the Document Viewer
Agent” in “WebAccess” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7)

5.3 Planning GroupWise WebAccess

Before installing GroupWise WebAccess, you should complete the planning tasks listed below. The
planning tasks help you gather information you will need as you install and set up GroupWise
WebAccess. You can use Section 5.6, “GroupWise WebAccess Installation Worksheet,” on page 132
to record your installation and setup information.

* Section 5.3.1, “Deciding Where to Install the GroupWise WebAccess Components,” on
page 109
» Section 5.3.2, “Determining the WebAccess Agent’s Configuration,” on page 109

* Section 5.3.3, “Determining the WebAccess and WebPublisher Applications” Configuration,”
on page 115
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IMPORTANT: If you plan to install WebAccess in a clustered server environment, refer to the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) as you plan your
WebAccess installation.

5.3.1 Deciding Where to Install the GroupWise WebAccess
Components

After reviewing Section 5.1, “GroupWise WebAccess Overview,” on page 103 and the system
requirements listed in Section 5.2, “WebAccess System Requirements,” on page 107, plan where
you want to install the WebAccess components in your system.

For best performance, the WebAccess Agent should be installed on the same server where the
domain it belongs to is located. If you need to install it on a remote server, you can create a
secondary domain on the remote server so that the WebAccess Agent has a local domain and MTA
to communicate with.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under ltem 2: Server Platform and Installation Directory, specify the platform where you will install the
WebAccess Agent, then specify the directory where you want to install the WebAccess Agent files. The
default installation directories are:

* NetWare: sys:\system

e Linux: /opt/novell/groupwise/agents

* Windows: c: \webacc

Under ltem 13: Web Server Type and Root Directory, select the type of Web server where you will install
the WebAccess Application and WebPublisher Application, then specify the Web server’s root directory.

Under ltem 14: Novell Root Directory, specify a directory on the Web server where you want to install the
configuration files for the WebAccess Application and WebPublisher Application.

Under Iltem 15: Java Servlet Engine, mark whether you want to use the Tomcat Servlet Container
(recommended) or another servlet engine.

5.3.2 Determining the WebAccess Agent’s Configuration

As you install the WebAccess Agent, you are prompted to supply the configuration information
described in the following sections:

» “Network Address” on page 110

» “Gateway Directory Location and Name” on page 110

+ “Gateway Object Name” on page 110

* “Domain and Post Office Access” on page 111

* “Web Console” on page 111

* “WebPublisher” on page 112

» “NetWare Installation Option: Novell Cluster Services” on page 113

» “Linux Installation Options: LDAP Information and Clustering” on page 113

* “Windows Installation Options: Service vs. Application and SNMP Traps” on page 114
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Network Address

The WebAccess Agent communicates with the WebAccess Application and WebPublisher
Application (on the Web server) through TCP/IP.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 3: Server Address, specify the IP address or DNS hostname of the WebAccess Agent’s
server, then specify the port number for the agent to use. The default is 7205.

Gateway Directory Location and Name

The WebAccess Agent requires a GroupWise gateway directory in which to store configuration
information and work files. The gateway directory must be located under a GroupWise domain
directory. The default directory name is webac70a. If you change the name, use the following
platform-specific conventions:

NetWare: Use a maximum of 8 characters
Linux: Use only lowercase characters

Windows: No limitations.

After you specify the domain directory location and a gateway directory name, the WebAccess
Installation program creates the gateway directory under the doma i n\wpgate directory (for
example, provo\wpgate\webac70a).

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 5: Gateway Directory, specify the domain name and the full path to the domain directory
where you want to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux WebAccess Agent, record the eDirectory™ context of the Domain object
(for example, cn=provo3, ou=groupwise, o=corporate).

Gateway Object Name

The WebAccess Agent also requires a GroupWise Gateway object in Novell eDirectory. By default,
it is named the same as the gateway directory and is referred to as the WebAccess Agent object. This
object stores the WebAccess Agent’s information and enables configuration of the agent through
ConsoleOne®.

The WebAccess Agent object is created below the Domain object. If you have multiple domains, the
WebAccess Installation program uses the Domain object associated with the domain directory where
you are creating the WebAccess Agent gateway directory.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 6: Gateway Object, specify the name you want to give the WebAccess Agent object. The
default name is the same as the gateway directory name you chose for ltem 5.
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Domain and Post Office Access

The WebAccess Agent requires access to the domain. It also requires access to each post office
where mailboxes or libraries are located that WebAccess or WebPublisher users will access.

Domain: The WebAccess Agent needs direct access (mapped drive, UNC path, or file system
mount) to the domain directory so that it can write to its gateway directory
(domain\wpgate\webac70a).

Post Offices: The WebAccess Agent needs direct access (mapped drive, UNC path, or file system
mount) to the post office directory so that it can write to the POAs input queue, or it needs client/
server access (TCP/IP) to the post office’s POA. By default, the WebAccess Agent uses whatever
access mode has been established for the post office on the Post Office Settings property page of the
Post Office object in ConsoleOne.

If the WebAccess Agent must access a remote server in order to access a domain or post office, it
needs to be able to log in to the remote server.

NetWare: Ensure that an eDirectory user account exists that provides the required access to the
domain and post office directories. For direct access to the domain directory or a post
office directory, the WebAccess Agent needs Read, Write, Create, Erase, Modify, and File
Scan rights.

Windows: Ensure that a Windows user account exists on the Windows server for the agent.

If the domain or any post office directories directly accessed by the WebAccess Agent are
on remote Windows servers, ensure that the Windows user account provides Full Control
access to those directories.

If the domain directory or any post office directories directly accessed by the WebAccess
Agent are on remote NetWare servers, ensure that the WebAccess Agent has an
eDirectory user account with the same username and password as the agent’'s Windows
user account. The eDirectory account must provide Read, Write, Create, Erase, Modify,
and File Scan rights to the directories.

If the WebAccess Agent does require an eDirectory user account, ensure that the context
of the account is defined in the bindery context of all NetWare servers that will be
accessed.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 7: eDirectory Authentication, specify the eDirectory username and password you want the
WebAccess Agent to use to access the domain directory and post office directories. This applies to the
NetWare WebAccess Agent only.

If you are using the Windows WebAccess Agent, ensure that the appropriate Windows and eDirectory
user accounts exist.

Web Console

The WebAccess Agent server console enables you to monitor the WebAccess Agent from the server
where it is running. If you want, you can enable the WebAccess Agent Web console. The Web
console lets you view the WebAccess Agent’s statistical and diagnostic information through a Web
browser, which is useful if want to see the WebAccess Agent’s activity without physically visiting
the agent’s server.

Installing GroupWise WebAccess

111



You access the Web console by entering the WebAccess Agent’s network address and HTTP port
number in a Web browser (for example, http://172.16.5.18:7211). If necessary, you can change the
WebAccess Agent’s default HTTP port number (7211).

If you want to restrict access to the Web console, you can assign a username and password. This can
be any username and password you want. By default, the username and password are passed through
an unsecure connection between the Web browser and the WebAccess Agent. Therefore, do not use
an existing eDirectory username and password unless you secure this connection using SSL. For
information about securing the WebAccess Agent’s connections, see “WebAccess” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 10: Web Console, select Yes if you want to enable the Web console. If you want to restrict
access to the Web console, enter a username and password.

WebPublisher

You can choose whether or not you want the WebAccess Agent to support GroupWise
WebPublisher. If you enable WebPublisher support, you need to specify a GroupWise account
(mailbox ID and password). The GroupWise account serves two purposes:

» GroupWise users publish documents to WebPublisher users by sharing the documents with this
GroupWise account.

* When Web users access WebPublisher, the WebAccess Agent logs in to this GroupWise
account. This lets the WebAccess Agent know which documents have been shared with
WebPublisher users. It can then retrieve these documents (and only these documents) for the
WebPublisher users.

Create a new GroupWise account specifically for GroupWise WebPublisher. If you’ve already
created an eDirectory account for the WebAccess Agent to use when accessing domain or post office
directories, as described in “Domain and Post Office Access” on page 111, you might want to create
the GroupWise account under that eDirectory user account.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 12: WebPublisher Support, select Yes if you want to enable the WebAccess Agent to support
WebPublisher, then enter the Mailbox ID and password for the GroupWise account you want the
WebAccess Agent to use.

If you enable GroupWise WebPublisher support, you need to select the libraries that you want to
make public. The WebAccess Agent, acting on behalf of WebPublisher users, only accesses
documents in public libraries.

Making a library public does not automatically give WebPublisher users access to all documents in
the library. For WebPublisher users to have access to a document in a public library, the document’s
owner must have shared the document with the WebPublisher user account.
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GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 13: Libraries, list the libraries from which documents can be shared. The WebAccess
Installation program lists all libraries in your GroupWise system. If you want, you can wait until then to
select libraries.

NOTE: When a WebPublisher user requests a library document in HTML format rather than its
native format, the Viewer Agent renders the document from its native format to HTML format. The
Viewer Agent can be configured to cache the HTML document to a subdirectory of the WebAccess
Agent installation directory. This enables the WebAccess Agent to use the cached document for
future requests. For instructions to configure the Viewer Agent, see “WebAccess” in the Group Wise
7 Administration Guide (http://www.novell.com/documentation/gw7).

NetWare Installation Option: Novell Cluster Services

Novell Cluster Services is a server clustering system that ensures high availability and
manageability of critical network resources including volumes (where GroupWise domains and post
offices reside) and applications (such as the GroupWise WebAccess Agent). Novell Cluster Services
supports failover, failback, and migration of individually managed cluster resources.

During installation, the NetWare WebAccess Agent can be configured to take advantage of the fault-
tolerant environment provided by Novell Cluster Services if the following requirements are met:

» The domains and post offices to be serviced by the NetWare WebAccess Agent have already
been created on shared NSS volumes in the cluster.
» The NetWare WebAccess Agent is being installed to a server that is part of the same cluster.

When the WebAccess Agent is configured for clustering, its startup file (webac70a.waa) is
configured with shared volume names rather than specific server names.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 4: Clustering Support, mark whether or not you want to configure the NetWare WebAccess
Agent for clustering. If you do, follow the installation instructions in “Implementing WebAccess in a
NetWare Cluster” in “Novell Cluster Services on NetWare” in the GroupWise 7 Interoperability Guide
(http://www.novell.com/documentation/gw7), rather than the installation instructions in this guide.

Linux Installation Options: LDAP Information and Clustering

When you install the Linux WebAccess Agent, the following Linux-specific options are available in
the Installation program:

* “LDAP Information” on page 113

* “Clustering Alternatives on Linux” on page 114

LDAP Information

If you are installing the Linux WebAccess Agent and WebAccess Application, the WebAccess
Installation program needs to access eDirectory through LDAP. eDirectory access is required in
order to create the WebAccess Agent and WebAccess Application objects. To obtain access, the
Installation program needs the IP address and port number of an LDAP server, along with an
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eDirectory username and password to log in with. The user must have sufficient rights to create
GroupWise objects in eDirectory. Because the Linux Installation program uses LDAP to access
eDirectory, you must provide the username in LDAP format. For example:

cn=admin, ou=users, o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For
background information about SSL, see “Encryption and Certificates” in “Security Administration”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by
deselecting Require TLS for Simple Binds with Password. The LDAP snap-in to ConsoleOne is
required in order to change the setting.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 11: LDAP Authentication, specify the IP address and port number of an LDAP server, a
username in LDAP format, the password for the username, and if necessary, the full path to your SSL
certificate file.

Clustering Alternatives on Linux

On Linux, you can install the WebAccess Agent in three different clustering environments, as
described in the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7):
* “Novell Cluster Services on Linux”
» “PolyServe Matrix Server on Linux”
If you are using Novell Cluster Services™, the Linux GroupWise Installation program provides a

Configure GroupWise for Clustering option that simplifies the process of installing the Linux
WebAccess Agent on multiple nodes in the cluster.

GROUPWISE WEBACCESS AGENT INSTALLATION WORKSHEET

Under ltem 2: Installation Options, mark whether or not you want to configure the Linux WebAccess
Agent for clustering using Novell Cluster Services. If you do, follow the installation instructions in
“Implementing WebAccess in a Linux Cluster” in Novell Cluster Services on Linux in the GroupWise 7
Interoperability Guide (http://www.novell.com/documentation/gw7), rather than the installation
instructions in this guide.

If you are installing the Linux WebAccess Agent on PolyServe Matrix Server, the Linux GroupWise
Installation program does not assist you with the setup. See the GroupWise 7 Interoperability Guide
(http://www.novell.com/documentation/gw7) for installation instructions.

Windows Installation Options: Service vs. Application and SNMP Traps

The WebAccess Agent can run as a Windows service rather than a standard Windows application.
To do so, the WebAccess Agent service requires a user account. The requirements for the Windows
service user account are the same as those listed for the Windows WebAccess Agent in “Domain and
Post Office Access” on page 111.
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GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 8: Execution Options, select Run WebAccess Agent as a Windows Service.

Under Iltem 9: Windows Service User, enter the username and password for the service’s user account.

The Windows WebAccess Agent can also be configured to support SNMP. This enables the
WebAccess Agent to be monitored and managed through an SNMP management program.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

If you want the WebAccess Agent to support SNMP, under Item 8: Execution Options, select the Install
and Configure SNMP for WebAccess Agent option.

NOTE: The NetWare and Linux WebAccess Agents rely on operating system components for
SNMP functionality and do not require this installation option.

5.3.3 Determining the WebAccess and WebPublisher
Applications’ Configuration

As you install the WebAccess Application and/or the WebPublisher Application to a Web server,
you are prompted to supply the configuration information described in the following sections:

» “Default Language” on page 115
» “eDirectory Objects and Configuration Files” on page 116

NOTE: You should have already selected the Web server where you will install the WebAccess
Application and WebPublisher Application. If you have not, see Section 5.3.1, “Deciding Where to
Install the GroupWise WebAccess Components,” on page 109.

Default Language

The WebAccess Installation program installs all available languages. You need to specify which
language should be used when displaying the Novell Web Services page. When users access the
Novell Web Services page, they can use the default language for WebAccess or WebPublisher, or
they can select another language.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 16: Default Language, specify the language for the Novell Web Services page.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw7).

Installing GroupWise WebAccess

115


http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7

eDirectory Objects and Configuration Files

WebAccess Application and WebPublisher Application configuration information is stored in two
places:

 eDirectory objects

* The webacc.cfgand webpub. cfqg files, located by default in the Web server’s novell
directory (worksheet item 14)

The WebAccess Application object and WebPublisher Application object allow you to easily modify
configuration information in ConsoleOne. The eDirectory information is the master information;
any changes made to the objects in eDirectory are also written to the configuration files.

In some installation scenarios, such as installing to a Web server outside a firewall or installing to a
UNIX Web server, you might not have access to eDirectory, which means the WebAccess
Installation program cannot create the objects. It can, however, still create the configuration files on
the Web server. In this case, to change the application’s configuration, you need to manually modify
the webacc.cfg and webpub. cfqg files.

You need to select the eDirectory container where you want the objects created. They are all created
in the same container. The default container is the Domain object, which means the objects are
created beneath the Domain object along with the MTA and Internet Agent objects.

NOTE: Each application also has several providers associated with it. For example, the WebAccess
Application has a GroupWise Provider and an LDAP Provider. The GroupWise Provider is the
component that actually communicates with the WebAccess Agent to request information for users.
The LDAP Provider communicates with LDAP servers to enable users to search LDAP address
books. Provider objects are created in the same location as the application objects.

GROUPWISE WEBACCESS INSTALLATION WORKSHEET

Under Item 17: eDirectory Object Configuration, specify the tree where you want the objects created,
then specify the context. If you will be installing from a location where you don’t have access to
eDirectory, you can skip this item.

5.4 Setting Up GroupWise WebAccess

* Section 5.4.1, “NetWare and Windows: Setting Up GroupWise WebAccess,” on page 116
» Section 5.4.2, “Linux: Setting Up GroupWise WebAccess,” on page 123
» Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 129

5.4.1 NetWare and Windows: Setting Up GroupWise
WebAccess

Complete the following tasks to set up GroupWise WebAccess and WebPublisher:

» “Installing the WebAccess Agent” on page 117
» “Installing the WebAccess Application and WebPublisher Application” on page 119
» “Starting GroupWise WebAccess” on page 122
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IMPORTANT: If you plan to install GroupWise WebAccess in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you
install WebAccess.

Installing the WebAccess Agent

The following steps provide instructions for installing the WebAccess Agent. For information about
installing the WebAccess and WebPublisher Applications to a Web server, see “Installing the
WebAccess Application and WebPublisher Application” on page 119.

1 Select an appropriate location to run the WebAccess Installation program.

NetWare: If you are installing the NetWare WebAccess Agent, you can run the Installation
program from any Windows machine that meets the administrator machine
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on
page 21.

Windows: If you are installing the Windows WebAccess Agent, you must run the Installation
program at the Windows server were you want to install the WebAccess Agent. It
must also meet the administrator machine requirements listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21.

2 Make sure that no other GroupWise agents are running on the server where you want to install
the WebAccess Agent.

3 Make sure that you have access to the directory where you want to install the WebAccess
Agent and to the domain directory.

4 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the
Installation program to create the WebAccess Agent object.

5 Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install Group Wise WebAccess. If
the Installation program does not start automatically, run setup . exe from the root of the CD.

or

If you have already copied the GroupWise WebAccess software to a software distribution
directory, run internet\webacces\setup.exe to start the WebAccess Installation
program.

6 Click Yes to accept the license agreement and display the GroupWise WebAccess: Components
dialog box.

GroupWise WebAccess: Components ] x|

GroupWise Wehlcoess uses the components listed below
N ove " Select the components you want to install at this time.

Compaonents

Description
ALicceszes post offices and libranes to process uger requests
teceived from the WebArccess and WebPublisher
applications. Can be installed on a Metware or ‘windows
SEIVEr,

IristallGhield

< Back I Next > I Cancel
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7 Select GroupWise WebAccess Agent and deselect the GroupWise WebAccess Application and
GroupWise WebPublisher Application options (worksheet item 1).

NOTE: You can also install the WebAccess Application and WebPublisher Application to your
Web server at this time, if you have the appropriate Web server file system access and
eDirectory access, as described in “Installing the WebAccess Application and WebPublisher
Application” on page 119.

8 Follow the prompts to provide information about WebAccess Agent configuration, using the
following information from the GroupWise WebAccess Installation Worksheet.

Item 2: Server Platform and Installation Directory
Item 3: Server Address
Item 4: Clustering Support (NetWare only)
Item 5: Gateway Directory
Item 6: Gateway Object
I[tem 7: eDirectory Authentication
Item 8: Execution Options (Windows only)
Item 9: Windows Service User (Windows only)
Item 10: Web Console
Item 12: WebPublisher Support (WebPublisher only)
Item 13: Libraries (WebPublisher only)
9 If you are installing the WebAccess Application and WebPublisher Application along with the

WebAccess Agent, skip to Step 10 in Installing the WebAccess Application and WebPublisher
Application.

of

If you are installing the WebAccess Application and WebPublisher Application as a separate
task, continue with Step 1 in Installing the WebAccess Application and WebPublisher
Application.

Installing the WebAccess Application and WebPublisher Application

The following steps provide instructions for installing the WebAccess Application and
WebPublisher Application. For information about installing the WebAccess Agent, see “Installing
the WebAccess Agent” on page 117.

1 Select an appropriate location to run the WebAccess Installation program.

NetWare: If you are installing to a NetWare Web server, you can run the WebAccess
Installation program on any Windows machine that meets the administrator
machine requirements listed in Section 2.1, “GroupWise Administration
Requirements,” on page 21.

Windows: If you are installing to a Windows Web server, you must run the WebAccess
Installation program on that server. It must also meet the administrator machine
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on
page 21.

2 Make sure that you have access to the directory where you want to install the WebAccess
Agent and to the domain directory.
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3 Make sure that you have the file system access required to install the WebAccess Application
and the WebPublisher Application:

* You need full file system rights to the GroupWise domain directory. See Item 5: Gateway
Directory in Section 5.6, “GroupWise WebAccess Installation Worksheet,” on page 132.

* You need full file system rights to the Web server. If your Web server is on a UNIX server,
the WebAccess Installation program copies tar files to a location you specify; this can be
the UNIX server if you have access to it from the Windows workstation where you are
performing the installation, or another location from which you can then copy the tar files
to the UNIX server. See Item 13: Web Server Type and Root Directory in Section 5.6,
“GroupWise WebAccess Installation Worksheet,” on page 132.

4 Shut down the Web server and Java.

NetWare:

Linux:

Windows:

NetWare 6:

unload apache
unload java

NetWare 6.5:

unload apache2
unload java

GroupWise installation of Apache:

/etc/init.d/novell-httpd stop
/etc/init.d/novell-tomcat4 stop

Novell Open Enterprise Server Linux installation of Apache:

/etc/init.d/apache2 stop
/etc/init.d/novell-tomcat4 stop

SLES 9 installation of Apache:

apachectl stop
CATALINA HOME/bin/shutdown.sh

Refer to your Microsoft Windows documentation.

5 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the
Installation program to create the WebAccess objects (worksheet item 17).

6 Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install Group Wise WebAccess. If
the Installation program does not start automatically, run setup . exe from the root of the CD.

or

If you have already copied the GroupWise WebAccess software to a software distribution
directory, run internet\webacces\setup.exe to start the WebAccess Installation

program.
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7 Click Yes to accept the license agreement and display the GroupWise WebAccess: Components
dialog box.

GroupWise WebAccess: Components x|

GroupWise Webdcocess uses the companents I\st_ed below.
N OVS " Select the components you want ta install at this time.
Companents
[ ] Groupifise Wehdccess Agent ok
Group'wise webe Application
Group'wise webPublisher Application ER S

i Description
Communicates with a'Web server and Webéccess Agent to
process Webdocess users' requests. Must be installed to the
‘wieb server. Also includes Movell Speller Application,

Iristal|S Hield

< Back I Next > I Cancel I

8 Select GroupWise WebAccess Application and Group Wise WebPublisher Application (if you
plan to use WebPublisher).

9 Deselect the GroupWise WebAccess Agent option, then click OK.

10 Follow the prompts to provide information about WebAccess Application and WebPublisher
configuration, using the following information from the GroupWise WebAccess Installation
Worksheet.

Item 13: Web Server Type and Root Directory
Item 14: Novell Root Directory

Item 15: Java Servlet Engine (NetWare only)
Item 16: Default Language

Item 17: eDirectory Object Configuration

11 When the installation is complete, select from the following options:

Launch Installation Summary: This option displays a list of the information you provided
during installation. You can print it for future reference.

Start the GroupWise WebAccess Agent: This option starts the WebAccess Agent
immediately. If you want to configure the server to start the WebAccess Agent automatically
each time the server restarts, see “Starting the NetWare GroupWise Agents” on page 175 or
“Starting the Windows GroupWise Agents” on page 196.

Restart the Web Server: This option starts the Web server, which loads the WebAccess
Application (and WebPublisher Application if you installed it).

12 After installation is complete, if you are installing to an Apache Web server on UNIX Solaris,
continue with “Completing the Installation on a UNIX Apache Web Server” on page 121.

or

Skip to Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 129.
Completing the Installation on a UNIX Apache Web Server
The WebAccess Installation program copies the following files to the location you specified:

* webaccess.tar

* webaccessdocs.tar
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webaccessjars.tar
webaccessservlets.tar
index.html

web.xml

commgr.cfg

To complete the installation and configuration process:

1

2
3

Using the tar -xvf command, extract the following tar files to the specified locations:

* webaccess.tar: Extract to the root of the UNIX server. A /novell directory is created
for the files.

* webaccessdocs.tar: Extract to the Tomcat GroupWise document root directory (for
example, /usr/local/tomcatd/webapps/gw).

* webaccessservlets.tar: Extract to the Tomcat GroupWise classes directory (for example,
/usr/local/tomcatd/webapps/gw/WEB-INF/classes).

* webaccessjars.tar: Extract to the Tomcat GroupWise lib directory (for example, /usr/
local/tomcat4d/webapps/gw/WEB-INF/1ib).

Copy the web . xm1 file is in the Tomcat webapps/gw/WEB-INF directory.

Modify the webacc.cfg and webpub . cfg files, located in the /novell/webaccess
and /novell/webpublisher directories at the root of the UNIX server, to change the
Templates.path setting to point to the templates.

For example, change the following line in webacc.cfg:
Templates.path=/java/servlets/com/novell/webaccess/templates
to

Templates.path=/usr/local/tomcatd/webapps/gw/WEB-INF/classes/com/
novell/webaccess/templates

Copy the commgr . cfg file to the /novell/webaccess directory. If you installed
GroupWise WebPublisher, you also need to copy the file to the /novell/webpublisher
directory.

In the webacc . cfg file, verify that the paths for the following settings point to valid
directories. Typically, these directories reside in the /novell/webaccess directory, but
you can relocate them if desired. Refer to the comments in the webacc . cfg file for
explanations of each of these settings.

Log.path=/novell/webaccess/logs
Security.Timeout.path=/novell/webaccess/users
File.Upload.path=/novell/webaccess/temp

Verify that the paths for the following settings are correct.

Provider.GWAP.Config.file=/novell/webaccess/commgr.cfg
Provider.LDAP.Config.file=/novell/webaccess/ldap.cfg

In the webpub . cfg file, verify that the paths for the following settings point to valid
directories. Typically, these directories reside in the /novell/webpublisher directory,
but you can relocate them if desired. Refer to the comments in the webpub . c fg file for
explanations of each of these settings.

Log.path=/novell/webpublisher/logs
File.Upload.path=/novell/webpublisher/temp
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Verify that the path for the following setting is correct.
Provider.GWDOC.Config.file=/novell/webpublisher/commgr.cfg

7 Copy the index.html file to the Tomcat GroupWise document root directory (for example,
/usr/local/tomcatd/webapps/gw).

For the convenience of your users, you can link to the GroupWise file from your current default
home page.

Starting GroupWise WebAccess

If you did not have the WebAccess Installation program start the WebAccess components, complete
the following steps:

1 Restart Java and the Web server.

NetWare: NetWare 6:

load tomcat33
load apache

NetWare 6.5:

load tomcati4
load apache?2

Linux: GroupWise installation of Apache:

/etc/init.d/novell-tomcat4 start
/etc/init.d/novell-httpd start

Novell Open Enterprise Server Linux installation of Apache:

/etc/init.d/novell-tomcat4 start
/etc/init.d/apache2 start

SLES 9 installation of Apache:

CATALINA HOME/bin/startup.sh
apachectl start

Windows: Refer to your Microsoft Windows documentation.

This loads the WebAccess Application (and WebPublisher Application if you installed it).
2 Start the WebAccess Agent

NetWare: Enter strtweb.ncf at the NetWare server console.

Windows: To run as an application, click Start > Programs > Novell GroupWise WebAccess >
GroupWise WebAccess.

To run as a service, from the Control Panel click Administrative Tools > Services.
Right-click the WebAccess service, then click Start.

NOTE: When you start the WebAccess Agent, the Document Viewer Agent also starts.
However, the Viewer Agent cannot run as a Windows service.
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4

If the WebAccess Agent does not start successfully, see “Starting the NetWare GroupWise
Agents” on page 175.

If you enabled the WebAccess Agent Web console, you can use the following URL to view the
Web console:

http://webaccess _agent network address:http port
For example:
http://172.16.5.18:7211

For more information, see “Using the WebAccess Agent Web Console” in “WebAccess” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

Skip to Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on page 129.

5.4.2 Linux: Setting Up GroupWise WebAccess

Complete the following tasks to set up GroupWise WebAccess and WebPublisher. These tasks are
designed to help you get Linux WebAccess up and running as quickly as possible and to help you
manage the WebAccess Agent in the future.

“Installing the Linux WebAccess Agent” on page 124
“Configuring the Linux WebAccess Agent” on page 125

“Installing and Configuring the WebAccess Application and WebPublisher Application” on
page 126

“Configuring WebPublisher” on page 127
“Restarting the Web Server” on page 128
“Starting the Linux WebAccess Agent” on page 128

IMPORTANT: If you plan to install GroupWise WebAccess in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw?7) before you
install WebAccess.

Installing the Linux WebAccess Agent

1

Make sure that LDAP is running on your eDirectory server and that it is configured to accept
login from the WebAccess Agent Installation program (worksheet item 11)

The Installation program requires eDirectory access in order to create the WebAccess Agent
object in eDirectory. The Installation program uses LDAP to gain the required access.

In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise Installation program. If you are not using the X Window System, you can install
GroupWise components individually, as described in “Installing the GroupWise Agents Using
the Text-Based Installation Program” on page 179.

3 Change to the root of the GroupWise 7 Administrator for Linux CD.

4 Start the GroupWise Installation program.

./install
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5 Select the language in which you want to run the GroupWise Installation program, then click
Next.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.

[ Groupiizs (D me———————————— 23]
R

© Novell. GroupWise. N
View the Readme Displays aweb paye with inporant infomiation yeu should vead before installing.,
View the Quickstart Displays a hiyh-level chechlistof system vequivements and installation steps to yuide you throwgh setting

I YONFGROVPWiSe System.

Wiew the Installation Guide Displays overview and fash infomation that will help vou plan, instal, and update 2 GroupWise system,
as well as install additienal suth as Wi and P! Intemet Agent

Create or update a GroupWise system Launches the GroupWise Installation and Setup Advisors, These advisors step vou thwugh the creation
of anew CroupWise system orthe wpdating of an existing GroupWise systen.

Install Products Displays the its you can individually install ence you've created a GroupWise
systen,

Wisit the Novell GronpWise Web Site Launches your Web browserto display GroupWise information located on the Novel| web site.

(hittp: twww novell.com
reduCts RONDwiSE),

6 Click Install Products > GroupWise WebAccess > Install WebAccess Agent.
7 When the installation is complete, click OK.

The WebAccess Agent software is installed to /opt/novell /groupwise/agents.
8 Continue with Configuring the Linux WebAccess Agent.

Configuring the Linux WebAccess Agent
1 After the WebAccess Agent files have been installed, click Configure WebAccess Agent.

The WebAccess Agent installation and configuration steps are separate so that you can install
updated agent software without repeating the agent configuration steps.

* _ GroupWise WebAccess Agent Configuration )m“

Introduction

[ mtroduction Welcome to the Groupiise WebAccess Agent Configuration Program.
This procgram will do the following

» Create the Group'Mise ‘WebAccess Agent obiect in eDirectory

# Create configuration files for Groupitise WebAccess Agent

OooOooo0ooao

Cancel |

Next.
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2 Follow the prompts to configure the WebAccess Agent, using the following information from
the GroupWise WebAccess Installation Worksheet in the order listed.

Item 3: Server Information
Item 5: Gateway Directory
Item 11: LDAP Authentication
Item 6: Gateway Object

On the Configuration Complete page, Launch WebAccess Agent on System Startup is selected
by default.

IMPORTANT: If you want to configure the WebAccess Agent for high availability, as
described in “Enabling the High Availability Service for the Linux GroupWise Agents” on
page 187, it must be configured to start automatically on system startup.

3 Ifyou do not want the WebAccess Agent to start automatically when the server restarts,
deselect Launch WebAccess Agent on System Startup.

4 Click Exit to complete the configuration.

5 Continue with Installing and Configuring the WebAccess Application and WebPublisher
Application.

Installing and Configuring the WebAccess Application and WebPublisher
Application

1 After installing and configuring the WebAccess Agent, if you want to use an existing Apache
and Tomcat installations, click Install GroupWise WebAccess Application.

or
Click Install GroupWise WebAccess Application with Apache and Tomcat.

This installs a version of Apache and Tomcat specifically for use with GroupWise. Apache files
are installed under /var/opt/novell/httpand /etc/opt/novell/http. Tomcat
files are installed under /var/opt/novell/tomcat4 and /etc/opt/novell/
tomcat4.

In addition, a self-signed certificate is generated, enabling users to use WebAccess and
WebPublisher using an SSL connection.

NOTE: The option to install Apache and Tomcat along with the WebAccess Application is not
available if you are installing to Novell Open Enterprise Server Linux because Apache and
Tomcat are already installed and configured correctly in that environment.

2 When the installation is complete, click OK.
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3 Click Configure WebAccess Application.

Introduction

D Introduction “Welcome 10 the GroupWise Webiccess Application Configuration
Program. This program will da the Tollowing:

» Create the Groupiise WebAccess obiects in eDirectory

o Configure your webserver to work with Groupiiise Webdccess

OooooOooao

Cancel | | Mext |

4 Follow the prompts to provide information about WebAccess Application, using the following
information from the GroupWise WebAccess Installation Worksheet in the order listed.

Item 5: Gateway Directory

Item 13: Web Server Information
Item 11: LDAP Authentication
Item 17: WebAccess Objects

5 On the Configuration Complete page, click Exit to complete the configuration.
6 If you installed WebPublisher, continue with Configuring WebPublisher.
or

Skip to “Restarting the Web Server” on page 128

Configuring WebPublisher

After installing and configuring WebAccess, as described in Section 5.4.2, “Linux: Setting Up
GroupWise WebAccess,” on page 123, if you want to enable WebPublisher as well, you must
perform some manual configuration.

1 In ConsoleOne, connect to the domain where the WebAccess Agent object was created during
installation.
2 In a convenient context, create a new user specifically for use with WebPublisher.

3 Add the new user to a post office and provide a GroupWise password for the WebPublisher
user.
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4 Browse to and right-click the WebAccess Agent object (by default, webac70a), then click
Properties > WebPublisher.

Properties of WEBAC70A -l—

ccess Cantral v| Reattach I Post Office Links I Croupiise vI KD Rights -( E’z

WebPublisher Proxy User

GroupWise Mailbox ID:

Password:

Library Access
Allow access to these libraries:
Object ID [ ek Display Mame| Domain [ Postoffice | | Add..

["] Assign General User Access to WebPublisher users

5 Inthe GroupWise Mailbox ID field, specify the WebPublisher user you created in Step 2 above.
6 Click Add, then select the library for WebPublisher to access for documents.
7 Select Assign General User Access to WebPublisher Users.
8 Click OK to save the WebPublisher configuration information.
9 Restart your Web server, as described in “Restarting the Web Server” on page 128
10 Restart the WebAccess Agent, as described in “Starting the Linux WebAccess Agent” on
page 128.

In order the add documents to the library so that they can be viewed on the Internet, WebPublisher
user must use the GroupWise Windows client. See “Publishing Documents to the Web with
WebPublisher” in “Creating and Working with Documents” in the GroupWise 7 Windows Client
User Guide (http://www.novell.com/documentation/gw?7).

NOTE: WebPublisher functionality is not currently available in the GroupWise Cross-Platform
client.

Restarting the Web Server

In order to load the WebAccess Application (and WebPublisher Application if you installed it), you
must restart the Web server.

If you installed the Novell version of Apache and Tomcat along with the WebAccess Application,
follow the instructions below to start your Web server. If you did not install the Novell version of
Apache and Tomcat along with the WebAccess Application, restart Apache and Tomcat as you
usually would.

1 Make sure you are logged in as root.

2 Ifyou have other instances of Apache and Tomcat running on this server, bring them down
before you start the new versions you just installed.
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3 Change to the /etc/init.d directory.
4 Start Tomcat.
./novell-tomcat4 start
5 Wait until Tomcat is all the way up.
6 Start Apache.
./novell-httpd start
7 Continue with Starting the Linux WebAccess Agent.

Starting the Linux WebAccess Agent
To start the Linux WebAccess Agent with a user interface:

1 Make sure you are logged in as root.

2 Make sure that the MTA for the domain is running.

3 Change to the /opt/novell/groupwise/agents/bin directory.
4 To start the WebAccess Agent, enter one of the following commands:

./gwinter --show --home domain directory/wpgate/webac70a &
./gwinter --show @webac70a.waa &

The WebAccess Agent --show switch does not display a server console interface like the other
GroupWise agents. Instead, WebAccess configuration and status information displays in the
terminal window where you start the WebAccess Agent.

The --home startup switch specifies the gateway directory and is required to start the
WebAccess Agent.

The @webac70a.waa startup switch specifies the WebAccess Agent startup file, which
contains the --home startup switch.

The ampersand (&) causes the WebAccess Agent to run in the background, so that the terminal
window you started it in is again available for use.

& Shell - Konsole <2> &

Session Edit View Bookmarks Settings Help

000 ©4:59:02 sseeex WebAccess Configuration Information sesese *
000 ©4:59:02

000 ©4:59:02 General Settings:

000 ©4:59:02  Agent Version: 7.0

000 04:59:02 Gateway Home Directory: sgusystemswalthan2/upgate uebac?0a
000 04:59:02 Linux Release 2.6.5-7.97-default

000 ©4:59:02 SNMP: Disabled

000 04:59:02  Uork Directory: soptsnovell groupwisesagents/share/tnpFiles
000 ©4:59:02

000 ©4:59:02 Log Settings:

000 04:59:02 Log File: ~varslog/novel l-groupwise ualthanZ.uwebac?0a 000 . prc 052
Bueb . 004

000 04:59:02 Log Level: NORMAL

000 04:59:02 Max Log File Age (days): 7

000 ©4:59:02 Max Log Disk Space (kb): 65536

000 ©4:59:02

000 ©4:59:0Z Client/Server Settings:

000 94:59:03  IP Address: pru—gudoc (172.15.44.65)

000 94:59:03  ICP Port for Incoming Connections: 7205

000 04:59:03 Client/Server ouver SSL: Disabled

000 ©4:59:03 WebConsole: Enabled

000 ©4:59:03  UebConsole Url: http://172.15.44.65:7211

000 ©4:59:03

000 ©4:59:03 Performance Settings:

w0

Ab | (@ shel

NOTE: When you start the WebAccess Agent, the Document Viewer Agent also starts.

Status messages for the WebAccess Agent are written to the WebAccess Agent log file
(mmddlog.nnn)inthe /var/log/novell/groupwise/domain.webac70a/
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000 .prc directory. The log file name includes the month and day when it was created, along
with an incrementing extension to accommodate multiple log files on the same day.

After the WebAccess Agent starts successfully, refer to the following sections in Chapter 7,
“Installing GroupWise Agents,” on page 161 for additional information about managing the
WebAccess Agent on Linux:

» “Starting the Linux GroupWise Agents as Daemons” on page 182
* “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 183
» “Starting the Linux GroupWise Agents on System Startup” on page 183
* “Running the Linux GroupWise Agents as a Non-root User” on page 184
» “Enabling the High Availability Service for the Linux GroupWise Agents” on page 187
» “Stopping the Linux GroupWise Agents” on page 190
» “Uninstalling the Linux GroupWise Agents” on page 192
5 Continue with Testing GroupWise WebAccess and WebPublisher.

5.4.3 Testing GroupWise WebAccess and WebPublisher

To test GroupWise WebAccess and WebPublisher, complete the steps in the following sections:

» “Testing WebAccess on a Workstation” on page 129
» “Testing WebAccess on a Mobile Device” on page 130
» “Testing GroupWise WebPublisher” on page 131

Testing WebAccess on a Workstation

1 To access the WebAccess client, enter the IP address or hostname of the Web server plus the
directory where the Novell Web Services page is located:.

http://web_server_address/gw

Select a service and a language

GroupWise WebAccess: English =| Go
GroupWise WebPublisher: English »| Gao

@ Copyright 1993-2008 Movell, Inc, All rights reserved

2 Select a GroupWise WebAccess language and service, then click Go to display the Login page.

You can bypass the Novell Web Services page to go directly to the Login page by using the
following URL.:

http://web_server_address/gw/webacc
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If the Web server uses SSL, use https rather than http.

@ Novell. GroupWise.

Usernarme: |

Password:

& High (Broadband)

Cornection Speed
’7  Low (Dial-up)

[~ Use the basic interface  Mare Information

v Remernber rmy settings

3 Type your GroupWise user ID or GroupWise full name in the Name box and your GroupWise
mailbox password in the Password box.

4 Select the desired settings.

High Connection Speed: Select this option if your connection to the Internet is faster than a 56
KB modem.

Low Connection Speed: Select this option if your are on a 56 KB modem or slower. This
reduces the amount of data downloaded from the server by disabling Name Completion so that
the Frequent Contacts Address Book does not need to be downloaded, and by disabling some
aspects of AutoUpdate in the message list, such as no updating after a send or delete action.

Use the Basic Interface: Select this option for a mobile device. It uses simplified templates
and assumes a smaller display area. A few features, such as Name Completion, right-click
menus, and drag-and-drop functionality, are not available in the basic interface.

5 Click Login to display the GroupWise WebAccess main window.

6 Click Help for more information about using GroupWise WebAccess.

Testing WebAccess on a Mobile Device

1 Enter the following URL:

http://web server address/gw/webacc

where web_server _address is the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

Follow the instructions in your mobile device’s documentation to add this URL to your
Favorites or Bookmarks so you don’t need to type the URL every time you log in.

2 Enter your GroupWise user ID and GroupWise mailbox ID.
Testing GroupWise WebPublisher

GroupWise WebPublisher only supports access through a Web browser on a computer. Mobile
devices are not supported.

1 To access the WebPublisher client, enter the IP address or hostname of the Web server plus the
directory where the Novell Web Services page is located:
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http://web_server address/gw

2 Select a GroupWise WebPublisher language, then click Go to display GroupWise
WebPublisher.

You can bypass the Novell Web Services page to go directly to WebPublisher by using the
following URL:

http://web server address/gw/webpub

where web_server _address is the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

3 To search for a specific document, enter the search words, then click Search.
or

To browse the documents in a library, click Document Browse, then click the library you want
to browse. When you browse a library, the first 10 documents are listed. You can list additional
documents if desired.

4 Click Help for more information about using GroupWise WebPublisher.

5.5 What’s Next

The “WebAccess” section of the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7) provides information to help you further configure and maintain GroupWise
WebAccess, including how to:

 Scale GroupWise WebAccess to meet the needs of your users and environment. See “Scaling
Your WebAccess Installation”.

 Control users’ access to GroupWise WebAccess. See “Managing User Access”.

» Secure connections via SSL. See “Securing WebAccess Agent Connections with SSL”.

* Modify the WebAccess Agent’s configuration information, including the number of threads
allocated for request processing. See “Configuring the WebAccess Agent”.

* Monitor the WebAccess Agent and the WebAccess Application. See “Monitoring WebAccess
Operations”.

» Control logging for the WebAccess Agent, WebAccess Application, and WebPublisher
Application. See “Using WebAccess Log Files”

* Modify configuration information for the WebAccess Application and WebPublisher
Application. See “Configuring the WebAccess Application” and “Configuring the
WebPublisher Application”

If you want to set up mailbox synchronization for users’ mobile devices, see the Group Wise Mobile
Server 1 Installation Guide (http://www.novell.com/documentation/gw?7).

5.6 GroupWise WebAccess Installation
Worksheet

The following table lists the information you are prompted to provide as you complete the
WebAccess installation. The table is divided into three sections:

* “WebAccess Agent and WebAccess/WebPublisher Applications” on page 132 offers the
options of which components to install.
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* “WebAccess Agent” on page 133 lists information you need to provide when installing the
WebAccess Agent.

* “WebAccess/WebPublisher Applications” on page 136 lists information you need to provide
when installing the WebAccess Application and/or the WebPublisher Application.

5.6.1 WebAccess Agent and WebAccess/WebPublisher

Applications

Item

Explanation

1) Components to
Install

* WebAccess
Agent

* WebAccess
Application

* WebPublisher
Application

Select the components you want to install.

For details, see Section 5.1.2, “GroupWise WebAccess Components,” on
page 104.

5.6.2 WebAccess Agent

Item

Explanation

2) Server Platform
and Installation
Directory

* Platform:
NetWare,
Linux, or
Windows

* Installation
directory:

3) Server Address

* |P address:
* DNS hostname:

* Port number:
(default = 7205)

Specify the type of server (NetWare, Linux, or Windows) where you plan to install
the WebAccess Agent.

Specify the directory where you plan to install the WebAccess Agent software.
The default installation directories are:

* NetWare: sys:\system
* Linux: /opt/novell/groupwise/agents

* Windows: c: \webacc

The directory path you specify must be from the perspective of the installation
workstation.

For details, see Section 5.3.1, “Deciding Where to Install the GroupWise
WebAccess Components,” on page 109.

Specify the IP address or DNS hostname of the server where you plan to install
the WebAccess Agent software. The WebAccess Installation program attempts to
discover this information from the server, but you should be prepared to supply it
in case the attempt fails.

If port 7205 is already in use, specify a different port.

For details, see “Network Address” on page 110.
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Item

Explanation

4) Configure
GroupWise Agent for
Clustering:

Yes | No

5) Gateway Directory

Domain name:

Domain
directory path:

Gateway
directory name:
(default=webac
70a)

eDirectory
context:

6) Gateway Object

Name:
(default=webac
70a)

7) eDirectory
Authentication

8) Execution Options

Username:

Password:

Install and
Configure
SNMP for
WebAccess
Agent: Yes | No

Run
WebAccess
Agent as a
Windows
Service: Yes |
No

Startup
Options:
Automatic |
Manual

This item applies to both the NetWare and the Linux WebAccess Agent.

Mark whether or not you want to configure the WebAccess Agent for clustering on
Novell Cluster Services.

For details, see “NetWare Installation Option: Novell Cluster Services” on
page 113 or “Linux Installation Options: LDAP Information and Clustering” on
page 113.

Specify the domain name and the path to the domain directory you want to
associate with the WebAccess Agent. The WebAccess Agent stores configuration
information and work files in the directory.

Specify the name of the gateway directory you want created for the WebAccess
Agent. This directory is created in the domain\wpgate directory.

On Linux, specify the eDirectory context of the Domain object.

For details, see “Gateway Directory Location and Name” on page 110.

Specify a name for the GroupWise Gateway object that will be created in
eDirectory to represent the WebAccess Agent. The default name is the same as
the gateway directory. It is referred to as the WebAccess Agent object.

For details, see “Gateway Object Name” on page 110.

This item applies if you are installing the NetWare or Linux WebAccess Agent. It
does not apply to the Windows WebAccess Agent.

Specify an eDirectory username and password that will provide the WebAccess
Agent with file system access to the servers where the domain and post office
directories reside.

For details, see “Domain and Post Office Access” on page 111.
This item applies only if you are installing the Windows WebAccess Agent.

If you want to enable the WebAccess Agent to be managed through an SNMP
management program, select the Install and Configure SNMP for WebAccess
option.

If you want to run the WebAccess Agent as a Windows service, select the Run
WebAccess Agent as a Windows Service option, then choose whether you want
to manually start the service each time or have it start automatically when the
server starts.

For details, see “Windows Installation Options: Service vs. Application and SNMP
Traps” on page 114.
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Item

Explanation

9) Windows Service
User
* Username:

« Password:

10) Web Console
Enable: Yes | No

* Username:
* Password:

* HTTP Port:
(default = 7211)

11) LDAP
Authentication

« LDAP server IP
address:

* LDAP server
port:

* Username in
LDAP format:

* Password:
* SSL certificate:

12) WebPublisher
Support

* Enable: Yes |
No

* Mailbox ID:
» Password:

13) Libraries

This item applies only if you are installing the Windows WebAccess Agent and
plan to run it as a Windows service rather than a Windows application.

Enter the username and password for a user account that provides the service
with access to the domain and post office directories.

For details, see “Windows Installation Options: Service vs. Application and SNMP
Traps” on page 114.

Specify whether or not you want to enable the WebAccess Agent Web console.
The Web console allows you to monitor the operation of the agent through a Web
browser.

If you choose to enable the Web console, specify a WebAccess Agent username
and password to use when logging in to the agent. If port 7211 is already in use,
specify a different HTTP port.

For details, see “Web Console” on page 111.

This item applies to the Linux WebAccess Agent only.

List the IP address and port of an LDAP server in your system and the username
and password that the WebAccess Installation program can use to log in to
eDirectory to create the WebAccess Agent object. If you want to use an SSL
connection, specify an SSL certificate file.

For more information, see “Linux Installation Options: LDAP Information and
Clustering” on page 113.

Specify whether or not you want to enable the WebAccess Agent to support
WebPublisher. If you enable WebPublisher support, you need to specify a
GroupWise account (mailbox ID and password).

For details, see “WebPublisher” on page 112.

List the libraries from which you want to enable GroupWise users to share
documents with WebPublisher users.

For details, see “WebPublisher” on page 112.
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5.6.3 WebAccess/WebPublisher Applications

Item

Explanation

13) Web Server Type
and Root Directory

Web server type:

* Apache Web
Server for
NetWare

* Netscape
Enterprise
Server for
NetWare

» Apache Web
Server for Linux

* Microsoft
Internet
Information
Server for
Windows
Server

» Apache Web
Serverfor UNIX
Solaris

Web server root
directory:

14) Novell Root
Directory

15) Java Servlet
Engine

* Use other Java
servlet engine

Path:

16) Default
Language

This item applies if you are installing the NetWare or Windows WebAccess
Application.

Select the type of Web server where you plan to install the WebAccess
Application and/or the WebPublisher Application.

Specify the path to the Web server’s root directory. The path must be from the
perspective of the machine where you run the Installation program.

For details, see Section 5.3.1, “Deciding Where to Install the GroupWise
WebAccess Components,” on page 109.

Specify a directory on the Web server where you want to install the configuration
files for the WebAccess Application and/or WebPublisher Application. For
NetWare and Windows, the default is the novell directory on the root of the server
volume. For Linux, the defaultis /opt/novell/groupwise/webaccess and /
opt/novell/groupwise/webpublisher.

For details, see Section 5.3.1, “Deciding Where to Install the GroupWise
WebAccess Components,” on page 109.

This item applies if you are installing the NetWare or Windows WebAccess
Application.

Specify whether you want to use Tomcat or another Java servlet engine that is
already installed on your Web server. If you use Tomcat or another Java servlet
engine, you need to specify the path to the Java servlet engine’s root directory.

For details, see Section 5.3.1, “Deciding Where to Install the GroupWise
WebAccess Components,” on page 109.

Specify the language for the initial Novell Web Services page.

For details, see “Default Language” on page 115.
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Item Explanation

17) eDirectory Specify the tree where you are installing WebAccess.

Object Configuration
Specify the context where the WebAccess Installation program should create the

e Tree: WebAccess Application and/or WebPublisher Application objects. The default

. Context: context is below the Domain object.

For details, see “eDirectory Objects and Configuration Files” on page 116.
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Installing GroupWise Monitor

Novell® GroupWise® Monitor is a monitoring and management tool that allows you to monitor
GroupWise agents and gateways from any location where you are connected to the Internet and have
access to a Web browser. Some agent administration can also be performed from your Web browser.
The topics below help you plan and set up GroupWise Monitor:

» Section 6.1, “GroupWise Monitor Overview,” on page 139

* Section 6.2, “Monitor System Requirements,” on page 142

* Section 6.3, “Planning GroupWise Monitor,” on page 143

* Section 6.4, “Setting Up GroupWise Monitor,” on page 147

* Section 6.5, “Using GroupWise Monitor,” on page 155

* Section 6.6, “GroupWise Monitor Installation Worksheet,” on page 157

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
Monitor.

6.1 GroupWise Monitor Overview

GroupWise Monitor consists of two components:

Monitor Agent: The Monitor Agent continuously polls other GroupWise agents (POA, MTA,
Internet Agent, WebAccess Agent, as well as the Messenger Agents, and Gateways gateways),
gathers status information from them, and displays the status information at the Monitor Agent
server console. The Monitor Agent also services requests for agent status information from the
Monitor Application.

NOTE: The Monitor Agent server console is available on Windows, but not on Linux.

Monitor Application: The Monitor Application extends the capability of your Web server so that
agent status information can be displayed in your Web browser. Two browser-based consoles are
available:

» The Monitor Web console, provided by the Monitor Application, takes advantage of your Web
server’s capabilities to make agent status information available to you when you are outside
your firewall.

» The Monitor Agent Web console, provided by the Monitor Agent itself, can be used only
behind your firewall but provides capabilities not available in the Monitor Web console. This
section focuses on using full-featured Monitor Agent Web console. Specific differences in
functionality between the two Web consoles are summarized in “Comparing the Monitor
Consoles” in “Monitor” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7).
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The Monitor Agent and the Monitor Application can run on the same server or on different servers,
depending on the needs of your system.

* “One Monitor Server vs. Two” on page 140

* “Monitor Security Requirements” on page 140

6.1.1 One Monitor Server vs. Two

The Monitor Agent and the Monitor Application can run together on a Linux server or a Windows
server, as illustrated below:

Figure 6-1 Monitor Agent and Application Installed on the Same Machine

Web Web Moni
Browser server Ap?;l]itc?artion
.. ) ﬂ § Monitor J : ]/
Workstation Wonws Agent p—————p| Other GroupWise
or Linux

System

The server where they run together must be a Web server because the Monitor Application is
installed into the Web server installation.

The Monitor Agent and the Monitor Application can also run on different servers. In addition to
running on a Linux or Windows server, the Monitor Application can also run on a NetWare® or
UNIX Solaris server in conjunction with a Web server running on one of those platforms, as
illustrated below:

Figure 6-2 Monitor Agent Installed on a Windows Machine with the Monitor Application Installed on a NetWare,
Linux, Windows or UNIX Web Server
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Security, discussed in the next section, might also determine whether you run the Monitor Agent on
the same server as the Web server.

6.1.2 Monitor Security Requirements

GroupWise Monitor can be configured to support the level of security you have established for your
Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use Monitor on a
secured intranet), you can install the Monitor components to any servers that provide access for your
GroupWise administrators and that meet the requirements listed in Section 6.2, “Monitor System
Requirements,” on page 142.
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If you plan to use Monitor to provide GroupWise administrators with access to your GroupWise
system from anywhere on the Internet (rather than simply within a secured intranet), and you already
have a firewall in place to provide security, you have the following options for configuring Monitor:

* Install both Monitor components inside your firewall and use a proxy service. See
“Configuring Monitor Using a Proxy Service” on page 141. This is the recommended
configuration.

* Install the Monitor Application on a Web server outside your firewall and the Monitor Agent
on a server inside your firewall. See “Configuring Monitor Without a Proxy Service” on
page 141.

Configuring Monitor Using a Proxy Service

If your firewall includes a proxy service, you can install the Monitor Application to a Web server
inside your firewall, and the Monitor Agent to another server inside the firewall, as shown in the
following illustration.

Figure 6-3 Monitor Installed in an Environment That Uses a Proxy Service
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If desired, the Monitor Agent can also be installed to the Web server rather than a separate server, as
discussed in Section 6.1.1, “One Monitor Server vs. Two,” on page 140.

Configuring Monitor Without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Monitor Application to a
Web server that is outside the firewall. Because the Monitor Agent requires direct access (mapped
drive, UNC path, or file system mount) to a GroupWise domain directory, it needs to be installed to
a server that is located within the firewall.

Figure 6-4 Monitor Installed in an Environment That Doesn t Use a Proxy Service
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The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port
number of the Monitor Agent (for example, 172.16.5.18:8200).

In addition, the firewall must allow outbound IP packets to be sent from the Monitor Agent to the
Web server. This requires all high ports (above 1023) to be open to outbound IP packets.
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6.2 Monitor System Requirements

O 32-bit/x86 processor or 64-bit/x86 processor running in 32-bit mode

O Any of the following server operating systems for the Monitor Agent:
* Novell Open Enterprise Server (NetWare or Linux version), plus the latest Support Pack
+ SUSE® Linux Enterprise Server 9, plus the latest Support Pack

The X Window System is required by the GUI Installation Advisor and Setup Advisor that
step you through the process of creating a new GroupWise system. A text-based
Installation program is also available.

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles. By default, the agents run as daemons without user interfaces.

* Windows Server 2000 or Windows Server 2003, plus the latest Service Pack for your
version of Windows

O Adequate server memory as required by the operating system
O Any of the following Web servers for the Monitor Application:

* NetWare 6: Netscape Enterprise Server for NetWare; Apache 1.3 plus Tomcat 3.3 plus the
Jakarta Connector

* NetWare 6.5: Apache 2 plus Tomcat 4 plus the Jakarta Connector
+ Linux: Apache 2 plus Tomcat 4 plus the Jakarta Connector

* Windows Server 2000/2003: Microsoft Internet Information Server (IIS) 5 or later plus
Tomcat 5.5 plus the Jakarta Connector

» UNIX: Apache 2 plus a compatible servlet engine and connector
O Any of the following Web browsers for the Monitor Web consoles:
* Linux: Mozilla Firefox
* Windows: Microsoft Internet Explorer 6.0 or later; Mozilla Firefox
* Macintosh: The latest version of Safari 1.0 for your Mac OS; Mozilla Firefox
* UNIX: Mozilla Firefox
O Any of the following mobile devices for the Monitor Web console:

* Any mobile device that supports the Wireless Access Protocol (WAP) and has a
microbrowser that uses Handheld Device Markup Language (HDML) 3.0 or later, or
Wireless Markup Language (WML) 1.1 or later

+ Pocket PC with Windows 2000/2002/2003
O Adequate server disk space

» Approximately 140 MB for the Monitor program files (111 MB shared with WebAccess;
varies by platform)

* 50 MB to 100 MB for log files if you plan to use Monitor’s reporting capabilities that rely
on MTA message logging, as described in “Generating Reports” in “Monitor” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7)
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6.3 Planning GroupWise Monitor

Before installing GroupWise Monitor, you should complete the planning tasks listed below. The
planning tasks help you gather information you need as you install and set up GroupWise Monitor.
You can use Section 6.6, “GroupWise Monitor Installation Worksheet,” on page 157 to record your
installation and setup information.
* Section 6.3.1, “Deciding Where to Install the GroupWise Monitor Components,” on page 143
* Section 6.3.2, “Determining the Monitor Agent’s Configuration,” on page 144

* Section 6.3.3, “Determining the Monitor Application’s Configuration,” on page 146

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, refer to
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) as you plan
your Monitor installation.

6.3.1 Deciding Where to Install the GroupWise Monitor
Components
After reviewing Section 6.1, “GroupWise Monitor Overview,” on page 139 and the system

requirements listed in Section 6.2, “Monitor System Requirements,” on page 142, plan where you
want to install the Monitor components in your system.

* “Monitor Server” on page 143

* “Web Server” on page 144

Monitor Server
The Monitor Agent runs on Linux and Windows.

If you want to install the Monitor Agent and the Monitor Application on the same server, you can
install them at the same time. If you want to install them on different servers, you must run the
Monitor Installation program twice, once for each server. For example, you might want to install the
Monitor Application on NetWare for use with a NetWare Web server, but you must always install the
Monitor Agent on Linux or Windows.

The installation directory for the Monitor Agent depends on the platform:

Linux: The Linux Monitor Agent is automatically installed to /opt/novell/groupwise/
agents.

Windows: The default installation directory is c: \gwmon.
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GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 1: Platform, mark the platform (Linux or Windows) where you plan to install the Monitor
Agent.

Under Item 2: Components to Install, select whether you want to install the Monitor Agent, the Monitor
Application, or both.

Under Item 3: Monitor Agent Installation Path, specify the directory on the Linux or Windows server
where you want to install the Monitor Agent software.

Web Server

The Monitor Application integrates with your Web server to pass agent status information gathered
by the Monitor Agent to your Web browser for display in the Monitor Web console. The location of
the Monitor Application files that are installed depends on the Web server that it is being integrated
with. For a list of supported Web servers, see Section 2.1, “GroupWise Administration
Requirements,” on page 21.

The Web server uses a servlet engine in order to incorporate product-specific components, such as
the Monitor Application, into its functioning.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 8: Web Server, select the Web server you want to use with Monitor.
Under Iltem 9: Web Server Path, specify the directory path to the Web server root directory.

Under Item 11: Java Servlet Engine, mark whether you want to use the Tomcat Servlet Container or
another Java servlet engine. Also specify the directory path to where the servlet engine is installed.

6.3.2 Determining the Monitor Agent’s Configuration

As you install the Monitor Agent, you are prompted to supply the configuration information
described in the following sections:

* “Systems to Monitor” on page 144

* “Monitor Agent Network Address” on page 145

* “Domain Directory Path” on page 145

* “Windows Installation Option: Default Monitor Agent Language” on page 145

* “Linux Installation Option: LDAP Information” on page 145

Systems to Monitor

The Monitor Agent can monitor both GroupWise agents and Messenger agents. In addition, the
Monitor Agent works in conjunction with the GroupWise High Availability service on Linux to
automatically restart GroupWise and Messenger agents that go down unexpectedly

It is not necessary to have an entire GroupWise system installed in order for the Monitor Agent to
monitor Messenger agents. For more information, see “Setting up the High Availability Service” in
“Installing a Novell Messenger System” in the Messenger 2 Installation Guide (http://
www.novell.com/documentation/nm?2).
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GROUPWISE MONITOR INSTALLATION WORKSHEET

Under ltem 5: System Options, mark whether you want to monitor a GroupWise system, a Messenger
system, or both.

Monitor Agent Network Address

The Monitor Agent communicates with the Monitor Application and with monitored agents by way
of TCP/IP.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 4: Monitor Agent Network Address, record the IP address or DNS hostname of the Linux or
Windows server where you plan to install the Monitor Agent software. Use the default port number of
8200 unless that number is already in use on that server.

Domain Directory Path

The Monitor Agent can gather information about the locations of GroupWise agents to monitor by
reading from a domain database. Using the gathered information, the Monitor Agent can display a
list of monitored agents when you start it for the first time.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 6: Domain Directory, specify the directory path to a domain where a GroupWise 6.x or later
MTA is running.

Windows Installation Option: Default Monitor Agent Language

GroupWise Monitor is automatically installed in all available languages. During installation, you
can select a default language for the Monitor Agent server console interface, which is available only
on Windows.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 7: Default Language, specify a default language.

NOTE: On Linux, you use the Monitor Web consoles exclusively.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw7).

Linux Installation Option: LDAP Information

If you are installing the Linux Monitor Agent and Monitor Application, the Installation program
needs to access eDirectory™ through LDAP. eDirectory access is required in order to create the
Monitor Application objects. To obtain access, the Installation program needs the IP address and
port number of an LDAP server, along with an eDirectory username and password to log in with.
The user must have sufficient rights to create GroupWise objects in eDirectory. Because the Linux
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Installation program uses LDAP to access eDirectory, you must provide the username in LDAP
format. For example:

cn=admin, ou=users, o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For
background information about SSL, see “Encryption and Certificates” in “Security Administration”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne® by
deselecting Require TLS for Simple Binds with Password.

WORKSHEET

Under Item 14: LDAP Authentication, specify the IP address and port number of an LDAP server, a
username in LDAP format, the password for the username, and if necessary, the full path to your SSL
certificate file.

6.3.3 Determining the Monitor Application’s Configuration

As you install the Monitor Application to a Web server, you are prompted to supply the
configuration information described in the following sections:

» “eDirectory Objects and Configuration File” on page 146
* “Default Monitor Web Console Language” on page 147

eDirectory Objects and Configuration File
Monitor Application configuration information is stored in two places:

* In Novell eDirectory

* In a configuration file (gwmonitor.cfg).

You can easily modify the configuration information in ConsoleOne by editing the properties of the
GroupWise Monitor Application object (named GroupWiseMonitor). However, the configuration
file is required if you need to install the Monitor Application to a Web server that is outside your
firewall, where access to eDirectory is not available. The default location of the Monitor Application
configuration file depends on the platform:

Linux: /opt/novell/groupwise/agents/gwmonitor/gwmonitor.cfg

Windows: The gwmonitor subdirectory of the Monitor installation directory
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GROUPWISE MONITOR INSTALLATION WORKSHEET

If you are installing the Windows Monitor, under Item 10: Novell Root Directory, specify the directory on
the Web server where you want to create the Monitor Application configuration file. On Linux, the Monitor
software is automatically installed in subdirectories under /opt/novell/groupwise/agents.

Under Item 13: Monitor Object Configuration, specify the tree and context where you want the Monitor
Installation program to create the GroupWise Monitor Application object (named GroupWiseMonitor) and
the accompanying Monitor Provider object (named GroupWiseProvider).

eDirectory is considered the master location for the Monitor Application configuration information.
Any changes made directly to the Monitor Application configuration file are overwritten the next
time the information in eDirectory is modified and saved.

The default configuration information is sufficient for an initial Monitor installation. For more
information about configuring Monitor, see “Monitor” in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7).

Default Monitor Web Console Language

GroupWise Monitor is automatically installed in all available languages. If necessary, you can select
a different default language for the Monitor Web console interface than you selected for the Monitor
Agent server console interface.

NOTE: The Monitor Agent server console interface is available only on Windows.

GROUPWISE MONITOR INSTALLATION WORKSHEET

Under Item 12: Default Monitor Web Console Language, specify a default language.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw?7).

6.4 Setting Up GroupWise Monitor

Follow the instructions for the platform where you are setting up GroupWise Monitor:

» Section 6.4.1, “Windows: Setting Up GroupWise Monitor,” on page 148
* Section 6.4.2, “Linux: Setting Up GroupWise Monitor,” on page 149
* Section 6.4.3, “Completing Optional Post-Installation Tasks,” on page 154

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
Monitor.
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6.4.1 Windows: Setting Up GroupWise Monitor

1 At a Windows server that meets the requirements listed in Section 2.1, “GroupWise
Administration Requirements,” on page 21, log in as an Admin equivalent to the eDirectory
tree in which you are installing Monitor.

2 If you want to monitor non-HTTP-enabled agents (such as earlier versions of any GroupWise
agent), install the SNMP service for Windows.

This enables the Monitor Agent to use SNMP in addition to HTTP.

3 Make sure no GroupWise agents are currently running on the Windows server where you plan
to install the Monitor Agent.

4 TInsert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install GroupWise Monitor. If
the Installation program does not start automatically, run setup . exe from the root of the CD.

or

If you have already copied the Monitor software to a software distribution directory, run
admin\monitor\setup.exe to start the Monitor Installation program.

5 Click Yes to accept the license agreement and display the GroupWise Monitor: Components
dialog box.

GroupWise Monitor: Components

Groupise Monitor uses the components listed below. Select the
N ove " components you want b install at this ime.

Components

GroupWise Monitor Application 4FR4 K

— Description
Gathers and displays status information from Grouptsise
agents [MTA, POA, Internet Agent, and Wehéccess Agent]
Must be installed on windows.

IristallGhield

< Back I Next > | Cancel |

6 Follow the prompts to provide information about Monitor Agent configuration, using the
following information from the GroupWise Monitor Installation Worksheet.

Item 2: Components to Install

I[tem 3: Monitor Agent Installation Path
Item 4: Monitor Agent Network Address
Item 5: System Options

Item 6: Domain Directory

Item 7: Default Language

7 Follow the prompts to provide information about Monitor Application configuration, using the
following information from the GroupWise Monitor Installation Worksheet.

Item 8: Web Server

Item 9: Web Server Path

Item 10: Novell Root Directory
Item 11: Java Servlet Engine
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Item 12: Default Language
Item 13: eDirectory Object Configuration

On Windows, the Monitor Installation program can start the Monitor Agent for you and the

Monitor Agent server console displays on the Windows server.

b: GroupWise Monitor ;IQIEI
Configuration  Wiew Actions Reports Log Help
m Status | Status Duration I Mame I Type | Up Time | Closed Links I Queued | Platfo
¥ Mormal O0d4hZ2Zm Development. Provol POA OddhZlm M/ Mt Metw
@ Mot Listering O0ddhZ1m Finance W altham1 POA Unknown M7a Mt 7
# Mormal Oddh23m Provol MTa Oddh2lm 2 MNetus
¥ Normal Oddh23m Provol GwWlA Gwild  Oddh2im  MNA [ Netis
¥ Mormal Oddh22m Provo2 MTA Oddh2lm 1 Wfindh
A Nohddess 0d4h23m Prowo Giw/la Gl Unknown MAA RES) ?
& Mormal Od4h1?m Sales. Provo2 POA O0d4h20m /A M Wind
@ Mot Listening 0d4h21m ‘waltham1 MTa Unknown 1] 7
' Normal OddhZ3m waltham 1. G Gwis  Odllhdm  MN/A [ Linus
¥ Normal 0d0h2Zm WEBAC0A Provol WEB.. 1d7h18m  N/A I Neti.
¥ Normal Oddh17m WEBALCTA Prova2 WEB Oddh2im  MA& [ Windh
® Unlcnow 0d0h0Om WEBACTOS Waltham1  WEB Unknown MNZ& REY 7
) 1| | i
[Mext Pall: 175 seconds | TR EzO0 agerts: 12

If the Monitor Agent does not start successfully, see “Starting the Windows GroupWise

Agents” on page 196

After installation is complete, you might need to perform some additional steps, as described in

Section 6.4.3, “Completing Optional Post-Installation Tasks,” on page 154.

6.4.2 Linux: Setting Up GroupWise Monitor

Complete the following tasks to install GroupWise Monitor on Linux:

* “Installing the Linux Monitor Agent” on page 149

“Configuring the Linux Monitor Agent” on page 150

“Installing and Configuring the Monitor Application” on page 151

“Restarting the Web Server” on page 152

“Starting the Linux Monitor Agent as a Daemon” on page 153

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the
GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you install
Monitor.

Installing the Linux Monitor Agent

1 Make sure that LDAP is running on your eDirectory server and that it is configured to accept
login from the Monitor Agent Installation program (worksheet item 14)

The Monitor Installation program requires eDirectory access in order to create the Monitor
objects in eDirectory. The Installation program uses LDAP to gain the required access.

2 At the Linux server where you want to install Monitor, open a new terminal window.

3 Become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise Installation program. If you are not using the X Window System, you can install
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GroupWise components individually, as described in “Installing the GroupWise Agents Using
the Text-Based Installation Program” on page 179.

4 Change to the root of the GroupWise 7 Administrator for Linux CD.
5 Start the GroupWise Installation program.
./install

6 Select the language in which you want to run the Installation program, then click OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.

[ GroUBWiSS o ———————————————————— 33
. Novell. GroupWise. N
View the Readme Displays a web page with important infermation you should read before installing.
View the Quickstart Displays a high-level checklist of system requirements and installation steps to guide you through setting
up your GroupWise system.
Wiew the Installation Guide Displays overview and task infommation that will help veu| plan, install, and updm AGrOUpWise systen,
as well as install additonal suchas Intemet Agert
Create or update a GroupWise system Launches the Groupwise Installation and Setup Advisers, These advisors mp vou through the creation
of anew GroupwWise system orthe updating of an existing Groupwrise syste)
Install Products Displavs the VO CAR install once you 've created A CroupWise
system,
W¥isit the Novell Gmupwige Web Site Lawunches vour Web browserto display GroupWise information located on the Hovell Web site,
(httms s novell.com,
productsyroupwise).

7 Click Install Products > GroupWise Monitor > Install GroupWise Monitor Agent.
8 When the installation is complete, click OK.
The Monitor Agent software is installed to /opt/novell/groupwise/agents.

9 Continue with Configuring the Linux Monitor Agent.

Configuring the Linux Monitor Agent

1 After the Monitor Agent files have been installed, click Configure Monitor.
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The Monitor Agent installation and configuration steps are separate so that you can install
updated agent software without repeating the agent configuration steps.

" _ GroupWise Monitor Agent Configuration ‘—

Introduction

[ mtroduction “Welcome to the GroupWise Monitor sgent Configuration Program . This
program will create configuration files for the Group\yise Monitor Agent.

Ooo

Cancel | Hext |

2 Follow the prompts to configure the Monitor Agent, using the following information from the
GroupWise Monitor Installation Worksheet.

Item 5: System Options
[tem 6: Domain Directory

On the Configuration Complete page, Launch Monitor Agent on System Startup is selected by
default.

3 Click Exit to complete the installation.
4 Continue with Installing and Configuring the Monitor Application.

Installing and Configuring the Monitor Application

1 After installing and configuring the Monitor Agent, if you want to use an existing Apache/
Tomcat installation, click Install Monitor Application.

or
Click Install Monitor Application with Apache and Tomcat.

This installs a version of Apache and Tomcat specifically for use with GroupWise. Apache files
are installed under /var/opt/novell/httpand /etc/opt/novell/http. Tomcat
files are installed under /var/opt/novell/tomcat4 and /etc/opt/novell/
tomcati.

NOTE: The option to install Apache and Tomcat along with the Monitor Application is not
available if you are installing to Novell Open Enterprise Server Linux because Apache and
Tomcat are already installed and configured correctly in that environment.

2 When the file copy is complete, click OK.
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3 Click Configure Monitor Application.

Introduction

D Introduction ‘Welcome to the Group'ise Monitor Application Configuration Program.
This program will do the following:

s Create the Group'ise Monitor objects in eDirectory

s Configure your webserver to work with Groupise Monitor

Ooo0oo0oooano

Cancel Hext

4 Follow the prompts to provide information about Monitor Application, using the following
information from the GroupWise Monitor Installation Worksheet in the order listed.

Item 4: Server Information

Item 8: Web Server Information

Item 14: LDAP Authentication

Item 13: Monitor Object Configuration

5 Click Exit to complete the configuration.

After installation is complete, you might need to perform some additional steps, as described in
Section 6.4.3, “Completing Optional Post-Installation Tasks,” on page 154.

6 Continue with Restarting the Web Server.

Restarting the Web Server
In order to load the Monitor Application, you must restart the Web server.

If you installed the Novell version of Apache and Tomcat along with the Monitor Application,
follow the instructions below to start your Web server. If you did not install the Novell versions of
Apache and Tomcat along with the Monitor Application, restart Apache and Tomcat as you usually
would.

1 Make sure you are logged in as root.

2 If you have other instances of Apache and Tomcat running on this server, bring them down
before you start the new versions you just installed.

3 Change to the /etc/init.d directory.
4 Start Tomcat.
./novell-tomcatd start
5 Wait until Tomcat is all the way up.
6 Start Apache.
./novell-httpd start

7 Continue with Starting the Linux Monitor Agent as a Daemon.
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Starting the Linux Monitor Agent as a Daemon

NOTE: Unlike the other GroupWise agents, you do not need to be logged in as root in order to
start the Monitor Agent.

1 Make sure you know the path to a domain directory where a domain database
(wpdomain.db) is located or the IP address of a server where the MTA is running.

2 Change to the GroupWise agent bin directory.
cd /opt/novell/groupwise/agents/bin
3 Use one of the following commands to start the Monitor Agent:

./gwmon --home /domain directory &
./gwmon --ipa IP address --ipp port number &

The --home startup switch specifies a domain directory where the Monitor Agent can access a
domain database.

The --ipa startup switch specifies the IP address of a server where an MTA is running, which is
another way for the Monitor Agent to obtain information from a domain database. The --ipp
startup switch specifies the port number of the MTA’s HTTP port on which the Monitor Agent
communicates with the MTA.

The ampersand (&) causes the Monitor Agent to run in the background, so that the terminal
window you started it in is again available for use.

A message indicates that the Monitor Agent is polling the domain you specified.

You can also start the Monitor Agent using its startup script (/etc/init.d/grpwise-ma).

The Monitor Agent does not have a --show switch. The Monitor log file (mmddmon . nnn) for
status messages is located in the /var/log/novell /groupwise/gwmon directory. The
log file name includes the month and day when it was created, along with an incrementing
extension to accommodate multiple log files on the same day. The Monitor Agent can also be
monitored from your Web browser.

If the Monitor Agent does not start successfully, see “Starting the Linux GroupWise Agents as
Daemons” on page 182.

4 After installation is complete, you might need to perform some additional steps, as described in
Section 6.4.3, “Completing Optional Post-Installation Tasks,” on page 154.

5 After the Monitor Agent starts successfully, refer to the following sections in Chapter 7,
“Installing GroupWise Agents,” on page 161 for additional information about managing the
Monitor Agent on Linux:

» “Starting the Linux GroupWise Agents on System Startup” on page 183

* “Configuring the Monitor Agent to Communicate with the High Availability Service” on
page 189

» “Stopping the Linux GroupWise Agents” on page 190
* “Uninstalling the Linux GroupWise Agents” on page 192

6 For instructions on using the Monitor Web consoles, skip to Section 6.5, “Using GroupWise
Monitor,” on page 155.
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6.4.3 Completing Optional Post-Installation Tasks

Depending on the configuration you have chosen for the Monitor Agent and Monitor Application,
you might need to perform one of more of the following tasks after you have installed the Monitor
software:

+ Ifyou use a proxy service, follow the instructions in “Configuring Proxy Service Support for
the Monitor Web Console” in “Monitor” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7).

» Ifyou are installing to the Apache Web Server for UNIX Solaris, continue with “Completing
the Monitor Installation on a UNIX Apache Web Server” on page 154.

After completing any post-installation tasks that pertain to your Monitor configuration, skip to
Section 6.5, “Using GroupWise Monitor,” on page 155.

Completing the Monitor Installation on a UNIX Apache Web Server
The Monitor Installation program copies the following files to the location you specified:

* gwmonitor.tar

* gwmonitordocs.tar

* gwmonitorjars.tar

* gwmonitorservlets.tar
* index.html

* web.xml
To complete the installation and configuration process:

1 Using the tar -xvf command, extract the following tar files to the specified locations:

e gwmonitor.tar: Extract to the root of the UNIX server. A /novell directory is created
for the files.

e gwmonitordocs.tar: Extract to the Tomcat Monitor document root directory (for
example, /usr/local/tomcatd/webapps/gwmon).

* gwmonitorservlets.tar: Extract to the Tomcat Monitor classes directory (for example, /
usr/local/tomcatd/webapps/gwmon/WEB-INF/classes).

* gwmonitorjars.tar: Extract to the Tomcat Monitor lib directory (for example, /usr/
local/tomcat4d/webapps/gwmon/WEB-INF/1ib).

2 Copy the web . xml file to the Tomcat webapps/gwmon/WEB-INF directory.

3 Modify the gwmonitor. cfqg file, located in the /novell/gwmonitor directory at the
root of the UNIX server, to change the Templates.path setting to point to the templates.

For example, change the following line in webacc.cfg:
Templates.path=/java/servliets/com/novell/gwmonitor/templates
to

Templates.path=/usr/local/tomcatd/webapps/gwmon/WEB-INF/classes/
com/novell/gwmonitor/templates

4 In the gwmonitor. cfq file, verify that the paths for the following settings point to valid
directories. Typically, these directories reside in the /novell/gwmonitor directory, but
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you can relocate them if desired. Refer to the comments in the gwmonitor.cfqg file for
explanations of each of these settings.

Log.path=/novell/gwmonitor/logs

Security.Timeout.path=/novell/gwmonitor/users

Copy the index.html file to the Tomcat Monitor document root directory (for example, /
usr/local/tomcat4d/webapps/gwmon).

For the convenience of your users, you can link to the Monitor file from your current default

home page.

6.5 Using GroupWise Monitor

You can use GroupWise Monitor in various environments:

* Section 6.5.1, “Monitor Agent Server Console on a Windows Server,” on page 155

* Section 6.5.2, “Monitor Web Consoles in Your Web Browser,” on page 156

6.5.1 Monitor Agent Server Console on a Windows Server

To start the Monitor Agent on a Windows server and display the Monitor Agent server console, click
Start > Programs > GroupWise Monitor > GroupWise Monitor. The Monitor Agent server console
appears.

Figure 6-5 Monitor Agent Console

4 GroupWise Monitor

Configuration ¥iew Actions Reports Log  Help

~=lalx|

m Status | Status Duration | MName | Type | Up Time: | Clozed Links | Queusd | Platfo
W Marmal 0ddh22m Development. Proval PO& 0ddh21m MaA M7 Metw,
@ Mot Listening 0dd4h21m Finance \Walthara1 POA Unknown Mad M A ?
¥ Nomal 0d4h23m Proval MTA Oddh2lm 2 Hetw,
v Namal 0d4h23m Proval G4 Gwia  Oddh2lm  MNAA N Metw
" Nomal 0ddh22m ProvaZ2 MTA 0ddh2lm 1 Wind
9 Nodddiess 0d4h23m Provo2 Gl Gw/ld Unknown Méd N ?
¥ Nomal O0ddh1fm Sales.Provo2 PO& O0ddh20m Mot M Wind:
E9 NotListening Dd4h 21 m W altham MTA Unknow 0 7
¥ Nomal Odd4h23m ‘' althaml G4 Gwis  Od1lhdm M N/ Lirwx
¥ Nomal 0dOh2Zm WEBACTOA Provol WER 1d7h18m  Mib N/ Hetw,
7 Namal 0d4hi?m WEBACTOA Provol WEB.. Odd4h2lm M N “wind:
®Unknawm 0d0hOm ‘WEBACTOA W alkhaml  “WEB.. Unknown M M/ ?

4 |

Mext Poll: 175 seconds |

|HTTP: B200

|Agents: 12

At the Monitor Agent server console, you can perform many activities, for example:

Use items on the Configuration menu to configure the Monitor Agent as needed.

Use items on the View menu to choose how much and what kind of agent status information to

display.

Create agent groups in order to monitor related agents together.

Use items on the Reports menu to check the status of links throughout your GroupWise system
and to organize status information into a format that can be e-mailed or printed.

Use items on the Actions menu to control agent polling.

For more information about using the Monitor Agent server console, see “Monitor” in the

GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).
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6.5.2 Monitor Web Consoles in Your Web Browser

Monitor has two different Web consoles. The Monitor Web console uses the capabilities of your
Web server to provide access from outside your firewall. The Monitor Agent Web console is
provided by the Monitor Agent itself and provides additional functionality beyond that which is
available from outside your firewall.

* “Monitor Web Console” on page 156

* “Monitor Agent Web Console” on page 156

Monitor Web Console

To display agent status information in your Web browser from outside your firewall, enter the
Monitor Web console URL in your Web browser:

NetWare Web Server: https://network address/gw/gwmonitor
Linux Web Server: https://network address/gwmon/gwmonitor
Windows Web Server: https://network address/gw/gwmonitor

where network_address represents the IP address or DNS hostname of the server where your Web
server runs. The Monitor Web console appears.

Figure 6-6 Monitor Web Console

GroupWise, Monitor

FREEY @

~ @ corporate Mail [0] Monitored agents for "Corporate Mail.NetWare Agents” group
- HetWare Agents [2]  Tgtal: 2 Displayed: 1-2
Windows Gateways [2] MName Status Status Duration Up Time Type
[ @ Provel Mormal 3d5h52m  3d5h53m MTA
Exsh ™ (@ Development.Provol Mormal 3d5h52m 3d5h52m POA

Rename
Moye
Delete

Felresh
Help

You can use this same URL to view the same agent status information in various browsers and
mobile devices.

You can perform many of the same monitoring activities at the Monitor Web console as you can at
the Monitor Agent server console. Refer to the online help in the Monitor Web console for
additional information about each Monitor Web console page.

For more information about using the Monitor Web console, see “Monitor” in the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

Monitor Agent Web Console

To display agent status information in your Web browser from inside your firewall, enter the
Monitor Agent Web console URL in your Web browser:

http://network address:8200
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Figure 6-7 Monitor Agent Web Console
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For instructions on protecting the Monitor Agent Web console with a password, see “Configuring
Authentication and Intruder Lockout for the Monitor Web Console” in “Monitor” in the GroupWise
7 Administration Guide (http://www.novell.com/documentation/gw7).

6.6 GroupWise Monitor Installation Worksheet

Item Explanation

1) Platform Mark the platform where you want to install the Monitor Agent.
* Linux For more information, see Section 6.3.1, “Deciding Where to Install the
« Windows GroupWise Monitor Components,” on page 143.

2) Components to
Install:

* GroupWise
Monitor Agent

» GroupWise
Monitor
Application

3) Monitor Agent
Installation Path:

Linux:

Windows:

Mark the components you want to install. You don’t need to install both

components at the same time or on the same platform.

For more information, see Section 6.3.1, “Deciding Where to Install the

GroupWise Monitor Components,” on page 143.

This item applies only on Windows.

Specify the directory path where you want the Monitor Agent software installed.

The default directories are:

e Linux: /opt/novell/groupwise/agents

* Windows: c:\gwmon

For more information, see Section 6.3.1, “Deciding Where to Install the

GroupWise Monitor Components,” on page 143.
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Item Explanation

4) Monitor Agent Specify the IP address or DNS hostname of the server where you plan to install
Network Address: the Monitor Agent.

* |P address: Specify the port number for the Monitor Agent to listen on. The Monitor Agent
. DNS must use a unique port number.
hostname: For more information, see “Monitor Agent Network Address” on page 145.

e Port number:
8200 (default)

5) System Options Mark whether you want to monitor a GroupWise system, a Messenger system, or
both.
* GroupWise
» GroupWise
Messenger

6) Domain Directory: Specify a domain directory where a GroupWise 6.x or later MTA is running.
For more information, see “Domain Directory Path” on page 145.
7) Default Language: This item applies only on Windows.

Select the default language for the Monitor Agent server console interface on the
Windows server.

For more information, see “Windows Installation Option: Default Monitor Agent
Language” on page 145.

8) Web Server: Mark the Web server you want to use with GroupWise Monitor.

» Apache Web For more information, see Section 6.3.1, “Deciding Where to Install the
Server for GroupWise Monitor Components,” on page 143.
NetWare

* Netscape
Enterprise
Server for
NetWare

* Apache Web
Server for Linux

¢ Microsoft
Internet
Information
Server (IIS)
Windows

» Apache Web
Serverfor UNIX
Solaris

9) Web Server Path: Specify the directory path to the Web server’s root directory.

For more information, see Section 6.3.1, “Deciding Where to Install the
GroupWise Monitor Components,” on page 143.
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Item

Explanation

10) Novell Root
Directory:

11) Java Servlet
Engine:

* Use Novell
Servlet
Gateway

* Use Tomcat
Servlet
Gateway

* Use Other Java
Servlet Engine

Java Servlet Root
Directory:

12) Default
Language:

13) eDirectory

Object

Configuration:
* Tree:

« Context:

14) LDAP
Authentication

* LDAP server IP
address:

* LDAP server
port:

* Username in
LDAP format:

« Password:
» SSL certificate:

Specify the directory path where you want the Monitor configuration file installed.
The default directory is:

e Linux: /opt/novell/groupwise

¢ Windows: c:\novell

For more information, see “eDirectory Objects and Configuration File” on
page 146.

This item applies only on Windows.
Select the Java servlet engine you want to use with Monitor.

For the Tomcat Servlet Gateway or another Java servlet engine, specify the
directory path to the servlet engine.

For more information, see Section 6.3.1, “Deciding Where to Install the
GroupWise Monitor Components,” on page 143.

Select the default language for the Monitor Web console Interface.
For more information, see “Default Monitor Web Console Language” on page 147.
Specify the tree where you are installing Monitor.

Specify the context in which the Monitor Installation program should create the
GroupWise Monitor and Monitor Provider objects, where configuration information
is stored.

For more information, see “eDirectory Objects and Configuration File” on
page 146.

This item applies only on Linux.

List the IP address and port of an LDAP server in your system and the username
and password that the Monitor Installation program can use to log in to eDirectory
to create the Monitor Agent object. If you want to use an SSL connection, specify
an SSL certificate file.

For more information, see “Linux Installation Option: LDAP Information” on
page 145.
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Installing GroupWise Agents

Novell® GroupWise® agents are first installed and started as part of installing a basic GroupWise
system, as described in Chapter 3, “Installing a Basic GroupWise System,” on page 25. The
following sections help you install additional agents as you create new domains and post offices in
your growing GroupWise system.

» Section 7.1, “GroupWise Agent Overview,” on page 161

* Section 7.2, “Agent System Requirements,” on page 163

 Section 7.3, “Planning the GroupWise Agents,” on page 164

* Section 7.4, “Setting Up the GroupWise Agents,” on page 169

» Section 7.5, “What’s Next,” on page 199

* Section 7.6, “GroupWise Agent Installation Worksheet,” on page 199

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you
install the agents.

7.1 GroupWise Agent Overview

Each time you create a new post office, you must set up at least one Post Office Agent (POA) for it.
Some of the POA’s tasks in the post office include:

» Connecting GroupWise clients to mailboxes through network connections (TCP/IP, IMAP,
SOAP)

+ Sending messages to other users and delivering incoming messages into mailboxes

* Indexing messages and documents to support the Find feature in the GroupWise clients

» Managing disk space usage in the post office and controlling the size of messages that users are

allowed to send and receive

Each time you create a new domain, you must set up a Message Transfer Agent (MTA) for it. Some
of the MTA’s tasks in the domain include:
* Routing user messages between post offices and domains

* Routing administration messages throughout the GroupWise system so that databases are kept
in sync

» Synchronizing GroupWise user information with Novell eDirectory™ user information
The POA requires direct access to the post office directory so that it can write to the post office
database. The MTA requires direct access to the domain directory so that it can write to the domain
database. In addition, the POA and the MTA must be able to communicate with each other.

» Section 7.1.1, “Local Access to Databases,” on page 162

» Section 7.1.2, “Remote Access to Databases,” on page 162

 Section 7.1.3, “Links between the MTA and the POA,” on page 163
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7.1.1 Local Access to Databases

The preferred way to fulfil this requirement is to install each agent on the same server with its
directory. Running an agent locally on the same server where its directory and database are located
simplifies network connections, because no remote login is required. In addition, it reduces network
traffic and protects database integrity. The following diagram illustrates direct access:

Figure 7-1 Direct Access between Agents and Directories

Message Post Office
Transfer Agent Agent

4 P 4

& -

Domain Post Office

7.1.2 Remote Access to Databases

However, if necessary, you can install the agent on a different server from its directory if you are
using NetWare® or Windows. This requires the agent to have a direct link (mapped drive or UNC
path) to its directory on the remote server in order to function. The following diagram illustrates the
direct links:

Figure 7-2 Direct Links between Agents and Directories

Message Post Office
Transfer Agent Agent
Mapped Drive Mapped Drive
UNC Path UNC Path
Domain Post Office

IMPORTANT: On Linux, file system mounts between Linux servers to not provide the necessary
file locking mechanisms for the GroupWise Linux agents to access their databases on remote Linux
servers.
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7.1.3 Links between the MTA and the POA

To route user and administration messages to the post office, the MTA requires a TCP/IP link to the
POA for the post office, or alternatively, a direct link (mapped drive, UNC path, or file system
mount) to the post office directory. The following diagram illustrates the alternatives:

Figure 7-3 MTA Link Alternatives

Message Post Office Message Post Office
Transfer Agent Agent Transfer Agent Agent
TCP IP
Mapped
UNC

v v v v

Q@ + & -

Domain Post Office Domain Post Office

7.2 Agent System Requirements

O 32-bit/x86 processor or 64-bit/x86 processor running in 32-bit mode
O Any of the following server operating systems for the POA and the MTA:
* Novell Open Enterprise Server (NetWare or Linux version), plus the latest Support Pack

* NetWare 5.1, NetWare 6.0, or NetWare 6.5, plus the latest Support Pack for your version
of NetWare

« SUSE® Linux Enterprise Server 9, plus the latest Support Pack

The X Window System is required by the GUI GroupWise Installation program. A text-
based Installation program is also available.

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles. By default, the agents run as daemons without user interfaces.

* Windows Server 2000 or Windows Server 2003, plus the latest Service Pack for your
version of Windows

O Adequate server memory as required by the operating system

O Approximately 25 MB for the agent software (varies by platform)

The amount of memory actually used by the POA depends on the number of active users, as
illustrated by the table below:

Table 7-1 Memory Usage Examples

Actual Memory Usage
Concurrent Users at Peak Time

100 active users (100-250 users in post office) 80 MB
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Actual Memory Usage

Concurrent Users at Peak Time
250 active users (250-500 users in post office) 160 MB
500 active users (500-1000 users in post office) 250 MB
1000 active users (1000-2500 users in post office) 500 MB

The POA typically performs best with abundant cache memory available. On the server where it
runs, at least 2 GB of memory is recommended.

7.3 Planning the GroupWise Agents

Use Section 7.6, “GroupWise Agent Installation Worksheet,” on page 199 to record your decisions
about how to install the GroupWise agents as you review the following considerations:

* Section 7.3.1, “Selecting the Agent Platform,” on page 164

» Section 7.3.2, “Selecting the Agent Location,” on page 165

* Section 7.3.3, “Selecting the Agent Installation Directory,” on page 165

» Section 7.3.4, “Gathering Domain and Post Office Information,” on page 166

» Section 7.3.5, “Deciding Which Languages to Install,” on page 166

 Section 7.3.6, “NetWare Installation Options: Automatic Startup and Clustering,” on page 166

» Section 7.3.7, “Linux Installation Option: Clustering,” on page 167

» Section 7.3.8, “Windows Installation Options: Service vs. Application and SNMP Traps,” on
page 168

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, refer
to the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw?7) as you plan
your agent installation.

7.3.1 Selecting the Agent Platform

The MTA and POA are available as NetWare NLM™ programs, Linux executables, and Windows
executables.

In general, GroupWise is most efficient if you match the agent platform with the network operating
system where the post office and domain are located. For example, if a domain and post office are
located on a NetWare server, then you would install the NetWare agents for them. However, this is
not required.

Those with mixed networks might wonder what platform combinations are possible. For more
information, see the following sections in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw7):

* “Cross-Platform Issues in the Post Office” in “Post Office Agent”

* “Cross-Platform Issues between Domains and Post Offices” in “Message Transfer Agent”
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GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 1: Agent Platform, mark whether you plan to install the agents on NetWare, Linux, or
Windows. Review Section 7.2, “Agent System Requirements,” on page 163 to ensure that the specific
server you have selected meets the listed requirements.

7.3.2 Selecting the Agent Location

Record which GroupWise agents you plan to run on the selected server (POA, MTA, or both) and
whether you want to install the agents locally or remotely in relation to their directories and
databases, as described in Section 7.1, “GroupWise Agent Overview,” on page 161.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 2: Agents and Locations, mark the agents to install and their locations relative to the
directories and databases they need to access.

If the NetWare agents need to access their directories and databases on remote NetWare servers, you
must add configuration information to the agent startup files to provide the needed access. Use the /
dn switch to specify the distinguished name of the agent object that was created along with the
Domain or Post Office object. The remote servers must be in the same eDirectory tree as the server
where the agents are running.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 2: Agents and Locations, for the NetWare agents, record the startup switches and settings
you'll need to add to the agent startup files after installation if you are installing the agents on a different
NetWare server from where their directories and databases are located.

7.3.3 Selecting the Agent Installation Directory

The agent installation directory depends on the platform where you are installing the agents.

Consider these platform-specific guidelines:

NetWare: When installing the NetWare agents, we recommend you use the sys: \ system directory
on the NetWare server. This simplifies the use of startup files and ensures that the NLM
programs are in the server’s search path. If you use a different directory, you must add that
directory to the server’s search path.

Linux: The Linux agents are automatically installed to /opt/novell/groupwise/agents.

Windows: The default installation directory is c¢: \grpwise. However, you can install the agents to
any directory you want.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 3: Installation Path, record the directory where you want to install the GroupWise agent
software.
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Both the MTA and the POA are installed to the specified directory.

7.3.4 Gathering Domain and Post Office Information

Record the following information about the domain and post office for which you are installing and
setting up the GroupWise agents:

GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 6: Domain Information, record the domain name and path to the domain directory for the new
domain.

Under ltem 7: Post Office Information, record the post office name and path to the post office directory for
the new post office.

The domain and post office must exist before you install the agents for them. If necessary, create the
domain and post office that you are installing the agents for now.

7.3.5 Deciding Which Languages to Install

If you have administrators with various language preferences, you can install and run the
GroupWise agents in multiple languages. You should also install all languages used by GroupWise
client users, so that message status information returned from the POA to users’ mailboxes matches
the language in which each user is running the client.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 5: Language, list the languages you want to install the agents for.

By default, the agents start in the language selected for the domain. If that language has not been
installed, the agents start in the language used by the operating system. If that language has not been
installed, the agents start in English.

For more information, see “Multilingual GroupWise Systems” in the GroupWise 7 Administration

Guide (http://www.novell.com/documentation/gw?7).

7.3.6 NetWare Installation Options: Automatic Startup and
Clustering

When you install the NetWare GroupWise agents, the following options specific to NetWare are
available in the Agent Installation program:

* “Automatic Startup” on page 167

* “Novell Cluster Services” on page 167
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Automatic Startup

You can have the Agent Installation program add a reference to the grpwise.ncf file in the
NetWare server’s autoexec.ncft file so that the GroupWise agents are automatically loaded
whenever the server is started.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 10: Update AUTOEXEC File, mark whether or not you want to configure the NetWare server
to start the GroupWise agents automatically.

Novell Cluster Services

Novell Cluster Services is a server clustering system that ensures high availability and
manageability of critical network resources including volumes (where GroupWise domains and post
offices reside) and applications (such as the GroupWise agents). Novell Cluster Services supports
failover, failback, and migration of individually managed cluster resources.

The NetWare GroupWise agents can be configured to take advantage of the fault-tolerant
environment provided by Novell Cluster Services if the following requirements are met:

* The domains and post offices to be serviced by the NetWare agents have already been created
on shared NSS volumes in the cluster.
» The NetWare agents are being installed to a server that is part of the same cluster.
When the agents are configured for clustering, their startup files are configured with shared volume

names rather than specific server names. In addition, the POA is configured to more effectively re-
establish logins with GroupWise clients when a failover or migration situation arises.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 4: Configure GroupWise Agents for Clustering, mark whether or not you want to configure the
NetWare agents for clustering. If you do, follow the installation instructions in “Setting Up a Domain and
Post Office in a NetWare Cluster” in “Novell Cluster Services on NetWare” in the GroupWise 7
Interoperability Guide (http://www.novell.com/documentation/gw7), rather than the installation
instructions in this guide.

7.3.7 Linux Installation Option: Clustering

On Linux, you can install the GroupWise agents in three different clustering environments, as
described in the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7):

* “Novell Cluster Services on Linux”

* “PolyServe Matrix Server on Linux”

If you are using Novell Cluster Services™, the Linux GroupWise Installation program provides a
Configure GroupWise for Clustering option that simplifies the process of installing the Linux
GroupWise agents on multiple nodes in the cluster.
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GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 4: Configure GroupWise Agents for Clustering, mark whether or not you want to configure the
Linux GroupWise agents for clustering using Novell Cluster Services. If you do, follow the installation
instructions provided in “Setting Up a Domain and a Post Office in a Linux Cluster” in Novell Cluster
Services on Linux in the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/
gw7), rather than the installation instructions in this guide.

If you are installing the Linux GroupWise agents on PolyServe Matrix Server, the Linux GroupWise
Installation program does not assist you with the setup. See the GroupWise 7 Interoperability Guide
(http://www.novell.com/documentation/gw7) for installation instructions.

7.3.8 Windows Installation Options: Service vs. Application
and SNMP Traps

When you install the Windows agents, you have choices about how the agents interact with the
Windows operating system.

» “Service vs. Application” on page 168

* “SNMP Traps” on page 169

Service vs. Application

When you run the GroupWise Windows agents as services, they can start automatically and run
without a user interface.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under ltem 8: Installation Options, mark Install as Windows Services if you want to run the agents as
services.

When you run the Windows agents as services, they must run under a specific Windows user
account.

When domains and post offices are located on the same server where you are installing the agents,
the agents can run under the local system account. You can also display the agent server consoles
when the agent software, directories, and databases are local.

When domains and post offices are located on a remote server, you must specify a user with rights to
access the domain and post office directories.

Remote Windows Server:  If the Windows agents need to log in to a another Windows server, provide a
Windows username and password.

Remote NetWare Server:  If the Windows agents need to log in to a NetWare server, provide an
existing eDirectory username and password, or create a new account for
the agents, as described in “Creating a NetWare Account for Agent Access
(Optional)” on page 172.
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GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, record the account the agents will run under, and if
necessary, the password for the account.

As with all Windows services, the Windows agents can be started automatically or manually as
services each time the Windows server restarts.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 9: Windows Service Information, mark how you want the Windows agents to start each time
the server is restarted.

SNMP Traps

If you want to use an SNMP manager program, such as the Management and Monitoring Services
component of Novell ZENworks® Server Management, to monitor the agents, you must install some
SNMP components along with the Windows agent software.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Item 8: Installation Options, mark Install and Configure SNMP for GroupWise Agents if you want to
use an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows
server where you are installing the agents. If you want to monitor the agents from an SNMP management
program, the SNMP service must be enabled so you can select this option.

NOTE: The NetWare and Linux agents rely on operating system components for SNMP
functionality and do not require this installation option.

7.4 Setting Up the GroupWise Agents

After creating a new domain or post office, you need to configure the Agent object that was
automatically created with it, then follow the setup instructions for the platform where you are
installing the GroupWise agents:

» Section 7.4.1, “Configuring New Agent Objects in eDirectory,” on page 170

» Section 7.4.2, “NetWare: Setting Up the GroupWise Agents,” on page 170

» Section 7.4.3, “Linux: Setting Up the GroupWise Agents,” on page 177

» Section 7.4.4, “Windows: Setting Up the GroupWise Agents,” on page 193
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7.4.1 Configuring New Agent Objects in eDirectory

When you create new post offices and domains, Agent objects are automatically created for them.
Most agent configuration can be done after installation, but a few settings should be established
before you install the agent software.

1 In ConsoleOne, browse to and expand the eDirectory container where the new post office or
domain is located to display its contents.

2 Select the Post Office object or Domain object to display its contents.

3 Right-click the Agent object, then click Properties to display the agent Identification page.

4 1In the Description field, type a brief description of the agent for display at the agent server
console.

In the Platform field, select NetWare, Linux, or Windows.
Click OK to save the new Agent object properties.

Repeat these steps for each new post office and domain for which you are installing agents.

0 N O O

Continue with the installation instructions for the platform where you are installing the
GroupWise agents.

» Section 7.4.2, “NetWare: Setting Up the GroupWise Agents,” on page 170
* Section 7.4.3, “Linux: Setting Up the GroupWise Agents,” on page 177
» Section 7.4.4, “Windows: Setting Up the GroupWise Agents,” on page 193

7.4.2 NetWare: Setting Up the GroupWise Agents

Complete the following tasks to set up the NetWare agents. These tasks are designed to help you get
the POA and MTA up and running as quickly as possible.

» “Preparing the NetWare Server for the Agents” on page 170

+ “Installing the NetWare Agent Software” on page 172

+ “Editing the NetWare Agent Startup Files” on page 174

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you
install the agents.

Refer to the following additional tasks as you maintain all the GroupWise agents on NetWare:

» “Starting the NetWare GroupWise Agents” on page 175
* “Stopping the NetWare GroupWise Agents” on page 176
* “Uninstalling the NetWare GroupWise Agents” on page 176

Preparing the NetWare Server for the Agents

Make sure the NetWare server where you plan to install the GroupWise agents has been properly
prepared to run the agents:

* “Obtaining a Static IP Address for the NetWare Server” on page 171
» “Setting Recommended NetWare Server Parameters for the NetWare POA™ on page 171
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* “Setting Recommended NSS Parameters for the NetWare POA” on page 171
* “Setting Recommended NetWare Server Parameters for the NetWare MTA” on page 172
* “Creating a NetWare Account for Agent Access (Optional)” on page 172

* “Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)” on
page 172

Obtaining a Static IP Address for the NetWare Server

The NetWare server where the GroupWise agents run should have a static IP address. DHCP should
not be used to dynamically assign an IP address for it. Make sure the server where you plan to install
the agents has a static IP address.

Setting Recommended NetWare Server Parameters for the NetWare POA

Some default settings on the NetWare server where you plan to run the NetWare POA might be
inadequate for configurations of more than 100 concurrent client/server user connections. If your
anticipated post office size indicates a need for more than 100 concurrent client/server connections,
check the server parameters on the NetWare server to make sure they are adequate for the
anticipated number of GroupWise client connections. For example, in a medium-size post office of
500 users, use the following settings:

Table 7-2 NetWare Server Parameters

Parameter Setting
Maximum Packet Receive Buffers 2500
Minimum Packet Receive Buffers 1000
Maximum Concurrent Disk Cache Writes 200

Setting Recommended NSS Parameters for the NetWare POA

If you run the NetWare POA on NetWare 5.1 or 6.x Novell Storage Services™ (NSS) volumes, you
can significantly improve GroupWise performance by using the following parameters and settings
on the nss command in the autoexec.ncf file:

/NameCacheSize=20000
/OpenFileHashShift=15
/ClosedFileCacheSize=50000
/CacheBalance=60

The best /ClosedFileCacheSize setting for a server depends on many things, such as the amount of
memory on the server, the load on the POA, and the number of other programs running on the
server. For example, the 50000 setting can work well for a server that has 650 MB of memory.
Experiment with various settings in order to optimize performance.

The following TID, although originally written for GroupWise 5.x and NetWare 5.x, applies to
GroupWise 7 and NetWare 6.x as well:

» TID 10065215: Resolving GroupWise Performance Issues with NSS Volumes (http://
support.novell.com/cgi-bin/search/searchtid.cgi?/10065215.htm)
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Setting Recommended NetWare Server Parameters for the NetWare MTA

The default Maximum Packet Receive Buffers setting on a NetWare server is inadequate for the
NetWare MTA in configurations that include numerous TCP/IP and remote file connections. Set
Maximum Packet Receive Buffers to at least 2500 for the NetWare MTA in such configurations.

Creating a NetWare Account for Agent Access (Optional)

When the GroupWise agents run on a different NetWare server from where their directories and
databases are located, and they are not set up to authenticate through eDirectory (using the /dn
startup switch), the agents must use a specific eDirectory username and password to log in to that
server.

To create a user for the agents to log in as:

1 In ConsoleOne, create a new user (such as GWAgents).
2 Provide a password for that user (such as GWise).

3 Grant that user the following rights to all domain, post office, and document storage
directories:

* Read or execute files

* Write to files

* Create files or directories

* Erase files or directories

» Modify files (rename or change attributes)
* File scan

4 After you install the agent software, add the /user and /password startup switches to the agent
startup files so that the agents can log in to the remote server as the user you have created.

Adding the NetWare Agent Installation Directory to the Server Search Path (Optional)

If you have selected a directory other than sys: \system to install the agents to (worksheet item
3), add the agent installation directory to the server search path by adding a search command to the
autoexec.ncf file.

Installing the NetWare Agent Software

After you have prepared the NetWare server to run the GroupWise agents, you are ready to install
them.

At a Windows machine that meets the administrator machine requirements listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21:

1 Map a drive to the NetWare server where you want to install the agents.

2 Make sure you have sufficient rights to install software in the desired directory.

3 Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install GroupWise Agents. If the
Installation program does not start automatically, run setup . exe from the root of the CD.

or
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If you have already copied the agent software to a software distribution directory, run

agents\install.exe to start the Agent Installation program.

GroupWise Agent Installation — |EI ll

Novell.

Overview

Welcome to the GroupWise Agent [nstallation Program.
The following agent software will be installed and
configured;

Message Transfer Agent [MTA]  Routes messages between
domainz, post offices, and
Qatewas

Post Dffice Agent [POA] Delivers messages to users’
mailboxes

< Back I Next > I Exit |

4 Follow the prompts to provide NetWare Agent information from your Basic GroupWise
System Worksheet.

Item 3: Installation Path

Item 4: Configure GroupWise Agents for Clustering

[tem 5: Language
Item 6: Domain Information
[tem 7: Post Office Information

GroupWise Agent Installation

Novell.

Click Install to install the NetWare agents.

=10l x|
Installation Complete

The Group'wise agent software has been successfully
installed and configured.

i Options

¥ Update AUTDEXEL file
¥ Launch Groughise agents now
I Launchin Protected Mode

Installation Guide:

< Back I Finish I Exit |

The Agent Installation program has created a grpwise . ncf file that contains the commands
to start the GroupWise agents on the NetWare server whenever the server starts. Here at the end
of the Agent Installation program, you can select how you want to start the agents.

Update AUTOEXEC File: Select this option if you want the Agent Installation program to
add the grpwise.ncf file to the NetWare autoexec.ncf file so that the agents start
automatically whenever the server restarts.
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Launch GroupWise Agents Now: Select this option if you want the Agent Installation
program to start the agents for you immediately. This is appropriate when you have installed
the agents on the same server with the domain and post office directories.

If you have installed the agents on a remote server from where the domain and post office
directories are located, do not select this option. You must manually edit the agent startup files
to configure the agents to access the remote servers. This configuration procedure is explained
in “Editing the NetWare Agent Startup Files” on page 174.

Launch in Protected Mode: If you want the Agent Installation program to launch the agents
for you, you can choose to launch them in Protected Mode on NetWare 5.1 and later. This
option also adds the protect command to the grpwise.ncf line in the NetWare
autoexec.ncf file:

protect grpwise.ncf
This line automatically starts the agents in Protected Mode when the server restarts.
6 Select the desired agent startup options, then click Finish.

If you want to start the agents later or if the Agent Installation program fails to start them
successfully, see “Starting the NetWare GroupWise Agents” on page 175.

7 If necessary, modify the agent startup files as described in “Editing the NetWare Agent Startup
Files” on page 174, then manually start the NetWare agents by running grpwise.ncf.

8 To monitor an agent from your Web browser, view the agent Web console by supplying the IP
address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA
message transfer port, or the default HTTP port that is established during installation. The POA
client/server port and the MTA message transfer port are automatically redirected to their
respective HTTP ports.

Editing the NetWare Agent Startup Files

The Agent Installation program creates a customized agent startup file for each domain and post
office location. The first 8 characters of the post office and domain names became the names of the
agent startup files, along with an agent-specific extension. For example, if the post office name is
acctpo, then the POA startup file is named acctpo . poa. The Agent Installation program also
customizes each startup file with the correct /home switch setting, pointing to the domain or post
office directory.

Each startup file also provides a comprehensive list of startup switches, with all but the /home
switch commented out. You can use any ASCII text editor to set the startup switches. The agent
startup files are located in the agent installation directory.

When the MTA is not on the same server as the domain directory, you need to edit the MTA startup
file to include the MTA’s eDirectory distinguished name. When the POA is not on the same server as
the post office directory, you need to edit the POA startup file to include the POA’s eDirectory
distinguished name.

The /dn-distinguished object name startup switch is located in Section 1 of the startup file. Delete
the semicolon (;) at the beginning of the line and replace the distinguished object name variable
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with the distinguished name of the MTA or POA. For example, if the MTA is for a domain named
Provo that is located in a container named Novell, you would enter:

/dn-mta.provo.novell

After modifying the startup files, use the grpwise.ncf file to start the NetWare agents from the
NetWare server console.

If you want to learn more about running the NetWare agents, continue with “Starting the NetWare
GroupWise Agents” on page 175. If you want to customize the configuration of the NetWare agents
or expand your GroupWise system, skip to Section 7.5, “What’s Next,” on page 199.

Starting the NetWare GroupWise Agents

You might have one or more GroupWise agents installed on each NetWare server in your
GroupWise system. You can start the GroupWise agents on NetWare in several ways:

* “Manually with a Load Command” on page 175
+ “Manually with an NCF File” on page 176

» “Automatically in the Server’s Autoexec.ncf File” on page 176

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent Problems”
in GroupWise 7 Troubleshooting 2: Solutions to Common Problems (http://www.novell.com/
documentation/gw7) for assistance.

Manually with a Load Command

You can use the NetWare 1oad command to start the NetWare GroupWise agents at the NetWare
server console or a remote console:

POA: load gwpoa.nlm @ startup filename.poa
MTA: load gwmta.nlm @ startup filename.mta
Internet Agent: load gwia.nlm Qgwia.cfg

WebAccess: load gwinter @startup filename.waa

The startup file for the POA is named after the post office. The startup file for the MTA is named
after the domain. The startup file for the Internet Agent is always gwia.cfg. The WebAccess
Agent startup file is named after the WebAccess Agent object in eDirectory (typically
webacc70a).

At the NetWare server console or remote console, you can use the agent server consoles described in
the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7):

» “Using the POA Server Console”

* “Using the MTA Server Console”

» “Using the Internet Agent Server Console”

» “Using the WebAccess Agent Server Console”

» “Using the Monitor Agent Server Console”
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Manually with an NCF File

For your convenience, the GroupWise Agent Installation programs create NCF files for starting the
NetWare GroupWise agents:

POA and/or grpwise
MTA:

Internet Agent:  gwia

WebAccess: strtweb

During installation, the grpwise.ncf file is configured with one or more POA and/or MTA
load commands depending on the domains and/or post offices you listed during installation.

Automatically in the Server’s Autoexec.ncf File

When the GroupWise agents are running smoothly, you should modify the main NetWare
configuration file (autoexec.ncf) to load the NetWare GroupWise agents automatically
whenever you restart the server. You can add either the 1oad commands or the NCF commands to
the autoexec.ncf file.

When you are not at the NetWare server console, you can monitor the GroupWise agents from their
Web consoles described in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7):

» “Using the POA Web Console”

» “Using the MTA Web Console”

+ “Using the Internet Agent Web Console”

» “Using the WebAccess Agent Web Console”

Stopping the NetWare GroupWise Agents

At the NetWare server console, use Exit (F7). If a GroupWise agent does not respond to Exit (F7),
you can use the unload command to unload the agent NLM. For WebAccess, you can use the
stopweb command.

Uninstalling the NetWare GroupWise Agents

If you move the GroupWise agents to a different server, you can uninstall the agent software from
the old location to reclaim disk space.

POA and MTA:  Stop the POA and the MTA, then run the Agent Installation program (install.exe)in
the \agents subdirectory of the GroupWise software distribution directory or
GroupWise 7 Administrator for NetWare/Windows CD. On the Install/Uninstall page,
select Uninstall, then follow the prompts.

Internet Agent:  Stop the Internet Agent. If no other GroupWise agents are running on the server, delete
the Internet Agent software files listed in “NetWare Installation Directory” in “Directory
Structure Diagrams” in GroupWise 7 Troubleshooting 3: Message Flow and Directory
Structure (http://www.novell.com/documentation/gw7).
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WebAccess: Stop the WebAccess Agent. Delete the WebAccess Agent software files listed in
“NetWare Installation Directory” in “Directory Structure Diagrams” in GroupWise 7
Troubleshooting 3: Message Flow and Directory Structure (http://www.novell.com/
documentation/gw7). If you want to delete the WebAccess Application from your
Apache Web server, locate the WebAccessUninstall. ini file under the Tomcat
root directory (for example, under \tomcat\4). It lists all files that the GroupWise
Installation program installed to your Web server. Delete the listed files to uninstall the
WebAccess Application from your Web server.

7.4.3 Linux: Setting Up the GroupWise Agents

Complete the following tasks to set up the Linux agents. These tasks are designed to help you get the
Linux agents up and running as quickly as possible.
* “Installing the GroupWise Agents on Linux” on page 177
+ “Installing the GroupWise Agents Using the Text-Based Installation Program” on page 179
 “Starting the Linux Agents with a User Interface” on page 179

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you
install the agents.

Refer to the following additional tasks as you maintain all the GroupWise agents on Linux:

+ “Starting the Linux GroupWise Agents as Daemons” on page 182

» “Starting the Linux GroupWise Agents on System Startup” on page 183

* “Running the Linux GroupWise Agents as a Non-root User” on page 184

» “Enabling the High Availability Service for the Linux GroupWise Agents” on page 187
* “Stopping the Linux GroupWise Agents” on page 190

* “Uninstalling the Linux GroupWise Agents” on page 192

Installing the GroupWise Agents on Linux
1 In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise Installation program. If you are not using the X Window System, you can install
GroupWise components individually, as described in “Installing the GroupWise Agents Using
the Text-Based Installation Program” on page 179.

2 Change to the root of the GroupWise 7 Administrator for Linux CD.
3 Start the GroupWise Installation program.
./install

4 Sclect the language in which you want to run the GroupWise Installation program, then click
OK.

NOTE: On Linux, all available languages are included in the same RPM, so all languages are
always installed.
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5 Click Install Products > GroupWise Agents > Install Agents.
6 When the installation is complete, click OK.
The GroupWise agent software is installed to /opt/novell /groupwise/agents.
7 Click Configure GroupWise Agents.
The agent installation and configuration steps are separate so that you can install updated agent

software without repeating the agent configuration steps.

GroupWise Agents Configuration y ——

Introduction
D Introduction ‘Welcome to the GroupiMise Agent Configuration Program. The following
agent software will be configured:

Message Transfer Agent{MTA) Fioutes messages between
cormains, post offices, and
gateways.

Fost Office Agent{POA): Delivers messages to users’
railboxes

Cancel

Hext

8 Follow the prompts to provide Linux Agent information from your GroupWise Agent
Installation Worksheet.

[tem 6: Domain Information
Item 7: Post Office Information

On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected
by default.

IMPORTANT: If you want to configure the agents for high availability, as described in
“Enabling the High Availability Service for the Linux GroupWise Agents” on page 187, they
must be configured to start automatically on system startup.
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1"

If you do not want the agents to start automatically when the server restarts, deselect Launch
GroupWise Agents on System Startup.

Click Exit to complete the configuration.

Skip to “Starting the Linux Agents with a User Interface” on page 179 or “Starting the Linux
GroupWise Agents as Daemons” on page 182 depending on whether or not you want a user
interface on the Linux server where the agents run.

Installing the GroupWise Agents Using the Text-Based Installation Program

If you want to install any of the GroupWise agents on a server where the X Window System is not
running, you can use the text-based GroupWise Installation program. You must use ConsoleOne to
create the associated domain or post office before you can configure the agent software.

1
2

Make sure you are logged in as root.

Change to the root of the GroupWise 7 Administrator for Linux CD.

NOTE: If you need to perform the installation from a remote location, you can use ssh to
access the remote Linux server. Copy the GroupWise 7 Administrator for Linux CD to the
server where you want to install the agent software, then run the text-based GroupWise
Installation program to install the agents on the Linux server.

Start the GroupWise Installation program.
./install

4 Enter the number of the language you want to use for the installation.

1"

Enter the number of the language you want to use for reading the License Agreement.

Press any key to scroll through the License Agreement, then enter y to accept the License
Agreement.

In the list of agents, enter the number for the GroupWise agent component that you want to
install.

1. GroupWise Agents

2. GroupWise WebAccess

3. GroupWise Monitor

4. GroupWise Internet Agent

In the list of actions, enter 1 to install the agent software

A status bar indicates progress.

When the installation is complete, enter y to configure the agent component.

Follow the prompts to provide the configuration information, then press any key to exit.

In the text-based Installation program, you can press Ctrl+C to return to the previous menu.

When you have installed the agents that you want to run on the text-only server, skip to
“Starting the Linux GroupWise Agents as Daemons” on page 182.

Starting the Linux Agents with a User Interface

1

In a terminal window, become root by entering sux and the root password.

The sux command enables the X Window System, which is required for running the GUI
GroupWise agent server consoles.
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2 Change to the GroupWise agent bin directory.
cd /opt/novell/groupwise/agents/bin
3 Enter one of the following commands to start the MTA:

Syntax:
./gwmta --show --home domain directory &
./gwmta --show @domain.mta &

Example:
./gwmta --show --home /gwsystem/domlnx &
./gwmta --show @provo.mta &

The --show startup switch starts the MTA with a server console interface similar to that
provided for the NetWare and Windows MTA. This user interface requires that the X Window
System and Open Motif be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.

The @domain.mta startup switch specifies the MTA startup file, which contains the --home
startup switch. The MTA startup file is named after the domain that the MTA services. The
Installation program created the MTA startup file in the /opt/novell/groupwise/
agents/share directory. Because the Installation program prompted you for the domain
directory, it set the --home switch for you in the startup file.

The ampersand (&) causes the MTA to run in the background, so that the terminal window you
started it in is again available for use.

¥ Provo3 - GroupWise MTA

File Configuration Log Help

Frovod Up Tine: 3 Days & Hrs 12 Hins
Groupliise Messags Transfer Agent

—Status atistics

Processing * Total 10 Minutes
Total Closed || Routed 0 0

Tomains 8 0 | Undeliverable 0 0

Fost Offices i 0| Errars 0 0

Gateways 2 0

<02/26/2004 06309306 AM> TDI5; HTA configuration loaded

|1

<] |

The status messages displayed on the MTA server console are also written to the MTA log file
(mmddmta.nnn)inthe /var/log/novell/groupwise/domain.mta directory. The
log file name includes the month and day when it was created, along with an incrementing
extension to accommodate multiple log files on the same day.

In ConsoleOne, you can see that the MTA has updated the domain database because the
Version field on the Identification page of the Domain object shows 7 when the database update
is complete.

4 Wait until the domain database has been updated before you start the POA.
5 Use the following command to start the POA:
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Syntax:

./gwpoa --show --home post office directory &
./gwpoa --show @post office.poa &

Example:

./gwpoa --show --home /gwsystem/polnx &
./gwpoa --show @research.poa

The --home startup switch specifies the post office directory and is required to start the POA.

The @post_office.poa startup switch specifies the POA startup file, which contains the --home
startup switch. The POA startup file is named after the post office that the POA services. The
Installation program created the POA startup file in the /opt/novell/groupwise/
agents/share directory. Because the Installation program prompted you for the post office
directory, it set the --home switch for you in the startup file.

=% Research.Provo3 - GroupWise POA

File Configuration Log Statistics fctions Help

Research.Prova3 Up Tine: 3 Days & Hrs 13 Hins
Groupliss Post DFfice Agent

—Status atistics
Processing % Busy: 0 : 0 C/S Requests: 3731 Total Messages: 0

o

Requests Pending: 0 Undeliwerable:

User Timed Out: 2 Problem Messages:

S}

User Connectionss

o

File Ousues; 0

Check disk space everut § (mins)

Parforn disk check actions no more than susrus 2 (hrs)
Event #1 & Default POA Disk Check Event

Fres disk space thresholds 20HB

fiction Set #1 & Default POR Disk Check Actions

Hail message to adninistrators upon Failure

Tupe of database files to check: User feg Doc
Database check action: Reduce

Delete tenporarufbackup files older than (days): 1

202 Database Haintenance Ewents:

803 Event #1 ; Default PUA Hailbox/Library Maintenance Event

202 Days to perforn actionfs): F

803 Time to perforn action(s): Midnight (12an)

202 fction Set #1 ¢ Default POA Hailbox/Library Maintenance Actions
803 Tupe of databass Files to checks User fsg Doc

202 Database check action: AnaluzedFixup

803 Level of database analysis and werification: Structural

202 Delete temporarufbackup files older than (deys): 7

803
14 [1A Guardian database: OK

The status messages displayed on the POA server console are also written to the POA log file
(mmddpoa.nnn)inthe /var/log/novell/groupwise/post office.poa
directory. The log file name includes the month and day when it was created, along with an
incrementing extension to accommodate multiple log files on the same day.

In ConsoleOne, you can see that the POA has updated the post office database because the
Version field on the Identification page of the Post Office object shows 7 when the database
update is complete.

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent
Problems” in GroupWise 7 Troubleshooting 2: Solutions to Common Problems (http://
www.novell.com/documentation/gw?7) for assistance.

After the post office database has been updated, users can connect to the post office using either
the Cross-Platform client or the Windows client.

When you start the Linux agents with a user interface, you can use the agent server consoles
described in “Using the POA Server Console” in “Post Office Agent” and “Using the MTA
Server Console” in “Message Transfer Agent” in the GroupWise 7 Administration Guide (http:/
/www.novell.com/documentation/gw?7).
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Starting the Linux GroupWise Agents as Daemons

All of the Linux GroupWise agents except the Monitor Agent can be started using the grpwise
script. The Monitor Agent uses its own customized grpwise-ma script that works essentially the
same way.

1 Make sure you are logged in as root.

2 Changeto the /etc/init.d directory.

3 To start all of the Linux GroupWise agents that are installed on the server, enter the following
command:

./grpwise start
4 To confirm that the agents have started, enter the following command:
./grpwise status

Agent status is displayed in terms of the names of the domain and post office associated with
each agent. It lists the agent locations in the following format:

POA [post office.domain]

MTA: [domain]

Internet Agent: [domain.GWIA]

WebAccess: [WEBAC70A]

[gwdva.hostname]

When using the grpwi se script, you refer to the agents by the location names displayed when
you list agent agent status (without the brackets), not by the names of the agent executables.

5 Use the following set of commands as needed to start the agents as daemons and verify their

status:

./grpwise start Starts the GroupWise agents that are installed
on the server

./ Starts the specified agent

grpwise start agent location name

./grpwise status Displays the status of the GroupWise agents
that are installed on the server

./ Displays the status of the specified agent
grpwise status agent location name

NOTE: The GroupWise agents are Run Control compliant. During installation, a symbolic link
is created from /etc/init.d/grpwiseto /usr/sbin/rcgrpwise. Typically, /usr/
sbin is already on your path, so you can run rcgrpwise from any directory, rather than
changing to /etc/init.d in order to run the grpwise script. A /usr/sbin/
grpwise-ma link is also created.

When you use the grpwi se script to start the GroupWise agents as daemons, they run without
a user interface.
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If GroupWise Messenger agents are installed on the same server, the grpwi se script also
starts them.

Monitoring the Linux GroupWise Agents from Your Web Browser

To monitor any GroupWise agent from your Web browser, view the agent Web console by supplying
the IP address or DNS hostname and the port number of the agent. The following table lists the
default port numbers:

Table 7-3 GroupWise Agent Web Console URLs

POA: http://server network address:7181
MTA: http://server network address:7180
Internet Agent:  http://server network address:9850
WebAccess: http://server network address:7211

Monitor: http://server network address:8200

Figure 7-4 Linux POA Web Console

GroupWise 7.0 POA - Accounting.Waltham2

Status | Configuration | Environment | Log Files | Scheduled Events | MTP Status | Help
GroupWise Post Office Agent

Up Time: 0 Days 1 Hours 49 Minutes

CJs Users

Application Connections 1]
Physical Connections 1]
Priority Queues o
Normal Queues o
k Auto Queues a
Scheduled Queues o

For more information about the agent Web consoles, including instructions on protecting the agent
Web consoles with passwords see the following sections in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7).

» “Using the POA Web Console”

» “Using the MTA Web Console”

» “Using the Internet Agent Web Console”

* “Using the WebAccess Agent Web Console”
* “Using the Monitor Web Console”

Starting the Linux GroupWise Agents on System Startup

If you selected Launch GroupWise Agents on System Startup in any Agent Installation program, the
Agent Installation program configured your system so that the agents start automatically each time
you restart your server. The Agent Installation programs always creates a grpwi se startup script in
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/etc/init.d for starting the agents, as described in “Starting the Linux GroupWise Agents as
Daemons” on page 182. To enable automatic startup, the Agent Installation programs also create
symbolic links named S99grpwise inthe rc3.d and rc5. d directories so that the agents load
on restart into level 3 or 5, depending on the configuration of your Linux system.

When the grpwi se script runs and starts the GroupWise agents, the agents read the agent startup
files in /opt/novell/groupwise/agents/share to check for configuration information
provided by startup switches. Because the --show switch cannot be used in the startup files, the
agents never run with server console interfaces when started automatically when the server restarts.

Running the Linux GroupWise Agents as a Non-root User

For security reasons, it is preferable that the GroupWise agents not run with root user privileges.
For example, if an intruder manages to assume the identity of a GroupWise agent, the intruder gains
all the privileges of the commandeered process. If the process is running with root user privileges,
then the intruder has root access to your system. If the process is running as a user with minimal
privileges, then the intruder has only restricted access to your system. Therefore, your system is
more secure if the GroupWise agents do not run as root.

The root user still needs to start the agents, because the agents do need to access some root-only
resources on startup. However, you can configure the agents to switch to a different user after they
start. After the agents are running as the non-root user, they need adequate access to the locations
where each domain, post office, library, and software distribution directory is located.

» “Setting Up Typical Non-root Access” on page 184

» “Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux” on
page 185

* “Changing the Non-root User” on page 186

NOTE: You can configure the POA, the MTA, and the Internet Agent to run as a non-root user.
The WebAccess Agent, with its accompanying Viewer Agent, must still run as root. Unlike the
other agents, the Monitor Agent can be started as a non-root user by default, so no setup is
required for it to run as a non-root user.

Setting Up Typical Non-root Access
To configure the GroupWise agents to switch users after startup:

1 Make sure you are logged in as root.

2 Select a Linux user for the agents to run as and make sure that the user is listed in the /etc/
passwd file.

You might want to create a new user specifically for this purpose, perhaps named gwagents.
3 Change to the groupwise directory under /etc:

cd /etc/opt/novell/groupwise
4 Create a new agents directory, then change to that directory:

mkdir agents
cd agents

5 Create a file named uid.conf.

6 Type the selected username in the file, for example:
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gwagents
7 Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office directory structures from root to the user you specified in the uid. conf file. Then
they switch users and run as the user you specified, rather than as root.

If you list the agent processes, you can observe that they are no longer running as root.

If the post office and domain are located on different servers, you must complete the above
steps on each server.

IMPORTANT: All agents running on the same server must run as the same user.

If you later want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 186.

Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux

When your domains, post offices, libraries, and software distribution directories are located on a
Novell Open Enterprise Server (OES) Linux NSS volume, you must set up an eDirectory user for
the agents to run as and you must LUM-enable that user. On OES Linux, you can use Novell
iManager to accomplish these tasks.

To configure the agents to switch users after startup and provide access to an NSS volume:
1 Select or create an eDirectory user for the agents to run as.

You might want to create a new user specifically for this purpose, perhaps named gwagents.

1a From the Open Enterprise Server Welcome page in your Web browser, expand Network
Management, then click iManager 2.5.x.

1b In the iManager Links box, click Open Novell iManager 2.5.
1¢c To log in to iManager, specify a username, a password, and a tree.
1d In the left pane, expand Users, then click Create User.
1e Provide the required information, then click OK.
The user does not need a password
2 LUM-enable the user you just created.
2a In the left pane, expand Linux User Management, then click Enable User for LUM.
2b Browse to and select the user you just created, then click OK.
2c¢ Select the primary group for the user to belong to (for example, admingroup).
2d Change /bin/bashto /bin/false because the user does not need a shell.
2e Click OK to LUM-enable the user.
3 In a terminal window, change to the groupwise directory under /etc:
cd /etc/opt/novell/groupwise
4 Create a new agents directory, then change to that directory.

mkdir agents
cd agents

5 Create a file named uid.conf
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6 Type the selected username in the file, for example:
gwagents

7 Use the following command to grant the user the required rights to the directories that the
agents need to access on the local server:

rights -f /directory -r rwcemf trustee user.context.tree

The POA needs access to the post office directory. The MTA and the Internet Agent need
access to the domain directory.

8 Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office directory structures from root to the user you specified in the uid. conf file. Then
they switch users and run as the user you specified, rather than as root.

If you list the agent processes, you can observe that they are no longer running as root.

If the post office and domain are located on different servers, you must complete the above
steps on each server.

IMPORTANT: All agents running on the same server must run as the same user.

If you later want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 186.

Changing the Non-root User

To prevent an agent from running as a different user than the one for which it was originally
configured, the GroupWise agents create a uid. run file in the domain or post office directory that
they service.

If, for any reason, the user specified in the uid. run file does not match the user specified in the
uid.conf file, the agent displays the following message:

Error: Running the agent with conflicting effective users

This could happen if the user specified in the uid. conf file is manually edited, or if the
uid.conf file is deleted, thus changing or removing the information about the user that the agent
should run as. If this message appears, verify that the uid. conf file specifies the desired user, then
delete the uid. run file.

After displaying the message, the agent does not start, because it no longer has appropriate
permissions in the domain or post office directory that it needs to service. By deleting the uid. run
file, you enable the agent to reset the permissions in the domain or post office directory to
appropriate user and then start successfully.

After configuring an agent to run as a specific non-root user:

 If you want the agent to run as a different non-root user, modify the uid. conf file in the /
etc/opt/novell/groupwise/agents directory to specify the desired non-root user,
then delete the uid. run file from the domain or post office directory serviced by the agent.

« If you want the agent to run as root, delete the uid. conf file from the /etc/opt/
novell/groupwise/agents directory and delete the uid. run file from the domain or
post office directory serviced by the agent.
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Enabling the High Availability Service for the Linux GroupWise Agents

The GroupWise High Availability service makes sure that if the MTA, the POA, the Internet Agent,
or the WebAccess Agent with its accompanying Document Viewer Agent goes down for any reason,
it starts again automatically. On NetWare, this capability is provided by using a restartable protected
address space. On Windows, Microsoft Clustering Services automatically restarts a service that is
not responding. However, on Linux, some clustering environments do not include this capability, so
it is built into the Linux GroupWise agents.

The GroupWise High Availability service (gwha) is installed automatically, starts when your server
boots, and makes sure that any GroupWise agents installed on the server are running. It relies on the
Monitor Agent to detect when a GroupWise agent is no longer running. The Monitor Agent notifies
the High Availability service of any problem, then the High Availability service immediately issues
the command to start the problem agent.

» “Configuring the High Availability Service” on page 187

» “Configuring the Monitor Agent to Communicate with the High Availability Service” on
page 189

Configuring the High Availability Service
To set up the High Availability service:
1 In a terminal window, become root by entering sux and the root password.
The sux command enables the X Window System, which is required for running the GUI

GroupWise agent server consoles.

2 Before starting to configure the High Availability service, test the agents by starting and
stopping them manually with a user interface so that their agent server consoles display.

2a Change to the root directory of the Linux server.

2b Start the GroupWise agents manually, including providing the full path to the executable
and including the --show switch, to make sure that they are set up and configured
correctly.

/opt/novell/groupwise/agents/bin/gwpoa —--show @post.poa
/opt/novell/groupwise/agents/bin/gwmta —--show @dom.mta
/opt/novell/groupwise/agents/bin/gwia --show Qgwia.cfg
/opt/novell/groupwise/agents/bin/gwinter --show @webac70a.waa

2c After verifying that the agents start correctly, stop the agents.

3 Ifyou use SSL, you need to modify the High Availability service configuration file
(gwha.conf).

3a Change tothe /etc/opt/novell/groupwise directory.
3b Edit the gwha . conf file in a text editor
3¢ Under the [gwha] section, fill in the fields as follows:

[gwha]

ssl = yes

key = filename.key
cert = filename.crt

password = password

3d Save the file, then exit the text editor.
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4 Tf you want to control how the script manages starting and stopping the agents, you can modify
the delay = andwait = settings in the High Availability service configuration file
(gwha.conf).

The delay = setting controls the length of time between when the script issues the command
to start an agent and when the script displays a message indicating that the agent has started.
The default delay time is 2 seconds. Under certain circumstances, an agent could encounter a
problem and fail to start after 2 seconds. In this case, you would receive the success message
but the agent would not be running. You need to increase the delay = setting to
accommodate the length of time it typically takes for the agent to start successfully on your
system.

The wait = setting controls the length of time between when the script issues the command
to stop an agent and when the script kills the agent if the agent has not yet stopped. The default
wait time is 10 seconds. Under certain circumstances, an agent could take longer than 10
seconds to perform a normal shutdown, and killing the agent under those circumstances would
not be appropriate. You need to increase the wait = setting to accommodate the length of
time it usually takes for the agent to shut down. A message notifies you if the script kills an
agent because its shutdown exceeds the wait = setting.

The default settings are usually appropriate, so you do not need to change them unless you
frequently encounter problems with starting or stopping an agent using the script.

4a Change to the /etc/opt/novell/groupwise directory.
4b Edit the gwha . conf file in a text editor

Each agent has its own section in the file, for example:

[Waltham?2]

server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise

startup = waltham2.mta

delay = 2

wait = 10

4c Change the delay = and wait = settings as needed.
4d Save the file, then exit the text editor.

5 Enable the High Availability service:
5a In YaST, click Network Services > Network Services (inetd).
5b If necessary, select Enable to activate the list of services.

5¢ Scroll down to the gwha line, select it, then click Toggle Status (On or Off) to change the
status to On.

5d Click Finish.
6 Start the agents as daemons.
6a Change to the /etc/init.d directory.

6b Enter the following command to start the GroupWise agents that are installed on the
server:

./grpwise start
6¢ Use the following command to verify agent status:

./grpwise status
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For more information about using the grpwise script, see “Starting the Linux
GroupWise Agents as Daemons” on page 182

7 Create a new user and associated password on your Linux server to represent the High
Availability service.

You might name it gwha.

8 Continue with Configuring the Monitor Agent to Communicate with the High Availability
Service.

Configuring the Monitor Agent to Communicate with the High Availability Service

After you have the High Availability service set up and working correctly, you need to configure the
Monitor Agent to communicate with it and test it to make sure that you can rely on it in the future.

1 Start the Monitor Agent with the --hauser and --hapassword startup switches.

If you use the grpwi se-ma script to start the Monitor Agent, as described in “Starting the
Linux Monitor Agent as a Daemon” on page 153, you can edit it to include the switches:

1a
1b

1c
1d

1e

a A~ ODN

Change to the /etc/init.d directory, then edit the grpwise-ma script.
Locate the following line:

#MA OPTIONS="--hauser username —--hapassword password
—--hapoll 120"

Remove the pound sign (#) from the beginning of the line.

Replace username and password with the username and password you established in
Step 7 in “Configuring the High Availability Service” on page 187.

MA OPTIONS="--hauser gwha --hapassword gwagents --hapoll 120"

The --hapoll switch specifies that the Monitor Agent should check the status of
GroupWise agents every 120 seconds. You can use the MA OPTIONS variable to add any
Monitor Agent startup switches to the grpwise—-ma script as needed. For information
about Monitor Agent startup switches, see “Using Monitor Agent Switches” in “Monitor”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

Save the file, then exit the text editor.

Change to the /etc/init.d directory.

Stop one of the agents.

Check the status of the agent you stopped to make sure it is stopped.
Wait for the next Monitor Agent polling cycle.

You can check and, if necessary, change the Monitor Agent polling cycle in the Monitor Agent
Web console. Click Preferences, then scroll down to the HTTP Settings section.

6 After the polling cycle has passed, check the status of the agent again.

The agent that you stopped should now be running again.

NOTE: Although you would typically use the Linux Monitor Agent to monitor other Linux
GroupWise agents, the Windows Monitor Agent can be used to monitor the Linux agents and
communicate with the High Availability service.
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Stopping the Linux GroupWise Agents

How you stop the Linux GroupWise Agents depends on how you started them.
* “From the Agent Console User Interface” on page 190
» “Using the grpwise Script” on page 190

* “Manually as Daemons” on page 191

From the Agent Console User Interface

When you use the --show startup switch to start the GroupWise agents, you can stop them from the
agent server console interface.

1 Click File > Exit > Yes.

Since the WebAccess Agent does not have the same type of agent server console as the other Linux
agents, you can stop it by closing the terminal window in which it is running.

Using the grpwise Script

When you start the GroupWise agents with the grpwi se script, you can also use the script to stop
them. The same applies for the Monitor Agent and its grpwise-ma script.
1 Make sure you are logged in as root.
2 Change to the /etc/init.d directory.
3 To stop all of the GroupWise agents installed on the server, enter the following command:
./grpwise stop
4 To confirm that the agents have stopped, enter the following command:
./grpwise status

Agent status is displayed in terms of the names of the domain and post office associated with
each agent. It lists the agent locations in the following format:

POA [post office.domain]

MTA: [domain]

Internet Agent: [domain.GWIA]

WebAccess: [WEBAC70A]

[gwdva.hostname]

5 Use the following set of commands as needed to stop the agents as daemons and verify their
status:

./grpwise stop Stops the GroupWise agents that
are installed on the server

./grpwise stop agent location name Stops the specified agent

./grpwise status Displays the status of the
GroupWise agents that are installed
on the server
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./

Displays the status of the specified
grpwise status agent location name agent

IMPORTANT: For convenience in typing the command, the agent location _name is not case

sensitive.

NOTE: The GroupWise agents are Run Control compliant. During installation, a symbolic link
is created from /etc/init.d/grpwiseto /usr/sbin/rcgrpwise. Typically, /usr/
sbin is already on your path, so you can run rcgrpwise from any directory, rather than

changing to /etc/init.d in order to run the grpwise script. A /usr/sbin/grpwise-

ma link is also created.

Manually as Daemons

When you start the GroupWise agents manually on the command line (without using the grpwise

script), use the standard Linux ki 11 command to stop them.

1 Make sure you are logged in as root.

2 Determine the process IDs (PIDs) of the agent to kill:

POA ps -eaf
MTA: ps -eaf
Internet Agent: ps -eaf
WebAccess: ps -eaf

Monitor: ps -eaf

All of the PIDs for the specified agent are listed.

grep

grep

grep

grep

grep

gwpoa
gwmta
gwia
gwinter

gwmon

3 Kill the first process listed for each agent:

Syntax:
kill PID
Example:

kill 1483
kill 1892

It might take a few seconds for all agent processes to terminate.

4 Repeat the ps commands to verify that the agents have stopped.

You can also restart the MTA and the Internet Agent without stopping them first using the following

command:

Syntax:
kill -HUP PID

Example:
kill -HUP 1483
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The -HUP (hang up) option is equivalent to using Restart in the MTA and Internet Agent server
console or Web console. Because the other agents do not have a Restart feature in their consoles, the
-HUP option cannot be used to restart them.

Uninstalling the Linux GroupWise Agents

If you move the GroupWise agents to a different server, the GroupWise agent software can be
uninstalled just like any other software on Linux. To determine what GroupWise software is
currently installed on the Linux server, use the following command:

rpm -ga | grep groupwise

This lists all of the GroupWise RPM packages on the server. The POA and the MTA are together in
the same RPM. WebAccess and Monitor have two RPMs each, one for the agent software and one
for the application software. The following list provides the list of all GroupWise agent and
administration RPMs that you might need to uninstall from a server:

POAand MTA novell-groupwise-agents-version-date

Internet Agent: novell-groupwise-gwia-version-date

WebAccess: novell-groupwise-gwinter-version-date
novell-groupwise-webaccess-version-date

Monitor: novell-groupwise-gwmon-version-date
novell-groupwise-monitor-version-date

High Availability novell-groupwise-gwha-version-date
Service

GroupWise novell-groupwise-admin-version-date
Administrator

GroupWise novell-groupwise-gwcheck-version-date
Check
GroupWise novell-groupwise-dbcopy-version-date

Database Copy

Use the following command to uninstall a GroupWise RPM package:
rpm -e novell-groupwise-package

Uninstalling the RPMs does not uninstall files created after installation by the GroupWise programs.
To see what GroupWise files are created in locations other than under /opt/novell/
groupwise and its subdirectories, see the Linux sections of “Agent Installation Directories” in the
GroupWise 7 Troubleshooting 3: Message Flow and Directory Structure (http://www.novell.com/
documentation/gw?7):

* POA and MTA: “Linux Installation Directory”

* Internet Agent: “Linux Installation Directory”

* WebAccess: “Linux Installation Directory”

* Monitor: “Linux Installation Directory”
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7.4.4 Windows: Setting Up the GroupWise Agents

Complete the following tasks to set up the Windows agents. These tasks are designed to help you get
the Windows POA and MTA up and running as quickly as possible:

» “Preparing the Windows Server for the Windows Agents” on page 193
* “Installing the Windows Agent Software” on page 194

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see
the GroupWise 7 Interoperability Guide (http://www.novell.com/documentation/gw7) before you
install the agents.

Refer to the following additional tasks as you maintain all the GroupWise agents on Windows:

+ “Starting the Windows GroupWise Agents” on page 196
* “Stopping the Windows GroupWise Agents” on page 198
* “Uninstalling the Windows GroupWise Agents” on page 198

Preparing the Windows Server for the Windows Agents

Make sure the Windows server where you plan to install the GroupWise Windows POA and MTA
has been properly prepared to run the agents:

* “Obtaining a Static [P Address” on page 193

» “Mapping Drives to Post Offices and Domains” on page 193

* “Creating a Windows User Account for Remote Access (Optional)” on page 194
» “Enabling SNMP (Optional)” on page 194

Obtaining a Static IP Address

The Windows server where the GroupWise Windows agents run should have a static IP address.
DHCP should not be used to dynamically assign an IP address for it. Make sure the server where
you plan to install the Windows agents has a static IP address.

Mapping Drives to Post Offices and Domains

The Windows POA requires direct access to the post office directory so that it can write to the post
office database. The Windows MTA requires direct access to the domain directory so that it can
write to the domain database. If the agents are not installed on the same server where their
directories are located, make sure the server has drives mapped to all locations where the agents
need access. If you are running the Windows POA for a post office located on a NetWare server, you
might need to increase Maximum File Locks Per Connection from its default setting on the
Windows server.

After installation, the agents can access their directories using either mapped drives or UNC paths.
However, mapped drives are required during installation so that the agent startup files can be set up

properly.
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Creating a Windows User Account for Remote Access (Optional)

If you specified a new Windows username and password under worksheet item 9, create the new
Windows user account so it is ready when you start the agents for the first time.
1 In the Windows Control Panel, double-click Users and Passwords to add a new user.

2 Grant the user Full Control rights in the domain and post office directories.

Enabling SNMP (Optional)

If you want to monitor the GroupWise Windows agents from an SNMP manager program, such as
the Management and Monitoring Services component of Novell ZENworks Server Management,
SNMP must be enabled on the Windows server where the agents are installed. If it is not already
enabled, you should enable it before you run the Agent Installation program.

1 In the Windows Control Panel, double-click Add/Remove Programs.

2 Click Add/Remove Windows Components.

3 Select Management and Monitoring Tools, click Details, select Simple Network Management
Protocol, then click OK

4 Follow the prompts to finish the installation.

Installing the Windows Agent Software

After you have prepared the Windows server to run the GroupWise Windows POA and MTA, you
are ready to install them.

At a Windows server that meets the requirements listed in Section 2.1, “GroupWise Administration
Requirements,” on page 21:

1 Make sure you have mapped drives to all domain and post office directories for which you are
installing agents.

2 Insert the GroupWise 7 Administrator for NetWare/Windows CD into the CD drive to start the
GroupWise Installation program, then click Install Products > Install GroupWise Agents. If the
Installation program does not start automatically, run setup . exe from the root of the CD.

or
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If you have already copied the agent software to a software distribution directory, run
agents\install.exe to start the Agent Installation program.

GroupWise Agent Installation — |EI ll
Overview
Welcome to the GroupWise Agent [nstallation Program.
N ove "> The follawing agent software will be installed and

configured;

Message Transfer Agent [MTA]  Routes messages between
domainz, post offices, and
Qatewas

Post Dffice Agent [POA] Delivers messages to users’
mailboxes

< Back I Next > I Exit |

3 Follow the prompts to provide the Windows Agent information from your GroupWise Agent
Installation Worksheet.

Item 3: Installation Path

Item 5: Language

Item 6: Domain Information

Item 7: Post Office Information

[tem 8: Installation Options

Item 9: Windows Service Information

4 On the Installation Complete page, choose whether or not you want the Agent Installation
program to start the agents for you immediately, then click Finish.

If you want to start the agents later or if the Agent Installation program fails to start them
successfully, see “Starting the Windows GroupWise Agents” on page 196.

5 To monitor an agent from your Web browser, view the agent Web console by supplying the IP
address and port number of the agent. For example:

http://172.16.5.18:1677
http://172.16.5.18:7100
http://172.16.5.18:7180
http://172.16.5.18:7181

When viewing the agent Web console, you can specify the POA client/server port, the MTA
message transfer port, or the HTTP established during installation.

6 If you want to learn more about running the Windows agents, continue with “Starting the
Windows GroupWise Agents” on page 196 and “Stopping the Windows GroupWise Agents”
on page 198.

or

If you want to customize the configuration of the Windows agents or expand your GroupWise
system, skip to Section 7.5, “What’s Next,” on page 199.
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Starting the Windows GroupWise Agents

You might have one or more GroupWise agents installed on each Windows server in your
GroupWise system. You can start the GroupWise agents on Windows in several ways:

* “Manually As Applications” on page 196

* “Automatically in the Windows Startup Group” on page 196

* “Manually or Automatically as Services” on page 197
If you encounter any problems starting the GroupWise agents, see “Strategies for Agent Problems”

in GroupWise 7 Troubleshooting 2: Solutions to Common Problems (http://www.novell.com/
documentation/gw7) for assistance.

Manually As Applications

On the Windows desktop, click Start > Programs, select the GroupWise agent, then start the
GroupWise agent.

You can also use desktop shortcuts to start the GroupWise agents. The GroupWise Installation
program automatically creates desktop shortcuts for the POA, the MTA, and the Internet Agent. You
can easily create desktop shortcuts for WebAccess and Monitor by linking to the following target

files:
WebAccess: c:\webacc\strtweb.bat
Monitor: c:\gwmon\gwmon.exe

When you start the GroupWise agents as applications, you can use the agent server consoles
described in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7):

» “Using the POA Server Console”

* “Using the MTA Server Console”

* “Using the Internet Agent Server Console”

» “Using the WebAccess Agent Server Console”

+ “Using the Monitor Agent Server Console”

Automatically in the Windows Startup Group

After the GroupWise agents are running smoothly, you should add them to the Windows Startup
group to start them automatically whenever you restart the Windows server.

For example, on a Windows 2000 server:

1 From the Windows desktop, click Start > Settings > Taskbar & Start Menu > Advanced > Add.
2 Browse to the directory where you installed the GroupWise agent.

The default installation directories are:

POA: c:\grpwise
MTA: c:\grpwise

Internet Agent: c:\grpwise\gwia
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WebAccess: c:\webacc

Monitor: c:\gwmon

3 Double-click agent executable, then if necessary, add the startup file to the command line.

POA: gwpoa.exe (@startup filename.poa
MTA: gwmta.exe @startup filename.mta
Internet Agent: gwia.exe Qgwia.cfg

WebAccess: strtweb.bat

Monitor: gwmon .exe

The startup file for the POA is named after the post office. The startup file for the MTA is
named after the domain. The startup file for the Internet Agent is always gwia.cfg. The
WebAccess Agent startup file is provided in st rtweb .bat. The Monitor Agent does not use
a startup file.

4 Click Next.
5 Select the Startup folder, provide a name for the shortcut, then click Finish.
All programs in the Startup folder are automatically started when the server reboots.

6 If possible, restart the server to verify that the GroupWise agents start automatically.

Manually or Automatically as Services

If you installed the GroupWise agents as services, you can manage them just like you would any
other Windows services.

NOTE: The Monitor Agent cannot currently be installed as a Window service.

For example, on a Windows 2000 server:

1 From the Windows desktop, click Start > Settings > Control Panel > Administrative Tools.
2 Double-click Services, select the agent service, then click Start.

The POA service is named after the post office. The MTA service is named after the domain.
The Internet Agent service is named GWIA. The WebAccess Agent service is named
WebAccess (webaccess_agent_object_name).

You can check the status of the agent service by using the Windows Event Viewer. From
Administrative Tools, double-click Event Viewer, click Application Log, sort the log entries on
the Source column, scroll to the agent service, then double-click a log entry to view information
about it.

3 To configure the agent service to start automatically when the server reboots, right-click the
agent service, then click Properties.

4 1In the Startup Type field, click Automatic, then click OK.

When running as services, the GroupWise agents do not display an agent console on the Windows
server where they are running. Instead, you can monitor the GroupWise agents using their Web
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consoles described in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7):

» “Using the POA Web Console”

» “Using the MTA Web Console”

» “Using the Internet Agent Web Console”

» “Using the WebAccess Agent Web Console”

Stopping the Windows GroupWise Agents
» “As Applications” on page 198
* “As Services” on page 198

As Applications

When the GroupWise agents run as applications, you can stop them from their server consoles.

POA: At the POA server console, click File > Exit.
MTA: At the MTA server console, click File > Exit.
Internet Agent: At the Internet Agent server console, click File > Exit.

WebAccess: From the Windows desktop, click the title bar of the window in which the WebAccess
Agent or Document Viewer Agent is running, then press F7.

Monitor: At the Monitor Agent server console, click Configuration > EXxit.

If the GroupWise agent does not respond to Exit, you can close the agent server console window to
stop the agent or use the Windows Task Manager to terminate the agent task.

As Services

When the GroupWise agents run as Windows services, you can stop them as you would any other
Windows services.

For example, on a Windows 2000 server:

1 From the Windows desktop, click Start > Settings > Control Panel > Administrative Tools.
2 Double-click Services, select the agent service, then click Stop.

The POA service is named after the post office. The MTA service is named after the domain.
The Internet Agent service is named GWIA. The WebAccess Agent service is named
WebAccess (webaccess_agent_object_name).

Uninstalling the Windows GroupWise Agents

If you move the GroupWise agents to a different server, you can uninstall the agent software from
the old location to reclaim disk space.
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POA and MTA:

Internet Agent:

WebAccess:

Monitor:

Stop the POA and the MTA, then run the Agent Installation program (install.exe)in
the \agents subdirectory of the GroupWise software distribution directory or
GroupWise 7 Administrator for NetWare/Windows CD. On the Install/Uninstall page,
select Uninstall, then follow the prompts. This deletes most of the contents of the
c:\grpwise directory and uninstalls the POA and the MTA as Windows services.

Stop the Internet Agent, then run the Internet Agent Installation program
(install.exe) inthe \internet\gwia subdirectory of the GroupWise software
distribution directory or GroupWise 7 Administrator for NetWare/Windows CD. On the
Install/Uninstall page, select Uninstall, then follow the prompts. This deletes most of
the contents of the c: \grpwise\gwia directory and uninstalls the Internet Agentas a
Windows service.

Stop the WebAccess Agent. Delete the contents of the c: \webacc directory to delete
the WebAccess Agent software. If the WebAccess Agent was running as a Windows
service, run “Delete Service.exe” in the \internet\webacces subdirectory of the
GroupWise software distribution directory or GroupWise 7 Administrator for NetWare/
Windows CD. If you want to delete the WebAccess Application from your Apache Web
server, locate the WebAccessUninstall.ini file under the Tomcat root directory
(for example, under \tomcat\4). It lists all files that the GroupWise Installation
program installed to your Web server. Delete the listed files to uninstall the WebAccess
Application from your Web server.

Stop the Monitor Agent. Delete the contents of the c¢: \gwmon directory.

7.5 What’s Next

After you have created new domains and post offices, and installed the agents for them, you can
complete their configuration by referring to the following sections of the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw7):

+ Refining the configuration of the agents to meet the specific needs of the new domains and post

offices. See “Post Office Agent” and “Message Transfer Agent”.

* Refining the configuration of the new domains and post offices. See “Post Offices” and

“Domains”.

» Adding users to the new post offices. See “Users”.

7.6 GroupWise Agent Installation Worksheet

Item Explanation
1) Agent Platform: Mark the platform where you are installing the GroupWise agents.
* NetWare For more information, see Section 7.3.1, “Selecting the Agent
Li Platform,” on page 164
* Linux
* Windows
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Item

Explanation

2) Agents and Locations:
POA:

* Local to post office

« Different server from post
office

/dn setting (NetWare only)
MTA:

* Local to domain

« Different server from
domain

/dn setting (NetWare only)

3) Installation Path:

4) Configure GroupWise Agents
for Clustering:
Yes | No

5) Language:

6) Domain Information:

* Domain name:
« Path to database:

7) Post Office Information:

» Post office name:
« Path to database:

8) Installation Options:

* Install GroupWise agent
software:
Yes | No

* Install and configure SNMP
for GroupWise agents:
Yes | No

* Install as Windows
services:
Yes | No

Mark the agents you want to install and where you want to install
them.

On NetWare, if you want to install the agents on a server different from
where their directories and databases are located, specify the settings
for the /dn switches in the agent startup files so that the agents can
access the remote servers.

For more information, see Section 7.3.2, “Selecting the Agent
Location,” on page 165.

Specify the directory where you want to install the agent software.

For more information, see Section 7.3.3, “Selecting the Agent
Installation Directory,” on page 165.

This item applies to the NetWare and Linux agents.

Mark whether or not you want to configure the agents for clustering on
Novell Cluster Services.

For more information, see Section 7.3.6, “NetWare Installation
Options: Automatic Startup and Clustering,” on page 166 or Section
7.3.7, “Linux Installation Option: Clustering,” on page 167.

List the languages you want to install.

For more information, see Section 7.3.5, “Deciding Which Languages
to Install,” on page 166.

List the domain you are installing the MTA for.

For more information, see “System and Domain Names” on page 30
and “Domain Directory” on page 31.

List the post office you are installing the POA for.

For more information, see “Post Office Name” on page 35 and “Post
Office Directory” on page 36.

This item applies only if you are installing the Windows agents.

Mark the installation options you want when you install the Windows
agents.

For more information, see “Selecting the Agent Location” on
page 165, “SNMP Traps” on page 169, and “Service vs. Application”
on page 168.
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Item

Explanation

9) Windows Service Information:
Account type:

» Use local system account

Allow service to interact
with desktop:
Yes | No

* Use this Windows user
account:
User name:
Password:

Startup type:

« Automatic
* Manual
* Disabled

10) Update AUTOEXEC File:
Yes | No

11) Launch GroupWise Agents
Now:

Yes | No
12) Launch in Protected Mode:

Yes | No

This item applies only if you are installing the Windows agents.

If you are installing the Windows agents as services, mark the type of
account they can use to log in.

If needed, specify the Windows user account they can run under.

Also mark whether you want them to be started automatically or
manually each time the Windows server restarts.

For more information, see “Service vs. Application” on page 168.

This item applies only if you are installing the NetWare agents.

Mark whether or not you want the Agent Installation program to
configure the NetWare server so that the GroupWise agents start
automatically whenever the server is started.

Mark whether or not the Agent Installation program can start the
agents for you at the end of the installation process.

This item applies only if you are installing the NetWare agents.

Mark whether or not you want the Agent Installation program to start
the NetWare agents in Protected Mode on NetWare 5.1 or later.
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Installing the GroupWise Windows
and Cross-Platform Clients

The following sections assist you with assigning GroupWise® accounts to users and with installing
the Novell® GroupWise 7 Windows client and the GroupWise 7 Cross-Platform client.

* Section 8.1, “GroupWise Client Overview,” on page 203

» Section 8.2, “GroupWise Client Workstation Requirements,” on page 203

» Section 8.3, “Planning Your GroupWise Client Installation,” on page 204

» Section 8.4, “Setting Up the GroupWise Client,” on page 206

8.1 GroupWise Client Overview

Each user with a GroupWise account has a mailbox in a post office. In a corporate workplace
environment, GroupWise users with Windows workstations can run the GroupWise Windows client
to access their mailboxes and to send and receive mail. GroupWise users with Linux or Macintosh
workstations can run the GroupWise Cross-Platform client.

GroupWise users can also access their mailboxes via a Web browser, WAP-enabled cellular phone,
Palm OS device, or Windows Pocket PC device by using the GroupWise WebAccess client. For
information about WebAccess, see Chapter 5, “Installing GroupWise WebAccess,” on page 103.

The GroupWise Windows client provides a full set of features, the GroupWise WebAccess client
provides a similar but more limited set of features, and the GroupWise Cross-Platform client
provides a basic set of features. Subsequent releases of the Cross-Platform client will include
additional features.

8.2 GroupWise Client Workstation Requirements

* Section 8.2.1, “GroupWise Windows Client,” on page 203
* Section 8.2.2, “GroupWise Cross-Platform Client on Linux,” on page 204
» Section 8.2.3, “GroupWise Cross-Platform Client on Macintosh,” on page 204

8.2.1 GroupWise Windows Client

O Any of the following Windows versions:
* Windows 2000 on a Pentium II 200 or higher with at least 128 MB of RAM
* Windows XP Professional on a Pentium IIT 300 or higher with at least 128 MB of RAM
* Windows 2003 on a Pentium III 350 or higher with at least 256 MB of RAM

O 200 MB of free disk space to install the GroupWise Windows client
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8.2.2 GroupWise Cross-Platform Client on Linux

U Any of the following desktop operating systems:

* Novell Linux Desktop, plus the KDE desktop or the GNOME desktop

* Red Hat Desktop 4 or Red Hat Enterprise Linux WS 4, plus the GNOME desktop
O Java Virtual Machine (JVM) 1.5 or later
O 200 MB of free disk space to install the GroupWise Cross-Platform client

8.2.3 GroupWise Cross-Platform Client on Macintosh

O Any of the following desktop operating systems:
* Mac OS 10.3 (Panther) or Mac OS 10.4 (Tiger)
* Mac OS X on Intel
O Java Virtual Machine (JVM) 1.4.2 or later
O 75 MB of free disk space to install the GroupWise Cross-Platform client

8.3 Planning Your GroupWise Client Installation

» Section 8.3.1, “Assigning GroupWise Accounts to Users,” on page 204
» Section 8.3.2, “System-Wide Rollouts,” on page 205

8.3.1 Assigning GroupWise Accounts to Users

After you’ve finished your basic GroupWise system setup, you need to add users to the post office
before they can log in to a GroupWise client. To do so, follow the instructions in one of the
following sections:

» “Assigning GroupWise Accounts to eDirectory Users” on page 204

» “Assigning GroupWise Accounts to Non-eDirectory Users” on page 205

Assigning GroupWise Accounts to eDirectory Users
To give an eDirectory™ user a GroupWise account in the post office:

1 In ConsoleOne®, right-click the user you want to give an account to, then click Properties.
2 Click the GroupWise tab to display the GroupWise Account page.
3 In the Post Office field, click the Browse button to select the post office.

4 1In the Mailbox ID field, specify the name the user will use when logging in to his or her
mailbox. The field defaults to the eDirectory username.

5 Click OK.
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Assigning GroupWise Accounts to Non-eDirectory Users

You give a non-eDirectory user a GroupWise account in a post office by adding the user to
eDirectory as a GroupWise external entity.

1 In ConsoleOne, right-click the container where you want to create the GroupWise external
entity, click New, then click Object to display the New Object dialog box.

2 In the list, select GroupWise External Entity, then click OK to display the Create GroupWise
External Entity dialog box.

3 Define the following properties:

GroupWise Object ID: Specify the user’s GroupWise ID. The user’s ID, along with the user’s
post office and domain, provide the user with a unique name within the GroupWise system.

Last Name: Specify the user’s last name.
GroupWise Post Office: Select the post office where you want the user’s mailbox.
External Network ID: Specify the user’s network ID for the network that he or she logs in to.

Define Additional Properties: Select this option so that you can define additional information
such as the user’s first name. The user’s first name appears in the GroupWise Address Book.

Create Another External Entity: As soon as you select Define Additional Properties, this
option becomes unavailable. Repeat Step 1 through Step 3 if you need to create additional
GroupWise external entities.

4 Click Create.
5 Specify the user’s first name in the Given Name field.
6 Fill in any other fields you want, then click OK.

The user is given a GroupWise account in the post office you selected and can access his or her
mailbox through the GroupWise client.

Logging in to GroupWise as a Non-eDirectory User

Because non-eDirectory users do not log in to eDirectory, the GroupWise clients cannot use the
GroupWise information in eDirectory to automatically log in to the users’ post office. When a non-
eDirectory user starts a GroupWise client for the first time, he or she is prompted for a GroupWise
user ID and post office location (IP address and port number). You need to provide non-eDirectory
users with this information.

If you don’t want to provide non-eDirectory users with the post office information, you can
automate the login process by creating a GroupWise name server. A GroupWise name server is a
DNS hostname entry that defines the TCP/IP address of the POA. During startup, the GroupWise
client automatically looks for the GroupWise name server in DNS. For information about creating a
GroupWise name server, see “Post Office Agent” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7).

8.3.2 System-Wide Rollouts

For a system-wide rollout of the GroupWise client software, you might want to consider alternatives
to each user installing from the CD or the software distribution directory.

For the GroupWise Cross-Platform client, you can use Red Carpet® for a system-wide rollout.
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For the GroupWise Windows client, if you have Novell ZENworks® Desktop Management, you can
use it, along with the .ms1i files included with GroupWise 7, to distribute the client. Or, you can
have a login script run the client setup program with a response file to perform a silent install on
workstations.

For more information about these and other installation methods, see “Client” in the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

8.4 Setting Up the GroupWise Client

* Section 8.4.1, “Setting Up the GroupWise Windows Client,” on page 206
» Section 8.4.2, “Setting Up the GroupWise Cross-Platform Client on Linux,” on page 208
» Section 8.4.3, “Setting Up the GroupWise Cross-Platform Client on Macintosh,” on page 209

8.4.1 Setting Up the GroupWise Windows Client

* “Installing the Windows Client” on page 206
» “Starting the Windows Client” on page 208

Installing the Windows Client
1 At the user’s workstation, insert the GroupWise 7 Client for Windows CD in the CD drive.
or
Map a drive to the client files in the software distribution directory.

During the installation of your GroupWise system, the client files were copied to the software
distribution directory on your server. For example, if you accepted the default
z:\grpwise\software as your target, the client software was copied to
z:\grpwise\software\client\win32.

The setup program (setup . exe) can be run from the software distribution directory. In order
to run this setup program, users require rights to client\win32 in the software distribution
directory. The minimum rights required are Read and File Scan.

2 From the Windows taskbar, click Start > Run.
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3 Browse to the GroupWise 7 Client for Windows CD or the client\win32 directory in the
software distribution directory, then run setup.exe.

ii-‘!r“ GroupWise - Welcome L ll

Welcome to the InstallShield Wizard for
GroupWise

The Installshield(R) Wizard will install Groupiwise on your
computer, To continue, click Next,

WARNING: This program is protected by copyright law and
interniational treaties,

= Baclk Cancel |

4 Click Next to display the Setup Type dialog box, then select one of the following options:

Typical: Installs the most commonly used components in the standard installation directory of
c:\novell\groupwise with out prompting further information needed. By default, this
installs the software integration, Internet browser mail integration, GroupWise Tip of the Day,
and GroupWise PDA Connect. For information on installing GroupWise PDA connect, see the
GroupWise PDA Connect Readme (http://www.novell.com/documentation/gw7). A GroupWise
icon is added to your Desktop as well as the Quick Launch. However, Notify is not added to
your startup group. This means Notify does not run when Windows starts.

Custom: Allows you to select where you want GroupWise to install and what components of
GroupWise you want to install. Select this option if you want to add Notify to your startup
group.

Upgrade: Installs GroupWise 7 over your existing installation of GroupWise with the same
components you already had installed. The installation directory is also the same as your
previous installation of GroupWise.

See “Client” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7) for more information about setting up GroupWise Remote and Caching
modes.

5 Click Next.

If you selected Typical or Upgrade, click Next again to install the files. Click Finish to finalize
the installation program. When the setup program has completed, a shortcut to run GroupWise
appears on the your desktop.

If you selected Custom, continue with step 6.
6 Make sure each component you want to install is selected.

Languages: If you have the multilanguage version of the Group Wise 7 Client for Windows CD,
you can select which languages to install.

Internet Browser Mail Integration: Sets GroupWise to be the default e-mail program on the
workstation, so that whenever the user clicks an e-mail link on a Web page or chooses the
Mail command in the browser (Internet Explorer 3.x and higher, Netscape Navigator 4.03-
4.08), GroupWise starts.
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GroupWise Tip of the Day: The Tip of the Day displays different hints about using
GroupWise. A new tip is displayed each time GroupWise is started. The user can disable Tip of
the Day at any time.

GroupWise PDA Connect: Allows you to cradle synchronize GroupWise with a Palm OS or
Windows Pocket PC PDA device. For information about GroupWise PDA connect, see the
GroupWise PDA Connect Readme (http://www.novell.com/documentation/gw7).

7 Click Change to change the default installation path.
8 Click Next.
9 Select the Program Folder where you want to add the GroupWise icons.
The default is Novell GroupWise.
10 Select if you want the GroupWise icon added to your Desktop and Quick Launch.
11 Select if you want Notify added to the Startup Folder. This starts Notify when Windows starts.
12 Click Next.

13 Click Install to install GroupWise, then click Finish when all the files have finished copying to
your hard drive. When the setup program has completed, a shortcut to run GroupWise appears
on your desktop.

Starting the Windows Client

At startup, the GroupWise client needs to know the location (IP address/hostname and port number)
of the user’s post office. There are three ways that the client can get this information:

+ If'the user is logged into eDirectory, the GroupWise client can read eDirectory for the post
office’s location.

* If'the user is not logged into eDirectory, the GroupWise client can use a GroupWise name
server to get the user’s post office location. A GroupWise name server is a DNS hostname entry
that defines the IP address of the post office’s POA. During startup, the GroupWise client
automatically looks for the GroupWise name server in DNS. For information about creating a
GroupWise name server, see “Post Office Agent” in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7).

* The user can provide the post office location when prompted.
To start the GroupWise client for the first time:

1 Double-click the GroupWise icon on the Windows desktop.

2 Enter the password and post office address information, then click OK.

8.4.2 Setting Up the GroupWise Cross-Platform Client on Linux
* “Installing the Cross-Platform Client on Linux” on page 208

» “Starting the Cross-Platform Client on Linux” on page 209

Installing the Cross-Platform Client on Linux

1 Open a new terminal window, then become root by entering su and the root password.
2 Change to the root of the GroupWise 7 Client for Linux and Macintosh CD.
3 Enter ./install.
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The GroupWise Client is installed to /opt /novell/groupwise/client.

You can also install the Cross-Platform client by changing to the client/1inux directory on the
GroupWise 7 Client for Linux and Macintosh CD, then installing the RPM.

Starting the Cross-Platform Client on Linux

1 At the command line, change to the /opt/novell/groupwise/client/bin directory.
2 Enter the following:
./groupwise.sh

3 Specify the username, password, and server information, then click OK.

For your convenience, a Cross-Platform client icon is automatically created on your desktop.

8.4.3 Setting Up the GroupWise Cross-Platform Client on
Macintosh

+ “Installing the Cross-Platform Client on Macintosh” on page 209
 “Starting the Cross-Platform Client on Macintosh” on page 209

Installing the Cross-Platform Client on Macintosh

1 Browse to the GroupWise . dmg file on the GroupWise 7 Client for Linux and Macintosh CD.
2 Double-click the GroupWise . dmg file to install the Cross-Platform client software.

The installation process adds a GroupWise Cross-Platform client icon to your desktop.

Starting the Cross-Platform Client on Macintosh

1 Double-click the GroupWise Cross-Platform client icon to start the Cross-Platform client.

2 Specify the username, password, and server information, then click OK.

8.5 What’s Next

For information about using the features in the GroupWise Windows and GroupWise Cross-
Platform clients, click Help > Help Topics, or Help > User Guide in the client. The user guides are
both available at the GroupWise 7 Documentation Web site (http://www.novell.com/documentation/
ew7).
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Installing the GroupWise
Connector for Microsoft Outlook

The GroupWise® Connector for Microsoft Outlook* allows you to use Outlook to access your e-
mail, calendar, and other collaboration data that is stored in a GroupWise database. With the
GroupWise Connector for Outlook, you can continue working in the familiar Outlook environment
to without being trained on how to use GroupWise.

The GroupWise Connector for Outlook is installed separately from GroupWise. For information, see
the GroupWise Connector for Microsoft Outlook Quick Start and the GroupWise Connector for
Microsoft Outlook Readme at the GroupWise 7 Documentation Web site (http://www.novell.com/
documentation/gw?7).
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Installing the GroupWise Mobile
Server

Using GroupWise® Mobile Server, Powered by Intellisync, you can synchronize Personal
Information Manager (PIM) and e-mail data from Novell® GroupWise to Windows CE, Windows
Mobile*-based Smartphones, Symbian* OS, Palm OS* handheld devices, and SyncML* devices.

For information, see the GroupWise Mobile Server I Installation Guide (http://www.novell.com/
documentation/gw?7).
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Installing GroupWise Messenger

Novell® GroupWise® Messenger is a corporate-based, secure instant messaging solution that
supports instant messaging, presence, and archiving of conversations. The Messenger client
integrates with the GroupWise client to provide access to instant messaging features from with the
GroupWise client.

GroupWise Messenger is installed separately from GroupWise and does not rely on your GroupWise
system. All Messenger information is stored in eDirectory™, not in GroupWise databases. For
information, see the GroupWise Messenger Installation Guide (http://www.novell.com/
documentation/nm?2).
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Update

* Chapter 12, “What’s New in GroupWise 7,” on page 219

* Chapter 13, “Understanding the Update Process,” on page 245

* Chapter 14, “Preparing Your GroupWise System for Update,” on page 251

» Chapter 15, “Updating Your GroupWise 6.x System to Version 7,” on page 253
» Chapter 16, “Updating Your GroupWise 5.x System to Version 7,” on page 263

* Chapter 17, “Updating an Evaluation GroupWise System to a Fully Licensed System,” on
page 265
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What’s New in GroupWise 7

Novell® GroupWise® 7 provides substantial improvements over GroupWise 6.x in five areas:

* Windows Client Enhancements: The Windows client has a new look and feel that includes
the Nav Bar, Panels, Home Folder, color schemes, and new icons. In addition to the new look
and feel, you can now create and view multiple calendars, create all day events, spell check as
you type, use Quick Filters, see the Messenger presence information for users, create HTML
signatures, and control inline quotations.

¢ Cross-Platform Enhancements: The Cross-Platform client has added many features
including spell checking, rules, junk mail handling, cleanup tools for your mailbox, backup and
restore, and the ability to set your default views, create all day events, and control inline
quotations.

* WebAccess Client Enhancements: The WebAccess client has a new look and feel that brings
it closer to the look and feel of the Windows client. Some of the new features include easier
tabbed navigation, the ability to drag and drop items, right-click on items, folder management,
Work in Progress folder, and name completion from your Frequent Contacts Address Book.

¢ Administration Enhancements: GroupWise administrators have additional control over
users’ working environments, including granting rights to users to edit distribution lists,
appending global signatures to users’ messages, and controlling the appearance of the
GroupWise Windows client interface.

* Agent Enhancements: The POA now supports SOAP, so that SOAP clients such as
Evolution™ can connect to GroupWise. The GroupWise Linux agents can now run as a non-
root user and the new High Availability service automatically restarts the Linux agents if they
go down unexpectedly. The Linux and Windows agents support IPV6. IPV6 support is not
currently available on NetWare®.

For a complete listing of all major enhancements and new features in the GroupWise components,
refer to the following sections:

* Section 12.1, “GroupWise Administration,” on page 219

+ Section 12.2, “GroupWise Agents,” on page 224

» Section 12.3, “GroupWise Windows Client,” on page 226

» Section 12.4, “GroupWise Cross-Platform Client,” on page 230

» Section 12.5, “GroupWise Internet Agent,” on page 234

* Section 12.6, “GroupWise WebAccess,” on page 238

» Section 12.7, “GroupWise Monitor,” on page 241

12.1 GroupWise Administration

GroupWise 7 administration includes the following enhancements and new features.

» Section 12.1.1, “Distribution List Administration (v7.0),” on page 220
» Section 12.1.2, “Global Signatures (v7.0 / v7.0.1),” on page 220
» Section 12.1.3, “User Move Pending Items (v7.0),” on page 220
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* Section 12.1.4, “Address Book Delta Sync (v7.0),” on page 221

* Section 12.1.5, “Client Options Enhancements (v7.0),” on page 221

 Section 12.1.6, “More Flexibility with Preferred E-Mail IDs (v7.0),” on page 222
» Section 12.1.7, “Gateway Alias Migration (v7.0.1),” on page 222

* Section 12.1.8, “Refresh Views (v7.0),” on page 222

» Section 12.1.9, “Improved Backup Capabilities with Novell Cluster Services on NetWare
(v7.0.1),” on page 223

» Section 12.1.10, “Simplified Installation Procedure for Novell Cluster Services on Linux
(v7.0.1),” on page 223

* Section 12.1.11, “PolyServe Matrix Server Support (v7.0.1),” on page 223

12.1.1 Distribution List Administration (v7.0)

In ConsoleOne®, you can grant rights to users to modify distribution lists from the GroupWise
Windows client. However, users cannot create or delete distribution lists; that can be done only in
ConsoleOne by an administrator.

For more information about distribution list administration, see “Enabling Users to Modify a
Distribution List” in “Distribution Lists, Groups, and Organizational Roles” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.1.2 Global Signatures (v7.0/v7.0.1)

In ConsoleOne, you can build a list of globally available signatures that can be automatically
appended to messages sent by GroupWise client users. Global signatures are created in HTML
format. For users who prefer the Plain Text compose view in the GroupWise Windows client, a plain
text version of the signature is appended instead of the HTML version. When this occurs, HTML
formatting and embedded images are lost, but you can customize the plain text version as needed to
compensate for the loss of HTML formatting.

For Windows client users, the global signature is appended by the client to messages after any
personal signatures that users create for themselves. It is appended after the user clicks Send. If
encryption is enabled, the global signature is encrypted along with the rest of the message. For all
client users, global signatures can be appended by the Internet Agent for recipients outside the local
GroupWise system. However, the Internet Agent does not append global signatures to S/MIME-
encoded messages, nor does it duplicate global signatures already appended by the Windows client.

For more information, see “Global Signatures” in “System” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw?7).

12.1.3 User Move Pending Items (v7.0)

After you have moved a user in ConsoleOne, you can display detailed information about items
belonging to that account that have not yet been moved to the destination post office, perhaps
because problems were encountered when trying to move them. This information can help
determine the importance of moving residual items that are still pending after all other items have
been successfully moved.
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For more information about managing pending items, see “Monitoring User Move Status” in
“Users” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

12.1.4 Address Book Delta Sync (v7.0)

In earlier versions of GroupWise, Remote client users received updated system Address Books
based on the Refresh Address Books and Rules Every nn Days setting under Accounts > Mail >
Properties > Advanced. The entire Address Book was downloaded to the Remote client according to
the specified schedule.

In GroupWise 7, the POA automatically updates the post office database with changes to the
Address Book as they occur. As a result, whenever a Remote client connects to the GroupWise
system, it can automatically download updates to the Address Book that have occurred since the last
time it connected. This means that Remote client users always have an up-to-date Address Book.

Because the Address Book updates are stored as records in the post office database (wphost . db),
this feature causes the post office database to grow in size as time passes. Therefore, in ConsoleOne,
you can specify the maximum number of days you want to store the incremental update records. The
longer the incremental update records are stored, the larger the post office database becomes, which
can impact available disk space and backup time.

For more information, see “Controlling Address Book Synchronization for Remote Client Users” in
“System” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

Users should not deselect Refresh Address Books and Rules Every nn Days because rules are still
downloaded according to this schedule. Even if users do not want to download their rules, they still
should not deselect this option because it would turn off the Address Book delta sync. They can,
however, set the option to a greater number of days to cause the download of the full Address Book
to occur less frequently.

12.1.5 Client Options Enhancements (v7.0)

The following enhancements have been made to Client Options:

* “Windows Client Appearance Defaults” on page 221
* “Messenger Integration” on page 222

» “Limits on Caching/Remote Mailboxes” on page 222

For additional information about Client Options, see “Setting Defaults for the GroupWise Client
Options” in “Users” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw?7).

Windows Client Appearance Defaults

In ConsoleOne, you can preset the appearance of the GroupWise Windows client. You can choose
between Default, GroupWise 6.5 and Simplified. After you select a look, you can select the
functionality of individual features such as the main menu, the Nav bar, the main tool bar, the folder
list, and the Quick Viewer. You can also select a color scheme. You can lock your settings or allow
users to configure the Windows client according to their own preferences, starting with the default
appearance.

For more information, see “Modifying Environment Options” in “Client” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).
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Messenger Integration

In ConsoleOne, you can enable and disable the display of Messenger presence information in the
GroupWise Windows client. Messenger presence enables users to easily choose instant messaging
as an alternative to e-mail. Messenger presence icons appear in the From field of a received
message, in the Quick Info for users specified in the 7o, CC, and BC fields of a new message, and in
the Quick Info for users in the Address Book. Messenger presence is enabled by default.

For more information, see “Supporting Messenger Presence Display in GroupWise” in “System”
and “Modifying Environment Options” in “Client” in the Group Wise 7 Administration Guide (http:/
/www.novell.com/documentation/gw?7).

Limits on Caching/Remote Mailboxes

On the Disk Space Management page (Tools > GroupWise Utilities > Client Options > Send > Disk
Space Management) in ConsoleOne, you can limit the size of users’ Online mailboxes. You can now
enforce the same mailbox size limits on users’ Caching and Remote mailboxes, wherever those
mailboxes are located.

For more information, see “Modifying Environment Options” in “Client” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.1.6 More Flexibility with Preferred E-Mail IDs (v7.0)

You can now use the same e-mail ID for more than one user in your GroupWise system, provided
each user is in a different Internet domain. Rather than requiring that each e-mail ID be unique in
your GroupWise system, each combination of e-mail ID and Internet domain must be unique. This
provides more flexibility for handling the situation where two people have the same name.

For more information, see “User/Resource Overrides” in “System” in the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.1.7 Gateway Alias Migration (v7.0.1)

For those who have been using SMTP gateway aliases to handle e-mail addresses that do not fit the
default format expected by the Internet Agent or to customize users’ Internet addresses, the Gateway
Alias Migration utility can convert the usernames in those gateway aliases into preferred e-mail IDs.
The Preferred E-Mail ID feature was first introduced in GroupWise 6.5 and is the suggested method
for overriding e-mail address format, as described in“Changing a User's Internet Addressing
Settings” in “Users” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw7). The Gateway Alias Migration utility can also update users’ preferred Internet
domain names based on their existing gateway aliases.

For usage instructions, see “Transitioning from SMTP Gateway Aliases to Internet Addressing” in
“Internet Agent” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/
egw7).

12.1.8 Refresh Views (v7.0)

When you use AutoUpdate to force Windows client software updates, the AutoUpdate process
makes one attempt to update the view files. If that attempt fails, the problem is recorded in the POA
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log file and you can then use the Refresh Views option to distribute the latest view files to the post
office.

For more information, see “Refreshing the Client View Files in the Post Office” in “Post Offices” in
the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.1.9 Improved Backup Capabilities with Novell Cluster
Services on NetWare (v7.0.1)

On NetWare and Linux, for each /home switch that specifies a GroupWise domain or post office
directory, TSAFSGW can now determine what types of GroupWise objects are available at that
location. TSAFSGW recognizes four GroupWise object types:

* Domain [DOM]

* Post office [PO]

* Library [DMS] (for “document management services”)

» Remote document storage area [BLB] (for “blob”, meaning a compressed document file)
On NetWare, the new /vserver switch enables you to specify the name of a virtual server in your

NetWare cluster. Then you can use the /home switch to specify shared volumes and paths rather than
physical volumes and paths.

For usage instructions, see “GroupWise Target Service Agent for File Systems (TSAFSGW)” in
“Databases” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/
egw7).

12.1.10 Simplified Installation Procedure for Novell Cluster
Services on Linux (v7.0.1)

The GroupWise Installation program on Linux now includes a new Configure GroupWise for
Clustering option. It helps you install the agent software on all nodes in the GroupWise agents’
failover list in the cluster in a more convenient manner, so that you do not need to perform repetitive
configuration tasks as you install the agent software on each node.

For background information about clustering, see “Novell Cluster Services on Linux” in the
GroupWise 7 Interoperability Guide. For agent-specific installation details, see:

+ “Installing and Configuring the MTA and the POA in a Cluster”

 “Installing and Configuring the Internet Agent in a Cluster”

* “Implementing WebAccess in a NetWare Cluster”

* “Installing and Configuring the Monitor Agent on Each Node in Your Cluster”

12.1.11 PolyServe Matrix Server Support (v7.0.1)

PolyServe Matrix Server manages a group of networked servers and a Storage Area Network (SAN)
as a single entity. Matrix Server uses virtual hosts to provide failover protection for networked
applications. A PolyServe matrix is similar in purpose and function to the clustering technology
provided by Novell and Microsoft. A virtual host is a hostname/IP address configured on one or
more servers in the matrix. For a detailed description of installing PolyServe Matrix Server, refer to
the PolyServe Matrix Server Administration Guide for Linux that accompanies the PolyServe
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software. For instructions on installing GroupWise on PolyServe Matrix Server, see “PolyServe
Matrix Server on Linux” in the GroupWise 7 Interoperability Guide.

12.2 GroupWise Agents

The GroupWise 7 agents include the enhancements and new features listed below.

» Section 12.2.1, “Windows 2003 Server Support (v7.0),” on page 224

* Section 12.2.2, “IPV6 Support (v7.0),” on page 224

» Section 12.2.3, “GroupWise High Availability Service (v7.0),” on page 224

» Section 12.2.4, “Agents Run as Non-root User (v7.0 / v7.0.1),” on page 225

» Section 12.2.5, “SOAP Support (v7.0),” on page 225

* Section 12.2.6, “Agent Exclusive Bind (v7.0),” on page 225

* Section 12.2.7, “Disable Administration Task Processing for the POA (v7.0),” on page 225
» Section 12.2.8, “POA Creates Additional Message Databases (v7.0),” on page 226

* Section 12.2.9, “Fix for POA Problem with Deferred Messages (v7.0),” on page 226

12.2.1 Windows 2003 Server Support (v7.0)

You can now install and run the agents on Windows 2003 Server.

12.2.2 IPV6 Support (v7.0)

The agents support the IPV6 protocol when it is available on the server. If it is available, the agent
detects it and supports IPV6 by default, along with IPV4.

IPV6 support is available on Linux and Windows. IPV6 support is not currently available on
NetWare.

12.2.3 GroupWise High Availability Service (v7.0)

The GroupWise High Availability service makes sure that, if the MTA or the POA goes down for
any reason, it starts again automatically. On NetWare, this capability is provided by using a
restartable protected address space. On Windows, Microsoft Clustering Services automatically
restarts a service that is not responding. On Linux, Novell Cluster Services™ does not include this
capability, so it is built into the GroupWise Linux agents.

The GroupWise High Availability service (gwha) is installed automatically, starts when your server
boots, and makes sure that the POA, the MTA, and the Internet Agent are running. If it detects that
one of these agents is no longer running, it immediately issues the command to start it. The High
Availability service uses the Monitor Agent to periodically check the status of the agents that it is
responsible for restarting.

For setup instructions, see “Enabling the High Availability Service for the Linux GroupWise
Agents” on page 187.
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12.2.4 Agents Run as Non-root User (v7.0 / v7.0.1)

For security reasons, it is preferable that the GroupWise agents not run with root user privileges.
For example, if an intruder manages to assume the identity of a GroupWise agent, the intruder gains
all the privileges of the commandeered process. If the process is running with root user privileges,
then the intruder has root access to your system. If the process is running as a user with minimal
privileges, then the intruder has only restricted access to your system. Therefore, your system is
more secure if the GroupWise agents do not run as root.

The root user still needs to start the agents, because the agents need to access some root-only
resources on startup. However, you can configure the agents to switch to a different user after they
start.

To prevent an agent from running as a different user than the one for which it was originally
configured, the agent creates a uid. run file in the domain or post office directory that it services.
If the user specified in the uid. conf file is changed or if the uid. conf file is deleted, thus
changing or removing the information about the user the agent should run as, the agent displays and
error message and does not start.

For setup instructions, see “Running the Linux GroupWise Agents as a Non-root User” on page 184
and “Changing the Non-root User” on page 186.

12.2.5 SOAP Support (v7.0)

Simple Object Access Protocol (SOAP) is used by e-mail clients such as Evolution to access
mailboxes. You can now configure the POA to communicate with SOAP-enabled e-mail clients as it
has already been doing for IMAP e-mail clients.

For setup instructions, see “Supporting SOAP Clients” in “Post Office Agent” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.2.6 Agent Exclusive Bind (v7.0)

You can now cause the POA and the MTA to bind to a specified IP address when the server where
they run uses multiple IP addresses. The specified IP address is associated with all ports used by the
agent. Without an exclusive bind, the POA and the MTA bind to all IP addresses available on the
server.

You can set this option on the Network Address page of the POA or MTA object in ConsoleOne or
by using the /ip startup switch in the agent startup file. The POA has always had the /ip switch; it is
a new switch for the MTA.

For setup instructions, see “Binding the POA to a Specific IP Address” in “Post Office Agent” and
“Binding the MTA to a Specific [P Address” in “Message Transfer Agent” in the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.2.7 Disable Administration Task Processing for the POA
(v7.0)

You can now disable administration task processing for the POA on the Agent Settings page of the
POA object in ConsoleOne, as well as using the /noada startup switch in the POA startup file.
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See “Optimizing the POA” in “Post Office Agent” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw7) for POA configurations that include disabling administration
task processing.

12.2.8 POA Creates Additional Message Databases (v7.0)

In the past, the POA has created a maximum of 25 message databases (numbered 0 through 24) per
post office. Starting in GroupWise 7, the POA creates as many as 255 message databases (numbered
0 through 254) per post office. The larger number of databases speeds up message delivery and
minimizes user impact if a database is damaged.

For more information, see “Message Databases” “Post Office Agent” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.2.9 Fix for POA Problem with Deferred Messages (v7.0)

If a message database is locked (for example, it is in use by a backup program), arriving messages
are held in the defer database (ngwdfr . db) until the message database is again available. In
GroupWise 6.5, if the defer database is also locked for some reason, large numbers of extraneous
messages are generated. This problem no longer occurs in GroupWise 7.

12.3 GroupWise Windows Client

The GroupWise client for Windows includes the enhancements and new features listed below.

* Section 12.3.1, “Appearance Schemes (v7.0),” on page 227

* Section 12.3.2, “Individual Appearance Settings (v7.0),” on page 227

» Section 12.3.3, “Color Schemes (v7.0),” on page 227

» Section 12.3.4, “Header Controls (v7.0),” on page 227

» Section 12.3.5, “Quick Filter (v7.0),” on page 227

» Section 12.3.6, “Messenger Presence (v7.0),” on page 228

* Section 12.3.7, “Home View (v7.0),” on page 228

* Section 12.3.8, “New Customized Navigation Bar (v7.0),” on page 228
+ Section 12.3.9, “Unicode Support (v7.0),” on page 228

» Section 12.3.10, “Spell Check as You Type (v7.0),” on page 228

» Section 12.3.11, “HTML Signatures (v7.0),” on page 228

» Section 12.3.12, “Global Signatures (v7.0),” on page 229

* Section 12.3.13, “Inline Quotation for Replies (v7.0),” on page 229
 Section 12.3.14, “Prevent Images from Displaying for HTML Messages (v7.0),” on page 229
» Section 12.3.15, “Search Attachments (v7.0),” on page 229

» Section 12.3.16, “Multiple Calendars (v7.0),” on page 229

 Section 12.3.17, “Print Calendar in Full Color (v7.0),” on page 229

» Section 12.3.18, “All Day Events (v7.0),” on page 229

» Section 12.3.19, “Edit Corporate Distribution Lists (v7.0),” on page 230

226 GroupWise 7 Installation Guide


http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7

* Section 12.3.20, “Default Compose and Read Views (v7.0),” on page 230
» Section 12.3.21, “Interactive Tutorial (v7.0.1),” on page 230
» Section 12.3.22, “Check Mailbox Size (v7.0.1),” on page 230

» Section 12.3.23, “Quickly Adding Contacts to Your Personal Address Book (v7.0.1),” on
page 230

* Section 12.3.24, “Changing the Background for Calendar Parts (v7.0.1),” on page 230
» Section 12.3.25, “Printing Attachment Names (v7.0.1),” on page 230
» Section 12.3.26, “Accepting and Declining Internet Items (v7.0.1),” on page 230
For information about using new features, from the GroupWise Windows client, click Help > Whats

New. For additional information about using the GroupWise Windows client, see the GroupWise 7
Windows Client Guide (http://www.novell.com/documentation/gw?7).

12.3.1 Appearance Schemes (v7.0)

The appearance schemes allow you to select between Default, GroupWise 6.5 and Simplified. Each
of these schemes have default appearance settings. Default has the full Folder list, Main Menu, Main
Toolbar, and uses the sky blue color theme. GroupWise 6.5 has the full folder list, Main Toolbar and
looks just like the GroupWise 6.5 look. Simplified has the sky blue color scheme, the Nav Bar, and
the simple Folder list.

12.3.2 Individual Appearance Settings (v7.0)

You can control how GroupWise looks by using the individual appearance settings, in order to
control what is displayed in GroupWise. You select to display the Main Menu, display the Nav Bar,
display the Main Toolbar, use GroupWise color schemes, display the folder list and how you want to
the folder list to be displayed, display the QuickViewer, and where you want the QuickViewer to
display.

12.3.3 Color Schemes (v7.0)
You can control the color scheme for GroupWise. Your selection from the list of available color

schemes overrides any operating system color schemes you might have previously used for
GroupWise.

12.3.4 Header Controls (v7.0)

Header Controls allow you to select a font size, font color, and reset the header to the default.

12.3.5 Quick Filter (v7.0)

The Quick Filter lets you perform a filter on the panel or folder that is selected. The filter searches
on most fields that are available in the selected panel or folder, but it does not search message bodies
or attachments.
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12.3.6 Messenger Presence (v7.0)

If you have GroupWise Messenger installed, you can now see the presence information for users in
the Quick Info. For messages that you have received, the presence status is located in the From field.
For messages you are sending, the presence status is located in the TO, CC, and BC Quick Info. You
can also see the presence information in the Quick Info for an individual in the Address Book.

12.3.7 Home View (v7.0)

The Home View is a quick view of your most important information. The Home View uses panels to
display the information in sections. By default, the Home View displays your calendar for the day,
your checklist items, and your unread messages in a two-column view.

However, the Home View is fully customizable. You can create additional panels that display the
information you need. In addition, you can select to have only a one-column view. This stacks the
panels into one column instead of the default two columns. As well as showing panels, you can
display your folder list and the Quick Viewer.

12.3.8 New Customized Navigation Bar (v7.0)

The Navigation bar is designed for quick access to the folders you use the most. By default the
Navigation bar contains the Home, Mailbox, Calendar, Contacts, and Trash folders. However, the
Navigation bar is customizable, so you can add the folders you use the most.

12.3.9 Unicode Support (v7.0)

Unicode* support has been added to the subject and message body of items. Now you can write or
read messages in most languages in GroupWise.

12.3.10 Spell Check as You Type (v7.0)

Use spell checking as you type to check for misspelled words, duplicate words, and irregular
capitalization in items you are creating.

When spell checking finds a misspelled word as you type, the word is underlined in red. You can see
a list of suggestions, add the word to your word list, always skip the word, or disable spell checking
as you type by right-clicking the red-underlined word.

12.3.11 HTML Signatures (v7.0)

Use Signatures to insert a signature or tag line at the end of items you send. For example, you can
have GroupWise automatically list your name, phone number, and e-mail address at the bottom of
every item you send. If you have a number of different accounts, including POP3, IMAP4, and
NNTP newsgroup accounts, you can create a different signature for each account.

Now you can also create multiple HTML signatures. When you select to use an HTML signature,
you have a basic editor that you can use to create the signature. You can select a background, add a
picture, add a table, and perform formatting using an HTML Signature.
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12.3.12 Global Signatures (v7.0)

In addition to personal signatures, your system administrator can create a global signature for
everyone to use. The system administrator can require the global signature. If the system
administrator requires the global signature, it is automatically appended to all items that are sent. If
the system administrator does not require the global signature, it is appended to your signature. If
you don’t have a signature, the global signature is not added to sent items if it is not required.

12.3.13 Inline Quotation for Replies (v7.0)

When you reply to a message, you can select how the reply text should appear. GroupWise classic
format shows the date before the original message. Include Header format shows the header
information before the original text. Internet Standard format adds a greater-than sign (>) in front of
the original message.

12.3.14 Prevent Images from Displaying for HTML Messages
(v7.0)

When an HTML message is received, the images are not shown by default for security reasons. This
helps prevent viruses and other malicious attacks through e-mail messages.

To display the images, click the message that states, “GroupWise has prevented Images from
displaying. Click here to display the image.”

You can set GroupWise to always show the warning, never show the warning, or check Frequent

Contacts. If you select to check Frequent Contacts, it shows the images in messages from people
listed in your Frequent Contacts address book.

12.3.15 Search Attachments (v7.0)

When you perform a search in GroupWise, the text of attachments is automatically included in the
search.

12.3.16 Multiple Calendars (v7.0)

You can now create multiple calendars in GroupWise. Each new calendar that is created is assigned
a color. When the new calendars display in the calendar view, the appointment background color
matches the color of the calendar that it belongs to.

12.3.17 Print Calendar in Full Color (v7.0)

When you print the calendar, the individual calendar colors are printed in addition to the category
color.

12.3.18 All Day Events (v7.0)

GroupWise now has support for all day events. All day events are displayed at the top of the
calendar view. When you create an all day event, by default it does not mark the time as busy.
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12.3.19 Edit Corporate Distribution Lists (v7.0)

End users can now edit a corporate distribution list if they have been granted access. You edit a
corporate distribution list in the same way you edit any distribution list or group.

12.3.20 Default Compose and Read Views (v7.0)

You can now specify the default font and size for the compose and read views if you have text as
your default read view. However, if you select HTML as your default read view, you cannot set the
default font or font size. The default font and size for reading HTML messages are determined by
the message that is sent.

12.3.21 Interactive Tutorial (v7.0.1)

A link has been added to the Help menu that takes you to an interactive tutorial about customizing
your Home folder.

12.3.22 Check Mailbox Size (v7.0.1)

You can now check your Mailbox size at any time. In the past, you could check your Mailbox size
only if the GroupWise administrator had enabled size restrictions.

12.3.23 Quickly Adding Contacts to Your Personal Address
Book (v7.0.1)

You can now quickly add any recipient in an item to any personal address book by right-clicking on
the recipient, then selecting the address book to add the user to.

12.3.24 Changing the Background for Calendar Parts (v7.0.1)

You can change the background appearance for All Day Events, Appointments, Reminder Notes,
and Tasks.

12.3.25 Printing Attachment Names (v7.0.1)

When you open an item in a view and print the item, the attachment name is printed as well as the
From, To, Date, Subject, and CC information.

12.3.26 Accepting and Declining Internet Items (v7.0.1)

You can accept or decline appointments, all day events, and tasks that are sent from Internet enabled
collaboration clients. Some of these clients include Microsoft Exchange, Lotus Notes, and
Macintosh iCal.

12.4 GroupWise Cross-Platform Client

The GroupWise Cross-Platform client includes the enhancements and new features listed below.

» Section 12.4.1, “All Day Events (v7.0),” on page 231
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» Section 12.4.2, “Show Hidden Files (v7.0),” on page 231
* Section 12.4.3, “Cleanup (v7.0),” on page 231
* Section 12.4.4, “Reply Text Format (v7.0),” on page 231
* Section 12.4.5, “Default Compose and Read View Fonts (v7.0),” on page 232
» Section 12.4.6, “GroupWise Check (GWCheck) (v7.0),” on page 232
» Section 12.4.7, “User Interface Startup Switch (v7.0),” on page 232
» Section 12.4.8, “Rules (v7.0),” on page 232
» Section 12.4.9, “Spell Checker (v7.0),” on page 232
* Section 12.4.10, “Spell Checking As You Type (v7.0),” on page 232
* Section 12.4.11, “Filters (v7.0),” on page 232
» Section 12.4.12, “Junk Mail Handling (v7.0),” on page 233
» Section 12.4.13, “Backup and Restore (v7.0),” on page 233
» Section 12.4.14, “Improved HTML Rendering (v7.0.1),” on page 234
* Section 12.4.15, “Improved Calendar Performance (v7.0.1),” on page 234
+ Section 12.4.16, “Additional Folder Views (v7.0.1),” on page 234
» Section 12.4.17, “Toolbar Display/Hide Options (v7.0.1),” on page 234
For information about using new features, from the GroupWise Cross-Platform client, click Help >

Help Topics. For additional information about using the GroupWise Cross-Platform client, see the
GroupWise 7 Cross-Platform Client Guide (http://www.novell.com/documentation/gw?7).

12.4.1 All Day Events (v7.0)

GroupWise now has support for all day events. All day events are displayed at the top of the
calendar view. When you create an all day event, by default it does not mark the time as busy.

12.4.2 Show Hidden Files (v7.0)

You can have the GroupWise Cross-Platform client show any hidden files when it is displaying a list
of files and folders.

12.4.3 Cleanup (v7.0)

You can now select to have GroupWise Auto-archive or Auto-delete items, as well as have
GroupWise auto-delete the trash. When you select Auto-archive, GroupWise moves items older than
the number of days listed from your folder to your GroupWise Archive. When you select Auto-
delete, GroupWise moves items that are older than the date specified into your Trash. When you
select to have GroupWise Auto-delete your Trash, it permanently deletes all items in your Trash
folder.

12.4.4 Reply Text Format (v7.0)

When you reply to a message, you can select how the reply text should appear. You can select from
three settings for the reply text format: GroupWise classic, which shows the date before the original
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message; Include Header, which shows the header information before the original text; Internet
Standard, which adds a greater-than sign (>) in front of the original message.

12.4.5 Default Compose and Read View Fonts (v7.0)

You can now select a default font and size for the Compose View and Read View. In the Compose
View you can set the font and size for both plain text messages and HTML messages. In the Read
View you can set the font and size for plain text messages. You can also force plain text messages to
display instead of HTML messages. If you select HTML as the default Read View, you cannot select
the font and size of the message.

12.4.6 GroupWise Check (GWCheck) (v7.0)

You can now use the GWCheck utility to repair your mailbox on the Macintosh Cross-Platform
client.

12.4.7 User Interface Startup Switch (v7.0)

You can now start the GroupWise Cross-Platform client for Linux with a GTK look and feel.

12.4.8 Rules (v7.0)

You can automate many GroupWise actions, such as replying when you’re out of the office, deleting
items, or sorting items into folders, by using Rules to define a set of conditions and actions to be
performed when an item meets those conditions.

12.4.9 Spell Checker (v7.0)

Use Spell Checker to check for misspelled words, duplicate words, and irregular capitalization in
items you are creating.

When Spell Checker finds a misspelled word, you can replace it with a word Spell Checker
suggests, edit the word manually, or skip the word. You can also define an automatic replacement
for the word, or add the word to a user word list.

12.4.10 Spell Checking As You Type (v7.0)

Use spell checking as you type to check for misspelled words, duplicate words, and irregular
capitalization in items you are creating.

When spell checking as you type finds a misspelled word, the word is underlined in red. You can see
a list of suggestions, add the word to your word list, or always skip the word by right-clicking the
red-underlined word. By default, spell checking as you type is on.

12.4.11 Filters (v7.0)

If your Mailbox or Calendar contains many items, you might have a difficult time finding just one of
them. Filter lets you display items according to specific criteria. For example, a filter can display
only items that have a certain word in the subject. You can also use a filter to hide items that you
want to get out of your way.
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Filter does not actually move or delete items; it displays certain items based on the criteria you
specify. When you clear the filter, all the items reappear. Filters you create affect all folders.

Filters affect all folders. By clicking a folder, you can see the filter results immediately.

12.4.12 Junk Mail Handling (v7.0)

Use Junk Mail Handling to decide what to do with unwanted Internet e-mail that is sent to your
GroupWise e-mail address. Internet e-mail includes all e-mail where the sender’s address is in the
form of name@domain.com, name@domain.org, and so forth.

Junk Mail Handling does not apply to internal e-mail. Internal e-mail is e-mail where the sender is
part of your GroupWise system and the From field shows only the name of the sender, not an
Internet address as explained above. If you want to block or junk internal e-mail, you can use Rules.

You have three options for blocking or junking Internet e-mail:

* You can add individual e-mail addresses or entire Internet domains to a Block List. Items from
these addresses or Internet domains are blocked and never arrive in your Mailbox.

An Internet domain is the part of the e-mail address that comes after the @. For example, in the
address Henry@mymail.com, the Internet domain is mymail.com.

* You can add individual e-mail addresses or entire Internet domains to a Junk List. Items from
these addresses or Internet domains are delivered to the Junk Mail folder in your Mailbox. You
can specify that the items in this folder be automatically deleted after <n> days.

* You can specify that any e-mail items from users whose addresses are not in your personal
address books (including your Frequent Contacts address book and any personal address books
you have created) are sent to the Junk Mail folder. This is sometimes called white listing.

In addition to the Block List and Junk List, there is a Trust List. Use this list to add e-mail addresses
or Internet domains that you do not want blocked or junked, no matter what is specified in the other
two lists. For example, you might have zcompany.com in your Block List, but you have one friend
whose address is myfriend@zcompany.com. You can add this friend’s e-mail address to the Trust
List.

If you specify Junk Mail Handling options in Caching or Remote mode, make sure to synchronize
with your Online Mailbox in order to see the same options when you log in to GroupWise on another
computer.

However, e-mail from contacts in your Frequent Contacts address book and your corporate address
book are not blocked.

Your system administrator can turn off Junk Mail Handling so that it is not available.

12.4.13 Backup and Restore (v7.0)

Your system administrator typically backs up your network mailbox on a regular basis. You can
back up your local mailbox if you want to have an additional copy of your mailbox, or if you want to
back up information that is no longer in your network mailbox.

If the system administrator has created a restore area and has backed up the entire GroupWise
system, or if you have backed up your local mailbox in Remote or Caching mode, you can open a
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backup copy of your mailbox to view and restore items. You need Read and Write access to the
restore area if it is on the network.

12.4.14 Improved HTML Rendering (v7.0.1)

New technology has been added to the GroupWise Cross-Platform client that significantly enhances
the rendering of HTML items you receive.

12.4.15 Improved Calendar Performance (v7.0.1)

Enhancements to GroupWise have significantly improved the performance in the Calendar. More
specifically, the performance has been improved when you move the date forward or backward in
the Calendar.

12.4.16 Additional Folder Views (v7.0.1)

You can now view any folder in the following views:

e Details
¢ Check List

e Calendar

12.4.17 Toolbar Display/Hide Options (v7.0.1)

There are three different toolbars you can display in the Cross-Platform client:
* Main: The Main toolbar contains most of your commonly used functions, such as New
Appointment and New Mail. The Main toolbar is located under the Menu bar.

¢ Item Context: The Item Context toolbar contains context-sensitive buttons that relate to the
item that is displayed. The Item Context toolbar is located at the top of the QuickViewer
window.

* Folder Context: The Folder Context toolbar contains context-sensitive buttons that relate to
actions you can perform on particular folders (currently only the Trash folder and the Checklist
folder). The Folder Context toolbar displays above the folder list.

12.5 GroupWise Internet Agent

The GroupWise Internet Agent includes the enhancements and new features listed below.

» Section 12.5.1, “Windows 2003 Server Support (v7.0),” on page 235

» Section 12.5.2, “IPV6 Support (v7.0),” on page 235

* Section 12.5.3, “Internet Agent High Availability (v7.0),” on page 235

» Section 12.5.4, “Internet Agent Runs as Non-root User (v7.0),” on page 235

» Section 12.5.5, “Internet Agent Exclusive Bind (v7.0),” on page 235

» Section 12.5.6, “TCP/IP Links between the Internet Agent and the MTA (v7.0),” on page 235
» Section 12.5.7, “Alternate Internet Agents (v7.0),” on page 236

» Section 12.5.8, “Multiple Relay Hosts (v7.0),” on page 236

234 GroupWise 7 Installation Guide



» Section 12.5.9, “Improved Spam Identification (v7.0),” on page 236
* Section 12.5.10, “External Global Signatures for all Clients (v7.0.1),” on page 236
» Section 12.5.11, “iCal Support (v7.0.1),” on page 236

» Section 12.5.12, “More Internet Agent Settings Available on the Internet Agent Object in
ConsoleOne (v7.0),” on page 237

* Section 12.5.13, “New /nosmtpversion Startup Switch (v7.0),” on page 237

* Section 12.5.14, “New Message Defer Interval Setting (v7.0),” on page 237

* Section 12.5.15, “Consolidated Configuration Information (v7.0.1),” on page 237
* Section 12.5.16, “External Internet Message Threading (v7.0),” on page 238

12.5.1 Windows 2003 Server Support (v7.0)

You can now install and run the Internet Agent on Windows 2003 Server.

12.5.2 IPV6 Support (v7.0)

Like the POA and the MTA, the Internet Agent now supports IPV6 on Linux and Windows, as
described in Section 12.2.2, “IPV6 Support (v7.0),” on page 224.

12.5.3 Internet Agent High Availability (v7.0)

Like the POA and the MTA, the Internet Agent can be configured for high availability, as described
in Section 12.2.3, “GroupWise High Availability Service (v7.0),” on page 224.

12.5.4 Internet Agent Runs as Non-root User (v7.0)

Like the POA and the MTA, the Internet Agent can run as a non-root user, as described in Section
12.2.4, “Agents Run as Non-root User (v7.0 / v7.0.1),” on page 225.

12.5.5 Internet Agent Exclusive Bind (v7.0)

Like the POA and the MTA, the Internet Agent can be bound to a specific IP address, as described in
Section 12.2.6, “Agent Exclusive Bind (v7.0),” on page 225

12.5.6 TCPI/IP Links between the Internet Agent and the MTA
(v7.0)

Previously, the Internet Agent and the MTA have communicated by using message files. For
outgoing messages, the MTA placed message files in the Internet Agent’s input queue
(domain\wpgate\gwia\wpcsout\ 0-7), where the Internet Agent picked them up and
transferred them out across the Internet. For incoming messages, the Internet Agent placed message
files in the MTA input queue for Internet messages (domain\wpgate\gwia\wpcsin\0-7).

To see how this message flow worked for GroupWise 6.5 and earlier versions, see “Message
Delivery to and from the Internet” in Troubleshooting 3: Message Flow and Directory Structure
(http://www.novell.com/documentation/gw7).
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To see how this message flow works for GroupWise 7, see “Message Delivery to and from the
Internet” in Troubleshooting 3: Message Flow and Directory Structure (http://www.novell.com/
documentation/gw?7).

If, for some reason, you want to use message files instead of a TCP/IP link, set the Message Transfer
Port field to 0 (zero) on the Network Address page of the Internet Agent object in ConsoleOne.

12.5.7 Alternate Internet Agents (v7.0)

When you use TCP/IP links for multiple Internet Agents in your system, you can configure each
domain to fail over to an alternate Internet Agent if the primary Internet Agent becomes unavailable.

For setup instructions, see “Configuring an Alternate Internet Agent for a Domain” in “Internet
Agent” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.5.8 Multiple Relay Hosts (v7.0)

You can now specify multiple relay hosts, so that if the primary relay host is not available, the
Internet Agent tries the next relay host in the list.

For configuration instructions, see “Configuring Basic SMTP/MIME Settings” in “Internet Agent”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

12.5.9 Improved Spam Identification (v7.0)

Currently, you can use the /xspam startup switch to flag messages for handling by the client Junk
Mail Handling feature if they contain an x-spamflag=yes in the MIME header. In GroupWise 7,
you can configure as many strings as needed to identify junk mail.

For setup instructions, see “Customized Spam Identification” in “Internet Agent” in the GroupWise
7 Administration Guide (http://www.novell.com/documentation/gw?7).

12.5.10 External Global Signatures for all Clients (v7.0.1)

For all client users, global signatures can be appended by the Internet Agent for recipients outside
the local GroupWise system. The Internet Agent does not append global signatures to S/MIME-
encoded messages. The Internet Agent does not duplicate global signatures already appended by the
Windows client.

For more information, see “Global Signatures” in “System” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw?7).

12.5.11 iCal Support (v7.0.1)

The Internet Agent supports iCalendar (iCal), the Internet Calendaring and Scheduling core object
specification (RFC 2445), and iMIP, the iCalendar Message-based Interoperability Protocol (RFC
2447). When a GroupWise user sends an appointment to an external Internet user, the Internet agent
converts the appointment into an iMIP message that can be read and accepted or declined in
compatible e-mail systems such as Microsoft Exchange and Lotus Notes. GroupWise users can also
receive and accept or decline appointments from users of these e-mail systems. Accept/decline
notifications are also exchanged between systems.
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For setup instructions, see “Configuring Basic SMTP/MIME Settings” in “Internet Agent” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.5.12 More Internet Agent Settings Available on the Internet
Agent Object in ConsoleOne (v7.0)

The following Internet Agent startup switches now have equivalent settings on the Internet Agent
property pages in ConsoleOne:

* /flatfwd (Enable Flat-Forwarding on the SMTP/MIME Message Formatting page)

* /imapreadlimit (Maximum Number of Items to Read on the POP3/IMAP4 Settings page)

* /keepsendgroups (Retain Distribution Lists on Outgoing Messages on the SMTP/MIME
Address Handling page)

* /nomappriority (Disable Mapping X-Priority Fields on the SMTP/MIME Message Formatting
page)

» /mosmtpversion (Do Not Publish Group Wise Information on an Initial SMTP Connection on the
SMTP/MIME settings page)

* /popintruderdetect (Enable Intruder Detection on the POP3/IMAP4 Settings page)

* /realmailfrom (Use GroupWise User Address as Mail From: for Rule Generated Messages on
the SMTP/MIME Address Handling page)

* /xspam (Flag Any Messages That Contain s-spam-flag:yes... on the Junk Mail page)

12.5.13 New /nosmtpversion Startup Switch (v7.0)

When contacted by another SMTP host or a telnet session, the Internet Agent responds with
GroupWise version and copyright date information. To configure the Internet Agent to not disclose
this information, use the /nosmtpversion startup switch in the Internet Agent startup file
(gwia.cfqg).

For more information, see “Using Internet Agent Startup Switches” in “Internet Agent” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.5.14 New Message Defer Interval Setting (v7.0)

You can now configure how often the Internet Agent retries to deliver deferred messages. You can
provide the message defer interval setting on the SMTP/MIME Settings page of the Internet Agent
object in ConsoleOne or you can use the /msgdeferinterval startup switch in the Internet Agent
startup file (gwia.cfq).

For more information, see “Configuring Basic SMTP/MIME Settings” in “Internet Agent” in the

GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.5.15 Consolidated Configuration Information (v7.0.1)

Before GroupWise 7 SP1, Internet Agent configuration information was stored both in eDirectory,
as properties of the Internet Agent object, and in the Internet Agent configuration file (gwia.cfqg).
Starting in SP1, all primary configuration settings have been consolidated into the properties of the
Internet Agent object. Secondary settings are still available only through the startup file.
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When you update an Internet Agent to GroupWise 7 SP1 and access the Internet Agent object in
ConsoleOne, all primary configuration settings are moved from the startup file into eDirectory.
ConsoleOne no longer writes configuration settings to the startup file. Switches in the startup file
can be used to override the settings in ConsoleOne.

For more information about Internet Agent configuration, see “Configuring the Internet Agent” and
“Using Internet Agent Startup Switches” in “Internet Agent” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw?7).

12.5.16 External Internet Message Threading (v7.0)

Messages that arrive from an external Internet address are now threaded into discussions along with
native Group Wise messages, if the sending SMTP host also supports adding References and In-
Reply-to MIME header fields.

12.6 GroupWise WebAccess

GroupWise 7 WebAccess includes the enhancements and new features listed below.

» Section 12.6.1, “Windows 2003 Server Support (v7.0),” on page 238

* Section 12.6.2, “WebAccess Agent High Availability (v7.0.1),” on page 238

* Section 12.6.3, “WebAccess Agent Exclusive Bind (v7.0),” on page 239

* Section 12.6.4, “Simplified WebAccess Agent Startup (v7.0.1),” on page 239

» Section 12.6.5, “New Novell Web Services Page (v7.0),” on page 239

* Section 12.6.6, “Document Viewer Agent (v7.0),” on page 239

» Section 12.6.7, “New Document Viewer Agent Startup Switch (v7.0.1),” on page 239

+ Section 12.6.8, “New WebAccess Client URL on NetWare and Windows (v7.0),” on page 239
* Section 12.6.9, “New WebAccess Client Features (v7.0 / v7.0.1),” on page 240

» Section 12.6.10, “Improved Performance for Low-Bandwidth WebAccess Client Users
(v7.0.1),” on page 240

+ Section 12.6.11, “Improved Performance for All WebAccess Client Users,” on page 241

12.6.1 Windows 2003 Server Support (v7.0)

You can now install the WebAccess Agent and the WebAccess Application on Windows 2003. The
WebAccess Installation program can install and configure Tomcat 5.5 into an existing Microsoft
Internet Information Server.

NOTE: The Novell Servlet Gateway is no longer shipped or supported with WebAccess.

12.6.2 WebAccess Agent High Availability (v7.0.1)

Like the POA, the MTA, and the Internet Agent, the WebAccess Agent can be configured for high
availability, as described in Section 12.2.3, “GroupWise High Availability Service (v7.0),” on
page 224.
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12.6.3 WebAccess Agent Exclusive Bind (v7.0)

Like the POA and the MTA, the WebAccess Agent can be bound to a specific IP address, as
described in Section 12.2.6, “Agent Exclusive Bind (v7.0),” on page 225

12.6.4 Simplified WebAccess Agent Startup (v7.0.1)

Like the POA, the MTA, and the Internet Agent, the WebAccess Agent can be started using the
grpwise script, as described in “Starting the Linux GroupWise Agents as Daemons” on page 182.

12.6.5 New Novell Web Services Page (v7.0)

WebAccess no longer uses the novell.html file that earlier versions of GroupWise installed in
your Web server’s htdocs directory. If users have been accessing the WebAccess client by
displaying the novell.html file, the links in that file no longer work. You should remove the
obsolete novell.html file from the htdocs directory and use the new URL to access the
WebAccess client. If you have customized the novell.html file, you can transfer your changes
to the index.html file in the webapps/gw directory.

12.6.6 Document Viewer Agent (v7.0)

The documents that users attach to e-mail messages are as varied as the combinations of document
formats, tools, and users throughout the world. In order to display documents in your Web browser,
WebAccess must convert them to HTML. Because some documents contain totally unexpected data,
WebAccess cannot convert them. In extreme cases, the WebAccess Agent hangs when it cannot
convert a document. This occurrence then interrupts the activities of all WebAccess users.

The new Document Viewer Agent resolves the problem by taking over the document conversion
task from the WebAccess Agent. The Viewer Agent can process multiple documents simultaneously,
and if it encounters a problem with a document, the problem does not affect its processing of other
documents, nor does it affect the functioning of the WebAccess Agent. Therefore, WebAccess users
no longer experience interruptions because of documents that fail to convert into HTML.

For setup instructions, see “Configuring the Document Viewer Agent” in “WebAccess” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.6.7 New Document Viewer Agent Startup Switch (v7.0.1)

On NetWare, you can run each worker thread in its own namespace. Use the /addrspacename startup
switch in the gwdva . dva file to specify the base name for the series of address space names that
are created for the worker threads. The default base name is GWDVAWRKR, which results in
address spaces named GWDVAWRKR1, GWDVAWRKR2, and so on.

12.6.8 New WebAccess Client URL on NetWare and Windows
(v7.0)

The URL to access the WebAccess client through a Web server on NetWare or Windows is now:
http://web server address/gw/webacc

This matches the URL already in use on Linux.
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12.6.9 New WebAccess Client Features (v7.0/ v7.0.1)

The GroupWise 7 WebAccess client offers a number of enhancements, including:

New look and feel similar to the Windows client
Drag-and-drop functionality to easily move items between folders

Context-sensitive right-click menus on Mailbox and Calendar items for easy access to
commonly used features (for example, Open, Reply, Forward, Accept, Decline, Delete, and so
on)

Enhanced item properties (including delivery status, send options, and Junk Mail Handling
results)

Mark Read item action
Automatic name completion from your Frequent Contacts Address Book

Folder management, so that you can rearrange the folders in your folder list, add and delete
folders, and share folders more easily

Work in Progress folder, so that items you save in your Work in Progress folder in the Windows
client or Cross-Platform client are available to you in the WebAccess client

Quick Find feature for fast full-text searches through your mailbox without setting Advanced
Find options

Inline Calendar appointments, tasks, and notes

Posted Calendar appointments, tasks, and notes

GroupWise 7 SP1 adds the following additional enhancements:

Support for Safari* on Macintosh OS 10.2 (Jaguar)

Resend

Edit posted items

Prompt for signature before send

Static folder tree after page refresh

Go to Date feature in the Calendar

Appointment acceptance as Busy, Free, Tentative, or Out of Office

Frequent Contact Address Book creation for WebAccess-only users

For information about using new features, from the GroupWise WebAccess client, click Help. For
additional information about using the GroupWise WebAccess client, see the GroupWise 7
WebAccess Client Guide (http://www.novell.com/documentation/gw?7).

12.6.10 Improved Performance for Low-Bandwidth WebAccess
Client Users (v7.0.1)

All users of GroupWise 7 SP1 WebAccess should experience some performance improvement
because the amount of data downloaded when accessing the server has been reduced for nearly all
requests. In addition, options have been added to the Login page to allow users to select from the
default interface, a new low-bandwidth interface, and the simple interface.
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The low-bandwidth interface is designed for users on 56 KB modems or slower. It further reduces
the amount of data downloaded from the server by disabling Name Completion and AutoUpdate of
the message list.

The simple interface is designed for mobile device users. It uses simplified templates and assumes a
smaller display area. A few features, such as Name Completion, right-click menus, and drag-and-
drop functionality, are not available from the simplified interface.

For more information, see Section 5.4.3, “Testing GroupWise WebAccess and WebPublisher,” on
page 129.

12.6.11 Improved Performance for All WebAccess Client Users

By enabling data compression on your Web server, you can increase performance for all WebAccess
users. However, because this is a change to the configuration of your Web server, it affects all
programs that interact with the Web server. A side effect of enabling data compression might be a
decline in Web server scalability.

For setup instructions, see “Enabling Web Server Data Compression” in “WebAccess” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

12.7 GroupWise Monitor

GroupWise Monitor includes the enhancements and new features listed below.

* Section 12.7.1, “Windows 2003 Server Support (v7.0),” on page 241

» Section 12.7.2, “IPV6 Support (v7.0),” on page 241

» Section 12.7.3, “New Monitor Web Console URL (v7.0),” on page 242

» Section 12.7.4, “Monitor Agent Web Console Emphasized (v7.0),” on page 242

» Section 12.7.5, “Agent GroupWise Available at Monitor Agent Web Console (v7.0.1),” on
page 242

» Section 12.7.6, “Gateway Accounting Report (v7.0),” on page 242
* Section 12.7.7, “Trends Report (v7.0),” on page 242

» Section 12.7.8, “Downtime Report (v7.0),” on page 242

» Section 12.7.9, “Image Map (v7.0),” on page 243

12.7.1 Windows 2003 Server Support (v7.0)

You can now install the Monitor Agent and the Monitor Application on Windows 2003. The
Monitor Installation program can install and configure Tomcat 5.5 into an existing Microsoft
Internet Information Server.

NOTE: The Novell Servlet Gateway is no longer shipped or supported with Monitor.

12.7.2 IPV6 Support (v7.0)

Like the POA and the MTA, the Monitor Agent now supports IPV6 on Linux and Windows, as
described in Section 12.2.2, “IPV6 Support (v7.0),” on page 224.
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12.7.3 New Monitor Web Console URL (v7.0)

The URL to access the Monitor Web console through a Web server on NetWare or Windows is now:
http://Web server address/gwmon/gwmonitor

This matches the URL already in use on Linux. The Monitor Web console enables you to monitor
your GroupWise system from outside your firewall.

12.7.4 Monitor Agent Web Console Emphasized (v7.0)

The Monitor Agent Web console can be used only behind your firewall. However, the Monitor
Agent Web console includes functionality that the Monitor Web console does not. In particular, it
provides the new Monitor features in GroupWise 7. Starting with GroupWise 7, the Monitor Agent
Web console is being emphasized as the primary browser access point for displaying the information
provided by Monitor.

Use the following URL to access the Monitor Agent Web console:

http://web server address:8200

12.7.5 Agent GroupWise Available at Monitor Agent Web
Console (v7.0.1)

You can now create agent groups at the Monitor Agent Web console just as you can at the Monitor
Agent server console and the Monitor Web console.

For more information about agent groups, see “Creating and Managing Agent Groups” in “Monitor”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw?7).

12.7.6 Gateway Accounting Report (v7.0)

The Gateway Accounting report organizes information gathered in gateway accounting files into a
format that is visually easy to read. Some setup is required to enable the gateway accounting report.

For setup instructions, see “Gateway Accounting Report” in “Monitor” in the Group Wise 7
Administration Guide (http://www.novell.com/documentation/gw?7).

12.7.7 Trends Report (v7.0)

The Trends report presents graphs of agent MIB variables as sampled over time.

For setup instructions, see “Trends Report” in “Monitor” in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7).

12.7.8 Downtime Report (v7.0)

The Downtime report graphically illustrates how much time each GroupWise agent has been down
during the day.

For setup instructions, see “Down Time Report” in “Monitor” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw?7).
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12.7.9 Image Map (v7.0)

An image map enables you to create a visual picture of your GroupWise system, whether it resides
in a single office building or spans the globe. You provide the maps; Monitor provides up-to-the-

minute status information at a glance.

For setup instructions, see “Image Map Report” in “Monitor” in the GroupWise 7 Administration
Guide (http://www.novell.com/documentation/gw7).
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Understanding the Update
Process

You can update a Novell® GroupWise® 5.x or 6.x system to GroupWise 7.

NOTE: To update a GroupWise 4.x system to GroupWise 7, you must first update the system to
GroupWise 5.x. The functionality to update from GroupWise 4.x is not part of the GroupWise 7
Administrator snap-ins to ConsoleOne.

Before you begin updating your GroupWise system to GroupWise 7, you should review the
following sections. These sections, which describe the process to follow when updating, help you
plan and implement a successful update strategy:

* Section 13.1, “Understanding eDirectory Schema Extensions,” on page 245

* Section 13.2, “Understanding GroupWise Software Updates,” on page 245

» Section 13.3, “Understanding Domain and Post Office Database Updates,” on page 246

» Section 13.4, “Understanding GroupWise Client Updates,” on page 247

» Section 13.5, “Understanding Internet Agent Updates,” on page 248

* Section 13.6, “Understanding WebAccess Updates,” on page 248

* Section 13.7, “Understanding Monitor Updates,” on page 249

+ Section 13.8, “Understanding GroupWise Gateway Compatibility,” on page 249

For a list of enhancements and new features in GroupWise 7, see Chapter 12, “What’s New in
GroupWise 7,” on page 219.

In some cases, you might need to maintain a mixed-version environment as you roll out GroupWise
7. For a table showing which GroupWise 5.x and 6.x components can be used with GroupWise 7, see
Appendix A, “GroupWise Version Compatibility,” on page 303.

13.1 Understanding eDirectory Schema
Extensions

GroupWise 7 includes new functionality that requires you to extend the schema of any Novell
eDirectory™ trees where you have GroupWise objects. The GroupWise Setup automatically extends
the schema for any trees you select.

13.2 Understanding GroupWise Software
Updates

The GroupWise 7 software requirements are different than previous GroupWise software
requirements. To review the requirements, see Chapter 2, “GroupWise System Requirements,” on
page 21.
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13.2.1 Software Distribution Directory

The GroupWise Installation Advisor helps you copy the GroupWise 7 software (administration,
agents, client, and so forth) to a GroupWise software distribution directory. This can be an existing
software distribution directory or a new software distribution directory.

NOTE: Starting with GroupWise 7, GroupWise Windows client users cannot run the client software
from the software distribution directory. They must install the GroupWise Windows client locally on
their workstations. Users running the GroupWise client from their local drives can continue to run
the local GroupWise client until you prompt them to update to GroupWise 7.

13.2.2 ConsoleOne

GroupWise 7 is administered through ConsoleOne®, using the version listed in Section 2.1,
“GroupWise Administration Requirements,” on page 21. You can use the same version of
ConsoleOne to administer earlier GroupWise components in your GroupWise system.

IMPORTANT: Earlier versions of ConsoleOne should not be used to administer GroupWise 7
domains, post offices, users, or other GroupWise 7 objects.

ConsoleOne is included on the GroupWise 7 Administrator for NetWare/Windows CD. If necessary,
you can install it at the same time as the other GroupWise software.

Linux users can download ConsoleOne for Linux from the Novell Product Downloads site (http://
download.novell.com) and install it before starting to install GroupWise.

NOTE: Earlier versions of GroupWise required or allowed the use of NetWare® Administrator to
administer your GroupWise system. Currently, NetWare Administrator should only be used if you
still run very early gateways that require it. Otherwise, do not use NetWare Administrator.

13.3 Understanding Domain and Post Office
Database Updates

Functionality enhancements in GroupWise 7 require the GroupWise domain and post office
databases to be updated with new records and fields, similar to the schema extensions that are
required for eDirectory.

You must update the primary domain first so that correct replication of GroupWise 7 information
can take place as you update post offices and secondary domains. After you update the primary
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domain, you can update the primary domain’s post offices or you can update a secondary domain
and its post offices. The following diagram illustrates this update sequence.

Figure 13-1 Update Must Occur in the Following Order: 1) Primary Domain, 2) Primary Domain's Post Offices or
Secondary Domain, 3) Secondary Domain's Post Offices

@ Primary Domain @ Secondary Domain
/%\ }‘i
® S B R S

@ Post Post Post 9 Post Post
Office Office Office Office Office

To update a domain database, you run the GroupWise 7 Message Transfer Agent (MTA) against it.
The first time the GroupWise 7 MTA runs against a domain, it rebuilds the domain database
(wpdomain.db) so the database includes the records required for new GroupWise 7 information.
The MTA uses a new domain dictionary file (gwdom. dc) to rebuild the database for use with
GroupWise 7.

Likewise, to update a post office database, you run the GroupWise 7 Post Office Agent (POA)
against it. The first time the GroupWise 7 POA runs against the post office, it rebuilds the post office
database (wphost . db) so the database includes the new records required for GroupWise 7
information. The POA uses a new post office dictionary file (gwpo . dc), which it requests from the
MTA, to rebuild the database for use with GroupWise 7. A user cannot run a GroupWise 7 client
until his or her post office has been updated.

IMPORTANT: Before you update a secondary domain, you must wait until the update to the
primary domain has run to completion. Before you update a post office, you must wait until the
update to its domain has run to completion. Updating a large domain database can take 20 minutes
or more. If you do not wait until the update runs to completion, you might encounter database
versioning discrepancies. If such discrepancies occur, see “MTA Fails to Update the Domain
Database Version” and “POA Fails to Update the Post Office Database Version” in “Strategies for
Agent Problems” in GroupWise 7 Troubleshooting 2: Solutions to Common Problems (http://
www.novell.com/documentation/gw?7).

13.4 Understanding GroupWise Client Updates

After a post office is updated to version 7, users can run the GroupWise 7 Windows client or Cross-
Platform client on workstations listed in Section 2.2, “GroupWise Client Requirements,” on

page 22. If necessary, they can also continue to run their older GroupWise clients, but they will not
have GroupWise 7 functionality.

IMPORTANT: Users who need to proxy into other users’ mailboxes should not update to the
GroupWise 7 clients until the proxy users’ post office has been updated to version 7. GroupWise 7
client users cannot access the proxy into users’ mailboxes that have not been updated to GroupWise
7.

For a list of new features in the GroupWise 7 client, see Chapter 12, “What’s New in GroupWise 7,”
on page 219.
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For client update instructions, see Section 15.4, “Updating Users’ GroupWise Clients,” on page 259.

13.5 Understanding Internet Agent Updates

The GroupWise 7 Internet Agent is fully functional only when running against GroupWise 7
domains and post offices. If you run it against a GroupWise 5.x or 6.x domain or post office, users on
GroupWise 5.x and 6.x post offices can send and receive Internet messages (SMTP support), but
cannot use POP3 and IMAP4 clients to access their mailboxes.

The GroupWise 5.x/6.x Internet Agent can run against a GroupWise 7 domain and post office, which
means that you can continue to use it until all domains and post offices are updated to version 7.

For a list of new features in the GroupWise 7 Internet Agent, see Chapter 12, “What’s New in
GroupWise 7,” on page 219. If you are updating from GroupWise 7 to Support Pack 1 or later, see
Section 12.5.15, “Consolidated Configuration Information (v7.0.1),” on page 237 for important
changes to where Internet Agent configuration information is stored.

For Internet Agent update instructions, see Chapter 14, “Preparing Your GroupWise System for
Update,” on page 251.

13.6 Understanding WebAccess Updates

As you plan how to update GroupWise WebAccess, you need to consider both the WebAccess Agent
and the WebAccess Application on the Web server.

» Section 13.6.1, “WebAccess Agent,” on page 248
» Section 13.6.2, “WebAccess Application on the Web Server,” on page 249

For a list of new features in GroupWise 7 WebAccess, see Chapter 12, “What’s New in GroupWise
7,” on page 219.

For WebAccess update instructions, see Chapter 14, “Preparing Your GroupWise System for
Update,” on page 251.

13.6.1 WebAccess Agent

The GroupWise 7 WebAccess Agent cannot access earlier (pre-GroupWise 7) domains and post
offices. In addition, WebAccess Agents older than version GroupWise 5.5 Enhancement Pack SP3
cannot access GroupWise 7 domains and post offices.

Therefore, to continue to provide WebAccess service to users while you are updating your system,
you need to:

» Update the WebAccess Agent at the same time you update its domain and post offices. This
keeps the WebAccess Agent version synchronized with the domain and post office version.

 If you have multiple domains or post offices that will be updated over a long period of time,
install the GroupWise 7 WebAccess Agent in a GroupWise 7 domain to service users on
GroupWise 7 post offices. Keep your current WebAccess Agent, installed in a GroupWise
domain that supports it, to service users on post offices where earlier GroupWise versions are
still running.
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13.6.2 WebAccess Application on the Web Server

The GroupWise WebAccess Agent can communicate with the GroupWise 5.5 or newer WebAccess
Applications on your Web server. If you have GroupWise 5.5 or later, you can update your
WebAccess Agent independent of the WebAccess components on the Web server.

The GroupWise 7 WebAccess Agent cannot communicate with pre-5.5 Web server components. In
this case, you need to update the WebAccess Application on your Web server at the same time you
update the WebAccess Agent.

13.7 Understanding Monitor Updates

GroupWise Monitor is not dependent on any other GroupWise agents, so it can be updated at any
time.

For a list of changes and new features in GroupWise 7 Monitor, see Chapter 12, “What’s New in
GroupWise 7,” on page 219.

For Monitor update instructions, see Chapter 14, “Preparing Your GroupWise System for Update,”
on page 251.

13.8 Understanding GroupWise Gateway
Compatibility

There are no known issues with using GroupWise gateways with GroupWise 7.
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Preparing Your GroupWise
System for Update

To prepare your Novell® GroupWise® system to be updated to version 7, complete the following
tasks:

* Validate your domain and post office databases to make sure that there are no physical
inconsistencies with the database. If problems exist, you should recover or rebuild the database.
For information about validating, recovering, or rebuilding a database, see the documentation
for your GroupWise version at the Novell Documentation Web site (http://www.novell.com/
documentation).

» Back up the domain or post office immediately before updating it. For information about
backing up your GroupWise databases, see the documentation for your GroupWise version at
the Novell Documentation Web site (http://www.novell.com/documentation).

* Collect the information about your GroupWise system that the various Installation programs
prompt you for as your update the GroupWise software. If you are not completely familiar with
all aspects of your GroupWise system, you might find it helpful to record the information on
the worksheets provided for an initial installation:

 Section 3.5, “Basic GroupWise System Worksheet,” on page 73 (includes administration,
domain, post office, and agent information)

* Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 100
* Section 5.6, “GroupWise WebAccess Installation Worksheet,” on page 132

» Section 6.6, “GroupWise Monitor Installation Worksheet,” on page 157

» Section 7.6, “GroupWise Agent Installation Worksheet,” on page 199
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Updating Your GroupWise 6.x
System to Version 7

The following sections provides step-by-step instructions for updating your Novell® GroupWise®
6.x system to GroupWise 7. Before beginning, make sure you have reviewed Chapter 13,
“Understanding the Update Process,” on page 245 and Chapter 14, “Preparing Your GroupWise
System for Update,” on page 251.

The update process described in this section is generalized to apply to all GroupWise platforms
(NetWare®, Linux, and Windows). Platform-specific cross-references are provided as needed.

Section 15.1, “Installing the GroupWise 7 Software,” on page 253
Section 15.2, “Updating the Primary Domain,” on page 256

Section 15.3, “Updating Post Offices,” on page 257

Section 15.4, “Updating Users’ GroupWise Clients,” on page 259
Section 15.5, “Updating Secondary Domains,” on page 261

Section 15.6, “Updating the GroupWise Internet Agent,” on page 261
Section 15.7, “Updating GroupWise WebAccess,” on page 261
Section 15.8, “Updating GroupWise Monitor,” on page 262

15.1 Installing the GroupWise 7 Software

To start the GroupWise Installation program:

1

2
3

Log in as an Admin equivalent to the Novell eDirectory™ tree where you are installing
GroupWise.

Insert the GroupWise 7 Administrator CD for your platform into the CD drive.

Run the GroupWise Installation program.

Linux: Run install at the root of the CD.

Windows: Run setup.exe at the root of the CD.
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» GroupWise =o)x]
e
Novell. GroupWise. N

View the Readme Displays a text file with important information you should read before installing.

. , Displays a high-level checklist of system requirements and installation steps to guide you
View the Quick Start through setting up your GroupWise system.

Displays overview and task information (in .PDF format) that will help you plan, install, and
View the Installation Guide update a GroupWise system, as well as install additional comy nts such as Grouy
WebAccess and GroupWise Internet Agent.

Creat dat L: the Grouy ion and Setup Advisors. These advisors step you
Lreate or update a through the creation of anew GroupWise system or the updating of an existing GroupWise
GroupWise system system.
Displays the GroupWise comy its you can individually install once you've created a
Install Products GroupWise system.
Visit the Novell GroupWise Launches your Web browser to display GroupWise information located on the Novell Web
Web Site site. (httpziwww.novell.com/productsigroupwise).

4 Click Create or Update a GroupWise System, then click Yes to accept the license agreement and
display the Welcome to GroupWise Install dialog box.

GroupWise Installation ] |

Welcome to GroupWise Install

N ove " Install does the following:

® Helps vou plan your spestem

& Ensures that eDirectory is extended to work with
Groupise

Updates Consolelne

Installz Group'ise Administrator files for
Conzole0ne

i

Setz up the Grouptw/ize software distibution
directory

& Runs Console0ne with the Setup Advisor lo
help pou configure pour Groupwise spstem if
necessary

< Back I Mext > I Exit
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5 Click Next until you reach the Administration Options dialog box.

GroupWise Installation - |E| 5'
Administration Options

N ove " “T'ou may create or update a GroupWWise system, or
‘ perform other administrative tagks.

[V Create a new system or update an esisting system

¥ [stall admiristration files

‘.IQ ¥ Copy files to a software distibution diectan,
.

s

Installation Guide: < Back. I Mext > I Exit |

6 Make sure that Create a New System or Update an Existing System is selected, then click Next

7 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet. Not all prompts appear on all platforms

Item 1: Select Languages

Item 2: ConsoleOne Path

Item 3: Software Distribution Directory
Item 4: Select Software

When you have provided this information, the Installation Advisor is ready to install the
GroupWise administrative software.

GroupWise Installation ] |

Ready to Install

Click Install to copy Groupise files to your spstem.
Novell. PeRE o

1

Installation Guide: < Back Irstall Exit
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8 Click Install, then follow the prompts until you reach the Determine Next Step dialog box.

GroupWise Installation : =1=]=|
Determine Next Step

N ove "‘ Groupwise software has been successfully installed

Install will nows guide you through the remaining
steps to complete the Groupttise system

caonfiguration.
[
\{:-
| €
. Are you
-F * Updating an existing Groupiise system?

"~ Creating a hew Grouphwise system?

Installation Guide: < Back. I Mext > I Exit |

9 Click Updating an Existing GroupWise System, then click Next to display the Update
GroupWise System dialog box.

8 [=]

GroupWise Installation 3
Update GroupWise System

To update an existing GroupgWise system, you must
N ove "‘ perform the fallowing steps in order.

1. Click Update to update all agents in the primary

domain. Always run the MTA to update the domain
database first and then run the POAs to update the

‘_:._:— post office databases.
Lo~ 2. Alter verifying that the primary domain has been
: updated successfully, update all agents in each
1 secondary domain by running install exe from the
| agents directory on the CD or software distribution
directory.

3. Users can update the Group\fize client after
you've updated their post office.

ﬁ Enter the location of the primary domain:

[ ]

Inztallation Guide < Back I Update I Finigh |

10 Continue with the next section, Updating the Primary Domain.

15.2 Updating the Primary Domain

To update the primary domain, you need to install and start the GroupWise 7 MTA. The MTA uses
the new domain dictionary file (gwdom . dc) to update the domain database to version 7.

IMPORTANT: The MTA cannot be running while you update the MTA software files.

To install and start the GroupWise 7 MTA:

1 Follow the instructions for your platform to start the Agent Installation program:
NetWare: To install the MTA to a NetWare server, make sure the workstation has access to
both the primary domain directory and the NetWare server where you want to

install the MTA, enter the path to the primary domain directory, then click Update
to launch the Agent Installation program.
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Linux: To install the MTA on a Linux server, click Finish, then click Install Products >
Install GroupWise Agents to start the Agent Installation program.

Windows: To install the MTA to a Windows server, click Finish, go to the Windows server,
ensure that you have access to the primary domain directory, then start the Agent
Installation program (install.exe). The Agent Installation program is located in
the \agents directory in the GroupWise 7 software distribution directory or on the
GroupWise 7 Administrator for NetWare/Windows CD.

2 Follow the instructions for your platform to install the GroupWise 7 MTA to your primary
domain.

* “NetWare: Installing and Starting the GroupWise Agents” on page 53
* “Installing and Starting the Linux GroupWise Agents” on page 68
* “Windows: Installing and Starting the GroupWise Agents” on page 55

3 Start the MTA for the primary domain so that the primary domain database (wpdomain.db) is
updated to GroupWise 7.

4 Before you update post offices in the primary domain or any secondary domains in your
system, make sure that the domain database has been updated by checking the Database
Version field on the Identification property page of the Domain object in ConsoleOne.

5 To update post offices in the domain, continue with the next section, Updating Post Offices.
or

To update other domains, skip to Section 15.5, “Updating Secondary Domains,” on page 261.

15.3 Updating Post Offices

To update a post office, you need to install the GroupWise 7 POA and run it against the post office.
The POA uses a new 7 version of the post office dictionary file (gwpo . dc) to update the post office
database to version 7.

NetWare After you've installed the NetWare or Windows POA, you might need to manually copy

and the new GroupWise Windows client views from the software distribution directory to the

Windows: post office directory. This could be necessary if the Agent Installation program did not
have access to the software distribution directory during the installation process or if
you update your agent software before you update your software distribution directory
with the latest Windows client software.

» Section 15.3.1, “Installing and Starting the POA,” on page 257
» Section 15.3.2, “Copying the GroupWise Views to the Post Office Directory,” on page 258

15.3.1 Installing and Starting the POA

The POA cannot be running while you update it. Users who connect to the post office via client/
server (TCP/IP) cannot access the post office while the POA is shut down.

IMPORTANT: The MTA for the domain that the post office belongs to should be updated and
running before you install and start the POA.

To install and start the POA:
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1 Start the Agent Installation program.

NetWare: To install the POA to a NetWare server, make sure the workstation has access to
both the post office directory and the NetWare server where you want to install the
POA.

If you are installing from the GroupWise 7 Administrator for NetWare/Windows
CD, insert the CD in the CD drive, run setup.exe at the root of the CD to start
the GroupWise Installation program, then click Install Components > Install
GroupWise Agents.

If you are installing from the software distribution directory, run install.exe in
the \agents subdirectory to start the Agent Installation program.

Linux: Run install at the root of the GroupWise 7 Administrator for Linux CD for Linux or
at the root of the software distribution directory to start the GroupWise Installation
program.

Windows: If you are installing from the GroupWise 7 Administrator for NetWare/Windows

CD, insert the CD in the CD drive, run setup.exe at the root of the CD to start
the GroupWise Installation program, then click Install Components > Install
GroupWise Agents.

If you are installing from the software distribution directory, run install.exe in
the \agents subdirectory.

To streamline the update process on NetWare and Windows, you can run the Agent Installation
program (agents\install.exe) with the /copyonly startup switch, which copies the updated agent
software files but does not perform any other agent configuration. On Linux, the Installation
program offers separate file copy and configuration options to streamline the update process.

2 Follow the instructions for your platform to install the GroupWise 7 POA to each post office in
your GroupWise system.

* “NetWare: Installing and Starting the GroupWise Agents” on page 53
+ “Installing and Starting the Linux GroupWise Agents” on page 68
* “Windows: Installing and Starting the GroupWise Agents” on page 55

3 Start the POA for the post office so that the post office database (wphost.db) is updated to
GroupWise 7.

4 Before you run GroupWise 7 clients against the post office, make sure that the post office
database has been updated by checking the Database Version field on the Identification
property page of the Post Office object in ConsoleOne.

5 Continue with Copying the GroupWise Views to the Post Office Directory.

15.3.2 Copying the GroupWise Views to the Post Office
Directory

GroupWise 7 includes new views for the GroupWise Windows client. When the POA starts, it
updates the post office database and also attempts to update the client views in the post office

directory. To do so, it requires access to the software distribution directory. If it doesn’t have access,
you must manually copy the views.
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You can check whether or not the POA was able to update the views by verifying the existence of
the us02*.vew filesinthe x: \post office\ofviews\win directory, where x:\po is the
path to the post office directory.

If the us02* . vew files do not exist or have older dates, copy all files from
z:\software\client\win32\ofviews\win

to

x:\post officel\ofviews\win

where z:\software is the path to the software distribution directory and x:\post_office is the path to
the post office directory.

You can also perform this task in ConsoleOne®. See “Refreshing the Client View Files in the Post
Office” in “Post Offices” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw?7).

15.4 Updating Users’ GroupWise Clients

After a post office is updated to version 7, users who have accounts in that post office can start using
the GroupWise 7 clients. Starting with GroupWise 7, uses cannot run the GroupWise client software
from the software distribution directory, but the software is still installed to users’ workstations from
software distribution directories. Users might access a software distribution directory and run the
installations themselves, or you might configure automatic updates for them.

When you used the Installation Advisor as described in Section 15.1, “Installing the GroupWise 7
Software,” on page 253, you had the opportunity to update one software distribution directory. To
fully implement GroupWise 7 throughout your GroupWise system, you must update all of your
software distribution directories.

IMPORTANT: Before you update a software distribution directory, make sure all post offices that
use the software distribution directory have been updated. The GroupWise 7 client cannot access a
post office that still uses an earlier version of GroupWise. Users who update to the GroupWise 7
client before their post office has been updated are locked out of the post office.

To update a GroupWise software distribution directory to GroupWise 7:

1 Make sure you have Read, Write, Create, Erase, Modify, and File Scan rights (or equivalent
rights) in an existing GroupWise 7 software distribution directory and in the software
distribution directory you are updating to version 7.

or

If you still have access to the GroupWise 7 Administrator CD for your platform, you can use it
instead of an existing GroupWise 7 software distribution directory.
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2 In ConsoleOne, click Tools > GroupWise System Operations > Software Directory
Management.

Snftware Distribution Directory Management

Software Distribution Directories: Close
Natne | UNC Path [

Groupiiize 6.5 Software WPRY-GWISY Sigrpwiseisotiwares i Create |

GroupWise 7 Software NPRYV-GW sy s prvizeizottware T

il
Delete

Upelste

LR

Help

3 Select the software distribution directory you want to update, then click Update to display the
Update Software Distribution Directory dialog box.

¥ update Software Distribution Directory x|
G D o
¥ Saftware Distribution Directary: w
IGroup\Mse 7 Software LI Help
£ Pathi

I™ Foree auto-update check by GroupWize componsnts

4 Click Update by Copying From.

5 Click Software Distribution Directory, then select the GroupWise 7 software distribution
directory.
or

If the GroupWise 7 software distribution directory is not listed, click Path, then enter the path
to the directory. You can also use this option to update the software directly from the
GroupWise 7 Administrator CD for your platform.

¥ update Software Distribution Directory x|
F# g o o |
{* Software Distribution Directory: Cancel
IGruup\Mss 7 Software LI Hela
" Path:

I Foree auto-update check by Groupiiizse compongnts

The Force Auto-Update Check by GroupWise Components option is automatically selected.
This causes the GroupWise client to check for a new version; if a new version is found, the
client then prompts users to update the next time they start the client.

IMPORTANT: If the software distribution directory is already updated to version 7 and you
are now trying to force users to update to the GroupWise 7 client, you should select only the
Force Auto-Update Check by GroupWise Components option.
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6 Click OK to copy the files.

IMPORTANT: When you turn on auto-update (the Force Auto-Update Check by GroupWise
Components option), a flag is set in each post office database. This flag instructs the
GroupWise client to check for updated software. GroupWise clients using direct access mode
(mapped or UNC path) read this new setting in the post office database and automatically
check for updated software. However, GroupWise clients running in client/server mode do not
access the post office database directly; instead, the Post Office Agent accesses the post office
database for them. For the Post Office Agent to read the new auto-update setting, you need to
restart the Post Office Agent. Only after the POA restarts will GroupWise clients running in
client/server mode check for updated software.

15.5 Updating Secondary Domains

After you have updated the primary domain, you can update any secondary domains in your system.
To do so, follow the same process you used to update the primary domain, its post offices, and users.

To streamline the update process on NetWare and Windows, you can run the Agent Installation
program (agents\install.exe) with the /copyonly startup switch, which copies the updated agent
software files but does not perform any other agent configuration. On Linux, the Installation
program offers separate file copy and configuration options to streamline the update process.

IMPORTANT: The MTA for the domain that the secondary domain links to should be updated and
running before you update the secondary domain.

15.6 Updating the GroupWise Internet Agent

After you’ve updated your domains and post offices, you can update the Internet Agent. For
information about update issues you should consider, see Section 13.5, “Understanding Internet
Agent Updates,” on page 248.

To streamline the update process on NetWare and Windows, you can run the Internet Agent
Installation program (internet\gwia\install.exe) with the /copyonly startup switch, which copies the
updated Internet Agent software files but does not perform any other Internet Agent configuration.
On Linux, the Installation program offers separate file copy and configuration options to streamline
the update process

For information about installing the GroupWise 7 Internet Agent, see Chapter 4, “Installing the
GroupWise Internet Agent,” on page 79.

IMPORTANT: If you are updating from GroupWise 7 to Support Pack 1 or later, see Section
12.5.15, “Consolidated Configuration Information (v7.0.1),” on page 237 for important changes to
where Internet Agent configuration information is stored.

15.7 Updating GroupWise WebAccess

After you’ve updated your domains and post offices, you can update GroupWise WebAccess. For
information about update issues you should consider, see Section 13.6, “Understanding WebAccess
Updates,” on page 248.
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For information about installing GroupWise 7 WebAccess, see Chapter 5, “Installing GroupWise
WebAccess,” on page 103.

IMPORTANT: After you have updated the WebAccess software, notify your WebAccess client
users that they should clear their browser caches before logging into their mailboxes with the
updated WebAccess client. If old WebAccess files are pulled from users’ browser caches, they might
not be compatible with the updated files pulled from the Web server. The results can be
unpredictable and undesirable.

15.8 Updating GroupWise Monitor

You can update GroupWise Monitor at any time. For information about installing GroupWise 7
Monitor, see Chapter 6, “Installing GroupWise Monitor,” on page 139.
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Updating Your GroupWise 5.x
System to Version 7

The process and procedures for updating a Novell® GroupWise® 5.x system to version 7 are the
same as when updating a GroupWise 6.x system to version 7. Refer to the following sections for
instructions:

* Chapter 13, “Understanding the Update Process,” on page 245

» Chapter 14, “Preparing Your GroupWise System for Update,” on page 251

» Chapter 15, “Updating Your GroupWise 6.x System to Version 7,” on page 253

What’s New Since Your GroupWise 5.x Version

The GroupWise features and functionality that are new to you depend on the version of GroupWise
5 that you are updating from (5, 5.1, 5.2, 5.5, 5.5 Enhancement Pack). For example, if you are
updating from GroupWise 5.2, the new features and functionality added in versions 5.5, 5.5
Enhancement Pack, 6, 6.5, and 7 are all new. If you are updating from GroupWise 5.5 Enhancement
Pack, only the version 6, 6.5, and 7 features are new.

Chapter 12, “What’s New in GroupWise 7,” on page 219 includes only the changes made since
version 6.5. For changes made in previous versions, refer to the following:

* Version 5.2 to 5.5: What’s New in GroupWise 5.5 (http://www.novell.com/documentation/lg/
gw55/gw55updt/data/a4dx2i3.html)

* Version 5.5 to 5.5 Enhancement Pack (EP): GroupWise 5.5 Enhancement Pack Getting
Started (http://www.novell.com/documentation/lg/gw55ep/pdfdoc/gw55ep.pdf)

* Version 5.5 EP to 6: What’s New in GroupWise 6 (http://www.novell.com/documentation/
gw6/gw6 _install/data/aady513.html)

* Version 6 to 6.5: What’s New in GroupWise 6.5 (http://www.novell.com/documentation/
gw65/gw65_install/data/aady513.html)

GroupWise 5.2 Administration Agent

WARNING: Beginning with GroupWise 5.5, the Administration Agent’s functionality was moved
into the Message Transfer Agent (MTA) and the Post Office Agent (POA). If you are updating a
GroupWise 5, 5.1, or 5.2 system, you need to make sure that you do not run the Administration
Agent against the domain after you’ve started the GroupWise 7 MTA. Doing so can result in the loss
of GroupWise 7 information.

Updating Your GroupWise 5.x System to Version 7 263


http://www.novell.com/documentation/lg/gw55/gw55updt/data/a4dx2i3.html
http://www.novell.com/documentation/lg/gw55ep/pdfdoc/gw55ep.pdf
http://www.novell.com/documentation/lg/gw55ep/pdfdoc/gw55ep.pdf
http://www.novell.com/documentation/gw6/gw6_install/data/aady5l3.html
http://www.novell.com/documentation/gw65/gw65_install/data/aady5l3.html

264 GroupWise 7 Installation Guide



Updating an Evaluation
GroupWise System to a Fully
Licensed System

An evaluation GroupWise® system, available from the Novell® Product Downloads site (http://
download.novell.com/index.jsp), can consist of one domain, two post offices, and as many as five
users in each post office. When you purchase the full GroupWise product, install the GroupWise
Administrator snap-ins to ConsoleOne®. When you begin to administer your evaluation system with
the licensed snap-ins, your evaluation system is converted into a fully licensed system, in which you
can create any number of domains and post offices, along with the number of users for which you
are licensed.
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Migration

This section is designed for those who are moving existing GroupWise® 7 users, post offices, and
domains from NetWare® or Windows to Linux.

IMPORTANT: If you have GroupWise 6.x or 5.x, review Chapter 15, “Updating Your GroupWise
6.x System to Version 7,” on page 253 or Chapter 16, “Updating Your GroupWise 5.x System to
Version 7,” on page 263 to acquaint yourself with the issues involved in updating from one version
of GroupWise to another. You should update your GroupWise system to GroupWise 7 before
migrating it to Linux.

* Section 18, “Transitioning Windows Users to Linux or Macintosh,” on page 269
* Chapter 19, “Transitioning GroupWise Administration to Linux,” on page 271

* Chapter 20, “Migrating a Post Office and Its POA to Linux,” on page 275

* Chapter 21, “Migrating a Domain and Its MTA to Linux,” on page 283
 Chapter 22, “Migrating the Internet Agent to Linux,” on page 289

» Chapter 23, “Migrating WebAccess to Linux,” on page 291

 Chapter 24, “Migrating Monitor to Linux,” on page 297
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Transitioning Windows Users to
Linux or Macintosh

When users move from Windows workstations to Linux or Macintosh, they first need to install the
Cross-Platform client, as described in Section 8.4, “Setting Up the GroupWise Client,” on page 206.
They can then immediately use the Cross-Platform client to connect to their GroupWise®
mailboxes, regardless of whether the mailboxes reside on Linux, NetWare®, or Windows servers.

If users have Caching mailboxes or archives on their Windows workstations, they can simply copy
them to an appropriate location on their Linux or Macintosh workstations, and then update the file
location information in the Cross-Platform client (7ools > Options > Archive Directory and Caching
Mailbox Directory).

NOTE: Remote mode is not currently supported in the Cross-Platform client, so Remote users
should not copy their Remote mailboxes to Linux or Macintosh.

For a comparison of feature availability between the Cross-Platform client and the Windows client,
see “GroupWise Client Comparison” in the GroupWise 7 Client Frequently Asked Questions (FAQ).
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Transitioning GroupWise
Administration to Linux

You migrate your GroupWise® system from NetWare® or Windows to Linux one post office and
domain at a time. During the migration process, your system has domains and post offices on
various platforms. You might use ConsoleOne® on both Windows and Linux to administer domains
and post offices located on any platform.

This section helps you set up the cross-platform connections that enable ConsoleOne to successfully
access GroupWise databases on any platform.

» Section 19.1, “Using Windows ConsoleOne to Access Domains and Post Offices on Linux,” on
page 271

» Section 19.2, “Using Linux ConsoleOne to Access Domains and Post Offices on NetWare or
Windows,” on page 272

» Section 19.3, “Migrating eDirectory to Linux,” on page 273

19.1 Using Windows ConsoleOne to Access
Domains and Post Offices on Linux

In order for you to be able to use ConsoleOne on Windows to administer GroupWise domains, post
offices, and agents that are located on Linux, the Linux servers where the domains, post offices, and
agents are located must be accessible from Windows.

» Section 19.1.1, “Making a Linux Server Visible from Windows,” on page 271

» Section 19.1.2, “Accessing a Domain or Post Office on Linux from Windows ConsoleOne,” on
page 272

19.1.1 Making a Linux Server Visible from Windows

To make a Linux server visible from Windows, you need to configure it so that you can map a drive
to it as if it were a Windows server.
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Table 19-1 Creating a Connection from Windows to Linux

Operating .

System Connection Method

Open Enterprise Use the NetWare Core Protocol™ (NCP™) Server to create an NCP volume on the
Server (OES) Linux server that will be visible from Windows just as a NetWare volume would be.
Linux

On the Linux server, become root, then enter the following command:
ncpcon create volume volume name directory

From a Windows workstation or server where the Novell client is installed, you can
now use the Novell Map Network Drive feature to map a drive to the volume on your
Linux server.

For more information about NCP Server, see the NCP Server Administration Guide
for Linux (http://www.novell.com/documentation/oes/ncp_Ix/data/
h9izvdye.html#h9izvdye).

SUSE Linux Use Samba to create a Windows share on the Linux server that will be visible from
Enterprise Server  Windows just as a directory on another Windows server would be. For instructions
(SLES) on setting up a Samba share, see the SUSE Linux Enterprise Server Administration

and Installation Guide (http://www.novell.com/documentation/sles9/pdfdoc/
sles_9 admin_guide/sles_9 admin_guide.pdf).

From a Windows workstation or server, you can now use the Windows Map
Network Drive feature to map a drive to the directory on your Linux server.

19.1.2 Accessing a Domain or Post Office on Linux from
Windows ConsoleOne

After you have made the Linux server visible from Windows:

1 Map a drive to the domain directory on the Linux server.
2 In Windows ConsoleOne, click Tools > GroupWise System Operations > Select Domain.

3 Browse to and select the domain directory, then click OK.

You can now use Windows ConsoleOne to administer all GroupWise objects that belong to the
domain that is located on Linux.

19.2 Using Linux ConsoleOne to Access
Domains and Post Offices on NetWare or
Windows

In order for you to be able to use ConsoleOne on Linux to administer GroupWise domains, post
offices, and agents that are located on NetWare or Windows, the NetWare or Windows servers where
the domains, post offices, and agents are located must be accessible from Linux.

» Section 19.2.1, “Making a NetWare or Windows Server Visible from Linux,” on page 273

* Section 19.2.2, “Accessing a Domain or Post Office on NetWare or Windows from Linux
ConsoleOne,” on page 273
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19.2.1 Making a NetWare or Windows Server Visible from Linux

To make a NetWare or Windows server visible from Linux, you mount the directory you need to
access as a Linux file system.

Table 19-2 Creating a Connection from Linux to NetWare or Windows

Operatin

g System Connection Method

NetWare: mount -t ncpfs NetWare server full DNS name
/Linux mount location/mount point directory
-0 user=fully qualified username
-0 lipserver=NetWare server full DNS name

A NetWare server full DNS name should have the format of mail2.provo.corporate.com. A
fully qualified username should have the format of Admin.Users.Corporate. A typical Linux
mount location would be /mnt.

Windows: mount -t smbfs //Windows server name/sharename
/Linux mount location/mount point directory
-0 username=Windows username

To use this command, the WINS protocol must be functioning properly on your network. The
specified Windows user must have sufficient rights to access the post office directory.

19.2.2 Accessing a Domain or Post Office on NetWare or
Windows from Linux ConsoleOne

After you have made the NetWare or Windows server visible from Linux:

1 Mount the domain directory to the Linux server.
2 In Linux ConsoleOne, click Tools > GroupWise System Operations > Select Domain.
3 Browse to and select the domain directory, then click OK.

You can now use Linux ConsoleOne to administer all GroupWise objects that belong to the domain
that is located on NetWare or Windows.

19.3 Migrating eDirectory to Linux

ConsoleOne modifies information stored in eDirectory. Novell eDirectory is available on NetWare,
Linux, and Windows. eDirectory can be in use on any of these platforms when you are migrating
your GroupWise system to Linux.

As part of the migration process, you might want to migrate eDirectory to Linux. Step-by-step
instructions for migrating eDirectory to Linux are beyond the scope of the Group Wise Installation
Guide, but the following documentation can provide assistance:

+ If you are migrating to OES Linux, review Consolidating Data to OES Linux and Migrating
Data from NetWare Servers in the Novell Server Consolidation and Migration Toolkit
Administration Guide (http://www.novell.com/documentation/scmt/index.html).
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 For situations not covered in the above guide, the eDirectory migration process includes
installing eDirectory on Linux, creating an eDirectory replica on one or more Linux servers,
and ultimately making one of the Linux replicas the master replica so that you can phase out the
replicas on other platforms. For guidance, see the documentation for your version of
eDirectory:

 eDirectory 8.7.3 (http://www.novell.com/documentation/edir873/index.html)

* eDirectory 8.8 (http://www.novell.com/documentation/edir88/index.html)
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Migrating a Post Office and Its
POA to Linux

Migrating a post office and its POA to Linux includes copying directory structures to Linux,
installing the POA software on Linux, and updating configuration information in ConsoleOne®.

* Section 20.1, “Preparing for the Post Office Migration,” on page 275

* Section 20.2, “Performing the Post Office Migration,” on page 276
 Section 20.3, “Reconfiguring the Post Office in ConsoleOne,” on page 279
 Section 20.4, “Finalizing the Post Office Migration,” on page 280

20.1 Preparing for the Post Office Migration

1 On the Linux server, become root in a terminal window.
2 Check the Linux server for adequate disk space for your backup solution of choice.

If you want to use the GroupWise® Database Copy utility (DBCopy), as described in
“GroupWise Database Copy Utility” in “Databases” in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7), you create a copy of the post office and then
back up the copy, which requires double the post office size in disk space.

If you want to use the GroupWise Target Service Agent (TSAFSGW), as described in “Target
Service Agents” in “Databases” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7), this extra disk space is not required. However, having a
recent complete online backup available can be helpful in a variety of circumstances.

3 Make the Linux server visible from Windows.

This is necessary in order to perform administration tasks from Windows ConsoleOne during
the post office migration process. For Linux server configurations to accomplish this, see
Section 19.1.1, “Making a Linux Server Visible from Windows,” on page 271.

4 Make the NetWare® or Windows server visible from Linux.

This is necessary in order to use the Linux version of the GroupWise Database Copy utility
(DBCopy) to copy the post office directory and its contents to the Linux server. The Linux
version of DBCopy includes switches specialized for the post office migration process. For
mount commands, see Section 19.2.1, “Making a NetWare or Windows Server Visible from
Linux,” on page 273.

5 In a location on the Linux server that is accessible from Windows, create a new directory for
your GroupWise system into which you plan to copy the post office directory. For example:
mkdir gwsystem

6 Install the GroupWise Database Copy utility (DBCopy) as described in “Using DBCopy on

Linux” in “Databases” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw?7).

7 Install GroupWise Check (GWCheck) as described in “Using GWCheck on Linux” in
“Databases” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/
gw7).
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8 Continue with Performing the Post Office Migration.

20.2 Performing the Post Office Migration

In order to reduce the amount of time during which users cannot access their GroupWise mailboxes
during the post office migration process, the post office data is copied twice. During the first copy,
the POA is allowed to continue running and users can continue working. Because users are still
accessing their mailboxes, some files are modified after being copied, thus necessitating the second
copy of the files. For the second copy, the POA is stopped and users cannot access their Online
mailboxes. However, only the modified files are copied, so the second copy procedure completes
much more quickly.

1 Inthe /opt/novell/groupwise/agents/bin directory, use DBCopy to copy the post
office directory from the NetWare or Windows server to the new directory on the Linux server.

./dbcopy -m -f /post office directory /destination directory

The -m switch indicates that DBCopy is being used for migration to Linux. The -f switch
indicates that this is the first pass of the migration process, during which the post office queue
directories (wpcsin and wpcsout) are not copied. The post office directory
variable includes the Linux mount location (for example, /mnt), the mount point directory, and
the full path to the post office directory on the NetWare or Windows server. The
destination_directory variable is the directory you created on the Linux server in Step 5 in the
previous section.

DBCopy creates a log file named mmddgwbk . nnn. The first 4 characters represent the date.
A three-digit extension allows for multiple log files created on the same day. The log file is
created at the root of the destination post office directory. Include the -v switch in the dbcopy
command to enable verbose logging for the post office migration.

DBCopy is typically used for backing up your GroupWise system, but when you use the -m
switch to migrate a post office to Linux, it changes directory names to lowercase as required on
Linux and copies the message queue directories as well as the GroupWise databases in the post
office. For more information about DBCopy, see “GroupWise Database Copy Utility” in
“Databases” in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/
gw7).

This initial copy operation might require a substantial amount of time, but users are still able to
access their mailboxes. Use the fastest network connection available for this copy operation.

2 If your Linux environment includes the X Window System, run the GroupWise Installation
program to install the Linux POA for the post office, as described in “Installing the GroupWise
Agents on Linux” on page 177.

or

If the X Window System is not available, run the text-based GroupWise Installation program,
as described in “Installing the GroupWise Agents Using the Text-Based Installation Program”
on page 179.

3 Change to the /opt/novell/groupwise/agents/bin directory.

4 If the X Window System is available, enter the following command to start the Linux POA to
verify that it runs for the post office in the new location:

./gwpoa --show --home /post office directory --noconfig
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The --show switch starts the POA with a user interface. The --home switch provides the
location of the post office. The --noconfig switch prevents the POA from reading configuration
information from eDirectory™,; the current eDirectory information is obsolete because the post
office has been migrated. For purposes of this initial test, the POA starts with default
configuration settings, including using any available IP address.

You should see the POA server console described in “Starting the Linux Agents with a User
Interface” on page 179. If the POA server console does not appear, review the preceding steps
to verify that all steps have been followed. For additional assistance, see “Post Office Agent
Problems” in “Strategies for Agent Problems” in GroupWise 7 Troubleshooting 2: Solutions to
Common Problems (http.//www.novell.com/documentation/gw7).

or
If the X Window system is not available:

4a If LDAP authentication is not in use, enter the following command to start the Linux POA
to verify that it runs for the post office in the new location:

./gwpoa —--home /post office directory --noconfig
-—ip POA server IP address --httpport 7181

The --home switch provides the location of the post office. The --noconfig switch prevents
the POA from reading configuration information from eDirectory; the current eDirectory
information is obsolete because the post office has been migrated. The --ip switch
provides the IP address of the server where the POA 1is running. The -httpport switch
enables the POA Web console and provides the port number.

or
If LDAP authentication is enabled for the post office, enter the following command:

./gwpoa --home /post office directory --noconfig
-—-ip POA server IP address --httpport 7181
--ldapipaddr LDAP server IP address
--ldapport LDAP port (if not the default of 389)

The --ldapipaddr switch provides the location of the LDAP server. The --1dapport switch
is required only if the LDAP server communicates on a port other than the default of 389.

IMPORTANT: To simplify this test, do not use an SSL connection to the LDAP server.

4b Open a Web browser and display the following URL:
http://POA server IP address:7181

You should see the POA Web console described in “Monitoring the Linux GroupWise
Agents from Your Web Browser” on page 183. If the POA Web console does not appear,
review the preceding steps to verify that all steps have been followed. For additional
assistance, see “Post Office Agent Problems” in “Strategies for Agent Problems” in
GroupWise 7 Troubleshooting 2. Solutions to Common Problems (http://www.novell.com/
documentation/gw?7).

5 If you have access to a GroupWise mailbox on the post office you have migrated, start the
GroupWise client to further verify the functioning of the POA.

6 After verifying that the Linux POA runs successfully for the post office in the new location on
Linux, stop the Linux POA, as described in “Stopping the Linux GroupWise Agents” on
page 190.

7 Ifyou are using SSL, create a new certificate file (filename.crt) and a new key file
(filename.key) forthe Linux server and place them in the /opt/novell/
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groupwise/agents/bin directory, which is the default location where the POA looks for
certificate files.

For instructions on creating certificate and key files, see “Server Certificates and SSL
Encryption” in “Security Administration” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw7)

8 Ifyou are using LDAP authentication, copy the public root certificate file (fi lename.der)
from the LDAP server to the /opt/novell/groupwise/agents/bin directory.

9 Ifyou are migrating a post office that has a library with a document storage area located outside
the post office directory structure, decide how to handle the document storage area:

You have two alternatives for accessing the document storage area from the post office on
Linux:

¢ Mount the document storage area: You can leave the document storage area on the
NetWare or Windows server. To provide access, permanently mount the storage area
directory to the Linux server where the post office is located, using the mount command
provided in Section 19.2.1, “Making a NetWare or Windows Server Visible from Linux,”
on page 273.

* Migrate the document storage area: If you want to eliminate the NetWare or Windows
server, you can migrate the document storage area to a convenient location on the Linux
server. This also eliminates the need for the permanently mounted file system.

Use the following DBCopy command to migrate the document storage area to the Linux
server:

./dbopy -b /storage area directory /destination directory

The -b switch indicates that DBCopy is being used to migrate a documentation storage
area containing document BLOB (binary large object) files. The

storage area directory variable includes the Linux mount location (for
example, /mnt), the mount point directory, and the full path to the document storage area.
The destination directory variable is the location on the Linux server where you
want to migrate the document storage area.

DBCopy creates a log file named mmddgwlbk . nnn. The first 4 characters represent the

date. A three-digit extension allows for multiple log files created on the same day. The log
file is created at the root of the destination document storage area directory. Include the -v
switch in the dbcopy command to enable verbose logging for the storage area migration.

10 Notify users that they must exit the GroupWise client unless they are running in Caching mode.

Users in Caching mode do not need access to the post office in order to continue using
GroupWise. However, they cannot send and receive new messages while the POA is not
running.

11 Continue with Reconfiguring the Post Office in ConsoleOne.

20.3 Reconfiguring the Post Office in
ConsoleOne

If the connection between Linux and Windows is set up correctly, as described in Step 3 in Section
20.1, “Preparing for the Post Office Migration,” on page 275, you can use Windows ConsoleOne to
perform the reconfiguration of the post office. You can also use Linux ConsoleOne if desired.

1 In ConsoleOne, disable logins to the post office:
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1a
1b
1c

Browse to and right-click the Post Office object, then click Properties.
Click GroupWise > Client Access Settings.
Select Disable Logins, then click Apply to save the setting.

2 Update the location information for the post office:

2a
2b

2c

Display the Identification property page of the Post Office object.

In the UNC Path field, change the path to the location on the Linux server where you
copied the post office. For example:

\\linuxsvr3\gwsystem\research

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a
Linux path with front slashes in the UNC Path field, because backslashes are expected.

Click OK to save the new path information for the post office.

3 Update the configuration information for the POA:

3a
3b
3c
3d
3e

3f

39

3h

Browse to and right-click the POA object for the post office, then click Properties.
Click GroupWise > Identification.

In the Platform field, make sure that Linux is selected.

Display the Network Address property page of the POA object.

In the TCP/IP Address field, specify the IP address of the Linux server.

Display the Log Settings property page of the POA object.

Make sure that the Log File Path field is empty so that the POA on Linux creates its log
files in the default location (/var/log/novell/groupwise/
post office name.poa) on the Linux server.

Click OK to save the new configuration information for the POA.

4 If you are using SSL, update the location for the certificate and key files:

4a
4b

4c

Display the SSL Settings property page of the POA object.

Browse to and select the certificate file and the key file that you created for the Linux
server in Step 7 in Section 20.2, “Performing the Post Office Migration,” on page 276.

Click OK to save the SSL information for the POA.

5 If you migrated a document storage area to the Linux server in Step 9 in Section 20.2,
“Performing the Post Office Migration,” on page 276, update the location of the document
storage area:

5a
5b
5c
5d

Se

Browse to and right-click the Library object, then click Properties.
Click GroupWise > Storage Areas.
Select the storage area that you have migrated, then click Edit.

In the Linux Path field, provide the full path to the storage area from the point of view of
the POA running on the Linux server.

Click OK twice to save the storage area information.

6 Check the status of the link between the POA still running on NetWare or Windows and the
MTA it communicates with:

6a

At the MTA server console, use Options > Configuration Status.

or
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At the MTA Web console, look on the Links page.

When the ConsoleOne updates that you have just made, including the post office location
change, have been processed by the MTA, the link changes to Closed. The status must
show as Closed before you finalize the migration.

7 Continue with Finalizing the Post Office Migration.

20.4 Finalizing the Post Office Migration

1 On the NetWare or Windows server, stop the POA for the post office. If multiple POAs are
currently running for the post office, stop all POAs.

GroupWise users can no longer access their Online mailboxes.
2 On the Linux server, run DBCopy again to copy the post office:

./dbcopy -m -i mm-dd-yyyy -s /post office directory
/destination directory

When you run DBCopy the second time and include the -i switch with the date of the initial
copy, it copies only files that have been modified since the initial copy, like an incremental
backup. The -s switch indicates that this is the second pass of the migration process, during
which the post office queue directories (wpcsin and wpcsout) are copied. The second
DBCopy process should be substantially shorter than the first one.

3 If you migrated a document storage area to the Linux server in Step 9 in Section 20.2,
“Performing the Post Office Migration,” on page 276, run DBCopy again to copy the document
storage area with the files modified since the first copy:

./dbcopy -b /storage area directory /destination directory

4 Run the standalone GroupWise Check utility (GWCheck), installed in Step 7 in Section 20.1,
“Preparing for the Post Office Migration,” on page 275, with the storelowercase support
option to convert the filenames and directory names stored inside GroupWise databases in the
post office to lowercase:

4a In the Database Type box, select Post Office.

4b Browse to and select the post office database in its new location, then specify the post
office name.

4c In the Object Type box, select Post Office.
4d In the Support Options field on the Misc tab, specify storelowercase.
4e Click Run to run GWCheck.

If you need to run GWCheck in a text-only environment, see “Using Text-Based
GWCheck (gwcheckt)” in “Databases” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw7) for additional instructions.

5 If your GroupWise system includes an Internet Agent that is used for POP and IMAP e-mail
clients, check the link between the Internet Agent and the post office:

5a In ConsoleOne, right-click the Internet Agent object, then click Properties.
5b Click Post Office Links.

5¢c Make sure that the link shows the correct IP address where the Linux POA for the
migrated post office is now running.

6 If your GroupWise system includes the WebAccess Agent, check the link between the
WebAccess Agent and the migrated post office:
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6a In ConsoleOne, right-click the WebAccess Agent object, then click Properties.
6b Click Post Office Links.

6¢c Make sure that the link shows the correct IP address where the Linux POA for the
migrated post office is now running.

Start the Linux POA with or without a user interface, as described in “Starting the Linux
Agents with a User Interface” on page 179 or “Starting the Linux GroupWise Agents as
Daemons” on page 182.

If necessary, provide GroupWise users with the new IP address where the Linux POA is now
running, so that they can start GroupWise again and access their Online mailboxes on the Linux
server.

If you are running a GroupWise name server, as described in “Simplifying Client/Server
Access with a GroupWise Name Server” in “Post Office Agent” in the GroupWise 7
Administration Guide (http://www.novell.com/documentation/gw7), users are automatically
redirected to the new IP address when they start GroupWise.

When the Linux POA is running smoothly for the new post office location, delete the old post
office directory structure from the NetWare or Windows server.

If you migrated a document storage area to the Linux server in Step 9 in Section 20.2,
“Performing the Post Office Migration,” on page 276, delete the old document storage are on
the NetWare or Windows server.

Set up a backup procedure for the post office in its new location on Linux, as described in
“GroupWise Database Copy Utility” or “Target Service Agents” in “Databases” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

If desired, uninstall the POA software to reclaim disk space on the NetWare or Windows server.
See “Uninstalling the NetWare GroupWise Agents” on page 176 or “Uninstalling the Windows
GroupWise Agents” on page 198.
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Migrating a Domain and Its MTA
to Linux

Migrating a domain and its MTA to Linux includes copying directory structures to Linux, installing
the MTA software on Linux, and updating configuration information in ConsoleOne®.

* Section 21.1, “Preparing for the Domain Migration,” on page 283

* Section 21.2, “Performing the Domain Migration,” on page 284

» Section 21.3, “Reconfiguring the Domain in ConsoleOne,” on page 285

» Section 21.4, “Finalizing the Domain Migration,” on page 286

21.1 Preparing for the Domain Migration

1 On the Linux server, become root in a terminal window.
2 Check the Linux server for adequate disk space for your backup solution of choice.

If you want to use the GroupWise® Database Copy utility (DBCopy), as described in
“GroupWise Database Copy Utility” in “Databases” in the GroupWise 7 Administration Guide
(http://www.novell.com/documentation/gw7), you create a copy of the domain and then back
up the copy, which requires double the domain size in disk space.

If you want to use the GroupWise Target Service Agent (TSAFSGW), as described in “Target
Service Agents” in “Databases” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7), this extra disk space is not required.

3 Make the Linux server visible from Windows.

This is necessary in order to perform administration tasks from Windows ConsoleOne during
the domain migration process. For Linux server configurations to accomplish this, Section
19.1.1, “Making a Linux Server Visible from Windows,” on page 271.

4 Make the NetWare® or Windows server visible from Linux.

This is necessary in order to use the Linux version of the GroupWise Database Copy utility
(DBCopy) to copy the domain directory and its contents to the Linux server. The Linux version
of DBCopy includes switches specialized for the domain migration process. For mount
commands, see Section 19.2.1, “Making a NetWare or Windows Server Visible from Linux,”
on page 273.

5 In a location on the Linux server that is accessible from Windows, create a new directory for
your GroupWise system into which you plan to copy the domain directory. For example:

mkdir gwsystem

6 Install the GroupWise Database Copy utility (DBCopy) as described in “Using DBCopy on
Linux” in “Databases” in the GroupWise 7 Administration Guide (http://www.novell.com/
documentation/gw?7).

7 Continue with Performing the Domain Migration.
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21.2 Performing the Domain Migration

1 On the NetWare or Windows server, stop the MTA for the domain.
2 If the domain has gateways, stop the gateways.

3 Inthe /opt/novell/groupwise/agents/bin directory, use DBCopy to copy the
domain directory from the NetWare or Windows server to the new directory on the Linux
server.

./dbcopy -m /domain directory /destination directory

The -m switch indicates that DBCopy is being used for migration to Linux. The

domain directory variable includes the Linux mount location (for example, /mnt), the
mount point directory, and the full path to the domain directory on the NetWare or Windows
server. The destination_directory variable is the directory you created on the Linux server in
Step 5 in the previous section.

DBCopy creates a log file named mmddgwbk . nnn. The first 4 characters represent the date.
A three-digit extension allows for multiple log files created on the same day. The log file is
created at the root of the destination domain directory. Include the -v switch in the dbcopy
command to enable verbose logging for the domain migration.

DBCopy is typically used for backing up your GroupWise system, but when you use the -m
switch to migrate a domain, it changes directory names to lowercase as required on Linux and
copies the message queue directories as well as well as the GroupWise databases in the domain.
For more information about DBCopy, see “GroupWise Database Copy Utility” in “Databases”
in the GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

4 If you are using the /work startup switch to place the MTA working directory (mslocal)
outside the domain directory structure:

4a Copy the mslocal directory to the Linux server so that no messages en route between
users are lost.

4b In the mslocal directory structure, rename files and directories that contain uppercase
letters to all lowercase.

5 If your Linux environment includes the X Window System, run the GroupWise Installation
program to install the Linux MTA for the domain, as described in “Installing the GroupWise
Agents on Linux” on page 177.

or

If the X Window System is not available, run the text-based GroupWise Installation program,
as described in “Installing the GroupWise Agents Using the Text-Based Installation Program”
on page 179.

If you need to perform the installation from a remote location, you can use ssh to access the
remote Linux server. Copy the GroupWise 7 Administrator for Linux CD to the server where
you have migrated the domain, then run the text-based Installation program to install the MTA
on the Linux server.

6 Change to the /opt/novell/groupwise/agents/bin directory.

7 If the X Window System is available, enter the following command to start the Linux MTA to
verify that it runs for the domain in the new location:

./gwmta --show --home /domain directory --noconfig

The --show switch starts the MTA with a user interface. The --home switch provides the
location of the domain. The --noconfig switch prevents the MTA from reading configuration
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information from eDirectory; the current eDirectory information is obsolete because the
domain has been migrated.

You should see the MTA server console described in “Starting the Linux Agents with a User
Interface” on page 179. If the MTA server console does not appear, review the preceding steps
to verify that all steps have been followed. For additional assistance, see “Message Transfer
Agent Problems” in “Strategies for Agent Problems” in the GroupWise 7 Troubleshooting 2:
Solutions to Common Problems.

or
If the X Window system is not available:

7a Enter the following command to start the Linux MTA to verify that it runs for the domain
in the new location:

./gwmta --home /domain directory --noconfig
--ip mta server ip address --httpport 7180

The --home switch provides the location of the domain. The --noconfig switch prevents
the MTA from reading configuration information from eDirectory; the current eDirectory
information is obsolete because the domain has been migrated. The --ip switch provides
the IP address of the server where the MTA is running. The -httpport switch enables the
MTA Web console and provides the port number.

To simplify this test, do not use an SSL connection.
7b In an appropriate environment, open a Web browser and display the following URL:
http://mta server ip address:7180

You should see the MTA Web console described in “Monitoring the Linux GroupWise
Agents from Your Web Browser” on page 183. If the MTA Web console does not appear,
review the preceding steps to verify that all steps have been followed. For additional
assistance, see “Message Transfer Agent Problems” in “Strategies for Agent Problems” in
the GroupWise 7 Troubleshooting 2: Solutions to Common Problems.

8 After verifying that the MTA starts successfully for the domain in the new location on Linux,
stop the MTA, as described in “Stopping the Linux GroupWise Agents” on page 190.

9 If you plan to use SSL on Linux, create new certificate and key files for the Linux server and
place them in the /opt/novell/groupwise/agents/bin directory, the default
location where the MTA looks for certificate and key files.

For instructions on creating certificate and key files, see “Server Certificates and SSL
Encryption” in “Security Administration” in the GroupWise 7 Administration Guide (http://
www.novell.com/documentation/gw?7)

10 Continue with Reconfiguring the Domain in ConsoleOne.

21.3 Reconfiguring the Domain in ConsoleOne

If the connection between Linux and Windows is set up correctly, as described in Step 3 in Section
21.1, “Preparing for the Domain Migration,” on page 283, you can use Windows ConsoleOne to
perform the reconfiguration of the post office. You can also use Linux ConsoleOne if desired.

1 In ConsoleOne, update the location information for the domain:

1a Browse to and right-click the Domain object, then click Properties.
1b Click GroupWise > Identification.
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1c In the UNC Path field, change the path to the location on the Linux server where you
migrated the domain. For example:

\\linuxsvr3\gwsystem\provo3

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a
Linux path in the UNC Path field.

1d Click OK to save the new location information for the domain.
2 Update the configuration information for the MTA:
2a Browse to and right-click the MTA object for the domain, then click Properties.
2b Click GroupWise > Identification.
2c In the Platform field, make sure that Linux is selected.
2d Display the Network Address property page of the MTA object for the domain.
2e In the Network Address field, specify the IP address of the Linux server.
2f Click OK to save the new configuration information for the MTA.

3 Ifthe domain that you migrated to Linux has gateways associated with it, reselect each gateway
directory:

3a Browse to and select the Domain object.

3b Right-click a Gateway object, then click Properties.

3¢ Click GroupWise > Identification.

3d In the Subdirectory field, reselect the gateway directory.

If you do not have any gateway subdirectories to choose from, you have not successfully
completed Step 1.

3e Click OK to save the gateway directory information.
3f Repeat Step 3a through Step 3e for each gateway that belongs to the domain.

4 Continue with Finalizing the Domain Migration.

21.4 Finalizing the Domain Migration

1 Start the Linux MTA with or without a user interface, as described in “Starting the Linux
Agents with a User Interface” on page 179 or “Starting the Linux GroupWise Agents as
Daemons” on page 182.

2 At the MTA server console or Web console, check to see if all links between the new Linux
MTA and other domains and post offices are open.

If you have closed links, see “MTA Status Box Shows a Closed Location” in “Strategies for
Agent Problems” in GroupWise 7 Troubleshooting 2: Solutions to Common Problems.

3 If the domain has gateways, start each gateway.

4 Set up a backup procedure for the domain in its new location on Linux, as described in
“GroupWise Database Copy Utility” or “Target Service Agents” in “Databases” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

5 If the domain has an Internet Agent that is running on the same NetWare or Windows server
where the domain directory was previously located, migrate the Internet Agent to the Linux
server where the domain directory is now located, as described in Chapter 22, “Migrating the
Internet Agent to Linux,” on page 289.
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After the domain has been migrated to Linux, the NetWare or Windows Internet Agent can
continue receiving and queuing Internet messages, but it cannot pass them into the GroupWise
system until the Internet Agent has been migrated to Linux along with its domain and MTA.

If the domain has a WebAccess Agent that is running on the same NetWare or Windows server
where the domain directory was previously located, consider migrating the WebAccess Agent
to the Linux server where the domain directory is now located, as described in Chapter 23,
“Migrating WebAccess to Linux,” on page 291.

Because it is common for the WebAccess Agent to run on a different server from where its
domain is located, there is no urgency about migrating it to Linux.

When the Linux MTA is running smoothly for the new domain location, and other GroupWise
agents belonging to the domain have been migrated to Linux as needed, delete the old domain
directory structure (and if applicable, the ms1ocal directory structure) from the NetWare or
Windows server.

If desired, uninstall the MTA software to reclaim disk space on the NetWare or Windows
server. See “Uninstalling the NetWare GroupWise Agents” on page 176 or “Uninstalling the
Windows GroupWise Agents” on page 198.
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Migrating the Internet Agent
to Linux

Migrating the Internet Agent to Linux includes migrating its domain to Linux, then installing the
Internet Agent software on Linux, updating Internet Agent configuration information in
ConsoleOne®, and copying queued Internet messages from the NetWare or Windows server to the
Linux server.

1

Migrate the Internet Agent’s domain to Linux, as described in Chapter 21, “Migrating a
Domain and Its MTA to Linux,” on page 283.

If you are using SSL, migrating the domain and its MTA includes creating a new certificate file
(filename.crt)and anew key file (filename.key) for the Linux server and placing
them in the /opt/novell/groupwise/agents/bin directory, as described in Step 9 in
Section 21.2, “Performing the Domain Migration,” on page 284.

2 On the Linux server, become root in a terminal window.

Make the Linux server visible from Windows.

This is necessary in order to perform administration tasks from Windows ConsoleOne during
the Internet Agent configuration process. For Linux server configurations to accomplish this,
see Section 19.1.1, “Making a Linux Server Visible from Windows,” on page 271.

Install and configure the Linux Internet Agent, as described in “Linux: Installing the Internet
Agent Software” on page 94.

In ConsoleOne, update the Internet Agent property pages for the new location of the Internet
Agent:
5a On the Identification property page of the GroupWise tab, set Platform to Linux, then click
Apply.
5b On the Network Address property page of the GroupWise tab, specify the IP address or
DNS hostname of the Linux server, then click Apply.

5¢ On the Log Settings property page of the GroupWise tab, if you have specified a directory
path in the Log File Path field, delete the NetWare® or Windows path, then click Apply.

On Linux, Internet Agent log files are stored in the /var/log/novell/groupwise/
domain.gwia.

5d On the SSL Settings property page of the GroupWise tab, if you have specified full paths
in the Certificate File and SSL Key File fields, delete the NetWare or Windows path, then
click Apply.
On Linux, the Internet Agent looks in the /opt/novell/groupwise/agents/bin
directory for certificate and key files by default.

5e On the Server Directories tab, update the Conversion Directory and SMTP Queues
Directory fields with corresponding Linux locations.

6 On the NetWare or Windows server, stop the Internet Agent.

Internet messages cannot be received into your GroupWise® system while the Internet Agent is
stopped.
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7 From Windows, copy the queued Internet messages in the Internet Agent SMTP queues
directory on the NetWare or Windows server to the Linux server.

NOTE: Because of Step 3 above, the Linux server is already visible from Windows. If you
prefer to perform the copy operation from Linux, you must first make the NetWare or Windows
server visible from Linux, as described in Section 19.2.1, “Making a NetWare or Windows
Server Visible from Linux,” on page 273.

The default Internet Agent SMTP queues directory is domain/wpgate/gwia. In this
directory, four queue subdirectories are used for SMTP processing: send, receive,
result, and defer. When you migrated the domain to Linux, DBCopy copied these queue
directories and their contents to the Linux server along with the rest of the domain directory
structure, but additional Internet messages might have arrived since that time. Therefore, you
need to copy these queue directories again now that the Internet Agent has been stopped.

If you have used the SMTP Queues Directory field on the Server Directories property page of
the Internet Agent object in ConsoleOne or the /dhome switch in the gwia . cfg file to place
the queue directories outside the domain directory structure, then DBCopy did not copy the
queue directories. Copy the queue directories from the NetWare or Windows server to their
default location in the domain directory structure or to another location of your choice on the
Linux server. If you do not copy them to their default location, update the SMTP Queues
Directory setting with the full path to the SMTP queues directory.

8 If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server, disable it
before starting the Internet Agent.

For example, use the following commands to stop and disable Postfix:

/etc/init.d/postfix stop
chkconfig postfix off

As an alternative, you can configure the Internet Agent to bind exclusively to the server IP
address, as described in “Binding the Internet Agent to a Specific I[P Address”, so that the
Internet Agent IP address does not conflict with the the default Postfix IP address of
127.0.0.1 (the loopback address).

9 If you want to use the Internet Agent for POP3 and IMAP4 mail, make sure no POP3 or
IMAP4 daemons are running on your Linux server.

10 Make sure that the MTA for the domain is running.

11 Start the Linux Internet Agent with or without a user interface, as described in “Linux: Starting
the Internet Agent” on page 97.

If the Internet Agent server console does not appear, or the Internet Agent Web console is not
available in your Web browser, review the preceding steps to verify that all steps have been
followed. For additional assistance, see “Internet Agent Problems” in “Strategies for Agent
Problems” in the GroupWise 7 Troubleshooting 2: Solutions to Common Problems (http://
www.novell.com/documentation/gw?7).

12 When the Linux Internet Agent is running smoothly for the new domain location, and other
GroupWise agents belonging to the domain have been migrated to Linux as needed, delete the
old domain directory structure from the NetWare or Windows server.

13 If the SMTP queue directory was located outside the domain directory structure, delete this
directory and its contents from the NetWare or Windows server.

14 If desired, uninstall the Internet Agent software to reclaim disk space on the NetWare or
Windows server. See “Uninstalling the NetWare GroupWise Agents” on page 176 or
“Uninstalling the Windows GroupWise Agents” on page 198.

290 GroupWise 7 Installation Guide


http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7
http://www.novell.com/documentation/gw7

Migrating WebAccess to Linux

You can migrate just the WebAccess Agent, just the WebAccess Application, or both from
NetWare® or Windows to Linux. The process includes installing the WebAccess software on Linux,
then transferring configuration information from old eDirectory™ objects to new eDirectory objects
and from old startup files and configuration files on NetWare or Windows to new startup files and
configuration files on Linux.

» Section 23.1, “Migrating the WebAccess Agent to Linux,” on page 291

» Section 23.2, “Migrating the WebAccess and WebPublisher Applications to Linux,” on
page 293

23.1 Migrating the WebAccess Agent to Linux

1 On the Linux server, become root in a terminal window.

2 Ifyou are installing the WebAccess Agent on a server other than the one where its domain is
located, provide access to the domain directory on the server where you are installing the Linux
WebAccess Agent.

If the domain directory is located on another Linux server, use your mount command of choice.
If the domain is located on a NetWare or Windows server, see Section 19.2.1, “Making a
NetWare or Windows Server Visible from Linux,” on page 273 for suggested mount
commands.

As an alternative to a permanent mount, and to provide better performance and stability, you
can create a secondary domain and run a Linux MTA on the Linux server local to the
WebAccess installation. For instructions, see “Creating a New Domain” in “Domains” in the
GroupWise 7 Administration Guide (http://www.novell.com/documentation/gw7).

3 If your Linux environment includes the X Window System, run the GUI GroupWise®
Installation program to install the Linux WebAccess Agent software, as described in “Installing
the Linux WebAccess Agent” on page 124.

or

If the X Window System is not available, run the text-based GroupWise Installation program
instead, as described in “Installing the GroupWise Agents Using the Text-Based Installation
Program” on page 179.

4 Configure the WebAccess Agent, as described in “Configuring the Linux WebAccess Agent”
on page 125.

4a On the Gateway Directory page, specify a new name for the WebAccess gateway
directory under wpgate in the domain directory, so that the old gateway directory and its
contents are retained.

4b On the Gateway Object page, specify a new object name, so that the old WebAccess
Agent object is retained.

5 In ConsoleOne®, review the property pages for the old WebAccess Agent object and transfer
any settings that you have customized on the on the old WebAccess Agent object to the new
WebAccess Agent object.
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IMPORTANT: The encryption key on the WebAccess Settings page is especially important.
Check and transfer it if necessary.

6 Copy the commgr . cfqg file from its location under the new WebAccess gateway directory:
domain directory/wpgate/new webaccess agent gateway directory
to the WebAccess, and optionally WebPublisher, software directories:

/opt/novell/groupwise/webaccess
/opt/novell/groupwise/webpublisher

If you plan to run multiple WebAccess Agents for the domain, this step needs to be done only
for the primary WebAccess Agent, as listed on the Environment property page of the
GroupWise Provider object.

7 Review the existing WebAccess Agent startup file :
old webaccess agent object name.waa

located on the NetWare or Windows server in:

NetWare: sys:\system

Windows: c:\webacc

and transfer any customized settings to the new WebAccess Agent startup file:
new webaccess _agent object name.waa

located on the following directory on the Linux server:
/opt/novell/groupwise/agents/share

8 Review the old Document Viewer Agent startup file (gwdva . dva) located on the NetWare or
Windows server in the same directory with the WebAccess Agent startup file, and transfer any
customized settings to the new Document Viewer Agent startup file on the Linux server.

9 Start the Linux WebAccess Agent with or without a user interface, as described in “Starting the
Linux WebAccess Agent” on page 128.

If the WebAccess Agent server console does not appear, or the WebAccess Agent Web console
is not available in your Web browser, review the preceding steps to verify that all steps have
been followed. For additional assistance, see “WebAccess Agent Problems” in “Strategies for
Agent Problems” in the GroupWise 7 Troubleshooting 2: Solutions to Common Problems
(http://www.novell.com/documentation/gw7).

10 After the new WebAccess Agent is running successfully, replace the old WebAccess Agent
with the new WebAccess Agent in the WebAccess Application’s provider list.

10a In ConsoleOne, right-click the GroupWise Provider object, then click Properties.
10b In the GroupWise WebAccess Agent Information box, click Add.

10c Browse to and select the new WebAccess Agent object, then click OK to add it to the list
of WebAccess Agents.

10d Seclect the old WebAccess Agent, then click Delete.

10e Click OK to save the updated WebAccess Agent list.
11 Stop the old WebAccess Agent on the NetWare or Windows server.
12 Delete the old WebAccess Agent object from eDirectory.
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13

Delete the old WebAccess Agent gateway directory under wogate in the domain directory.

14 1If desired, uninstall the WebAccess Agent software to reclaim disk space on the NetWare or

Windows server. See “Uninstalling the NetWare GroupWise Agents” on page 176 or
“Uninstalling the Windows GroupWise Agents” on page 198.

23.2 Migrating the WebAccess and
WebPublisher Applications to Linux

1
2

10

On the Linux server, become root in a terminal window.

Make sure that the Linux server already has Apache and Tomcat configured and running
successfully and that you know the full path to the Apache and Tomcat root directories.

If your Linux environment includes the X Window System, run the GUI GroupWise
Installation program to install and configure the Linux WebAccess Application, as described in
“Installing and Configuring the WebAccess Application and WebPublisher Application” on
page 126.

or

If the X Window System is not available, run the text-based GroupWise Installation program
instead, as described in “Installing the GroupWise Agents Using the Text-Based Installation
Program” on page 179.

IMPORTANT: On the WebAccess Objects page, specify a new context for the WebAccess
Application objects, so that the old objects are retained.

If you want to use WebPublisher on Linux, perform the manual configuration described in
“Configuring WebPublisher” on page 127.

In ConsoleOne, review the property pages for the old WebAccess Application objects:
* GroupWise WebAccess
* Novell Speller
* LDAP Provider
* GroupWise Provider
* GroupWise Document Provider

transfer any settings that you have customized on the old WebAccess Application objects to
the new WebAccess Application objects.

If you installed WebPublisher, review the property pages of the old GroupWise WebPublisher
object, then transfer any settings that you have customized on the old GroupWise WebPublisher
object to the new GroupWise WebPublisher object.

If you have customized any WebAccess or WebPublisher template files, copy the customized
template files from the old Web server to the following directories on the Linux Web server:

/var/opt/novell/gw/WEB-INF/classes/com/novell/webaccess/templates
/var/opt/novell/gw/WEB-INF/classes/com/novell /webpublisher/
templates

Stop and then start Apache and Tomcat, as described in “Restarting the Web Server” on
page 128.

Verify that the new WebAccess Application is communicating successfully with the existing
WebAccess Agent by accessing your GroupWise mailbox using the WebAccess client:
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11 To keep users’ existing browser bookmarks from being broken, redirect the old WebAccess and
WebPublisher URLSs to the new WebAccess and WebPublisher URLSs:

11a If your old Web server was Apache on NetWare:

11a1 Change to the conf subdirectory of the Apache root directory (for example,
\apache2\conf).

11a2 Edit the Apache configuration file for GroupWise.

On NetWare 6, the Apache configuration file is gwapache . conf. On NetWare 6.5,
the Apache configuration file is gwapache?2.conf.

11a3 Add the following line:

redirect permanent /servlet/webacc
http://web _server address/gw/webacc

11a4 If you use WebPublisher, add the following additional line:

redirect permanent /servlet/webpub
http://web server address/gw/webpub

11a5 Save the file, then exit the editor.
11a6 Restart Apache to put the redirections into effect.
11b If your old Web server was Internet Information Server (IIS) on Windows:

11b1 Change to the netpub\wwwroot subdirectory of the IIS root directory (for
example, c: \inetpub\wwwroot).

11b2 Create a subdirectory named servlet.
11b3 Under the servlet subdirectory, create a subdirectory named webacc.
11b4 If you use WebPublisher, create a second subdirectory named webpub.

11b5 In IIS Manager, expand the tree in the left pane to display Default Web Site under
Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in
Step 11b2

11b6 Expand the servlet subdirectory to display the webacc subdirectory (and
optionally, the webpub subdirectory) that you created in Step 11b3.

11b7 Right-click the webacc subdirectory, then click Properties.

11b8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the
associated field.

11b9 Select A Permanent Redirection for This Resource, then click OK to save your
changes.

11b10 If you use WebPublisher, repeat Step 11b7 through Step 11b9, using webpub in
place of webacc.

11b11 Restart the IIS Web server to put the redirections into effect.

11c If your old Web server was Netscape Enterprise Server for NetWare, search the Novell
Support Web site (http://www.novell.com/support) for redirection instructions.

12 Notify users of the new WebAccess and WebPublisher URLs so that users can update their
browser bookmarks if they want to.
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13 If desired, uninstall the WebAccess Application and the WebPublisher Application from the
Web server to reclaim disk space on the NetWare or Windows Web server. See “Uninstalling
the NetWare GroupWise Agents” on page 176 or “Uninstalling the Windows GroupWise
Agents” on page 198.
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Migrating Monitor to Linux

As with WebAccess, you can migrate just the Monitor Agent, just the Monitor Application, or both
from Windows to Linux. The process includes accessing a domain (either local or remote), installing
the Monitor software on Linux, copying the Monitor Agent configuration file (monitor.xml)
from Windows to Linux, and modifying the configuration file. For convenience, you can keep the
Monitor Application on the same Web server as the WebAccess Application.

Section 24.1, “Migrating the Monitor Agent to Linux,” on page 297
Section 24.2, “Migrating the Monitor Application to Linux,” on page 298

24.1 Migrating the Monitor Agent to Linux

1

On the Linux server, become root in a terminal window.

2 Make sure that the Web server where the Monitor Application is installed is up and running.

Provide access to a domain directory and its associated domain database (wpdomain . db).

If the domain directory is located on another Linux server, use your mount command of choice.
If the domain directory is located on a NetWare® or Windows server, see Section 19.2.1,
“Making a NetWare or Windows Server Visible from Linux,” on page 273 for suggested mount
commands.

If your Linux environment includes the X Window System, run the GUI GroupWise®
Installation program to install the Linux WebAccess Agent software, as described in “Installing
the Linux Monitor Agent” on page 149.

or

If the X Window System is not available, run the text-based GroupWise Installation program
instead, as described in “Installing the GroupWise Agents Using the Text-Based Installation
Program” on page 179.

Configure the Linux Monitor Agent, as described in “Configuring the Linux Monitor Agent”
on page 150.

Restart the Web server, as described in “Restarting the Web Server” on page 152.

Start the Linux Monitor Agent, as described in “Starting the Linux Monitor Agent as a
Daemon” on page 153.

Make sure that the Linux Monitor Agent can communicate with the Monitor Application by
viewing the URL for the platform of your Web server:

NetWare or Windows Web Server: http://web server network address/gw

Linux Web Server: http://web server network address/gwmon

If the Monitor Web console does not appear, review the preceding steps to verify that all steps
have been followed. For additional assistance, see “Monitor Agent Problems” in “Strategies for

Agent Problems” in the GroupWise 7 Troubleshooting 2: Solutions to Common Problems
(http://www.novell.com/documentation/gw7).
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9 Stop the Linux Monitor Agent, as described in “Stopping the Linux GroupWise Agents” on
page 190

10 Copy the Monitor Agent configuration file (monitor.xml) from its Windows location :
c:\gwmon
to its location on Linux:
/opt/novell/groupwise/agents/share

11 Edit the monitor.xml file for its new location:

11a Change the HOME PATH setting to the full path to the domain directory that you made
accessible in Step 3.

11b Change the LOG_PATH setting to the typical location for Monitor Agent log files on
Linux (/var/log/novell/groupwise/gwmon).

11c Change the LOG ACCOUNTING PATH setting to the typical location for Monitor Agent
accounting file on Linux (/var/log/novell/groupwise/gwmon/acct).

11d Change the LOG_EDITOR setting to " " (an empty setting).
12 Start the Linux Monitor Agent with its new configuration file.

13 Make sure that the Linux Monitor Agent can still communicate with the Monitor Application
by viewing the Monitor URL for the platform of your Web server:

NetWare or Windows Web Server: http://web server network address/gw

Linux Web Server: http://web server network address/gwmon

14 Stop the old Windows Monitor Agent, as described in “Stopping the Linux GroupWise Agents”
on page 190.

15 If desired, uninstall the old Monitor Agent software to reclaim disk space on the Windows
server. See “Uninstalling the Windows GroupWise Agents” on page 198.

24.2 Migrating the Monitor Application to Linux

1 On the Linux server, become root in a terminal window.

2 Make sure that the Linux server already has Apache and Tomcat configured and running
successfully and that you know the full path to the Apache and Tomcat root directories.

3 Ifyour Linux environment includes the X Window System, run the GUI GroupWise
Installation program to install and configure the Linux Monitor Application, as described in
“Installing and Configuring the Monitor Application” on page 151.

or

If the X Window System is not available, run the text-based GroupWise Installation program
instead, as described in “Installing the GroupWise Agents Using the Text-Based Installation
Program” on page 179.

4 Stop and then start Apache and Tomcat, as described in “Restarting the Web Server” on
page 152.

5 Verify that the new Monitor Application is communicating successfully with the existing
Monitor Agent by viewing the Monitor URL for the platform of your Web server:

298 GroupWise 7 Installation Guide



NetWare or Windows Web Server: http://web server network address/gw

Linux Web Server: http://web server network address/gwmon

6 If desired, uninstall the Monitor Application from the Web server to reclaim disk space on the
NetWare or Windows Web server. See “Uninstalling the NetWare GroupWise Agents” on
page 176 or “Uninstalling the Windows GroupWise Agents” on page 198.
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Appendixes

* Appendix A, “GroupWise Version Compatibility,” on page 303
* Appendix B, “Third-Party Materials,” on page 313
* Appendix C, “Documentation Updates,” on page 323
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GroupWise Version Compatibility

Use the tables in this section to determine compatibility among the following Novell® GroupWise®
versions:

» Section A.1, “GroupWise 7 on NetWare and Windows,” on page 303
» Section A.2, “GroupWise 7 on Linux,” on page 307

IMPORTANT: GroupWise 5.x versions have entered the end-of-life phase and are no longer
supported. For update instructions, see Chapter 16, “Updating Your GroupWise 5.x System to
Version 7,” on page 263. The GroupWise 5.x administration tool, NetWare® Administrator with
GroupWise snap-ins, cannot be used to administer GroupWise 6.x and GroupWise 7 systems.

For each GroupWise version, the tables indicate compatibility for:
* Administrative components: Domain and post office database platforms and versions,
eDirectory™ platforms, and GroupWise snap-in to ConsoleOne® platforms and versions
¢ Agents: Domain and post office database platforms and versions, agent platforms and versions
¢ Clients: Post office directory platforms and access, POA platforms and versions, client modes

In the compatibility tables, cells with combinations that are not applicable are marked N/A. For
example, the POA never needs to communicates with the Internet Agent, so that table cell is N/A.

For information about what operating system versions are supported for GroupWise 7 on NetWare,
Linux, and Windows, refer to “GroupWise System Requirements” on page 21. For information
about what operating system versions are supported for GroupWise 6.5, refer to the Group Wise 6.5
Installation Guide (http://www.novell.com/documentation/gw65). For information about what
operating system versions are supported for GroupWise 6, refer to the GroupWise 6 Installation
Guide (http://www.novell.com/documentation/gw6).

A.1 GroupWise 7 on NetWare and Windows

Select the GroupWise version that you want to determine GroupWise 7 compatibility with:

* Section A.1.1, “Compatibility with GroupWise 6.x on NetWare and Windows,” on page 303
» Section A.1.2, “Compatibility with GroupWise 5.x on NetWare and Windows,” on page 305

A.1.1 Compatibility with GroupWise 6.x on NetWare and
Windows

* “GroupWise 6.x Administrative Components with GroupWise 7" on page 304
* “GroupWise 6.x Agents with GroupWise 7" on page 304

* “GroupWise 6.x Windows Client with GroupWise 7" on page 305

* “GroupWise 7 Windows Client with GroupWise 6.x” on page 305
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GroupWise 6.x Administrative Components with GroupWise 7

GroupWise 6.x

GroupWise 7 Domain and Post Office

GW 6.x Objects in

ConsoleOne +

Components Databases eDirectory GW 6.x Snap-Ins
GW 7 Domain and Post N/A N/A Not Supported
Office Databases

GW 7 Objects in N/A N/A Not Supported
eDirectory

ConsoleOne + Supported Supported N/A

GW 7 snap-ins

Table Summary: ConsoleOne with the GroupWise 7 snap-ins can be used to access GroupWise 6.x
databases for domains and post office and GroupWise 6.x eDirectory objects. However, ConsoleOne
with the GroupWise 6.x snap-ins cannot be used to access GroupWise 7 databases and GroupWise 7

eDirectory objects. The general rule is that later GroupWise snap-ins can administer earlier

GroupWise system components, but earlier GroupWise snap-ins cannot administer later GroupWise

system components.

GroupWise 6.x Agents with GroupWise 7

GroupWise 6.x GW 6.x MTA GW 6.xPOA GW 6.x GWIA GW 6.x GW 6.x
Domain and WebAccess Monitor
GroupWise 7 Post Office
Agents Databases
GW 7 Domain N/A Not Not Not Not Not
and Post Office Supported  Supported Supported Supported  Supported
Databases
GW 7 MTA Supported Supported  Supported Supported N/A Supported
GW 7 POA Supported Supported  N/A N/A Supported  Supported
GW 7 GWIA Supported Supported  N/A Not N/A Supported
Supported
GW7 Supported N/A Not N/A N/A Supported
WebAccess Supported
GW 7 Monitor Supported Supported  Supported Supported Supported  N/A

Table Summary: GroupWise 6.x agents cannot access domain and post office databases that have

been updated to GroupWise 7. When a GroupWise 7 MTA or POA accesses a GroupWise 6.x
database, it automatically updates the database to GroupWise 7. Although most GroupWise 7/
GroupWise 6.x agent combinations are supported, two combinations are not supported.
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GroupWise 6.x Windows Client with GroupWise 7

GroupWise 7 GW 7 POA GW 7 POA GW 7 POA
GroupWise 6.x Post Office Client/Server Access Client/Server Access Dial-Up Access
Windows Client Direct Access Online Mode Caching Mode Remote Mode
Windows Not Supported Supported Supported Supported

client

Table Summary: The GroupWise 6.x Windows client can communicate with the GroupWise 7
POA, but it cannot access a GroupWise 7 post office directly. The general rule is that later POAs can
always communicate with earlier GroupWise clients, but earlier POAs cannot communicate with
later GroupWise clients.

GroupWise 7 Windows Client with GroupWise 6.x

GroupWise 6.x GW 6.x POA GW 6.x POA GW 6.x POA
GroupWise 7 Post Office Client/Server Access Client/Server Access Dial-Up Access
Windows Client Direct Access Online Mode Caching Mode Remote Mode
Windows Not Supported Not Supported Not Supported Not Supported

client

Table Summary: The GroupWise 7 Windows client cannot communicate with the GroupWise 6.x
POA, nor can it access a GroupWise 6.x post office directly. The general rule is that earlier POAs
cannot communicate with later GroupWise clients, but later POAs can always communicate with
earlier GroupWise clients.

A.1.2 Compatibility with GroupWise 5.x on NetWare and
Windows

* “GroupWise 5.x Administrative Components with GroupWise 7 on page 305
» “GroupWise 5.x Agents with GroupWise 7" on page 306

* “GroupWise 5.x Windows Client with GroupWise 7” on page 306

* “GroupWise 7 Windows Client with GroupWise 5.x” on page 307

GroupWise 5.x Administrative Components with GroupWise 7

GroupWise 5.x GW 5.x Objects in NetWare Administrator
GroupWise 7 Domain and Post Office eDirectory + GW 5.x Snap-Ins
Components Databases
GW 7 Domain and Post N/A N/A Not Supported
Office Databases
GW 7 Objects in N/A N/A Not Supported
eDirectory
ConsoleOne + Supported Supported N/A
GW 7 snap-ins
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Table Summary: NetWare Administrator cannot be used to administer GroupWise 7 systems.
ConsoleOne with the GroupWise 7 snap-ins can be used to administer GroupWise 5.x systems. The
general rule is that later GroupWise snap-ins can administer earlier GroupWise system components,
but earlier GroupWise snap-ins cannot administer later GroupWise system components.

GroupWise 5.x Agents with GroupWise 7

GroupWise 5.x GW 5.x MTA GW 5.xPOA GW 5.x GWIA GW 5.x GW 5.x
Domain and WebAccess Monitor
GroupWise 7 Post Office
Agents Databases
GW 7 Domain and N/A Not Not Not Not Not
Post Office Supported  Supported  Supported Supported  Supported
Databases
GW 7 MTA Supported Supported  Supported  Supported N/A Supported
GW 7 POA Supported Supported  N/A N/A Supported  Supported
GW 7 GWIA Supported Supported  N/A Not N/A Supported
Supported
GW 7 WebAccess Supported N/A Not N/A N/A Supported
Supported

GW 7 Monitor Supported Supported  Supported  Supported Supported  N/A

Table Summary: GroupWise 5.x agents cannot access domain and post office databases that have
been updated to GroupWise 7. When the GroupWise 7 MTA or POA accesses a GroupWise 5.x
database, it automatically updates the database to GroupWise 7. Although most GroupWise 6.x/
GroupWise 5.x agent combinations are supported, two combinations are not supported.

GroupWise 5.x Windows Client with GroupWise 7

GroupWise 7 GW 7 POA GW 7 POA GW 7 POA
GroupWise 5.x Post Office Client/Server Access Client/Server Access Dial-Up Access
Client Direct Access Online Mode Caching Mode Remote Mode
Windows Not Supported Supported Supported Supported

client

Table Summary: The GroupWise 5.x Windows client can communicate with the GroupWise 7
POA, but it cannot access a GroupWise 7 post office directly. The general rule is that later POAs can
always communicate with earlier GroupWise clients, but earlier POAs cannot communicate with
later GroupWise clients.
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GroupWise 7 Windows Client with GroupWise 5.x

GroupWise 5.x GW 5.x POA GW 5.x POA GW 5.x POA
GroupWise 7 Post Office Client/Server Access Client/Server Access Dial-Up Access
Client Direct Access Online Mode Caching Mode Remote Mode
Windows Not Supported Not Supported Not Supported Not Supported

client

Table Summary: The GroupWise 7 Windows client cannot communicate with the GroupWise 5.x
POA, nor can it access a GroupWise 5.x post office directly. The general rule is that earlier POAs
cannot communicate with later GroupWise clients, but later POAs can always communicate with
earlier GroupWise clients.

A.2 GroupWise 7 on Linux

Select the GroupWise version that you want to determine GroupWise 7 compatibility with:

» Section A.2.1, “Compatibility with GroupWise 7 on NetWare and Windows,” on page 307
* Section A.2.2, “Compatibility with GroupWise 6.x on NetWare or Windows,” on page 309

A.2.1 Compatibility with GroupWise 7 on NetWare and
Windows

* “GroupWise 7 Linux Administrative Components with GroupWise 7 on NetWare or Windows”
on page 307

» “GroupWise 7 Linux Agents with GroupWise 7 on NetWare or Windows” on page 308
* “GroupWise 7 Cross-Platform Client with GroupWise 7 on NetWare or Windows™ on page 308
* “GroupWise 7 Windows Client with GroupWise 7 on Linux” on page 309

GroupWise 7 Linux Administrative Components with GroupWise 7 on NetWare or
Windows

GroupWise 7 GW 7 Objects in Windows ConsoleOne
GroupWise 7 on Linux Domain and Post Office eDirectory on NetWare + GW 7 Snap-Ins
Administrative Databases on NetWare  or Windows
Components or Windows
GW 7 Domain and Post N/A N/A Supported
Office Databases
on Linux
GW 7 Objects in N/A N/A Supported
eDirectory on Linux
Linux ConsoleOne + Supported Supported N/A

GW 7 snap-ins on Linux

Table Summary: On both Linux and Windows, ConsoleOne with the GroupWise snap-ins can be
used to access GroupWise databases for domains and post offices and GroupWise objects in
eDirectory located on NetWare, Linux, or Windows. When using Linux ConsoleOne to administer
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domains and post offices on NetWare or Windows, you must mount the NetWare or Windows server
to your Linux machine. When using Windows ConsoleOne to administer domains and post offices
on Linux, you can use a Samba share to access the Linux server from your Windows machine.

GroupWise 7 Linux Agents with GroupWise 7 on NetWare or Windows

GroupWise7 GW7MTA GW7POA GWT7GWIA GW?7 GW7
Domain or on NetWare on NetWare on NetWare WebAccess Monitor on
Post Office or Windows orWindows orWindows on NetWare Windows
Databases on or Windows

GroupWise 7 on NetWare or

Linux Agents Windows

GW 7 Domain N/A Supported  Supported  Supported Supported  Supported

and Post Office

Databases

on Linux

GW 7 MTA Supported Supported  Supported  Supported N/A Supported

on Linux

GW 7 POA Supported Supported  N/A N/A Supported  Supported

on Linux

GW 7 GWIA Supported Supported  N/A Supported N/A Supported

on Linux

GW7 Supported N/A Supported  N/A N/A Supported

WebAccess

on Linux

GW 7 Monitor Supported Supported  Supported  Supported Supported  N/A
on Linux

Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We do
not recommend that you run the Linux agents for domains and post offices located on NetWare and
Windows. However, existing GroupWise 6.x domains and post offices can be moved onto Linux
servers so that the Linux agents can update them to GroupWise 7 on Linux. All the Linux agents can
communicate as usual with the NetWare and Windows agents.

GroupWise 7 Cross-Platform Client with GroupWise 7 on NetWare or Windows

GroupWise 7 GW 7 POA GW 7 POA GW 7 POA

Post Office Client/Server Access Client/Server Access Dial-Up Access

Direct Access on Online Mode on Caching Mode on Remote Mode on
GroupWise 7 NetWare or Windows NetWare or Windows NetWare or Windows NetWare or
Linux Client Windows
Cross-Platform  Not Supported Supported Supported Not Supported

client on Linux

Table Summary: The GroupWise 7 Linux Cross-Platform client can communicate in client/server
mode with the GroupWise 7 POA on NetWare or Windows. The Cross-Platform client cannot access
the post office directly, nor can it communicate with the GroupWise 7 POA across a dial-up
connection over a modem. Remote mode is not supported in the Cross-Platform client.
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GroupWise 7 Windows Client with GroupWise 7 on Linux

GroupWise 7 GW 7 POA GW 7 POA GW 7 POA

Post Office Client/Server Access Client/Server Access Dial-Up Access
GroupWise 7 Direct Access on Online Mode on Caching Mode on Remote Mode on
Windows Client Linux Linux Linux Linux
Windows Client  Not Supported Supported Supported Supported

Table Summary: The GroupWise 7 Windows client can communicate in client/server mode with
the GroupWise 7 POA on Linux. The Windows client cannot access the post office directly.

A.2.2 Compatibility with GroupWise 6.x on NetWare or
Windows

* “GroupWise 7 Linux Administrative Components with GroupWise 6.x on NetWare or
Windows” on page 309

* “GroupWise 7 Linux Agents with GroupWise 6.x on NetWare or Windows” on page 310

» “GroupWise 7 Cross-Platform Client with GroupWise 6.x on NetWare or Windows” on
page 310

* “GroupWise 6.5 Cross-Platform Client with GroupWise 7 on NetWare or Windows” on
page 311

GroupWise 7 Linux Administrative Components with GroupWise 6.x on NetWare or
Windows

GroupWise 6.x GW 6.x Objects in Windows ConsoleOne
Domain and Post eDirectory on NetWare + GW 6.x shap-ins
GroupWise 7 on Linux Office Databases on or Windows

Administrative Components NetWare or Windows

GW 7 Domain and Post N/A N/A Not Supported
Office Databases on Linux

GW 7 Objects in N/A N/A Not Supported
eDirectory on Linux

Linux ConsoleOne + Supported Supported N/A
GW 7 snap-ins on Linux

Table Summary: On Linux, ConsoleOne with the GroupWise snap-ins can be used to access
GroupWise databases for domains and post offices and GroupWise objects in eDirectory on
NetWare, Linux, and Windows. On Windows, ConsoleOne with the GroupWise 6.x snap-ins cannot
be used to access GroupWise 7 domains and post offices on Linux. The general rule is that later
GroupWise snap-ins can administer earlier GroupWise system components, but earlier GroupWise
snap-ins cannot administer later GroupWise system components.
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GroupWise 7 Linux Agents with GroupWise 6.x on NetWare or Windows

GroupWise 6.x GW 6.x MTA GW 6.x POA GW 6.x GWIA GW 6.x GW 6.x
Domain and on NetWare on NetWare on NetWare WebAccess Monitor
Post Office or Windows or Windows or Windows on NetWare on Windows
Databases on or Windows

GroupWise 7 NetWare or
Linux Agents Windows

GW Domain N/A Not Not Not Not Not

and Post Office Supported  Supported  Supported Supported  Supported
Databases

on Linux

GW 7 MTA Supported Supported  Supported  Supported N/A Supported
on Linux

GW 7 POA Supported Supported  N/A N/A Supported  Supported
on Linux

GW 7 GWIA Supported Supported  N/A Not N/A Supported
on Linux Supported

GW7 Supported N/A Not N/A N/A Supported
WebAccess Supported

on Linux

GW 7 Monitor  Supported Supported  Supported  Supported Supported  N/A
on Linux

Table Summary: Domains and post offices can be located on NetWare, Linux, or Windows. We do
not recommend that you run the Linux agents for domains and post offices located on NetWare and
Windows. However, existing GroupWise 6.x domains and post offices can be moved onto Linux
servers so that the Linux agents can update them to GroupWise 7 on Linux. Although most GW 7 on
Linux/GW 6.x agent combinations are supported, two combinations are not supported.

GroupWise 7 Cross-Platform Client with GroupWise 6.x on NetWare or Windows

GroupWise 6.x GW 6.x POA GW 6.x POA GW 6.x POA
GroupWise 7 Post Office Client/Server Access Client/Server Access Dial-Up Access
Client Direct Access on Online Mode on Caching Mode on Remote Mode on
on Linux NetWare or Windows NetWare or Windows NetWare or Windows NetWare or Windows
Cross-Platform  Not Supported Not Supported Not Supported Not Supported

client on Linux

Table Summary: The GroupWise 7 Linux Cross-Platform client cannot communicate in client/
server mode with the GroupWise 6.x POA on NetWare or Windows, nor can it access the post office
directly. The general rule is that earlier POAs cannot communicate with later GroupWise clients, but
later POAs can always communicate with earlier GroupWise clients. Remote mode is not supported
in the Cross-Platform client.
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GroupWise 6.5 Cross-Platform Client with GroupWise 7 on NetWare or Windows

GroupWise 7 GW 7 POA GW 7 POA GW 7 POA
GroupWise 6.x Post Office Client/Server Access Client/Server Access Dial-Up Access
Client Direct Access on Online Mode on Caching Mode on Remote Mode on
on Linux NetWare or Windows NetWare or Windows NetWare or Windows NetWare or Windows
Cross-Platform  Supported Supported Supported Not Supported

client on Linux

Table Summary: The GroupWise 7 Linux Cross-Platform client can communicate in client/server
mode with the GroupWise 6.x POA on NetWare or Windows, but it cannot access the post office
directly. The general rule is that later POAs can always communicate with earlier GroupWise
clients, but earlier POAs cannot communicate with later GroupWise clients. Remote mode is not
supported in the Cross-Platform client.

GroupWise Version Compatibility 311



312 GroupWise 7 Installation Guide



Third-Party Materials

The following third-party software is included in Novell® GroupWise® 7:

* Section B.1, “Apache,” on page 313

* Section B.2, “BLT,” on page 314

* Section B.3, “GD Graphics Library,” on page 314

» Section B.4, “getopt.h,” on page 315

» Section B.5, “JRE,” on page 316

» Section B.6, “NET-SNMP Open Source Package,” on page 316
» Section B.7, “ODMA 2.0,” on page 318

» Section B.8, “OpenLDAP,” on page 319

» Section B.9, “OpenSSL,” on page 320

» Section B.10, “Python 2.2,” on page 322

B.1 Apache

The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following
acknowledgment:

“This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).”

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-
party acknowledgments normally appear.

4. The names “Apache” and “Apache Software Foundation” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact apache@apache.org.

5. Products derived from this software may not be called “Apache”, nor may “Apache” appear in
their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ""AS IS” AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS
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BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache
Software Foundation. For more information on the Apache Software Foundation, please see <http://
www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National
Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

B.2 BLT

Copyright 1993-1998 Lucent Technologies, Inc.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that the copyright notice and warranty disclaimer appear in supporting documentation, and
that the names of Lucent Technologies any of their entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all implied
warranties of merchantability and fitness. In no event shall Lucent Technologies be liable for any
special, indirect or consequential damages or any damages whatsoever resulting from loss of use,
data or profits, whether in an action of contract, negligence or other tortuous action, arising out of or
in connection with the use or performance of this software.

B.3 GD Graphics Library

Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Cold
Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the National Institutes of Health.

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Boutell.Com, Inc.
Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip Warner.
Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg Roelofs.

Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John Ellson
(ellson@graphviz.org).

Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson (ellson@graphviz.org).

Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 2003, 2004, Doug
Becker and copyright (C) 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004
Thomas G. Lane. This software is based in part on the work of the Independent JPEG Group. See the
file README-JPEG.TXT for more information.

Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David Rowley, with
modifications for thread safety by Thomas Boutell.
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Portions relating to GIF decompression copyright 1990, 1991, 1993 by David Koblas, with
modifications for thread safety by Thomas Boutell.

Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo and Johan
Van den Brande.

Permission has been granted to copy, distribute and modify gd in any context without fee, including
a commercial application, provided that this notice is present in user-accessible supporting
documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper
credit for the authors of gd, not to interfere with your productive use of gd. If you have questions,
ask. “Derived works” includes all programs that utilize the library. Credit must be given in user-
accessible documentation.

This software is provided “AS IS.” The copyright holders disclaim all warranties, either express or
implied, including but not limited to implied warranties of merchantability and fitness for a
particular purpose, with respect to this code and accompanying documentation.

Although their code does not appear in the current release, the authors also wish to thank Hutchison
Avenue Software Corporation for their prior contributions.

B.4 getopt.h

Copyright (c) 2000 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation by Dieter Baron and
Thomas Klausner.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND

Third-Party Materials

315



ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.5 JRE

JRE Note

This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are
available at http://oss.software.ibm.com/icudj/.

B.6 NET-SNMP Open Source Package

» Section B.6.1, “---- Part 1: CMU/UCD copyright notice: (BSD like) ----- ,” on page 316

» Section B.6.2, “---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) ----- ,?
on page 316

» Section B.6.3, “---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- ,’on
page 317

» Section B.6.4, “---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- ,” on page 318

B.6.1 ---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appears in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and

that the name of CMU and The Regents of the University of California not be used in advertising or
publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR
THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

B.6.2 ---- Part 2: Networks Associates Technology, Inc
copyright notice (BSD) -----

Copyright (c¢) 2001-2003, Networks Associates Technology, Inc
All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.6.3 ---- Part 3: Cambridge Broadband Ltd. copyright notice
(BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

» Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.6.4 ---- Part 4: Sun Microsystems, Inc. copyright notice (BSD)

Copyright © 2003 Sun Microsystems, Inc.,
4150 Network Circle, Santa Clara, California 95054, U.S.A.
All rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

B.7 ODMA 2.0

OPEN DOCUMENT MANAGEMENT API LICENSE 1.0
ODMA 2.0 SPECIFICATIONS AND SOFTWARE
Copyright © 1994-1998 AIIM International

LICENSE:

318 GroupWise 7 Installation Guide



Redistribution and use in source and binary forms, with or without modifications, are permitted
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

* Neither the name of AIIM International nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ADDITIONAL INFORMATION:
* ODMA reference materials, software, and status:

<http://ODMA.info>

* Information about this ODMA License and its application:
<http://DMare.info/license/>

* Open Source Definition 1.9 and the BSD License
(the model for this ODMA license):
<http://opensource.org>

* HTML (ISO 8859-1) version of this license:
<http://Dmware.info/license/P040801F.htm>

B.8 OpenLDAP

The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:
1 Redistributions in source form must retain copyright statements and notices,

2 Redistributions in binary form must reproduce applicable copyright statements and notices, this
list of conditions, and the following disclaimer in the documentation and/or other materials
provided with the distribution, and

3 Redistributions must contain a verbatim copy of this document.
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The OpenLDAP Foundation may revise this license from time to time. Each revision is
distinguished by a version number. You may use this Software under terms of this license revision or
under the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS
CONTRIBUTORS "AS IS AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS CONTRIBUTORS, OR THE
AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to
promote the sale, use or other dealing in this Software without specific, written prior permission.
Title to copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

B.9 OpenSSL

OpenSSL License
Copyright (c) 1998-2002 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact openssl-core@openssl.org.

5 Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear
in their names without prior written permission of the OpenSSL Project.

6 Redistributions of any form whatsoever must retain the following acknowledgment:
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“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ""AS IS” AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscape's SSL.

This library is free for commercial and non-commercial use as long as the following conditions are
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the holder is Tim Hudson
(tth@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author of
the parts of the library used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”

The word “cryptographic” can be left out if the routines from the library being used are not
cryptographic related :-).

4 If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:
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“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS” AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code
cannot be changed; i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

B.10 Python 2.2

Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam, The Netherlands. All
rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and
that the name of Stichting Mathematisch Centrum or CWI not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL STICHTING MATHEMATISCH
CENTRUM BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
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Documentation Updates

This section lists updates to the Installation Guide that have been made since the initial release of
Novell® GroupWise® 7. The information helps you to keep current on documentation updates and,
in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Installation Guide was republished.
Within each dated section, the updates are listed by the section title.

The GroupWise 7 Installation Guide has been updated on the following dates:

» Section C.1, “June 15, 2006 (GroupWise 7 SP 1),” on page 323
» Section C.2, “November 30, 2005,” on page 325

C.1 June 15, 2006 (GroupWise 7 SP 1)

Location Change

Install

Section 2.1, “GroupWise Added support of 64-bit/x86 processors running in 32-bit mode; modified
Administration Requirements,” the Safari version in the list of supported Web browsers; removed

on page 21 Epiphany from the list of supported Web browsers.

Section 2.2, “GroupWise Added Mac OS X on Intel to the list of supported desktop operating
Client Requirements,” on systems; modified the Safari version in the list of supported Web

page 22 browsers; removed Epiphany from the list of supported Web browsers
Section 2.3, “Supported Listed support for PolyServe Matrix Server on Linux and for virtual

Environments,” on page 23 machines.

“Domain Context” on page 32 Clarified that the Domain object can be created in any Organization or
Organizational Unit container in any context in the eDirectory tree.

“Post Office Context” on Clarified that the Post Office object can be created in any Organization
page 37 or Organizational Unit container in any context in the eDirectory tree.

Section 4.3.3, “Selecting the  Clarified that it's best to install the Internet Agent on the same server
Internet Agent Installation where the domain directory is located.
Directory,” on page 86

“Linux: Starting the Internet Added an example of how to stop and disable Postfix before starting the

Agent” on page 97 Linux Internet Agent.
Section 5.3.1, “Deciding Added some best practice information about installing the WebAccess
Where to Install the Agent on a remote server.

GroupWise WebAccess
Components,” on page 109

“Installing the GroupWise Expanded the information about the text-based GroupWise Installation
Agents Using the Text-Based program to include all GroupWise agents; explained using ssh for
Installation Program” on installing to a remote server.

page 179
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Location

Change

“Starting the Linux GroupWise
Agents as Daemons” on
page 182

“Changing the Non-root User”
on page 186

“Enabling the High Availability
Service for the Linux
GroupWise Agents” on

page 187

“Preparing the Windows
Server for the Windows
Agents” on page 193

Chapter 10, “Installing the
GroupWise Mobile Server,” on
page 213

Update

Chapter 12, “What’s New in
GroupWise 7,” on page 219

Section 15.2, “Updating the
Primary Domain,” on
page 256

Section 15.3, “Updating Post
Offices,” on page 257

Section 15.5, “Updating
Secondary Domains,” on
page 261

Section 15.6, “Updating the
GroupWise Internet Agent,”
on page 261

Section 15.7, “Updating
GroupWise WebAccess,” on
page 261

Migration

Part 111, “Migration,” on
page 267

Expanded the information about the grpwi se script; added that the
WebAccess Agent and its accompanying Document Viewer Agent are
now controlled by the grpwise script; indicated that the GroupWise
Linux agents are now Run Control compliant; indicated that the
Messenger agents are also controlled by the grpwise script.

Added instructions for changing the user that the agents run as when
they are running as a non-root user.

Added that the WebAccess Agent and its accompanying Document
Viewer Agent are now supported by the GroupWise High Availability
Service.

Indicated that if you are running the Windows POA for a post office on a
NetWare® server, you might need to increase Maximum File Locks Per
Connection from its default setting on the Windows server.

Added information about GroupWise Mobile Server, Powered by
Intellisync.

Added Support Pack 1 enhancements to the list.

Emphasized that the MTA for the primary domain should be started
before you update post offices and secondary domains.

Included information about the /copyonly startup switch for the Agent
Installation program; emphasized that the POA for the post office should
be started before you run GroupWise clients against the post office.

Included information about the /copyonly startup switch for the Agent
Installation program

Included information about the /copyonly startup switch for the Internet
Agent Installation program; highlighted the SP 1 Internet Agent
enhancement of storing all primary configuration information in
eDirectory because it affects the contents of the gwia.cfg file.

Recommended that users clear their browser caches before using the
updated WebAccess client.

Added a new section detailing how to migrate all GroupWise
components from NetWare or Windows to Linux.
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C.2 November 30, 2005

Location

Change

Install

Section 2.3.1, “IPV6
Support,” on page 23

Section 4.3.2, “Gathering
Server Information,” on
page 85

Update

Section 20, “Migrating a
Post Office and Its POA to
Linux,” on page 275

Section 21, “Migrating a
Domain and Its MTA to
Linux,” on page 283

Entire Guide

Clarified that when you provide the network address for an IPV6
server, you need to use its DNS hostname.

Recommended installing the Internet Agent on the same server with
the domain that it belongs to.

Added a second example mount command.

Added a second example mount command.

Page design reformatted to comply with revised Novell documentation
standards.
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